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Chapter 1. Administration overview
With IBM® InfoSphere® Information Server, you can administer security,
entitlements, clusters and high availability configurations, logs, schedules, and
services, and back up data. Both the IBM InfoSphere Information Server console
and the IBM InfoSphere Information Server Web console provide administration
capabilities.

Security administration
As part of InfoSphere Information Server administration, you set up and manage
suite security. Security administration includes the following tasks:
v Configuring and administering the user registry
The user registry holds user account information, such as user names and
passwords, that can be accessed during authentication. You choose a user
registry for the suite to use. You can choose the internal InfoSphere Information
Server user registry, or an external local operating system or lightweight
directory access protocol (LDAP) user registry. Depending on the registry you
choose and the topology of your installation, you might also have to map
credentials from one user registry to another.
v Controlling access
You create user accounts and groups. You assign roles to users and groups to
specify which features users can use and which projects a user can access. User
roles can be defined at several levels that build on one another.
v Auditing security-related events
Security-related events include all activities that set or modify security-related
settings and all user authentications and application access attempts. You
configure which events to log and how much information to include. You
monitor and analyze the log information to help prevent unauthorized access to
sensitive data.
v

Administering account passwords
You periodically change administrator account passwords to comply with your
security policies.

v

Managing active user sessions
You view current active sessions, and manage session limits. If necessary, you
can force one user or all users to disconnect.

Entitled IBM InfoSphere DataStage® edition and feature pack
administration
As part of InfoSphere Information Server administrator, you control activation of
InfoSphere DataStage editions and feature packs to comply with your Proof of
Entitlement from IBM. Administration includes the following tasks:
v Initial edition and feature pack activation
When you install InfoSphere DataStage, the InfoSphere Information Server
installation program prompts you to select the InfoSphere DataStage editions
and feature packs to install and activate. Select the items for which you have a
valid Proof of Entitlement from IBM. The installation program activates the
features that are associated with the items that you select. Any other editions or
feature packs are deactivated and cannot be used.
© Copyright IBM Corp. 2007, 2014
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v

Maintaining the list of activated items
If you later acquire entitlements for an additional InfoSphere DataStage edition
or feature pack, you must activate the item within InfoSphere Information
Server. If you no longer have entitlement for an item, you must deactivate it.
When you deactivate the edition or feature pack, the features within the item are
no longer available for use.

Clusters and high availability configuration and administration
If a portion of your installation is set up in a clustered or high availability
configuration, you administer the cluster. Administration includes the following
tasks:
Administering an active-passive configuration administration
If one or more software tiers in your installation is set up in an active-passive
configuration, you monitor and manage the server pair. If a hardware or
network error causes a failover to the passive server, you recover projects and
restart any interrupted jobs. You can also force a failover to free the active server
for maintenance or upgrade tasks.
v Administering an application server cluster
v

If the InfoSphere Information Server services tier is implemented in an IBM
WebSphere® Application Server cluster, you administer and maintain the cluster.
Tasks include adding cluster members, adding managed nodes, synchronizing
information between nodes, and restarting processes.
v Administering an IBM DB2® high availability configuration
If the metadata repository tier is implemented in a DB2 cluster or high
availability disaster recovery (HADR) configuration, you monitor the cluster. If a
failover occurs, you recover from a failover and restore service.

Scheduling administration
Many of the product modules use scheduling capabilities. For example, a report
run and an analysis job in IBM InfoSphere Information Analyzer are scheduled
tasks. Scheduling administration includes the following tasks:
Creating, updating, and managing schedules
Schedule management is done within the product module. For example, you
create a schedule for a column analysis job to run weekly in an InfoSphere
Information Analyzer project in the console.
v Viewing schedules
You can obtain a global view of all the scheduled activities for all product
modules. With this data, you can ensure that enough resources are available to
process the schedules. You can monitor who schedules tasks and how often.
v Querying schedules
You can query all the schedules that are defined across all product modules. You
can check their status, history, and forecast. You can also do maintenance tasks
such as purging the scheduled execution history. You can stop or start existing
schedules to prevent system overload.
v

Backup administration
To prevent the loss of data and to prepare for disaster recovery, you administer
regular backups. Backup administration includes the following tasks:
v Backing up InfoSphere Information Server components
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You schedule and perform regular backups of all databases, profiles, libraries,
and other data.
v Restoring components
To recover your data in the event of a hardware failure or other disaster, you can
restore the data that you have backed up.

Service administration
You administer InfoSphere Information Server services and WebSphere Application
Server services. Administration includes the following tasks:
v Placing InfoSphere Information Server in and out of maintenance mode
You can place InfoSphere Information Server in maintenance mode to prevent
non-administrator users from logging in while you run maintenance tasks.
v Stopping and restarting services
Many maintenance and administration tasks require that you stop and restart
various InfoSphere Information Server services or WebSphere Application Server
services.
v

Checking the status of services
You can determine the status of services for troubleshooting or other
maintenance tasks.

Asset administration
Assets include projects, templates, configuration specifications, parameter sets, and
all other information that is produced within the InfoSphere Information Server
product modules. The assets are stored in the metadata repository. Administration
includes the following tasks:
Importing and exporting assets
To move assets from one InfoSphere Information Server installation to another,
you export the assets from one installation and import them into another. For
example, if you have a development system, a test system, and a production
system, you move assets between the systems.
v Querying and deleting assets
You can query certain assets and delete them as necessary.

v

Administration tools
To administer InfoSphere Information Server, you use the following software tools:
v IBM InfoSphere Information Server console
The IBM InfoSphere Information Server console ("the console") is a rich
client-based interface for activities such as profiling data and developing
service-oriented applications. In the console, you can complete administration
tasks, reporting tasks, and the tasks that are associated with IBM InfoSphere
Information Analyzer and IBM InfoSphere Information Services Director.
v

IBM InfoSphere Information Server Web console
The IBM InfoSphere Information Server Web console ("the Web console") is a
browser-based interface for administrative activities such as managing security
and creating views of scheduled tasks. In the Web console, you can perform
administration tasks, reporting tasks, and the tasks that are associated with IBM
InfoSphere Information Governance Catalog.
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For certain tasks, you also use the WebSphere Application Server administrative
console.
To administer assets, you use the istool command line.

IBM InfoSphere DataStage administration
For detailed IBM InfoSphere DataStage administration information, refer to
InfoSphere DataStage administration guides.
Table 1. InfoSphere DataStage administration guides
Title

Description

Administrator Client Guide

Describes the IBM InfoSphere DataStage and
QualityStage® Administrator client and
provides instructions about performing
setup, routine maintenance operations, and
administration on the IBM InfoSphere
Information Server engine.

Designer Client Guide

Describes the IBM InfoSphere DataStage and
QualityStage Designer client and gives a
general description of how to create, design,
and develop an InfoSphere DataStage and
QualityStage application.

Director Client Guide

Describes the IBM InfoSphere DataStage and
QualityStage Director client and explains
how to validate, schedule, run, and monitor
parallel jobs and server jobs.

Globalization Guide

Contains information about using the
national language support (NLS) features
that are available in InfoSphere DataStage
and QualityStage when NLS is installed.

By default, the documentation is installed on your system:
v

Windows
To access a list of the documentation on your system, click Start > All
Programs > IBM InfoSphere Information Server > Documentation.

v

The PDF documentation for the suite is installed in
\IBM\InformationServer\Documentation.
Linux

UNIX

A complete set of the PDF documentation for the suite is on the IBM InfoSphere
Information Server PDF CD that is included with the installation software.

IBM WebSphere Application Server administration
While you can perform most administration tasks in the IBM InfoSphere
Information Server console or IBM InfoSphere Information Server Web console,
you might need to change the user registry configuration, troubleshoot the
application, tune the performance, and perform other configuration tasks directly
in IBM WebSphere Application Server.
You can find information about WebSphere Application Server at the following
locations:
v Version 8.5: publib.boulder.ibm.com/infocenter/wasinfo/v8r5/index.jsp
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For detailed WebSphere Application Server administration information, refer to the
following administration topics.
Table 2. WebSphere Application Server administration topics
Task

Link

Configuring WebSphere Application Server
user registries

Version 8.5: publib.boulder.ibm.com/
infocenter/wasinfo/v8r5/topic/
com.ibm.websphere.base.doc/ae/
tsec_useregistry.html

WebSphere Application Server troubleshooting Version 8.5: publib.boulder.ibm.com/
infocenter/wasinfo/v8r5/topic/
com.ibm.websphere.base.doc/ae/
welc6toptroubleshooting.html
WebSphere Application Server log files

Version 8.5: publib.boulder.ibm.com/
infocenter/wasinfo/v8r5/topic/
com.ibm.websphere.base.doc/ae/
ttrb_mglogs.html

Performance tuning

Version 8.5: publib.boulder.ibm.com/
infocenter/wasinfo/v8r5/topic/
com.ibm.websphere.base.doc/ae/
tprf_tuneprf.html

Configuring language support for IBM
InfoSphere Information Governance Catalog

See the topic about language support in
Governing Information by Using IBM
InfoSphere Information Governance Catalog

Chapter 1. Overview
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Chapter 2. Working with the administration consoles
Use the IBM InfoSphere Information Server Web console (also known as the
InfoSphere Information Server Administration Console) to perform IBM InfoSphere
Information Server administration tasks, such as managing security, creating views
of scheduled tasks, and reporting. Use the IBM WebSphere Application Server
administrative console to manage application server resources, such as
communication ports, sessions, and JDBC data sources.

Opening the IBM InfoSphere Information Server console
To set up security, manage projects, analyze data, enable information services, or
run reports, use the IBM InfoSphere Information Server console. The console is a
rich-client-based interface.

About this task
The IBM InfoSphere Information Server console is a rich-client-based interface for
activities such as profiling data and developing service-oriented applications. In
the console, you can complete tasks that are associated with IBM InfoSphere
Information Analyzer and IBM InfoSphere Information Services Director.
Use the console for the following activities:
v Create and manage projects.
v Set project-level security.
v Analyze data with IBM InfoSphere Information Analyzer.
v Enable information services with IBM InfoSphere Information Services Director.
v Run reports.

Procedure
1. From the Microsoft Windows start menu, select Start > All Programs > IBM
InfoSphere Information Server > IBM InfoSphere Information Server
Console.
2. In the User Name field, type your user name.
3. In the Password field, type your password.
4. In the Server menu, type or select a host name and port number.
The host name and port depend on whether WebSphere Application Server
clustering is set up for your services tier configuration.
5. Click Login.

Opening the IBM InfoSphere Information Server web console
To manage security, view scheduled tasks, or work with reports, use the
InfoSphere Information Server Web console. To access the web console, configure
your browser, specify the URL to use, and navigate to the console window.

© Copyright IBM Corp. 2007, 2014
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Configuring your Web browser to work with the IBM
InfoSphere Information Server Web console
The IBM InfoSphere Information Server Web console is supported with both
Microsoft Internet Explorer and Mozilla Firefox. You must do these steps in your
preferred Web browser before you use the IBM InfoSphere Information Server Web
console.

Before you begin
v Make sure that your browser is supported by InfoSphere Information Server. For
information about supported browsers, see the InfoSphere Information Server
system requirements at www.ibm.com/software/data/integration/info_server/
overview/requirements.html.
v Determine the URL to use to access the web console. See Logging in to the IBM
InfoSphere Information Server Web console. The host name and port differ
depending upon the IBM WebSphere Application Server configuration in use.
v Because HTTPS is enabled, the first time that you access the Web console, a
message about a security certificate is displayed if the certificate from the server
is not trusted. If you receive such a message, follow the browser prompts to
accept the certificate and proceed to the login page.

Configuring Microsoft Internet Explorer to work with the IBM
InfoSphere Information Server Web console
You can enable Microsoft Internet Explorer to work with the IBM InfoSphere
Information Server Web console.

Procedure
1. Enable JavaScript:
a. Click Tools > Internet Options. On the Security tab, click Custom Level.
b. In the Security Settings window, select Scripting > Active Scripting >
Enable.
2. Set the browser to accept cookies for the InfoSphere Information Server host
site.
a. Click Tools > Internet Options.
b. On the Privacy tab, click Sites.
c. In the Address of Web site field, enter the InfoSphere Information Server
host name.
d. Click Allow.
e. Click OK.
3. Enable pop-up windows for the URL of the IBM InfoSphere Information Server
Web console:
a. Click Tools > Pop-up Blocker > Pop-up Blocker Settings or turn off the
pop-up window blocker.
b. If you selected the settings, type the URL and click Add.
Note: To enable pop-up windows for the site, you might also need to disable
or configure pop-up blockers.
4. Specify that the pages are refreshed every time you visit the site:
a. Click Tools > Internet Options and on the General tab, click Settings. Select
Settings in the Browsing history section.
b. Select Every time I visit to the webpage or Automatically and click OK.
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5. Configure Compatibility View settings:
a. Click Tools > Compatibility View settings.
b. Specify the URL of the Web console in the Add this website field, and then
click Add.
c. Click Close.
6. Optional: Disable the display of friendly HTTP error messages:
a. Click Tools > Internet Options.
b. On the Advanced tab, clear Browsing > Show friendly HTTP error
messages.

Configuring Internet Explorer to work with the IBM InfoSphere
Information Server Web console on Microsoft Windows Server
2008
In Microsoft Windows Server 2008, you might need to add the InfoSphere
Information Server web console URL to the trusted sites zones in Internet Explorer.

About this task
If you are browsing to an IBM InfoSphere Information Server Web console by
using its host name, such as https://hostname:9443/ibm/iis/console, you must
add the URL (https://hostname) to the trusted site zones in Internet Explorer.
You do not have to add the URL to the trusted sites zones if your client computer
is also your server and you are browsing to the server by using the URL
https//localhost:9443/ibm/iis/console, or if you are using Mozilla Firefox.

Procedure
1. In Microsoft Internet Explorer, choose Tools > Internet Options.
2. In the Security tab, select the Trusted Sites zone.
3. Click Sites.
4. In the Trusted Sites window, enter the URL and click Add.

Configuring Mozilla Firefox to work with the IBM InfoSphere
Information Server Web console
You can configure Mozilla Firefox to work with the IBM InfoSphere Information
Server Web console.

Procedure
1. Enable JavaScript:
a. Click Tools > Options, and on the Content tab, click Enable JavaScript.
2. Set the browser to accept cookies for the InfoSphere Information Server host
site.
a. Click Tools > Options.
b. On the Privacy tab, click the Accept cookies from sites option or click
Exceptions and add the site to the allowed site list by entering the host
name and clicking Allow.
3. Enable pop-up windows for the URL of the web console:
a. Click Tools > Options.
b. Select the Contents tab and either clear the Block pop-up windows option
or click Exceptions and add the site to the allowed list by entering the host
name and clicking Allow.
Chapter 2. Working with the administration consoles
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Viewing report results in a Web browser
Set additional security options to ensure that report results open correctly in
Microsoft Internet Explorer.

Procedure
1. In the Internet Explorer toolbar, click Tools > Internet Options.
2. On the Security tab, click the zone in which the services tier is located, such as
Local intranet.
3. On the Security tab, click Custom Level.
4. In the Security Settings window, scroll to Automatic prompting for file
downloads under Downloads and select Enable.
5. Click OK.
6. Click OK.

Logging in to the IBM InfoSphere Information Server Web
console
The IBM InfoSphere Information Server Web console is a browser-based interface
for administrative activities.

Before you begin
v Make sure that your browser is supported by IBM InfoSphere Information
Server. For information about supported browsers, see the InfoSphere
Information Server system requirements at www.ibm.com/software/data/
integration/info_server/overview/requirements.html.
v Configure your browser as described in “Configuring your Web browser to work
with the IBM InfoSphere Information Server Web console” on page 8.

Procedure
1. Open a web browser, and navigate to the IBM InfoSphere Information Server
Web console in one of two ways:
v Specify the URL directly: https://hostname:port/ibm/iis/console
v Launch it from the IBM InfoSphere Information Server Web console icon in
the launchpad, which is located at https://hostname:port/ibm/iis/
launchpad
hostname
The host name or IP address of the services tier computer. In a clustered
environment, specify the host name for the front-end dispatcher. Do not use
the host name of a particular cluster member.
port
The port number for the application server. In a clustered environment, use
the value for the front-end dispatcher. Do not use the port number for a
particular cluster member Unless changed during installation or afterward,
the default port number is 9443.
2. If a message is displayed indicating that the certificate from the server is not
trusted, follow the browser prompts to accept the certificate and proceed to the
login page.
3. Specify your user name and password.
4. Optional: If enabled, you can select the Automatically log in check box to
generate a cookie so that the next time you try to connect you are automatically
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connected. To remove the cookie, and to be able to log in with a different user
name and password, you must click the Logout link in the console to log out of
the session.
5. Click Login.

Logging in to the IBM WebSphere Application Server administrative
console
Because IBM InfoSphere Information Server server-side processes run on
WebSphere Application Server, you do certain administrative tasks with the
application server. You administer IBM WebSphere Application Server Network
Deployment by using the WebSphere Application Server administrative console.
IBM WebSphere Application Server Liberty Profile does not have an administrative
console.

Before you begin
To perform various tasks in the WebSphere Application Server administrative
console, you must have sufficient authority. The authority level that you require
differs from task to task.

Procedure
1. Open a Web browser, and navigate to the WebSphere Application Server
administrative console. The URL is in the following form:
https://hostname:port/ibm/console
Specify hostname and port in the following manner:
v If WebSphere Application Server clustering is set up for your services tier
configuration, specify the host name (or IP address) and port of the computer
that hosts the Deployment Manager. The default port number is 9043.
v If clustering is not set up, specify the host name or IP address of the
computer where WebSphere Application Server is installed. Specify the port
number that is assigned to the WebSphere Application Server administrative
console. The default port number is 9043.
2. Log in to the WebSphere Application Server administrative console.

Chapter 2. Working with the administration consoles
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Chapter 3. IBM InfoSphere Information Server console
overview
The IBM InfoSphere Information Server console is a rich-client-based interface for
activities such as creating and managing projects, setting project-level security,
analyzing data with IBM InfoSphere Information Analyzer, enabling information
services with IBM InfoSphere Information Services Director, and running reports.
From the IBM InfoSphere Information Server console, you can complete the
following tasks:
v Create a project
v Set up project-level security
v Analyze information
– Columns
– Primary keys and foreign keys
– Across multiple data sources
v Enable information services
– Connect to providers
– Develop projects, applications, services, and operations
– Deploy services
v Run reports
v Create views of scheduled tasks and logged messages
v Troubleshoot jobs

Opening the IBM InfoSphere Information Server console
To set up security, manage projects, analyze data, enable information services, or
run reports, use the IBM InfoSphere Information Server console. The console is a
rich-client-based interface.

About this task
The IBM InfoSphere Information Server console is a rich-client-based interface for
activities such as profiling data and developing service-oriented applications. In
the console, you can complete tasks that are associated with IBM InfoSphere
Information Analyzer and IBM InfoSphere Information Services Director.
Use the console for the following activities:
v Create and manage projects.
v Set project-level security.
v Analyze data with IBM InfoSphere Information Analyzer.
v Enable information services with IBM InfoSphere Information Services Director.
v Run reports.

Procedure
1. From the Microsoft Windows start menu, select Start > All Programs > IBM
InfoSphere Information Server > IBM InfoSphere Information Server
Console.
© Copyright IBM Corp. 2007, 2014
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2. In the User Name field, type your user name.
3. In the Password field, type your password.
4. In the Server menu, type or select a host name and port number.
The host name and port depend on whether WebSphere Application Server
clustering is set up for your services tier configuration.
5. Click Login.

Main areas of the console
The IBM InfoSphere Information Server console provides workspaces that you use
to investigate data, deploy applications and Web services, and monitor schedules
and logs.
In the following topics, both IBM InfoSphere Information Analyzer and IBM
InfoSphere Information Services Director were installed. Some features might not
be available if you have only one product module installed.

My Home workspace
When you open the IBM InfoSphere Information Server console, the My Home
workspace is shown. In this workspace, you can access getting started information
and you can access projects.
The following figure shows the My Home workspace. You can customize the
sections that appear in the workspace.
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Figure 1. The My Home workspace in the IBM InfoSphere Information Server console

This workspace contains the following sections:

Getting Started pane
The Getting Started pane describes how to work in a product module, such as how
to work in IBM InfoSphere Information Analyzer. The information that is displayed
corresponds to the product modules that you have installed.

Chapter 3. IBM InfoSphere Information Server console overview
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Figure 2. The Getting Started pane

Many topics in the Getting Started pane have a link that opens the related task and
a link that opens the information center for more information (the "Learn more"
link).

Projects pane
In the Projects pane, you can select a project to open. Multiple users can contribute
to and work on a project in the console. This pane shows a list of all of the projects
that you have access to.

Figure 3. The Projects pane

If you select an InfoSphere Information Analyzer project from the Projects pane,
you can see the status of that project in the project details section.

Workspace Navigator
The primary means of navigating through the workspaces is the Workspace
Navigator. The Workspace Navigator is a series of menus that you use to move
through workspaces.
The Workspace Navigator consists of five navigation menus. Each navigation menu
contains links to workspaces that you use to complete tasks. The workspaces that
are available depend on the product module that you are working in. Some
navigation menus might be empty if a particular component has not been installed.
Each workspace corresponds to a navigation menu. For example, if you open the
project properties workspace, the Overview navigation menu is highlighted. You
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can view all open workspaces that are associated with the current navigation menu
that is selected. You cannot view any open workspaces that are associated with a
navigation menu that is not selected.
When you select a link and open a workspace, the number on the navigation menu
indicates how many workspaces are open per menu. For example, if the dashboard
workspace and the project properties workspace are open, the number 2 is
displayed on the Overview navigation menu.

Figure 4. The Workspace Navigator on the IBM InfoSphere Information Server console toolbar

The types of tasks that are available depend on the product module and project
that you are working with. The following list describes the type of tasks that are
available in each of the menus.
Home navigation menu
Contains configuration and metadata tasks. For example, if you have IBM
InfoSphere Information Services Director installed, you can set up
connections to available information providers in the Information Services
Connection workspace.
Overview navigation menu
Contains the project dashboard and Project Properties workspace. For
example, you specify project details in the Project Properties workspace.
Investigate navigation menu
Contains information discovery and data profiling tasks. For example, if
you have IBM InfoSphere Information Analyzer installed, you can run a
column analysis job in the Column Analysis workspace.
Develop navigation menu
Contains data transformation and information services enablement tasks.
For example, if you have InfoSphere Information Services Director
installed, you design, create, and develop applications in the Information
Services Application workspace.
Operate navigation menu
Contains job scheduling tasks, logging tasks, and information services
application tasks. For example, you create views of logged messages in the
Log View workspace.

Project menu
Above the Workspace Navigator, you can access the project menu to open a
project, move between open projects, and create projects.
Chapter 3. IBM InfoSphere Information Server console overview
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To open the project menu, click the drop-down menu.

Figure 5. The Project menu above the Workspace Navigator

You can perform configuration and administrative tasks, such as logging,
scheduling, and reporting, outside of the context of a project in the console.
To perform product module tasks, such as information analysis or services
enablement, you must first open a project. A project is a logical container for all of
the tasks that can be performed in a product module.

Palettes
You can use the palettes to view a history of your activities and to open
workspaces, access shortcuts, and manage notes. You can dock, float, or anchor the
palettes. By default, the palettes are located on the left side of the console.
To open the palettes, click one of the tabs.
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Figure 6. The Palettes tabs

Notes Use this palette to view the notes that are associated with an object. Notes
are only available for some product modules.
Shortcuts
Use this palette to go to workspaces or panes for which you previously
created shortcuts.
History
Use this palette to view a list of the workspaces you visited. The current or
most recently visited workspace is at the top of the list.
Open Workspaces
This palette shows all open workspaces. Project-specific workspaces are
grouped by project.
To hide the palettes, click outside of the pane.

Chapter 3. IBM InfoSphere Information Server console overview
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Project dashboard
When you open a project, the project dashboard is displayed.
IBM InfoSphere Information Analyzer and IBM InfoSphere Information Services
Director projects both contain a dashboard. The following figure shows an example
of the InfoSphere Information Analyzer dashboard.

Figure 7. The Project dashboard for InfoSphere Information Analyzer

Use the Dashboard tab to learn more about the task workflow and, for some
product modules, to view the current status of the project. You can customize the
dashboard in the console to add or remove content panes. For some product
modules, you can also configure the dashboard to show a set of charts and graphs
that are based on underlying project information.

Status bar
After you submit a job that requires processing, the status bar is displayed at the
bottom of the workspace.
The status bar shows the progress of activities, error messages, and warnings. You
use the status bar to monitor any jobs or activities that you initiated.
The status bar can be in one of the following states:
Closed
When no activities are running, the status bar is closed.
Activity in progress
When an activity or job is running, the status bar remains closed and
displays a green status indicator that moves across the length of the bar.
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Notification
When you initiate an activity or when an activity is completed, the status
bar opens briefly and shows details about the status of the activity. When
an activity is running, you can view more information about the status of
the activity by rolling your cursor over the status bar to open the status
pane. The status pane contains a larger progress bar, summary information
about the activity, and a Details button. You can roll over the status bar at
any time to view the status of the jobs or activities that you initiated.
Details
To view information about the status of an activity, click the Details button
in the status pane. You can view details such as the time that the activity
started running and whether there are any system warnings or errors. The
Details state lists all the activities and jobs that you initiated.

Shortcuts
To quickly return to a task at a later time, you can create a shortcut.
To create a shortcut to the open task, click the Shortcut button

.

After you create the shortcut, you can click the Shortcuts tab to return to the task.

Figure 8. The Shortcuts tab

Notes
You can use notes to comment on objects, provide information to other users, and
identify issues for further investigation. Notes are available depending on the suite
component that you are working in.
You can create or view notes by using the notes palette or clicking on a note icon.
Note icons are located at the top of task panes.

Basic task flow in the workspaces
Even though you perform different types of tasks in an IBM InfoSphere
Information Analyzer project and an IBM InfoSphere Information Services Director
project, the basic task flow is the same.
The following topics describe the basic task flow in the workspaces. This example
shows the task flow in the context of creating a column analysis job with
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InfoSphere Information Analyzer. The types of tasks and options that are available
will vary between InfoSphere Information Analyzer projects and InfoSphere
Information Services Director projects.

Select a task menu from the Workspace Navigator
After you open a project, the first step is to select a task menu from the Workspace
Navigator.

About this task
The Workspace Navigator consists of five navigation menus. Each navigation menu
contains links to workspaces that you use to complete tasks. The workspaces that
are available depend on the suite component that you are working in. Some
navigation menus might be empty if a particular component has not been installed.
Select the menu that corresponds with the type of task you want to perform.

Figure 9. In this example, the user selects the Investigate task menu

Select the task that you want to perform from the task menu
Next, you select the task that you want to perform from the task menu.

About this task
Each navigation menu contains a list of high-level tasks that you can perform.
Select the task to open the workspace that is associated with that high-level task.
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Figure 10. In this example, the user selects Column Analysis to open the Column Analysis workspace

Select objects and a task in the workspace
In the workspace, you select an item to work with from the objects lists and then
select a task to perform from the Tasks list.

About this task
The object list contains the items that you perform the tasks on, such as data
sources, applications and services, or log views. The object list can also contains
status information, such as the completion of analysis or the creation date of a log
view.
The Tasks list contains the tasks that you can perform on the selected objects.
Select an object to work with in the objects list, as shown in the following figure.

Figure 11. Example of data sources selected in the Column Analysis workspace's object list
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23

And then, select the task that you want to perform from the Tasks list.

Figure 12. Example of selecting task from the Tasks list in the Column Analysis workspace.

Tasks might be unavailable if you have not yet selected an object, or if there is a
prerequisite task.

Work in a task pane
After you select a task from the Tasks lists, a task pane opens. In the task pane,
you can select options and provide details to complete the task.

About this task
Note that when the task pane opens, the object list and Tasks list are collapsed at
the top of the workspace. The following figure shows the Run Column Analysis
task pane.

Figure 13. The Run Column Analysis task pane
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The content of each task pane differs. Many task panes require that you select
options and provide additional details. You can also schedule certain tasks to run
at specified times or intervals. The asterisk (*) indicates a required field.
When you have completed the task, click Save or Submit.
After you submit a job that requires processing, the status bar is displayed at the
bottom of the workspace.

Figure 14. Status bar showing the progress of the column analysis job

Reporting and scheduling in the console
The IBM InfoSphere Information Server console also gives you access to common
administrative tasks, such as reporting and scheduling.

Reporting
You can use the reports workspace to create, edit, or view a report. A report shows
the details of an activity that has been completed in the suite.
To create a report, you select a report template and then specify the project that
you want to associate with the report. You then type parameters for the report and
choose the format that you want the report to be created in such as PDF or XML.
The report templates that are available correspond to the components in the suite.
To edit a report, you select the report that you want to modify and then create a
copy of it. You make any changes in the copy.
Reports can be saved in the metadata repository and can be accessed by you or by
other authorized users. You or other users can use the information in the reports to
complete other tasks in the product modules.
You can also use the reports workspace to view saved reports that were generated
in the suite and to select certain reports as your favorites. To find a report, you can
filter the list of available reports by the names of the projects that they are
associated with or by the dates on which the reports were created. If you select a
report as a favorite, the report is accessible in the report favorites pane in the My
Home workspace.

Scheduling
You create schedule views to query the schedules that you created elsewhere in the
suite.
You create a schedule to define when an activity will run in the suite component
that you are working in. A schedule contains details about when the activity will
run, such as a specific time or day. Schedules can be configured to run at any time
or on any date that you specify. You can also configure schedules to run repeatedly
or at different intervals.
A schedule view shows information such as a list of available schedules in the
suite, a history of the scheduled tasks that have completed, and a forecast of the
schedules that will run at a specific time. You can create a query in multiple ways:
Chapter 3. IBM InfoSphere Information Server console overview
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by selecting the name of a schedule that you want to view, the user who created
the schedule, the date on which the schedule will run, or the date on which the
schedule was created or updated. You can also query schedules by the suite
component that they were created in. You can view only the schedules that you
created. A suite administrator can view all schedules in the suite.
You can make a schedule view private to restrict users from accessing it. Schedule
views that are marked as private are available only to the user who created them.
If you want to make a schedule view available to all users, you can mark it as
shared. A shared schedule view can only be edited by the user who created the
schedule view or by the suite administrator.

Working with projects in the IBM InfoSphere Information Server
console
In the IBM InfoSphere Information Server console, a project is a logical container
for all of the tasks that can be performed in a product module. Multiple users can
contribute to a project and view the status of a project over time.

Setting up a project in the IBM InfoSphere Information Server
console
To set up a project, you first create a project and provide basic project details.

Creating a project
You must first create a project. A project is a logical container for all of the tasks
that can be performed in a product module.

Before you begin
You must have permissions to create a project. If you do not, all project creation
menus and tasks are disabled.

Procedure
1. On the File menu in the IBM InfoSphere Information Server console, select
New Project.
2. In the New Project window, select the type of project that you want to create.
The Type field is displayed only if more than one product module is installed.
3. Type a name for the project.
4. Click OK to open the Project Properties workspace.

What to do next
v “Modifying project properties”
v “Assigning users to a project and assigning roles” on page 100

Modifying project properties
You can view and modify the properties of your project.

Before you begin
You must have project administrator authority.
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Procedure
1. On the Overview navigator menu in the IBM InfoSphere Information Server
console, select Project Properties.
2. Specify information about the project.
3. Click Save All.

Customizing the project dashboard
You can customize the Dashboard workspace in the IBM InfoSphere Information
Server console to add or remove content panes. For some product modules, you
can also configure the dashboard to show a set of charts and graphs that are based
on underlying project information.

Procedure
1. On the Overview navigator menu in the IBM InfoSphere Information Server
console, select Dashboard.
2. In the Dashboard workspace, click Configure
3. Optional: Click Add to add content panes to the Content list. The available
content panes depend on the product modules that are installed.
4. In the Configure Dashboard window, select the content pane that you want to
modify.
5. For each content pane, you can modify the label of the pane and select whether
it is displayed on the workspace. Some content panes have additional
configuration properties.
6. Click OK to save your changes.

Opening an existing project in the InfoSphere Information
Server console
You can open an existing project to perform tasks that are associated with the
project's product module, such as information analysis or information services
enablement.

Before you begin
You or your administrator must create and set up a project.

Procedure
1. In the Projects pane of the My Home workspace, select a project from the list.
2. Click Open Project to open the Dashboard workspace.

Customizing the IBM InfoSphere Information Server console
The IBM InfoSphere Information Server console integrates multiple product
modules into a unified user interface. To customize the IBM InfoSphere
Information Server console, you can set user preferences, create shortcuts, create
notes, and change your password.

Modifying user preferences
You can modify user preferences for startup, to change the behavior of panes, and
to customize the status bar.

Chapter 3. IBM InfoSphere Information Server console overview
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Procedure
1. Select Edit > Preferences.
2. In the User Preferences window, select the type of preferences that you want to
modify.
3. Modify the available options.
4. Click OK to close the window and save your changes.

Creating shortcuts
You can create shortcuts to quickly access frequently used workspaces or tasks.

Procedure
On the workspace or task, click Add Shortcut
.
In the Add to Shortcuts window, type a name for the shortcut.
Optional: Click New Folder to create a folder to organize your shortcuts.
Optional: Select a folder to add your shortcut to. You can also drag folders
around in the list to reorder them or to nest them.
5. Click OK to save your changes.
1.
2.
3.
4.

What to do next
You can now access your shortcut on the Shortcuts palette.

Working with palettes
Palettes are containers for IBM InfoSphere Information Server console shortcuts,
workspace history, open workspaces, and notes. You can dock, float, and anchor
the palettes.

About this task
By default, the palettes are docked on the left side of the IBM InfoSphere
Information Server console. When docked, the palettes display as a set of vertical
tabs.

Procedure
To open a palette, click the tab. You can click a workspace to hide the palettes
again.

What to do next
To pin the palette to stay open, click the pin image

.

To reposition a palette, right-click the tab or the top bar of the palette.

Floating the palettes
You can float the palettes to move them as a separate pane in the IBM InfoSphere
Information Server console. You can float an individual palette or you can float the
palettes as a group.
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Procedure
To float the palettes as a group, select the top bar of the palettes and drag it to a
new location in the console. You can also select and drag an individual tab in the
palettes to just float that tab.

What to do next
Floated palettes can be docked by clicking Dock

, or anchored by clicking

.

Anchor

Anchoring the palettes
You can anchor the palettes to one side of the workspace. You can anchor an
individual palette or you can anchor the palettes in groups.

Procedure
To anchor a palette, drag the palette to the opposite edge of the workspace.
Anchored palettes can be stacked vertically or grouped together in one or more
sets.

What to do next
Anchored palettes can be docked by clicking Dock

, or floated by clicking

.

Float

To switch the side of the window that the palettes are docked or anchored to,
select the top bar of the docked palettes and drag it to the other side of the
workspace.

Creating notes
In some product modules, you can create notes to comment on an object, provide
information to other users, and flag issues for further investigation.

Procedure
1. On the pane or table that you want to add the note, click Note
.
2. On the Notes palette, click New. New notes are saved when you create them.
3. In the table, specify information for the note. Any changes you make to a note
are automatically saved.
4. In the Notes palette, click Close.

What to do next
After you create the note, you and other users can access the note by clicking Note
.

Refreshing an object list
You can refresh an object list to view changes made by other users.
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Procedure
To refresh an object list, click Refresh
object list.

or right-click the header above the

Changing your password
You can change the password that you use to log in to the server. If IBM
InfoSphere Information Server is configured to authenticate against an external
directory, passwords cannot be changed.

Procedure
To change your password, click File > Change Password.

Online help
If you need help when you are working on a task, press F1 to access
context-sensitive help, open the information center, or find specific information
about the task in the instruction pane.

Context-sensitive help
When you need assistance while you work, press F1 to open context-sensitive help.
For example, from the project properties workspace, press F1 to open the project
properties documentation in the information center.

Information center
The information center is this Web-based help system and knowledge base, in
which you can find conceptual and task-based information about the suite, the
console, and the tasks that you can complete in the IBM InfoSphere Information
Server console. You can also access information about all the products that you
have installed.

Instruction panes
You can find information about the task in the instruction pane. An instruction
pane button appears at the top of most panes and tabs. Most panes contain
instructional text.

Figure 15. The instruction icon highlighted

To show the instructional text, click
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(instruction pane).

To hide the instructional text, click the instruction icon again.
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Chapter 4. Working with projects in the IBM InfoSphere
Information Server console
In the IBM InfoSphere Information Server console, a project is a logical container
for all of the tasks that can be performed in a product module. Multiple users can
contribute to a project and view the status of a project over time.

Setting up a project in the IBM InfoSphere Information Server console
To set up a project, you first create a project and provide basic project details.

Creating a project
You must first create a project. A project is a logical container for all of the tasks
that can be performed in a product module.

Before you begin
You must have permissions to create a project. If you do not, all project creation
menus and tasks are disabled.

Procedure
1. On the File menu in the IBM InfoSphere Information Server console, select
New Project.
2. In the New Project window, select the type of project that you want to create.
The Type field is displayed only if more than one product module is installed.
3. Type a name for the project.
4. Click OK to open the Project Properties workspace.

What to do next
v “Modifying project properties” on page 26
v “Assigning users to a project and assigning roles” on page 100

Modifying project properties
You can view and modify the properties of your project.

Before you begin
You must have project administrator authority.

Procedure
1. On the Overview navigator menu in the IBM InfoSphere Information Server
console, select Project Properties.
2. Specify information about the project.
3. Click Save All.
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Customizing the project dashboard
You can customize the Dashboard workspace in the IBM InfoSphere Information
Server console to add or remove content panes. For some product modules, you
can also configure the dashboard to show a set of charts and graphs that are based
on underlying project information.

Procedure
1. On the Overview navigator menu in the IBM InfoSphere Information Server
console, select Dashboard.
2. In the Dashboard workspace, click Configure
3. Optional: Click Add to add content panes to the Content list. The available
content panes depend on the product modules that are installed.
4. In the Configure Dashboard window, select the content pane that you want to
modify.
5. For each content pane, you can modify the label of the pane and select whether
it is displayed on the workspace. Some content panes have additional
configuration properties.
6. Click OK to save your changes.

Opening an existing project in the InfoSphere Information Server
console
You can open an existing project to perform tasks that are associated with the
project's product module, such as information analysis or information services
enablement.

Before you begin
You or your administrator must create and set up a project.

Procedure
1. In the Projects pane of the My Home workspace, select a project from the list.
2. Click Open Project to open the Dashboard workspace.
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Chapter 5. Customizing the consoles
You can customize both the IBM InfoSphere Information Server console and the
IBM InfoSphere Information Server Web console.

Customizing the IBM InfoSphere Information Server console
The IBM InfoSphere Information Server console integrates multiple product
modules into a unified user interface. To customize the IBM InfoSphere
Information Server console, you can set user preferences, create shortcuts, create
notes, and change your password.

Modifying user preferences
You can modify user preferences for startup, to change the behavior of panes, and
to customize the status bar.

Procedure
1. Select Edit > Preferences.
2. In the User Preferences window, select the type of preferences that you want to
modify.
3. Modify the available options.
4. Click OK to close the window and save your changes.

Creating shortcuts
You can create shortcuts to quickly access frequently used workspaces or tasks.

Procedure
1. On the workspace or task, click Add Shortcut

.

2. In the Add to Shortcuts window, type a name for the shortcut.
3. Optional: Click New Folder to create a folder to organize your shortcuts.
4. Optional: Select a folder to add your shortcut to. You can also drag folders
around in the list to reorder them or to nest them.
5. Click OK to save your changes.

What to do next
You can now access your shortcut on the Shortcuts palette.

Working with palettes
Palettes are containers for IBM InfoSphere Information Server console shortcuts,
workspace history, open workspaces, and notes. You can dock, float, and anchor
the palettes.

About this task
By default, the palettes are docked on the left side of the IBM InfoSphere
Information Server console. When docked, the palettes display as a set of vertical
tabs.
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Procedure
To open a palette, click the tab. You can click a workspace to hide the palettes
again.

What to do next
To pin the palette to stay open, click the pin image

.

To reposition a palette, right-click the tab or the top bar of the palette.

Floating the palettes
You can float the palettes to move them as a separate pane in the IBM InfoSphere
Information Server console. You can float an individual palette or you can float the
palettes as a group.

Procedure
To float the palettes as a group, select the top bar of the palettes and drag it to a
new location in the console. You can also select and drag an individual tab in the
palettes to just float that tab.

What to do next
Floated palettes can be docked by clicking Dock

, or anchored by clicking

.

Anchor

Anchoring the palettes
You can anchor the palettes to one side of the workspace. You can anchor an
individual palette or you can anchor the palettes in groups.

Procedure
To anchor a palette, drag the palette to the opposite edge of the workspace.
Anchored palettes can be stacked vertically or grouped together in one or more
sets.

What to do next
Anchored palettes can be docked by clicking Dock
Float

, or floated by clicking

.

To switch the side of the window that the palettes are docked or anchored to,
select the top bar of the docked palettes and drag it to the other side of the
workspace.

Creating notes
In some product modules, you can create notes to comment on an object, provide
information to other users, and flag issues for further investigation.
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Procedure
1. On the pane or table that you want to add the note, click Note
.
2. On the Notes palette, click New. New notes are saved when you create them.
3. In the table, specify information for the note. Any changes you make to a note
are automatically saved.
4. In the Notes palette, click Close.

What to do next
After you create the note, you and other users can access the note by clicking Note
.

Refreshing an object list
You can refresh an object list to view changes made by other users.

Procedure
To refresh an object list, click Refresh
object list.

or right-click the header above the

Changing your password
You can change the password that you use to log in to the server. If IBM
InfoSphere Information Server is configured to authenticate against an external
directory, passwords cannot be changed.

Procedure
To change your password, click File > Change Password.

IBM InfoSphere Information Server Web console
You can access suite administration and reporting tasks, information about
deployed information services, and glossaries of information assets in the IBM
InfoSphere Information Server console.

Changing your password
You can change the password that you use to log in to the IBM InfoSphere
Information Server Web console.

Procedure
To change your password, click Change Password in the top right corner of the
Web console window and type the required information.
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Chapter 6. Managing security
To set up security, you configure the user registry, control access levels, create or
update users and groups, and configure audit logging. After security is set up, you
can change user names and passwords and perform other administrative tasks by
using IBM InfoSphere Information Server administration commands and tools.

Audit logging configuration
The Auditing service creates an audit trail of security-related events. These events
include all security-related settings changes and user login and logout operations.
You can configure which audit events to log and how much information to include
based on your auditing requirements.
The auditing configuration is controlled by the iisAdmin command. Security
auditing trails assist in the detection of access to controlled information and
application usage. Monitoring and analysis of the logged audit information can
lead to improvements in the control of data access and the prevention of malicious
or careless unauthorized access to sensitive data or configuration settings. The
monitoring of application and individual user access, including system
administration actions, provides an historic record of activity. This information
allows you to adjust user or group security roles to enable or prevent access to
application features. This information can also assist in showing compliance with
corporate security policies.
The following events log audit records:
v Creation and removal of users and groups
v Assignment or removal of a user from a group
v User password changes (does not log the password)
v Changes to security roles assigned to users or groups
v Changes to user or group permissions on a project and the associated
project-level security roles that are assigned
v Changes to mapped engine credentials
v User login
v User logout
v Session termination
v Session timeout
v Changes to audit logging configuration settings
See “Types of audit events” on page 42 for more information about these events.

Configuring auditing events
Use the iisAdmin command to configure auditing events. Use the following
command to configure audit logs for different events:
v

Linux

UNIX

cd IS_install_path/ASBServer/bin
./iisAdmin.sh -set -key value -value value

v

Windows
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cd IS_install_path\ASBServer\bin
iisAdmin.bat -set -key value -value value

For example, to create an audit event for logout, use the following command:
./iisAdmin.sh -set -key com.ibm.iis.isf.audit.event.LOGOUT -value ALL

Audit log files
The default naming convention for the audit files is ISauditLog_N.log.
The default path where audit files are located:
IBM WebSphere Application Server Network Deployment
v

Linux

v

Windows

UNIX

WAS_install_path/profiles/InfoSphere/logs

WAS_install_path\profiles\InfoSphere\logs

IBM WebSphere Application Server Liberty Profile
v

Linux

v

Windows

UNIX

IS_install_path/wlp/usr/servers/iis/logs

IS_install_path\wlp\usr\servers\iis\logs

Types of audit properties
Audit properties are set with the iisAdmin command. The following is a list of the
audit properties that can be set. The value that is specified for each option is the
default value.

Enable or disable auditing
If you set this value to false, then all other com.ibm.iis.isf.audit.* settings will
be ignored.
com.ibm.iis.isf.auditing.enable=true

Location where audit files are written
The application server process owner must have write access to this directory. A
relative path is from the IBM InfoSphere Information Server profile directory in the
application server profiles path.
com.ibm.iis.isf.audit.file.path=logs

Audit file name
A pattern consisting of a string that includes the following special components that
are replaced at runtime:
v %g: The generation number to distinguish rotated logs.
v %%: Translates to a single percent sign.
com.ibm.iis.isf.audit.file.name=ISauditLog_%g.log
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Maximum size of each audit log file
The size is indicated in bytes. If the value is zero (0) then there is no limit. Use
zero with caution.
com.ibm.iis.isf.audit.file.size=10000000

Maximum number of audit log files to rotate through
If greater than one and the %g generation parameter is not included in the audit
file name, then a dot followed by a generation number is added automatically to
the end of the file name. Generation numbers start with zero. Existing audit files
are renamed when a new file is created, incrementing the existing generation
number. Therefore, the file with the zero generation number is the most recent; the
higher the generation number, the older the log file. The count includes the zero
generation file. For example, if the count is 5, filenames ISauditLog_0.log through
ISauditLog_4.log are created.
com.ibm.iis.isf.audit.file.count=5

Audit file format
The choices are Simple, XML, or both. If configured as XML, then the file name
extension specified in the com.ibm.iis.isf.audit.file.name property is replaced
with .xml or .xml is added to the end of the file name if no extension is
configured. If specified as both, then an XML file will be written as previously
described and a simple file will be written according to the naming convention
specified in com.ibm.iis.isf.audit.file.name.
com.ibm.iis.isf.audit.file.format=Simple

Whether to append to existing files
If set to false, a new zero generation audit file is created whenever the application
server is restarted. A setting of false is recommended for audit file formats of
XML to prevent multiple XML headers being written to the same file. If set to true,
the existing zero generation audit file is appended to until the maximum file size is
reached.
com.ibm.iis.isf.audit.file.append=true

Audit event enablement and log level
You can set the desired log level for each audit event. The options available for
each event are ALL, INFO, or OFF. The value must be specified in uppercase. The ALL
option enables logging of finer audit events as well, such as system user login and
logout events. Defined audit events that are not configured here default to ALL.
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com.ibm.iis.isf.audit.event.ADD_USER=ALL
com.ibm.iis.isf.audit.event.ADD_GROUP=ALL
com.ibm.iis.isf.audit.event.DELETE_USERS=ALL
com.ibm.iis.isf.audit.event.DELETE_GROUPS=ALL
com.ibm.iis.isf.audit.event.ADD_USERS_TO_GROUPS=ALL
com.ibm.iis.isf.audit.event.DELETE_USERS_FROM_GROUPS=ALL
com.ibm.iis.isf.audit.event.CHANGE_PASSWORD=ALL
com.ibm.iis.isf.audit.event.SET_CREDENTIAL=ALL
com.ibm.iis.isf.audit.event.REMOVE_CREDENTIAL=ALL
com.ibm.iis.isf.audit.event.ADD_ROLE=ALL
com.ibm.iis.isf.audit.event.DELETE_ROLES=ALL
com.ibm.iis.isf.audit.event.ASSIGN_GROUP_ROLES=ALL
com.ibm.iis.isf.audit.event.ASSIGN_USER_ROLES=ALL
com.ibm.iis.isf.audit.event.REVOKE_GROUP_ROLES=ALL
com.ibm.iis.isf.audit.event.REVOKE_USER_ROLES=ALL
com.ibm.iis.isf.audit.event.ASSIGN_PROJECT_USER_ROLES=ALL
com.ibm.iis.isf.audit.event.ASSIGN_PROJECT_GROUP_ROLES=ALL
com.ibm.iis.isf.audit.event.REVOKE_PROJECT_USER_ROLES=ALL
com.ibm.iis.isf.audit.event.REVOKE_PROJECT_GROUP_ROLES=ALL
com.ibm.iis.isf.audit.event.REVOKE_PROJECT_ALL_ROLES=ALL
com.ibm.iis.isf.audit.event.ADD_DATASTAGE_CREDENTIAL=ALL
com.ibm.iis.isf.audit.event.SET_DEFAULT_DATASTAGE_CREDENTIAL=ALL
com.ibm.iis.isf.audit.event.REMOVE_DATASTAGE_CREDENTIAL=ALL
com.ibm.iis.isf.audit.event.REMOVE_DEFAULT_DATASTAGE_CREDENTIAL=ALL
com.ibm.iis.isf.audit.event.DATASTAGE_CREDENTIAL_MAPPING_DISABLED=ALL
com.ibm.iis.isf.audit.event.DATASTAGE_CREDENTIAL_MAPPING_ENABLED=ALL
com.ibm.iis.isf.audit.event.LOGIN=ALL
com.ibm.iis.isf.audit.event.LOGOUT=ALL
com.ibm.iis.isf.audit.event.SESSION_UPDATED=ALL
com.ibm.iis.isf.audit.event.SESSION_TERMINATED=ALL
com.ibm.iis.isf.audit.event.SESSION_EXPIRED=ALL
com.ibm.iis.isf.audit.event.AUDITING_CONFIGURATION_SETTINGS=ALL
com.ibm.iis.isf.audit.event.AUDITING_EVENT_SETTINGS=ALL

Types of audit events
The Auditing service provides groups of events that log audit records.
The following groups of audit events are logged:
v User and group management
v User, group, and project security role assignments
v Engine credential mapping
v User session management
v Audit configuration

User and group management events
User and group management consists of the following events: creation and
removal of users and groups, user group membership changes, and user credential
changes.
User and group management events can be logged only if the User Registry
Configuration is set to InfoSphere Information Server User Registry. These events
cannot be logged when the User Registry Configuration is set to Application
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Server Registry such as when configured to use LDAP for user authentication.
Those configurations manage users and groups through external tools so that IBM
InfoSphere Information Server is not involved in the management of these
resources and is not aware when changes are made.
The following event messages are logged with parameters that describe the
subjects that are changed or created. The (caller) indicated in each message is the
user ID of the caller to this event method:
ADD_USER (caller): UserID=”xxx”, LastName=”xxx”, FirstName=”xxx”
Logged when a new user is created in the InfoSphere Information Server
console, Web console, or DirectoryCommand command line tool. New
users created through the DirectoryAdmin command line tool on the
server do not log an audit event. However, these users cannot log in to
InfoSphere Information Server until they are assigned at least the SuiteUser
Security Role through the InfoSphere Information Server console or Web
console. This security assignment is audited. The DirectoryAdmin
command line tool is available on the server side installation that has
restricted access. This command cannot be executed on a client side
installation.
ADD_GROUP (caller): GroupID=”xxx”, GroupName=”xxx”
Logged when a group is created in the InfoSphere Information Server
console, Web console, or DirectoryCommand command line tool.
DELETE_USERS (caller): UserIDs=”xxx, yyy”
Logged when users are deleted through the InfoSphere Information Server
console or Web console. Deleting ALL USERS through the DirectoryAdmin
command line tool on the server does not log an audit event. This is not a
typical action and is used only in a recovery type operation.
DELETE_GROUPS (caller): GroupIDs=”xxx, yyy”
Logged when groups are deleted through the InfoSphere Information
Server console or Web console. Deleting ALL GROUPS through the
DirectoryAdmin command line tool on the server does not log an audit
event. This is not a typical action and is used only in a recovery type
operation.
ADD_USERS_TO_GROUPS (caller): UserIDs=”xxx, yyy”, GroupIDs=”xxx, yyy”
Logged when users are added to groups in the InfoSphere Information
Server console, Web console, or DirectoryCommand command line tool.
DELETE_USERS_FROM_GROUPS (caller): UserIDs=”xxx, yyy”, GroupIDs=”xxx, yyy”
Logged when users are removed from groups in the InfoSphere
Information Server console or Web console.
CHANGE_PASSWORD (caller): UserID=”xxx”
Logged when the Change Password action is used in the InfoSphere
Information Server console or Web console to change the password of the
user who is currently logged in.
SET_CREDENTIAL (caller): UserID=”xxx”
Logged when a password is changed for any user by an administrator in
the InfoSphere Information Server console or Web console. Changing a
user's password through the DirectoryAdmin command line tool on the
server does not log an audit event.
REMOVE_CREDENTIAL (caller): UserIDs=”xxx, yyy”
Logged when a password is cleared for one or more users.

Chapter 6. Managing security

43

User, group, and project security role assignment events
The user, group, and project security role assignments consist of the following
events: creation or deletion of a security role, assignment and removal of security
roles to users or groups, and assignment or removal of users or groups and roles
to a project.
The following event messages are logged with parameters that describe the
subjects that are changed or created. An event is logged regardless of which
application caused the event, whether it be the InfoSphere Information Server
console, IBM InfoSphere Information Server Web console, a client application, or
the DirectoryCommand tool. Audit events are not created for DirectoryAdmin tool
actions, however, because this tool can be used while the application server is not
running. The DirectoryAdmin tool is used for recovery purposes only. The (caller)
indicated in each message is the user ID of the caller to this event method:
ADD_ROLE (caller): RoleID=”xxx”
Logged when a new security role is created. Because security roles are
internally created by IBM InfoSphere Information Server, these audit events
can occur only during a maintenance release installation that includes new
roles, if any.
DELETE_ROLES (caller): RoleIDs=”xxx, yyy”
Logged when a security role is deleted. This audit event does not occur
because there is no user interface to delete a security role.
ASSIGN_GROUP_ROLES (caller): GroupIDs=”xxx, yyy”, RoleIDs=”xxx, yyy”
Logged when security roles are assigned to groups.
ASSIGN_USER_ROLES (caller): UserIDs=”xxx, yyy”, RoleIDs=”xxx, yyy”
Logged when security roles are assigned to users.
REVOKE_GROUP_ROLES (caller): GroupIDs=”xxx, yyy”, RoleIDs=”xxx, yyy”
Logged when security roles are deleted from groups.
REVOKE_USER_ROLES (caller): UserIDs=”xxx, yyy”, RoleIDs=”xxx, yyy”
Logged when security roles are deleted from users.
ASSIGN_PROJECT_USER_ROLES (caller): Project=”xxx”, UserIDs=”xxx, yyy”,
RoleIDs=”xxx, yyy”
Logged when users and associated project security roles are assigned to
project permissions.
ASSIGN_PROJECT_GROUP_ROLES (caller): Project=”xxx”, GroupIDs=”xxx, yyy”,
RoleIDs=”xxx, yyy”
Logged when groups and associated project security roles are assigned to
project permissions.
REVOKE_PROJECT_USER_ROLES (caller): Project=”xxx”, UserIDs=”xxx, yyy”,
RoleIDs=”xxx, yyy”
Logged when project security roles are changed for a user or when users
are removed from a project's permissions.
REVOKE_PROJECT_GROUP_ROLES (caller): Project=”xxx”, GroupIDs=”xxx, yyy”,
RoleIDs=”xxx, yyy”
Logged when project security roles are changed for a group or when
groups are removed from a project's permissions.
REVOKE_PROJECT_ALL_ROLES (caller): Project=”xxx”
Logged when all security roles assigned to a project are removed.
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Engine credential mapping events
The engine credential mapping consists of the following events: assignment and
removal of credentials to IBM InfoSphere DataStage suite users and assignment of
default credentials for an IBM InfoSphere Information Server engine when
mapping credentials using the Engine Credentials panel of the IBM InfoSphere
Information Server Web console.
The following event messages are logged with parameters that describe the
subjects that are changed or created. The (caller) indicated in each message is the
user ID of the caller to this event method:
ADD_DATASTAGE_CREDENTIAL (caller): UserIDs=”xxx, yyy”, DSServer=”xxx”,
Username=”xxx”
Logged when a mapped credential is set for one or more suite users in the
IBM InfoSphere Information Server Web console.
SET_DEFAULT_DATASTAGE_CREDENTIAL (caller): DSServers=”xxx, yyy”,
Username=”xxx”
Logged when default engine credentials are set in the Engine
Configuration in the IBM InfoSphere Information Server Web console.
REMOVE_DATASTAGE_CREDENTIAL (caller): UserIDs=”xxx, yyy”, DSServer=”xxx”
Logged when a mapped credential is cleared for one or more suite users in
the IBM InfoSphere Information Server Web console.
REMOVE_DEFAULT_DATASTAGE_CREDENTIAL (caller): DSServers=”xxx, yyy”
Logged when default engine credentials are cleared in the Engine
Configuration in the IBM InfoSphere Information Server Web console.
DATASTAGE_CREDENTIAL_MAPPING_DISABLED (caller): DSServer=”xxx”
Logged when Share User Registry is selected in the Engine Configuration
in the IBM InfoSphere Information Server Web console. With this setting,
InfoSphere DataStage users are authenticated to the operating system of
the server engine using the same credentials they used to log in to the
InfoSphere DataStage client application.
DATASTAGE_CREDENTIAL_MAPPING_ENABLED (caller): DSServer=”xxx”
Logged when Share User Registry is cleared in the Engine Configuration
in the IBM InfoSphere Information Server Web console. This restores the
use of the mapped credentials for InfoSphere Information Server engine
authentication.

User session management events
User session management consists of the following events: user login and logout,
direct session termination, and session expiration.
The following event messages are logged with parameters that describe the
subjects that are involved. The (caller) indicated in each message is the user ID of
the caller to this event method:
LOGIN (caller): UserID=”xxx”, Client=”xxx”, Origin=”xxx”, SessionID=”xxx”
Logged when a user logs in to an IBM InfoSphere Information Server client
application or command line tool or when an internal process logs in to
InfoSphere Information Server to perform an operation. This event is
logged in only after the successful authentication by the user. This action
creates an InfoSphere Information Server session. UserID is the userid used
to authenticate with the server. In some cases, this userid value indicates a
special trusted userid reserved for use by InfoSphere Information Server.
This type of login is for performing some scheduled or system-initiated
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operation. Client indicates the type of application that initiated the login.
Check the SESSION_UPDATED audit event with the same session
SessionID to know the client type of the logged in user. Origin indicates
the host name of the system from which the login originated. SessionID is
a unique alphanumeric value that unambiguously associates this login
session with a LOGOUT, SESSION_UPDATED, SESSION_TERMINATED,
or SESSION_EXPIRED audit event, or with log messages associated with
this session in other diagnostic logs. If this event is configured for LOG
LEVEL=INFO, the system user login events are filtered out and not logged.
These types of log ins are for InfoSphere Information Server internal
operations performed for various tasks. An example of a system user login
event is a LOGIN event with a UserID=InformationServerSystemUser. These
events typically occur every 30 minutes as part of a scheduler activity but
can occur for other operations at other times.
SESSION_UPDATED (caller): UserID=”xxx”, Client=”xxx”, Origin=”xxx”,
SessionID=”xxx"
Logged after the InfoSphere Information Server LOGIN event occurs. It
indicates the client type of the logged in user.
UserID is the authenticated userid that initially created this session. Client
indicates the type of application that initiated the login. The Client
parameter is updated in this audit event. Origin indicates the host name of
the system from which the login originated. SessionID is the same value
that was logged with the corresponding LOGIN.
LOGOUT (caller): UserID=”xxx”, Client=”xxx”, Origin=”xxx”, SessionID=”xxx”
Logged when a user or process explicitly logs out of an active InfoSphere
Information Server session. This event might not occur when an
application abnormally terminates, such as when the Web browser is
closed with an active InfoSphere Information Server Web console or when
a session is terminated by an administrator or times out (in which case a
SESSION_TERMINATED or SESSION_EXPIRED event is logged). UserID is
the authenticated userid that initially created this session. Client indicates
the type of application that uses this session. Origin indicates the host
name of the system from which the login originated. SessionID is the same
value that was logged with the corresponding LOGIN event to uniquely
identify this session. If this event is configured for LOG LEVEL=INFO,
then logouts from system user sessions are filtered out and not logged.
These types of log outs are for InfoSphere Information Server internal
operations performed for various tasks.
SESSION_TERMINATED (caller): UserID=”xxx”, Client=”xxx”, Origin=”xxx”,
SessionID=”xxx"
Logged when an InfoSphere Information Server session is disconnected by
an administrator in the IBM InfoSphere Information Server Web console. If
Disconnect All is selected, or multiple sessions are selected, each
disconnected session is logged as a separate audit event. Only active
sessions that are terminated log an audit event. Sessions that are already
expired are ignored because they were previously logged with a
SESSION_EXPIRED audit event. UserID is the authenticated userid that
initially created this session. Client indicates the type of application that
uses this session. Origin indicates the host name of the system from which
the login originated. SessionID is the same value that was logged with the
corresponding LOGIN event to uniquely identify this session.
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SESSION_EXPIRED (caller): UserID=”xxx”, Client=”xxx”, Origin=”xxx”,
SessionID=”xxx”
Logged when an idle InfoSphere Information Server session times out and
is terminated. The timeout is based on the Inactive Session Timeout value
configured in Global Session Properties of Session Management in the
IBM InfoSphere Information Server Web console.
UserID is the sme userid value that was logged with the corresponding
LOGIN. Client indicates the type of application that initiated the login.
Origin indicates the host name of the system from which the login
originated. SessionID is the same value that was logged with the
corresponding LOGIN event to uniquely identify this session.

Audit configuration events
Auditing configuration consists of the following events: auditing properties file
location, audit file configuration settings, and audit event settings.
The following event messages are logged with parameters that describe the audit
configuration settings used. These messages are logged when the application
server starts and the auditing service is initialized.
AUDITING_CONFIGURATION_SETTINGS: Path=”xxx”, Name=”xxx”, MaxSize=”xxx”,
Count=”xxx”, Format=”xxx”, Append=”xxx”
Logged when WebSphere Application Server starts and the Auditing
Service is initialized. Path indicates the location where audit log files are
created. Name is the pattern configured for the log file name. MaxSize is the
maximum size in bytes that each log file can grow to. Count is the
maximum number of files created before recycling. Format is the format of
the audit log file. Append indicates whether new records are appended or a
new file is created when the Auditing service is initialized.
AUDITING_EVENT_SETTINGS: xxx=”yyy”, xxx=”yyy”
Logged when WebSphere Application Server starts and the Auditing
Service is initialized. This event message includes a comma delimited list
of all auditing event types and the current log level setting for each where
xxx is the event type and yyy is the log level. Typical log levels are ALL,
INFO, or OFF. ALL indicates that all events of this type are always logged.
OFF indicates that no events of this type will be logged. Any other value
will filter which messages are logged for that event type. Each message is
assigned a specific log level by IBM InfoSphere Information Server. Only
INFO and FINE levels are currently assigned to messages. Messages
assigned at a lower level than INFO, which includes messages assigned a
log level of FINE, are not logged if the event type is configured for INFO.
The only event types that currently have FINE level log messages are
LOGIN and LOGOUT events. Refer to “User session management events”
on page 45 for more information about which messages are assigned which
log levels.

Audit configuration security
The Audit service creates an audit trail of security-related events. You can secure
the location of the logs to prevent unauthorized tampering.
The default path where audit files are located:
IBM WebSphere Application Server Network Deployment
v

Linux

v

Windows

UNIX

WAS_install_path/profiles/InfoSphere/logs

WAS_install_path\profiles\InfoSphere\logs
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IBM WebSphere Application Server Liberty Profile
v

Linux

v

Windows

UNIX

IS_install_path/wlp/usr/servers/iis/logs

IS_install_path\wlp\usr\servers\iis\logs

You can change the location by using the iisAdmin command to set the
com.ibm.iis.isf.audit.file.path property. If configured as a relative path, the
specified directory must exist off the IBM InfoSphere Information Server profile
directory under IBM WebSphere Application Server. If configured in another
location, the full path must be specified and you must ensure that the WebSphere
Application Server process owner has file system write permission to that
directory.
If the path that you specify doesn't exist, the logs are written to the default
location. A missing property key or an invalid value for a key results in the default
value being used for that property key. These precautions are in place to prevent
an unauthorized circumvention of audit logging.

Audit logs
The audit log file can be created in simple text format or in XML format. The size
of each audit record varies depending on the event, the string length, and the
number of parameters associated with the audit event and the format selected.
Audit events are recorded in the audit log file on the IBM InfoSphere Information
Server Services tier. Logging in to or out of any InfoSphere Information Server
client application or command-line tool logs events. Audit events are logged for
managing the users, groups, or security roles in the InfoSphere Information Server
console, InfoSphere Information Server Web console, the IBM InfoSphere FastTrack
client, and the InfoSphere DataStage Administrator client. Some command-line
tools, such as DirectoryCommand, also log events.

Log file sizing
With the default values of com.ibm.iis.isf.audit.file.size=10000000 and
com.ibm.iis.isf.audit.file.count=5, when the file grows to approximately 10
million bytes, it is renamed to ISauditLog_1.log. A new ISauditLog_0.log file is
created to hold the most recent audit events. Up to five files can be created, at
which time, when the current ISauditLog_0.log file exceeds the size limit of 10
million bytes, the oldest log is deleted, the other files are renamed, and a new file
with generation number 0 is created. The higher the generation number of the file,
the older the audit events.

Log file formats
The simple text format allows easy viewing and the XML format is convenient for
formatting or parsing the logs with custom applications. Both file formats can be
created at the same time. The XML format produces larger audit records and thus
fewer events per file than the simple text format. When XML format is used, the
Java™ logger creates the XML file and adds the XML file header. The logger is
initialized on each startup of IBM WebSphere Application Server at which time the
XML header is written to the file. If the logger is configured for
com.ibm.iis.isf.audit.file.append=true, the XML header is written to the current
end of the file causing multiple XML file header elements to appear in the log file
making the XML malformed. Configure com.ibm.iis.isf.audit.file.append as
false when configured for com.ibm.iis.isf.audit.file.format=xml or both.
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However, com.ibm.iis.isf.audit.file.append=false means the current 0 generation
log file is renamed to generation 1 and a new generation 0 log file is created each
time IBM WebSphere Application Server restarts. So certain log files might not be
the full maximum size in length when you use
com.ibm.iis.isf.audit.file.append=false.

Example: Simple text format
You can create the audit log in a simple text format.

Sample audit log
The following example is an excerpt from an audit log in simple text format. For
illustration purposes, this example shows each event on more than one line. In an
actual audit log file, each event is logged to a single line.
2009-04-04 03:58:25.357 EST INFO: LOGIN (admin): UserID="admin", Client="Console",
Origin="florence", SessionID="ED1D522D-D4DD-493D-80D9-0806EB4D907D"
2009-04-04 04:01:50.154 EST INFO: ADD_USER (admin): UserID="ppds1",
LastName="PersonDS1", FirstName="Project"
2009-04-04 04:01:50.387 EST INFO: SET_CREDENTIAL (admin): UserID="ppds1"
2009-04-04 04:01:50.654 EST INFO: ASSIGN_USER_ROLES (admin): UserIDs="ppds1",
RoleIDs="SuiteUser, DataStageAdmin, DataStageUser"
2009-04-04 04:11:41.325 EST INFO: ADD_GROUP (admin): GroupID="regPeeps",
GroupName="Regular People"
2009-04-04 04:11:42.895 EST INFO: ASSIGN_GROUP_ROLES (admin): GroupIDs="regPeeps",
RoleIDs="SuiteUser"
2009-04-04 04:12:01.343 EST INFO: ASSIGN_GROUP_ROLES (admin): GroupIDs="regPeeps",
RoleIDs="DataStageUser"
2009-04-04 04:12:12.784 EST INFO: LOGIN (admin): UserID="admin",
Client="DataStage Administrator", Origin="florence",
SessionID="FDBB462B-0381-4B14-80F9-82DDF060437A"
2009-04-04 04:12:45.336 EST INFO: REVOKE_PROJECT_GROUP_ROLES (admin):
Project="FLORENCE/test", GroupIDs="regPeeps", RoleIDs="DataStageProductionManager,
DataStageDeveloper, DataStageSuperOperator, DataStageOperator"
2009-04-04 04:12:45.779 EST INFO: ASSIGN_PROJECT_GROUP_ROLES (admin):
Project="FLORENCE/test", GroupIDs="regPeeps", RoleIDs="DataStageOperator"

Example: XML format
You can create the audit log in XML format.

Sample audit log
The following example is an excerpt from an audit log in an XML format:
<?xml version="1.0" encoding="windows-1252" standalone="no"?>
<!DOCTYPE log SYSTEM "logger.dtd">
<log>
<record>
<date>2009-05-21T00:00:00</date>
<millis>1242878400161</millis>
<sequence>323</sequence>
<logger>com.ibm.is.auditing</logger>
<level>FINE</level>
<thread>51</thread>
<message>LOGIN (InformationServerSystemUser): UserID="InformationServerSystemUser",
Client="Server client", Origin="SwordIFS",
SessionID="34BADF15-ABA5-4FA9-AA7D-68D26402C2D6"</message>
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<key>info.audit.session.LOGIN</key>
<catalog>com.ascential.acs.auditing.server.impl.resources.StringData</catalog>
<param>InformationServerSystemUser</param>
<param>InformationServerSystemUser</param>
<param>Server client</param>
<param>SwordIFS</param>
<param>34BADF15-ABA5-4FA9-AA7D-68D26402C2D6</param>
</record>
<record>
<date>2009-05-21T00:00:04</date>
<millis>1242878404458</millis>
<sequence>324</sequence>
<logger>com.ibm.is.auditing</logger>
<level>FINE</level>
<thread>51</thread>
<message>LOGOUT (InformationServerSystemUser): UserID="InformationServerSystemUser",
Client="Server client", Origin="SwordIFS",
SessionID="34BADF15-ABA5-4FA9-AA7D-68D26402C2D6"</message>
<key>info.audit.session.LOGOUT</key>
<catalog>com.ascential.acs.auditing.server.impl.resources.StringData</catalog>
<param>InformationServerSystemUser</param>
<param>InformationServerSystemUser</param>
<param>Server client</param>
<param>SwordIFS</param>
<param>34BADF15-ABA5-4FA9-AA7D-68D26402C2D6</param>
</record>
<record>
<date>2009-05-21T16:24:50</date>
<millis>1242937490614</millis>
<sequence>351</sequence>
<logger>com.ibm.is.auditing</logger>
<level>INFO</level>
<thread>46</thread>
<message>LOGIN (admin): UserID="admin", Client="Web Console", Origin="localhost",
SessionID="1C8D5CFD-269B-400F-8187-788D93681B09"</message>
<key>info.audit.session.LOGIN</key>
<catalog>com.ascential.acs.auditing.server.impl.resources.StringData</catalog>
<param>admin</param>
<param>admin</param>
<param>Web Console</param>
<param>localhost</param>
<param>1C8D5CFD-269B-400F-8187-788D93681B09</param>
</record>
<record>
<date>2009-05-21T16:27:24</date>
<millis>1242937644348</millis>
<sequence>370</sequence>
<logger>com.ibm.is.auditing</logger>
<level>INFO</level>
<thread>46</thread>
<message>ADD_USER (admin): UserID="ppds1", LastName="PersonDS1",
FirstName="Project"</message>
<key>info.audit.user.ADD_USER</key>
<catalog>com.ascential.acs.auditing.server.impl.resources.StringData</catalog>
<param>admin</param>
<param>ppds1</param>
<param>PersonDS1</param>
<param>Project</param>
</record>
<record>
<date>2009-05-21T16:27:24</date>
<millis>1242937644645</millis>
<sequence>371</sequence>
<logger>com.ibm.is.auditing</logger>
<level>INFO</level>
<thread>46</thread>
<message>ASSIGN_USER_ROLES (admin): UserIDs="ppds1", RoleIDs="SuiteUser"</message>
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<key>info.audit.role.ASSIGN_USER_ROLES</key>
<catalog>com.ascential.acs.auditing.server.impl.resources.StringData</catalog>
<param>admin</param>
<param>ppds1</param>
<param>SuiteUser</param>
</record>
<record>
<date>2009-05-21T16:27:24</date>
<millis>1242937644801</millis>
<sequence>372</sequence>
<logger>com.ibm.is.auditing</logger>
<level>INFO</level>
<thread>46</thread>
<message>ASSIGN_USER_ROLES (admin): UserIDs="ppds1", RoleIDs="DataStageAdmin,
DataStageUser"</message>
<key>info.audit.role.ASSIGN_USER_ROLES</key>
<catalog>com.ascential.acs.auditing.server.impl.resources.StringData</catalog>
<param>admin</param>
<param>ppds1</param>
<param>DataStageAdmin, DataStageUser</param>
</record>
<record>
<date>2009-05-21T16:27:24</date>
<millis>1242937644973</millis>
<sequence>373</sequence>
<logger>com.ibm.is.auditing</logger>
<level>INFO</level>
<thread>46</thread>
<message>SET_CREDENTIAL (admin): UserID="ppds1"</message>
<key>info.audit.user.SET_CREDENTIAL</key>
<catalog>com.ascential.acs.auditing.server.impl.resources.StringData</catalog>
<param>admin</param>
<param>ppds1</param>
</record>
<record>
<date>2009-05-21T16:27:53</date>
<millis>1242937673989</millis>
<sequence>375</sequence>
<logger>com.ibm.is.auditing</logger>
<level>INFO</level>
<thread>45</thread>
<message>LOGOUT (admin): UserID="admin", Client="Web Console", Origin="localhost",
SessionID="1C8D5CFD-269B-400F-8187-788D93681B09"</message>
<key>info.audit.session.LOGOUT</key>
<catalog>com.ascential.acs.auditing.server.impl.resources.StringData</catalog>
<param>admin</param>
<param>admin</param>
<param>Web Console</param>
<param>localhost</param>
<param>1C8D5CFD-269B-400F-8187-788D93681B09</param>
</record>
</log>

Security setup
Setting up a secure environment in IBM InfoSphere Information Server involves
configuring the user registry, creating users, and assigning security roles to those
users.
In InfoSphere Information Server, to set up a secure environment you complete the
following tasks:
1. Choose a user registry and configure it for InfoSphere Information Server.
A user registry contains valid user names and passwords. To log in to
InfoSphere Information Server, a user must have a user name and password in
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the user registry. The installation program configures InfoSphere Information
Server to use its internal user registry. As part of security setup, you can
configure InfoSphere Information Server to use an external user registry such as
a local operating system user registry or lightweight directory access protocol
(LDAP) user registry.
2. Create users and groups.
Create users and groups in the user registry. If InfoSphere Information Server is
configured to use the internal user registry, create users and groups by using
the InfoSphere Information Server console or the InfoSphere Information Server
Web console. If InfoSphere Information Server is configured to use an external
user registry, use standard operating system utilities or user registry utilities to
create users and groups.
3. Assign security roles to users and groups.
To configure which suite components a user or a group has access to and what
level of access that user or group has in the suite component, assign security
roles to the user or group.
4. Configure InfoSphere Information Server engine security.
The InfoSphere Information Server engine performs user authentication
separately from other InfoSphere Information Server components. Depending
on your user registry configuration, you might have to map credentials
between the InfoSphere Information Server user registry and the local operating
system user registry on the computer where the engine is installed.
5. Assign project roles to users.
Some suite components require that you assign project-specific roles to users.
Optionally, you can also complete the following setup tasks:
v Configure alternate security modes.
You can configure WebSphere Application Server to work with various security
standards, which are typically used to meet security requirements required by
the US government.
v Manage certificates.
The installation program creates a certificate for you. You can change the
certificate, such as if you want to certify it with a certificate authority or update
the certificate when it expires. After you change a certificate, you run the
UpdateSignerCerts.sh command to permanently accept the certificate to prevent
other command line tools to prompt to accept the certificate.
v Configure IBM WebSphere Application Server for non-root administration.
By default, WebSphere Application Server runs as root. However, it can also be
run by using a non-root user ID. You can configure and set appropriate file
system permissions for WebSphere Application Server to run as a non-root user
ID.
v Configure InfoSphere Information Server agents for non-root administration
By default, the InfoSphere Information Server agents (such as the ASB agent)
run as root. However, they can also be run by using a non-root user ID. You can
configure and set appropriate file system permissions for the agents to run as a
non-root user ID.
v Configure the Auditing service.
The Auditing service creates an audit trail of security-related events. The trail
includes all activities that set or modify security-related settings and all user
authentications and application logins. You can configure which audit events to
log and how much information to include based on your auditing requirements.
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User registry configuration
A user registry holds user account information, such as a user name and password,
that is accessed during authentication. To log in to IBM InfoSphere Information
Server, a user must have a user name and password in the user registry.
During installation, the InfoSphere Information Server installation program
configures InfoSphere Information Server to use an internal user registry. The
internal user registry is located in the metadata repository. After you install
InfoSphere Information Server, you can continue to use the internal user registry.
Alternatively, you can set up InfoSphere Information Server to use a local
operating system user registry or a Lightweight Directory Access Protocol (LDAP)
compliant user registry.
If you choose to change registries, complete the change immediately after the
installation finishes. For best results, do not change user registries after the system
has been in production. If you must change the user registry after the system has
been in production, consider migrating to a new installation to avoid security
issues and risks. Otherwise, a mismatch might occur between the users of the old
and new user registries.

Internal user registry overview
By default, IBM InfoSphere Information Server stores user information in the
internal user registry in the metadata repository.
The following figure shows an InfoSphere Information Server topology where the
services tier and metadata repository tier are on one computer. InfoSphere
Information Server and IBM WebSphere Application Server are both configured to
use the internal user registry provided by InfoSphere Information Server. The
internal user registry is stored in the metadata repository.
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IBM InfoSphere Information Server Clients
Console, Web Console, InfoSphere DataStage and QualityStage
Designer, InfoSphere DataStage and QualityStage Administrator,
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WebSphere Application
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Figure 16. Example of InfoSphere Information Server architecture that uses the internal user registry

As shown in the figure, the InfoSphere Information Server directory service
communicates with the internal user registry. WebSphere Application Server also
communicates with the internal user registry. WebSphere Application Server
performs the underlying InfoSphere Information Server user authentication.
When you use the internal user registry, you create users directly through the
InfoSphere Information Server console or the InfoSphere Information Server Web
console. You can also create groups and assign users to those groups. The
credentials are stored in the internal user registry. The group membership
information and the associations between users and their security roles are also
stored in the internal user registry. E-mail addresses and business addresses are
also stored here.
The internal user registry stores only digested (one-way encryption) passwords for
increased security. User names and group IDs can contain any letters or digits, and
the following special characters:
v Underscore (_)
v Hyphen (-)
v Comma (,)
v Backslash (\)
v Equal sign (=)
v Dollar sign ($)
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v
v
v
v

Period (.)
Colon (:)
Spacebar key ( )
At sign (@)

The InfoSphere Information Server engine performs user authentication separately
from other InfoSphere Information Server components, and cannot use the internal
user registry. Instead, the InfoSphere Information Server engine uses the operating
system user registry to perform user authentication. If you configure InfoSphere
Information Server to use the internal user registry, you must map credentials
between the InfoSphere Information Server user registry and the local operating
system user registry on the computer where the engine is installed.

External user registry overview
You can configure IBM InfoSphere Information Server to authenticate users based
on an existing external user registry, such as a local operating system user registry
or a Lightweight Directory Access Protocol (LDAP) user registry.
InfoSphere Information Server supports all external registries that are supported by
IBM WebSphere Application Server Network Deployment and IBM WebSphere
Application Server Liberty Profile. For more information about user registries that
WebSphere Application Server supports, see the WebSphere Application Server
documentation:
v IBM WebSphere Application Server Network Deployment 8.5:
http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/topic/
com.ibm.websphere.nd.multiplatform.doc/ae/tsec_useregistry.html
The following figures show an InfoSphere Information Server topology where the
services tier and metadata repository tier are located on one computer. In the first
figure, InfoSphere Information Server and IBM WebSphere Application Server are
both configured to use the local operating system user registry. In the second
figure, InfoSphere Information Server and IBM WebSphere Application Server are
both configured to use an external LDAP user registry.
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Figure 17. Example of an InfoSphere Information Server architecture that uses the local operating system user registry
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Figure 18. Example of an InfoSphere Information Server architecture that uses an external LDAP user registry

When you use an external user registry, WebSphere Application Server
communicates with that user registry. The InfoSphere Information Server directory
service communicates with the WebSphere Application Server user registry. It does
not communicate with the external user registry directly. By going through
WebSphere Application Server to access the external user registry, InfoSphere
Information Server takes advantage of the capabilities in WebSphere Application
Server for handling various kinds of external user registries.
When you use an external user registry, you create users and groups through the
administration tools for that user registry. InfoSphere Information Server looks to
the external user registry for user names, passwords, group definitions, and group
memberships. Password restrictions are imposed by the user registry.
If you are configuring WebSphere Application Server clustering for scalability or
high-availability, you cannot configure InfoSphere Information Server to use the
local operating system user registry. Instead, configure an LDAP user registry or
the internal user registry.
Even when you configure InfoSphere Information Server to use an external user
registry, certain user information is still maintained in the internal user registry.
Specifically, the internal user registry always stores the security roles that are
assigned to users and groups, as well as attributes that are not passed through by
WebSphere Application Server, such as e-mail addresses and business addresses.
The internal user registry is always available and working in the background.
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User registry considerations
Choose your user registry configuration based on the scale of your installation and
the experience of your administrators.
The supported user registry configurations differ in the following areas:
v Ease of installation and setup.
v Ease of maintenance of users and groups, and the level of authentication
required.
v The number of sets of credentials that you must maintain.
v How the credentials are stored.
v Feature support.
v Engine security considerations. The IBM InfoSphere Information Server engine
performs user authentication separately from other InfoSphere Information
Server components. Depending on your topology and the user registry that you
choose, you might have to map credentials between the InfoSphere Information
Server user registry and the local operating system user registry on the
computer where the engine is installed.
Internal user registry: Least complex, suitable for small-scale installations
Consider the following information when determining whether to use the
internal user registry:
v The internal user registry is set up by the installation program.
InfoSphere Information Server is configured to use this user registry by
default.
v To manage users and groups, you use the InfoSphere Information Server
console or Web console. With other user registry configurations, you
must have administrative access to the user registry.
v Because the internal user registry is separate from other user registries, it
requires that you maintain an independent set of credentials for each
InfoSphere Information Server user that are unrelated to any other user
registry that is maintained for other business applications.
v User credentials are stored in the InfoSphere Information Server
metadata repository database. User credential information is one-way
encrypted in the database.
v The internal user registry has no support for password policies, length,
or expiration dates.
v The InfoSphere Information Server engine cannot use the internal user
registry for authentication. The installation program maps the initial
engine administration operating system user (default is dsadm) with the
InfoSphere Information Server administrator user (default is isadmin). If
you want to create other engine users, you must map credentials
between the users in the InfoSphere Information Server internal user
registry with users in the operating system's user registry on the
computer where the engine is installed. If the user names or passwords
are changed in the operating system's user registry, an administrator
must update the mapping.
v The mapped user credentials are also stored in the InfoSphere
Information Server metadata repository database. User credential
information is strongly encrypted in the database.
Local operating system user registry: Suitable for small and self-contained
installations, if the internal user registry is unsuitable
Consider the following information when determining whether to use a
local operating system user registry:
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v If you plan to create a WebSphere Application Server cluster for
scalability or high-availability, you cannot use a local operating system
user registry configuration because it is not supported.
v If you plan to use IBM WebSphere Application Server Liberty Profile,
you cannot use a local operating system user registry configuration
because it is not supported.
v

v

v
v
v
v

Windows
You might experience major performance issues if you use a
local operating system user registry configuration on a Microsoft
Windows computer when the computer is registered in a Windows
domain.
To use a local operating system user registry configuration, you must
perform additional configuration steps after software installation is
complete.
To manage users and groups, you use standard operating system
utilities. For this reason, you must have administrative access.
Unlike the internal user registry configuration, with this configuration
you can maintain a single set of credentials for each user.
The local operating system user registry has support for features such as
password policies, length, and expiration dates.

IBM WebSphere Application Server must be run as
root, because the application server authenticates passwords.
Linux

UNIX

v If the services tier and engine tier are installed on the same computer,
you can configure both InfoSphere Information Server and the engine to
share the local operating system user registry. In this case, credential
mapping is not required. If the services tier and engine tier are installed
on separate computers, you must map credentials between the
InfoSphere Information Server user registry and the local operating
system user registry on the computer where the engine is installed.
Lightweight Directory Access Protocol (LDAP) user registry: More complex, but
the most powerful
v To use an LDAP user registry configuration, you must perform
additional configuration steps after the software installation is complete.
v Setup and administration of an LDAP user registry is more technically
complex than with the other user registry configurations.
v An LDAP user registry has better performance than the other user
registry configurations, and is more scalable.
v Unlike the internal user registry configuration, with this configuration
you can maintain a single set of credentials for each user.
v An LDAP user registry has support for features such as password
policies, length, and expiration dates.
v To manage users and groups, you use utilities that are specific to the
LDAP server. You must have LDAP server administrative access.
v You can configure both InfoSphere Information Server and the engine to
use the LDAP user registry. In this case, credential mapping is not
required. However, in IBM AIX®, Solaris, HP-UX, and Linux
installations, you must configure Pluggable Authentication Module
(PAM) support on the engine tier computer.
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Switching to the local operating system user registry (IBM
WebSphere Application Server Network Deployment)
After you install IBM InfoSphere Information Server, you can configure the suite to
use the local operating system user registry. You can follow this procedure if your
installation includes IBM WebSphere Application Server Network Deployment in a
stand-alone configuration. The local operating system registry is not supported in a
clustered configuration or by IBM WebSphere Application Server Liberty Profile.

Before you begin
WebSphere Application Server has a number of restrictions regarding local
operating system user registries on both UNIX and Microsoft Windows. For
example:
v

Linux

UNIX

WebSphere Application Server processes must be run as

UNIX

The network information service (NIS) protocol is not

root.
v

Linux

supported.
v

Windows
The use of domain accounts imposes access rights on users who run
WebSphere Application Server processes.

See the WebSphere Application Server documentation for more information:
v Version 8.5: publib.boulder.ibm.com/infocenter/wasinfo/v8r5/topic/
com.ibm.websphere.nd.doc/ae/usec_localosreg.html

Procedure
1. Create a user account on the local computer to use for the WebSphere
Application Server administration account. Alternatively, select an existing
account. As part of the switch to the local operating system user registry, you
direct WebSphere Application Server to use this account for the administrator
role.

2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
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Note: This account can be the same as the account that owns the WebSphere
Application Server installation. Alternatively, the account can be the same as
the account that runs the WebSphere Application Server processes.
Alternatively, it can be a different account.
Log in to the WebSphere Application Server administrative console.
In the console, click Security > Global Security. The Global Security page
appears.
Ensure that the Use realm-qualified user names option is not selected.
In the User account repository section on the right side of the page, click the
Available realm definitions list and select Local operating system.
Click Configure.
In the Primary administrative user name field, type the name of the user
account that you created in step 1.
Click Apply.
Select Server identity that is stored in the repository.
In the Server user ID or administrator user on a Version 6.0.x node field,
type the short name of the user account that you created in step 1.
In the Server user password field, type the password of the user account that
you created in step 1.
Click OK.

13. Click the Save link at the top of the page, and click the Save button.
14. On the Global Security page, ensure that LTPA is selected for the Active
authentication mechanism setting.
15. In the Available realm definitions list, select Local operating system, and
click Set as current. If an error occurs, the application server is unable to
authenticate with the local operating system by using the credentials that you
provided.
16. Click the Save link, and click the Save button.
17. Stop WebSphere Application Server.
18. Log in to the services tier computer.
19. From the command line, run the AppServerAdmin command. This command
propagates the WebSphere Application Server administrator user name and
password to WebSphere Application Server.
Linux

UNIX

/opt/IBM/Information/server/ASBServer/bin/AppServerAdmin.sh -was
-user was_admin_user_id -password was_admin_password
Windows

C:\IBM\InformationServer\ASBServer\bin\AppServerAdmin.bat -was
-user was_admin_user_id -password was_admin_password

In the command, was_admin_user_id and was_admin_password must match the
credentials that you provided in the WebSphere Application Server
administrative console.
Tip: The -password parameter is optional. If not provided, you will be
prompted for a password. If you do provide a password, it can be either plain
text or an encrypted string that has been created with the encrypt command.
20. If you are switching the user registry for a system that has been used for a
while by multiple users, clean up the users and groups that are related to the
security configuration. See “Switching the user registry configuration for a
system in use” on page 75.
21. Restart WebSphere Application Server.
After WebSphere Application Server is restarted, during the InfoSphere
Information Server initialization, the WebSphere Application Server user
registry configuration is checked and the InfoSphere Information Server user
registry configuration is automatically adjusted if needed. The default
WebSphere Application Server administrator user is also automatically
configured as the initial new InfoSphere Information Server default
administrator user.

What to do next
After you change the user registry, you can open the InfoSphere Information
Server Web console and grant suite administrator access to additional users as
needed.

Configuring IBM InfoSphere Information Server to use PAM
(Linux, UNIX)
Pluggable Authentication Module (PAM) is currently supported on Linux and
UNIX platforms. You can configure the services tier, engine tier, or both, to use
PAM. If you choose to use PAM on the engine tier and you also want to use an
LDAP user registry, you must configure PAM on the engine tier before setting up
IBM InfoSphere Information Server to use an LDAP user registry.
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Configuring the IBM InfoSphere Information Server services tier to use PAM
(Linux, UNIX):
Configuring PAM for the services tier is optional. Configure PAM only if you want
the services tier to use PAM for authentication. Unlike the engine tier, the services
tier can authenticate through LDAP without PAM. PAM configuration of the
services tier is only supported with IBM WebSphere Application Server Network
Deployment
Before you begin
To complete these tasks, you must have a working knowledge of PAM and the
authentication modules and strategies.
About this task
Consider these reasons why you might configure PAM on the services tier:
v Multiple PAM modules can be configured to allow fallback authentication
options. For example, you can configure an LDAP server as the primary user
registry for authentication and also configure a fallback to local operating system
authentication in case the LDAP authentication fails. Such a configuration allows
you to combine multiple user registries.
v PAM is a way to customize local operating system authentication. For example,
PAM can be used to delegate a local operating system authentication to an
LDAP server.
PAM provides authentication support only (verification of the user ID and
password). InfoSphere Information Server also requires user and group
membership information to determine the roles assigned to a user used for
authorization decisions. PAM does not provide user and group membership
support. InfoSphere Information Server determines user and group membership by
using two possible mechanisms:
1. By default, it looks in the /etc/passwd and /etc/group files.
2. You can specify the user and group files to use as PAM registry configuration
options.
Restrictions:
v If you configure PAM for use with InfoSphere Information Server, it is strongly
recommended that you not run IBM WebSphere Application Server Network
Deployment in a clustered environment. Because PAM relies on local files to
determine user and group memberships, you would need to ensure that the user
and group files are in sync across the nodes. Unexpected results can occur if the
files become out of sync.
v The PAM user registry is supported as a stand-alone user registry and is not
supported when using a WebSphere federated user registry.
v When a local operating system PAM module is used in the PAM configuration,
IBM WebSphere Application Server Network Deployment must be run as root.
When a local operating system PAM module is not configured, IBM WebSphere
Application Server Network Deployment can be run as a non-root user. This
restriction is true for all supported operating systems.
Perform this task on the computer that hosts the services tier. PAM support is
specific to each platform.
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Procedure
1. Add to or create the PAM configuration file on your platform.
2. Configure IBM WebSphere Application Server Network Deployment.
a. Log in to the IBM WebSphere Application Server Network Deployment
Administrative console.
b. Navigate to the security section of the IBM WebSphere Application Server
Network Deployment Administrative console. Select Security > Global
Security.
c. In the User account repository section, select Standalone custom registry
from the Available realm definitions field and click Configure.
In the Primary administrative user name field, type the administrator user
name, which is a valid PAM user ID.
e. Select the server identity that is stored in the repository. Enter the valid
PAM user ID and password.
f. Ensure that the custom registry class name is the following string:
com.ibm.iis.isf.j2ee.impl.was.security.WASExtendedCustomUserRegistry. Click
Apply.

d.

g. Complete this step only if you want to use files other than the local
operating system authentication files. In the Custom Properties section,
select New, define the following properties and values, and click OK.
Property

Value

com.ibm.iis.isf.j2ee.impl.was.security.\
WASExtendedCustomUserRegistry.usersFile

The file where the user information is stored. The
information in the file must be stored in the same
manner as it would in the /etc/passwd file. If this
property is not specified, the default user registry file
/etc/passwd is used.

com.ibm.iis.isf.j2ee.impl.was.security.\
WASExtendedCustomUserRegistry.groupsFile

The file where the group information is stored. The
information in the file must be stored in the same
manner as it would in the /etc/groups file. If this
property is not specified, the default group registry file
/etc/groups is used.

com.ibm.iis.isf.j2ee.impl.was.security.\
WASExtendedCustomUserRegistry.moduleName

You can configure multiple PAM modules with different
names on the same computer. Choose the one that you
want to specify for this configuration. If this property is
not specified, then the default value isfpam is chosen and
a module with that file name is expected to be in the
pam.d configuration directory.

h. Test your configuration. In the Standalone Custom Registry section, click
Set as current. If an error occurs, the application server is unable to
authenticate with the internal user registry by using the credentials that you
provided. Recheck your configuration.
i. Click Apply, click Save, and log out of the console.
3. Stop the application server.
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Attention:
v When stopping the application server processes, use the old user name and
password, that is, the credentials of the application server administrator from
the previous user registry.
v It is recommended that you not configure PAM in a clustered installation.
However, if you do, first stop the application servers and the node agents,
and then stop the Deployment Manager.
4. Log in to the computer on which the AppServerAdmin tool is installed. This tool
is on the same computer as the services tier, in the IS_install_dir/ASBServer/
bin directory.
5. From the command line, run the AppServerAdmin command. This command
propagates the administrator user name and password to the application server.
Specify the same user ID and password specified in the Administrative console
in step 2d on page 63
IS_install_dir/ASBServer/bin/AppServerAdmin.sh -was
-user was_admin_user_id -password was_admin_password

Tip: The -password parameter is optional. If not provided, you will be
prompted for a password. If you do provide a password, it can be either plain
text or an encrypted string that has been created with the encrypt command.
6. Restart the application server. In a clustered installation, start the Deployment
Manager, the node agents, and then the application servers. If one of the node
agents does not start, the node agent cannot be restarted because the user
registry configuration at the Deployment Manager and node levels do not
match. To fix this problem, run the application server syncNode command to
synchronize the node with the Deployment manager.
a. Log in to the node.
b. Run the syncNode command. (The ⇒ character indicates a line continuation.)
cd WAS_install_dir/AppServer/profiles/custom_profile/bin
./syncNode.sh dmgr_hostname dmgr_port -user was_admin_username ⇒
-password was_admin_password

dmgr_hostname
The host name of the computer on which the Deployment Manager is
running.
dmgr_port
The port number of the Deployment Manager. (The default is 8879.)
was_admin_username and was_admin_password
The administrator user name and password for the application server.
7. Check the application server log files to ensure that no errors occurred.
8. Verify the configuration by logging in to the IBM InfoSphere Information Server
Web console with the new user ID and password.
Configuring the engine to use PAM (Linux, UNIX):
Configuring PAM on the engine tier is required only if you want the engine to
authenticate through an LDAP server. If you do, you must configure the engine for
PAM before configuring IBM InfoSphere Information Server to use an LDAP user
registry.
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Before you begin
To complete these tasks, you must have a working knowledge of PAM and the
authentication modules and strategies.
About this task
Perform this task on the computer that hosts the engine tier.
Use the following procedure to configure PAM on Linux and UNIX.
Procedure
1. From the $DSHOME directory, set up the environment by running the following
command:
. ./dsenv

2. Stop the InfoSphere Information Server engine by running the following
command:
$DSHOME/bin/uv -admin -stop

3. Edit the uvconfig file in the DSHOME directory to change the setting of the
AUTHENTICATION tunable to 1. The following example shows the AUTHENTICATION
tunable set to 1.
# AUTHENTICATION - Specifies the method by which UNIX user
#
authentication is done. Currently, the following methods
#
are supported:
#
#
0) Standard O/S Authentication (default)
#
1) Pluggable Authentication Module (PAM)
#
#
This value should only be changed with a full understanding
#
of the implications, as improper setting of this value can
#
lead to the environment being unusable.
AUTHENTICATION 1

4. As the root user, edit the PAM configuration file. The file path and contents of
the PAM configuration file are platform-dependent.
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Operating
system
AIX

Procedure
1. Obtain the operating system level, where the nnnn-nn-nn-nnnn value
returned tells you the operating system base level (the first 4 digits),
the technology level (the next 2 digits), the service pack (the next 2
digits), and the date of release:
oslevel -s
2. Edit the /etc/pam.conf file, and add four lines based on your version
of the operating system:
v Add the following lines when the oslevel is lower than
6100-07-02-nnnn:
dsepam
dsepam
dsepam
dsepam

auth required /usr/lib/security/64/pam_aix
account required /usr/lib/security/64/pam_aix
session required /usr/lib/security/64/pam_aix
password required /usr/lib/security/security/64/pam_aix

v Add the following lines when the oslevel is higher than or equal to
than 6100-07-02-nnnn:
dsepam
dsepam
dsepam
dsepam

auth required pam_aix
account required pam_aix
session required pam_aix
password required pam_aix

Note: You cannot use PAM authentication with IMPERSONATION mode
turned off. For more information, see http://www-01.ibm.com/support/
docview.wss?uid=swg21516230
Linux

Add the following entry to the file /etc/pam.d/dsepam.
#%PAM-1.0
# for engine PAM authentication
auth include system-auth
account include system-auth
password include system-auth
session include system-auth

5. Regenerate the InfoSphere Information Server engine configuration file:
$DSHOME/bin/uv -admin -regen

6. Restart the InfoSphere Information Server engine:
$DSHOME/bin/uv -admin -start

What to do next
Set up the InfoSphere Information Server engine tier to use the Lightweight
Directory Access Protocol (LDAP) user registry.
If you have configured PAM for both the engine and services tier by using an
LDAP user registry, you can share the user registry with the tiers that you
configured for PAM. Both PAM configurations must point to the same user registry
by using the same set of PAM modules.

Switching to an LDAP user registry when using WebSphere
Application Server Liberty Profile
When you install IBM InfoSphere Information Server, users are set up to use the
internal registry. If your organization uses Lightweight Directory Access Protocol
(LDAP) for authentication, you can choose to configure IBM InfoSphere
Information Server to use LDAP as well, after installation.
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Before you begin
The InfoSphere Information Server engine performs user authentication separately
from other InfoSphere Information Server components. You can configure the
engine to share the LDAP user registry as well; however, it requires that you
configure Pluggable Authentication Module (PAM) support. Configuring PAM for
the engine must be done before switching InfoSphere Information Server to use the
LDAP user registry. See Configuring the engine to use PAM.

About this task
InfoSphere Information Server supports any LDAP-compliant user registry that
IBM WebSphere Application Server Liberty Profile supports. For more information
about supported LDAP servers, see the WebSphere Application Server Liberty
Profile system requirements:
v WebSphere Application Server Liberty Profile 8.5.5: http://www-01.ibm.com/
support/docview.wss?uid=swg27038218

Procedure
1. Stop the application server:
Linux

UNIX

IS_install_path/ASBServer/bin/MetadataServer.sh stop
Windows

net stop InfoSvr

2. Remove the default built-in user registry from the WebSphere Application
Server Liberty Profile configuration by commenting out the following line in
the IS_install_path/wlp/usr/servers/iis/server.xml file:
<usr_iisRegistry dataSourceRef="DataSource_ASBDataSource"/>

3. Add the LDAP configuration in the IS_install_path/wlp/usr/servers/iis/
server.xml file, anywhere before the closing server element, as documented in
Configuring LDAP user registries with the Liberty profile.
If you have a large LDAP server, such as when it has more than 10,000 users, it
is strongly recommended to use the optional ldapCache configuration, such as
in the following example. (The ⇒ character indicates a line continuation.)
<ldapRegistry
id="BluePages" realm="ldap" ignoreCase="true"
host="bluepages.ibm.com" port="389"
baseDN="o=ibm.com"
ldapType="IBM Tivoli Directory Server">
<idsFilters
userFilter="(&amp;(emailAddress=%v)(objectclass=person))"
groupFilter="(&amp;(cn=%v)(|(objectclass=groupOfNames)(objectclass=groupOf⇒
UniqueNames)(objectclass=groupOfURLs)))"
userIdMap="*:emailAddress"
groupIdMap="*:cn"
groupMemberIdMap="ibm-allGroups:member;ibm-allGroups:uniqueMember;groupOfN⇒
ames:member;groupOfUniqueNames:uniquemember"/>
<ldapCache>
<attributesCache size="4000" timeout="300000" enabled="true" sizeLimit="20⇒
00"/>
<searchResultsCache size="2000" timeout="300000" enabled="true" resultsSiz⇒
eLimit="1000"/>
</ldapCache>
</ldapRegistry>

4. Start the application server:
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Linux

UNIX

IS_install_path/ASBServer/bin/MetadataServer.sh run
Windows

net start InfoSvr

5. If you are switching the user registry for a system that has been used for a
while by multiple users, clean up the users and groups that are related to the
security configuration. See Switching the user registry configuration for a
system in use.
6. Manually configure one LDAP user as an administrator user to be able to login
to the IBM InfoSphere Information Server Web console and further assign roles
to LDAP users and groups:
cd IS_install_path/ASBServer/bin
./DirectoryAdmin.sh -user -userid LDAP_user -admin -checkid

Where:
LDAP_user
The LDAP user that you want to be the administrator user name. This user
name must be specified according to the value of the LDAP attribute that
you configured for the userFilter in the server.xml file. In the example
above, the userFilter is set to (&amp;(emailAddress=
%v)(objectclass=person)), which means that the LDAP user must be
specified as an email address.
-checkid
This option is used to verify that the provided user is a valid user, and
details about the user will be displayed in the output.

What to do next
After you change the user registry, you can use the administrator user to log into
the IBM InfoSphere Information Server Web console and assign roles to other
LDAP users and groups.

Switching to an LDAP user registry when using WebSphere
Application Server Network Deployment
You can authenticate users by using a Lightweight Directory Access Protocol
(LDAP) user registry. You configure IBM InfoSphere Information Server to use
LDAP authentication after installation finishes.

Before you begin
v The InfoSphere Information Server engine performs user authentication
separately from other InfoSphere Information Server components. You can
configure the engine to use the LDAP user registry that you set up. For IBM
AIX, Solaris, HP-UX, and Linux platforms, you can optionally configure
Pluggable Authentication Module (PAM) support before you switch the user
registry. For more information, see “Configuring IBM InfoSphere Information
Server to use PAM (Linux, UNIX)” on page 61.
v In an IBM WebSphere Application Server stand-alone installation, WebSphere
Application Server must be running.
v In a clustered installation, the Deployment Manager and all node agents must be
running.
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About this task
InfoSphere Information Server supports any LDAP-compliant user registry that
IBM WebSphere Application Server Network Deployment supports. For more
information about supported LDAP servers, see the IBM WebSphere Application
Server Network Deployment system requirements:
v IBM WebSphere Application Server Network Deployment 8.5.5:
http://www-01.ibm.com/support/docview.wss?uid=swg27038218

Procedure
1. Do the procedures in the WebSphere Application Server documentation for
configuring LDAP user registries.
Procedures for configuring LDAP user registries within WebSphere Application
Server can be found in the WebSphere Application Server information center:
v IBM WebSphere Application Server Network Deployment 8.5:
http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/topic/
com.ibm.websphere.nd.doc/ae/tsec_ldap.html
2. In a clustered installation, synchronize the configuration files on the nodes in
the cluster:
a. In the System administration > Nodes.
b. Select the check boxes beside all nodes.
c. Click Synchronize.
d. Log out of the console.
3. Stop WebSphere Application Server. In a clustered installation, stop the
application servers and the node agents, and then stop the Deployment
Manager.
Important: When stopping the WebSphere Application Server processes, use
the credentials of the WebSphere Application Server administrator from the
previous user registry.
4. Log in to the computer on which the AppServerAdmin tool is installed:
v If you have implemented WebSphere Application Server clustering within
your installation, log in to the computer that hosts the WebSphere
Application Server Deployment Manager.
v If you have not implemented clustering, log in to the services tier computer.
5. From the command line, run the AppServerAdmin command. This command
propagates the WebSphere Application Server administrator user name and
password to WebSphere Application Server.
Linux

UNIX

/opt/IBM/Information/server/ASBServer/bin/AppServerAdmin.sh -was
-user was_admin_user_id -password was_admin_password
Windows

C:\IBM\InformationServer\ASBServer\bin\AppServerAdmin.bat -was
-user was_admin_user_id -password was_admin_password

In the command, was_admin_user_id and was_admin_password must match the
new WebSphere Application Server administrator credentials that you provided
in the WebSphere Application Server administrative console.
Tip: The -password parameter is optional. If not provided, you will be
prompted for a password. If you do provide a password, it can be either plain
text or an encrypted string that has been created with the encrypt command.
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6. If you are switching the user registry for a system that has been used for a
while by multiple users, clean up the users and groups that are related to the
security configuration. See “Switching the user registry configuration for a
system in use” on page 75.
7. Restart WebSphere Application Server. In a clustered installation, start the
Deployment Manager, and then the node agents and application servers.
After WebSphere Application Server is restarted, during the InfoSphere
Information Server initialization, the WebSphere Application Server user
registry configuration is checked and the InfoSphere Information Server user
registry configuration is automatically adjusted if needed. The default
WebSphere Application Server administrator user is also automatically
configured as the initial new InfoSphere Information Server default
administrator user.
8. If one of the node agents was not running when you did the previous steps,
the node agent cannot be restarted because the user registry configuration at
the Deployment Manager and node levels do not match. To fix this problem,
run the WebSphere Application Server syncNode command to synchronize the
node with the Deployment manager. To run the syncNode command:
a. Log in to the node.
b. Run the syncNode command.
v

Linux

UNIX

/opt/IBM/WebSphere/AppServer/profiles/custom_profile/bin/syncNode.sh
dmgr_hostname dmgr_port -user was_admin_username -password
was_admin_password

v

Windows

C:\IBM\WebSphere\AppServer\profiles\custom_profile\bin\syncNode
dmgr_hostname dmgr_port -user was_admin_username -password
was_admin_password

In the command:
v dmgr_hostname is the host name of the computer where the Deployment
Manager is running.
v dmgr_port is the port number of the Deployment Manager (the default is
8879).
v was_admin_username is the user name of the WebSphere Application
Server administrator.
v was_admin_password is the administrator password.
c. Restart the node agent. See “Starting IBM WebSphere Application Server
(Windows)” on page 256 or “Starting IBM WebSphere Application Server
(Linux, UNIX)” on page 258.

What to do next
After you change the user registry, you can use theWebSphere Application Server
administrator user name and password to log in to the InfoSphere Information
Server Web console. In the console, grant suite administrator access to additional
users as needed. The WebSphere Application Server administrator is granted
InfoSphere Information Server administrator privileges by default.
LDAP distinguished name (DN) determination:
To configure IBM InfoSphere Information Server to use a lightweight directory
access protocol (LDAP) user registry, you might need the full LDAP distinguished
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name (DN) of the suite administrator. If you cannot get the LDAP DN from your
LDAP administrator, you can use these procedures to determine the LDAP DN.
Determining an LDAP distinguished name (DN) by using the IBM WebSphere
Application Server Administrative Console:
You can determine a full LDAP distinguished name (DN) by using the WebSphere
Application Server administrative console.
Procedure
1. Log in to the IBM WebSphere Application Server administrative console.
2. From the console, select Applications > Application Types > WebSphere
enterprise applications.
3. Click an application name.
4. Under Detail properties, click Security role to user/group mapping.
5. Select a role and click Map Users.
6. In the Search String field, enter an asterisk (*) and click Search.
Determining an LDAP distinguished name (DN) by using Active Directory search
(Windows):
If you have access to a Microsoft Windows computer that is registered with a
Windows Active Directory domain, you can use the user search feature to
determine a Windows Active Directory distinguished name.
Procedure
1. On the computer, click Start > Run.
2. In the window, type compmgmt.msc and press Enter.
3.
4.
5.
6.
7.

Expand Local Users and Groups.
Open the Groups folder and double-click one of the groups.
In the Properties window, click Add.
In the Select Users window, click Advanced.
In the Select Users window, search for the IBM WebSphere Application Server
user name. You must select the X500 name in the attributes to display the full
distinguished name. The search returns the full distinguished name.

Switching back to the internal user registry when using
WebSphere Application Server Network Deployment
If necessary, after configuring the IBM InfoSphere Information Server suite to use
an external user registry, you can switch back to the internal user registry. The
internal user registry is the user registry that was configured during the initial
installation of InfoSphere Information Server.

Before you begin
v In an IBM WebSphere Application Server stand-alone installation, WebSphere
Application Server must be running.
v In a clustered installation, the Deployment Manager and all node agents must be
running.
v See the WebSphere Application Server documentation for more information:
– IBM WebSphere Application Server Network Deployment 8.5:
http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/topic/
com.ibm.websphere.nd.doc/ae/tsec_tdaman.html
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Procedure
The internal user registry is an IBM WebSphere Application Server custom user
registry.
1. Log in to the computer on which the DirectoryAdmin tool is installed:
v If you have implemented WebSphere Application Server clustering for your
installation, log in to the computer that hosts the WebSphere Application
Server Deployment Manager.
v If you have not implemented clustering, log in to the services tier computer.
2. From the command line, run the following command to create the WebSphere
Application Server default administrator in the internal user registry:
Linux

UNIX

/opt/IBM/InformationSesrver/ASBServer/bin/DirectoryAdmin.sh -user
-userid was_admin_username -password was_admin_password -admin
Windows

C:\IBM\InformationServer\ASBServer\bin\DirectoryAdmin.bat -user
-userid was_admin_username -password was_admin_password -admin

In the command, was_admin_user_id and was_admin_password are the user
name and password of the new WebSphere Application Server administrator.
This account is the administrator from the newly configured internal user
registry.
3. Log in to the WebSphere Application Server administrative console.
4. In the console, click Security > Secure administration, applications, and
infrastructure.
In WebSphere Application Server, click Security > Global Security.
5. Ensure that the Use domain-qualified user names option is not selected.
6. In the User account repository section, click the Available realm definitions
list and select Standalone custom registry.
7. Click Configure.
8. In the Primary administrative user name field, enter the administrator user
name that you specified in the command in step 2.
9. Ensure that the custom registry class name is the following string:
com.ibm.iis.isf.j2ee.impl.was.security.WASCustomUserRegistry

10. Click Apply.
11. Select Server identity that is stored in the repository.
12. In the Server user ID or administrative user on a Version 6.0.x node field,
type the short name of the user account that you created in step 2.
13. In the Password field, type the password of the user account that you
specified in the command in 2.
14. Click OK.
15. In the User account repository section, click the Available realm definitions
list and select Standalone custom registry.
16. Click Set as current. If an error occurs, the application server is unable to
authenticate with the internal user registry by using the credentials that you
provided.
17. Click Apply and then click Save.
18. Log out of the console.
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19. Stop WebSphere Application Server. In a clustered installation, stop the
application servers and the node agents, and then stop the Deployment
Manager.
Important: When stopping the WebSphere Application Server processes, use
the credentials of the WebSphere Application Server administrator from the
previous user registry.
20. Log in to the computer on which the AppServerAdmin tool is installed. This
tool is on the same computer as the DirectoryAdmin tool.
21. From the command line, run the AppServerAdmin command. This command
propagates the WebSphere Application Server administrator user name and
password to WebSphere Application Server.
Linux

UNIX

/opt/IBM/Information/server/ASBServer/bin/AppServerAdmin.sh -was
-user was_admin_user_id -password was_admin_password
Windows

C:\IBM\InformationServer\ASBServer\bin\AppServerAdmin.bat -was
-user was_admin_user_id -password was_admin_password

In the command, was_admin_user_id and was_admin_password must match the
credentials that you provided in the WebSphere Application Server
Administrative Console.
Tip: The -password parameter is optional. If not provided, you will be
prompted for a password. If you do provide a password, it can be either plain
text or an encrypted string that has been created with the encrypt command.
22. If you are switching the user registry for a system that has been used for a
while by multiple users, clean up the users and groups that are related to the
security configuration. See “Switching the user registry configuration for a
system in use” on page 75.
23. Restart WebSphere Application Server. In a clustered installation, start the
Deployment Manager, and then the node agents and application servers.
24. If one of the node agents was not running when you did the previous steps,
the node agent cannot be restarted. The user registry configuration at the
Deployment Manager and node levels do not match. To fix this problem, run
the WebSphere Application Server syncNode command to synchronize the
node with the Deployment manager. To run the syncNode command:
a. Log in to the node.
b. Run the syncNode command.
v

Linux

UNIX

/opt/IBM/WebSphere/AppServer/profiles/custom_profile/bin/syncNode.sh
dmgr_hostname dmgr_port -user was_admin_username -password
was_admin_password

v

Windows

C:\IBM\WebSphere\AppServer\profiles\custom_profile\bin\syncNode
dmgr_hostname dmgr_port -user was_admin_username -password
was_admin_password

In the command:
v dmgr_hostname is the host name of the computer where the Deployment
Manager is running.
v dmgr_port is the port number of the Deployment Manager (default is
8879).
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v was_admin_username is the user name of the WebSphere Application
Server administrator.
v was_admin_password is the administrator password.
c. Restart the node agent. See “Starting IBM WebSphere Application Server
(Windows)” on page 256 and “Starting IBM WebSphere Application Server
(Linux, UNIX)” on page 258.
25. Check the WebSphere Application Server log files to ensure that there are no
errors.

What to do next
The administrator account is also automatically configured as the initial new
InfoSphere Information Server default administrator.
After the user registry configuration change, you can open the InfoSphere
Information Server Web console, create new users, and grant them roles.

Switching back to the internal user registry when using
WebSphere Application Server Liberty Profile
If you have configured IBM InfoSphere Information Server to use an LDAP user
registry with WebSphere Application Server Liberty Profile but no longer wish to
authenticate with LDAP, you can switch back to use the internal user registry.

About this task
InfoSphere Information Server supports any LDAP-compliant user registry that
IBM WebSphere Application Server Liberty Profile supports.

Procedure
1. Stop the application server:
Linux

UNIX

IS_install_path/ASBServer/bin/MetadataServer.sh stop
Windows

net stop InfoSvr

2. Remove the LDAP user registry from the WebSphere Application Server Liberty
Profile configuration by commenting out or removing the ldapRegistry element
in the IS_install_path/wlp/usr/servers/iis/server.xml file:
3. Add the InfoSphere Information Server user registry to the WebSphere
Application Server Liberty Profile configuration in the IS_install_path/wlp/
usr/servers/iis/server.xml file, anywhere before the closing server element.
<usr_iisRegistry dataSourceRef="DataSource_ASBDataSource"/>

4. Start the application server:
Linux

UNIX

IS_install_path/ASBServer/bin/MetadataServer.sh run
Windows

net start InfoSvr

5. If you are switching the user registry for a system that has been used for a
while by multiple users, clean up the users and groups that are related to the
security configuration. See Switching the user registry configuration for a
system in use.
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6. Manually configure one internal user registry user as an administrator user to
be able to login to the IBM InfoSphere Information Server Web console and
further create users and groups and assign roles.
cd IS_install_path/ASBServer/bin
./DirectoryAdmin.sh -user -userid user_name -password password -admin

Where:
user_name
The user name that you want to be the administrator user. You can name it
anything that you want according to the restrictions for internal user
registry user IDs. The internal user registry is stored in the metadata
repository database.
password
The password for the administrator user. You can specify anything
according to the restrictions for passwords.

What to do next
After you change the user registry, you can use the administrator user to log into
the IBM InfoSphere Information Server Web console to create other users and
groups, and to assign roles.

Switching the user registry configuration for a system in use
If you switch the user registry after the system has been used for a while by
multiple users, you must clean up the security repository as part of the user
registry change. If you switch the user registry immediately after installation, you
do not have to do this procedure.

About this task
If you must switch the user registry, do the registry switch immediately after
installing the software if possible, before you do any additional security
configuration tasks. If you must switch the user registry at a later time, do this
procedure to clean up all previous security configuration settings. Settings include
role assignments, credential mappings, and access rights. These settings are deleted
from the repository. You must configure the settings again manually for the new
users of the new registry.
If you must change the user registry after the system has been in production,
consider instead migrating to a new installation to avoid any security issues and
risks. Otherwise, a mismatch might occur between the users of the old and new
user registries.

Procedure
1. Perform the procedure to switch the user registry. For user registry switching
procedures, see “User registry configuration” on page 53. Stop that procedure
at the point where you are directed to this one.
2. Log in to the computer where the services tier is installed.
v If you have implemented WebSphere Application Server clustering within
your installation, log in to the computer that hosts the WebSphere
Application Server Deployment Manager.
v If you have not implemented clustering, log in to the services tier computer.
3. From the command line, run the following command to clean up all of the
groups that are related to the security configuration:
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Windows

C:\IBM\InformationServer\ASBServer\bin\DirectoryAdmin.bat -delete_groups
Linux

UNIX

/opt/IBM/InformationServer/ASBServer/bin/DirectoryAdmin.sh -delete_groups

4. From the command line, run the following command to clean up all of the
users related to the security configuration:
Windows

C:\IBM\InformationServer\ASBServer\bin\DirectoryAdmin.bat -delete_users
Linux

UNIX

/opt/IBM/InformationServer/ASBServer/bin/DirectoryAdmin.sh -delete_users

5. If you switch to the InfoSphere Information Server internal user registry, run
the following command from the command line again:
Windows

C:\IBM\InformationServer\ASBServer\bin\DirectoryAdmin.bat -user
-userid was_admin_username -password was_admin_password
Linux

UNIX

/opt/IBM/InformationServer/ASBServer/bin/DirectoryAdmin.sh -user
-userid was_admin_username -password was_admin_password

You can provide the password as plain text or as a string that has been
encrypted with the encrypt command.
6. Complete the remainder of the user registry switching procedure that you
started in step 1 on page 75.

User and group creation
Create users as the first level of security. You must create a user for each person
who will log in to IBM InfoSphere Information Server.
If the InfoSphere Information Server internal user registry is used, you can create
users and groups by using the InfoSphere Information Server console or the
InfoSphere Information Server Web console. The InfoSphere Information Server
console is available with IBM InfoSphere Information Analyzer and InfoSphere
Information Services Director. The InfoSphere Information Server Web console is
available to all InfoSphere Information Server users with the SuiteUser role.
If you are using an external user registry, such as the local operating system user
registry or Lightweight Directory Access Protocol (LDAP), you must create users
and groups by using the user registry administration tools. You cannot create users
and groups in external user registries by using the InfoSphere Information Server
consoles.

Default and preconfigured users
In addition to users that you create, several default or preconfigured users are
created by you or for you during the installation process.
Accounts must be created for the administrator users for IBM InfoSphere
Information Server and IBM WebSphere Application Server. These users are
typically called "isadmin" and "wasadmin." You can choose to create them during
installation. The accounts must be created in the user registry that is used by
WebSphere Application Server.
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Table 3. Services tier users
Sample user
name
Description
isadmin

InfoSphere Information Server administrator

wasadmin

WebSphere Application Server administrator and InfoSphere Information
Server administrator

Linux
UNIX
There must be at least one user account for the engine. This
user ID is typically called "dsadm." You can choose to create this account during
installation. It must be created in the user registry that is used by the engine. This
user registry can be the local operating system user registry. Alternatively, the user
registry can be an external user registry. This external user registry must be
configured through Pluggable Authentication Modules (PAM). PAM must run on
the operating system of the computer that is hosting the engine.

Table 4. Engine tier users
Sample user
name
Description
dsadm

IBM InfoSphere DataStage administrator

The following users must be local operating system users where the metadata
repository tier is installed. You can choose to create these accounts during
installation:
v All installations must have an owner for the metadata repository database
within the database management system. This account is typically called xmeta.
v IBM InfoSphere Information Analyzer installations must have an owner for the
information analysis database within the database management system. This
account is typically called "iauser."
v If you use IBM DB2 for the metadata repository:
– You must have a DB2 instance owner. This user is the owner of the DB2
database management system. This user is typically called db2admin in
Microsoft Windows installations, and db2inst1 in Linux and UNIX
installations. The db2inst1 user is a non-fenced user.
–

Linux

UNIX

You must have a fenced user. This user is typically called

db2fenc1.
Table 5. Additional users
Sample user
name
(Windows)

Sample user
name (Linux,
UNIX)

Description

xmeta

xmeta

Metadata repository database owner

iauser

iauser

Information analysis database owner

db2admin

db2inst1

DB2 instance owner (when DB2 is used to host the
metadata repository database or analysis database)

N/A

db2fenc1

DB2 fenced user (when DB2 is used to host the metadata
repository database or analysis database)
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Creating users in the IBM InfoSphere Information Server console
If the IBM InfoSphere Information Server internal user registry is used, you can
create users as the first level of security. You must create a user for each person
that needs to log in to InfoSphere Information Server.

Before you begin
v You must have IBM InfoSphere Information Analyzer or InfoSphere Information
Services Director installed.
v You must have Administrator authority.

Procedure
1. In the IBM InfoSphere Information Server console, on the Home navigator
menu, select Configuration > Users.
2. In the Tasks pane, click New User.
3. In the New User pane, specify information about the user. The User Name,
Password, Confirm Password, First Name (Given Name), and Last Name
(Family Name) fields are required.
4. In the Suite pane, specify the rights for the user.
5. In the Suite Component pane, select whether the user has any suite component
roles. You must add at least one suite component role for each suite component
that you want the user to access. For example, if you are creating a user that
will access IBM InfoSphere Information Analyzer, you must assign the
Information Analyzer Project Administrator, Data Administrator, or User role.
6. Optional: In the Groups pane, click Browse to add the user to a group.
a. In the Add Groups window, select the group that you want to add the user
to.
b. Click Add.
c. Click OK to close the window.
7. Click Save > Save and Close.

What to do next
After you create users, you can add the users to new or existing projects.

Creating groups in the IBM InfoSphere Information Server
console
If the IBM InfoSphere Information Server internal user registry is used, you can
create user groups and assign security settings and roles to the groups. All users
that belong to a group automatically inherit the security settings and roles that are
assigned to the group.

Before you begin
v You must have IBM InfoSphere Information Analyzer or InfoSphere Information
Services Director installed.
v You must have Administrator authority.

Procedure
1. In the IBM InfoSphere Information Server console, on the Home navigator
menu, select Configuration > Groups.
2. On the Groups workspace, click New Group on the Tasks pane.
3. Specify information about the group. The ID and the Group Name fields are
required.
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4. In the Suite pane, specify the rights for the group.
5. In the Suite Component pane, select whether the group has any suite
component roles. You must add at least one suite component role for each suite
component that you want the group of users to access. For example, if you are
creating a group that will access IBM InfoSphere Information Analyzer, you
must assign the Information Analyzer Project Administrator, Data
Administrator, or User role.
6. Optional: In the Users pane, click Browse to add users to the group.
a. In the Add Users window, select the user that you want to add to the
group.
b. Click Add.
c. Click OK to close the window.
7. Click Save > Save and Close.

What to do next
After you create groups, you can add the groups to new or existing projects.

Adding users to a group in the IBM InfoSphere Information
Server console
If the IBM InfoSphere Information Server internal user registry is used, you can
add users to a group to quickly assign and reassign user roles.

Before you begin
You must have IBM InfoSphere Information Analyzer or InfoSphere Information
Services Director installed.

Procedure
1. In the IBM InfoSphere Information Server console, on the Home navigator
menu, select Configuration > Groups.
2. In the Groups workspace, select a group.
3. In the Task pane, click Open.
4. In the Users pane, click Browse.
5. In the Add Users window, select the users that you want to add to the group.
6. Click Add.
7. Click OK to save your choices and to close the Add Users window.
8. Click Save > Save and Close to save the assignments.

Creating users in the IBM InfoSphere Information Server Web
console
If the IBM InfoSphere Information Server internal user registry is used, you can
create users as the first level of security. You must create a user for each person
that needs to log in to InfoSphere Information Server.

Before you begin
You must have suite administrator authority.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
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In the Navigation pane, select Users and Groups > Users.
In the Users pane, click New User.
In the Create New User pane, provide information about the user.
In the Roles pane, specify whether the user is an administrator and user of the
suite or a user of the suite.
6. In the Suite Component pane, select whether the user has any suite component
roles. To log in to any of the product modules, a user must have the suite user
role. Also add at least one suite component role for each suite component that
you want the user to access. For example, if you are creating a user that will
access IBM InfoSphere Information Analyzer, you must assign the suite user
role, and also the Information Analyzer Project Administrator, Data
Administrator, or User role.
7. Click Save and Close to save the user information in the metadata repository.
2.
3.
4.
5.

Creating groups in the IBM InfoSphere Information Server Web
console
If the IBM InfoSphere Information Server internal user registry is used, you can
create user groups and assign security settings and roles to the groups. All users
that belong to a group automatically inherit the security settings and roles that are
assigned to the group.

Before you begin
You must have suite administrator authority.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2.
3.
4.
5.

In the Navigation pane, select Users and Groups > Groups.
In the Groups pane, click New Group.
In the Create New Group pane, provide information for the group.
Optional: In the Roles pane, specify whether the group has administrator and
user privileges in the suite or user privileges in the suite.

6. Optional: In the Suite Component pane, select whether the group has any suite
component roles. You must add at least one suite component role for each suite
component that you want the users in the group to access. For example, if you
are creating a group for users that are to access IBM InfoSphere Information
Analyzer, you must assign the Information Analyzer Project Administrator,
Data Administrator, or User role.
7. Assign users to the group.
a. In the Users pane, click Browse.
b. In the Search for Users window, type a name in the search fields and click
Filter. To view all users, click Clear Filter.
c. Select the users that you want to assign to the group.
d. Click OK to save your choices and close the Search for Users window.
8. Click Save and Close to save the group.

Adding users to a group in the IBM InfoSphere Information
Server Web console
If the IBM InfoSphere Information Server internal user registry is used, you can
add users to a group to quickly assign and reassign user roles.
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Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Users and Groups > Groups.
3. In the Groups pane, select a group and click Open Group.
4. In the Users pane, click Browse.
5. In the Search for Users window, locate the users that you want to add to the
group.
Option

Description

To search for a user by name:

Type a name in the search fields and click
Filter.

To view all users:

Do not enter any text in the fields and click
Clear Filter.

6. Select the users that you want to assign to the group.
7. Click OK to save your choices and close the Search for Users window.
8. Click Save and Close to save the assignments.

Permissions and groups configuration (Windows Server 2008)
After you install IBM InfoSphere Information Server on Microsoft Windows 2008
Server, you must perform an additional task to configure users.

About this task
Which task you use depends on whether Microsoft Windows Server 2008 is
configured to be a domain controller.
The first time that a user of an InfoSphere Information Server client, such as the
IBM InfoSphere DataStage client or the IBM InfoSphere Information Server console,
successfully logs in to the InfoSphere Information Server services tier, the server is
added to the registered-servers.xml file. This file is located in the
C:\IBM\InformationServer\ASBNode\eclipse\plugins\com.ibm.iis.client.
directory by default.
When logging in to the services tier for the first time, the operating system user on
the client must have write permission to the registered-servers.xml file on the
client so that in can be updated. If the user does not have the required permission,
the login fails.
System administrators can limit access to specific InfoSphere Information Server
services tiers from any client by removing the file system write permission to the
registered-servers.xml file. The administrator, or anyone who has write
permission, can log in ahead of time to each server that the client user will access.
The administrator can then distribute the prepopulated registered-servers.xml
file to the remaining clients in their network. To set or remove file system write
permission, see “Configuring write permission to the registered-servers.xml file”
on page 85.
Configuring permissions and groups (Windows Server 2008):
You must complete these tasks to configure users and groups to access to IBM
InfoSphere Information Server. This configuration is required only for the engine
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tier computer. This configuration is only applicable to the users of the operating
system where the engine tier components are installed.
Procedure
1. Log in to Microsoft Windows Server 2008 as an administrator.
2. Create a group.
a. Click Start > Control Panel > Administrative Tools > Computer
Management.
b. In the Computer Management window, expand System Tools > Local Users
and Groups > Groups.
c. Click Action > New Group.
d. In the New Group window, type DataStage as the name for the group, click
Create, and click Close.
3. Configure users and the DataStage group to log in.
a. Click Start > Control Panel > Administrative Tools > Local Security
Policy.
b. In the Local Security Settings window, expand Local Policies > User Rights
Assignment to display the policies.
c. In the Local Security window, click the Allow log on Locally policy and
click Actions > Properties.
d. In the Allow log on Locally Properties window, click Add User or Group.
e. In the Select Users or Groups window, click Locations, click the name of
your local computer, and click OK.
f. In the Select Users or Groups window, click Advanced and click Find Now.
g. In the search results, select Authenticated Users and DataStage and click
OK three times to save the results and to return to the Local Security
window.
h. In the Local Security window, click the Log on as a Batch Job policy and
click Actions > Properties.
i. In the Log on as a Batch Job window, click Add User or Group.
j. In the Select Users or Groups window, click Locations, click the name of
your local computer, and click OK.
k. In the Select Users or Groups window, click Advanced, and then click Find
Now.
l. In the search results, select DataStage and click OK three times to save the
results and to return to the Local Security window.
m. Close the Local Security Policy window.
4. Add users to the group.
a.
b.
c.
d.
e.
f.

From the Computer Management window, click Groups.
Click the name of the group that you want to add users to (DataStage).
Click Action > Add to Group.
In the User Properties window, click Add.
In the Select Users or Groups window, click Location.
Click the name of your local computer, and then click OK.

g. In the Select Users window, click Advanced.
h. In the window that opens, click Find Now.
i. Click the names of users that you want to include in the group, and click
OK. At a minimum, include all authenticated users.
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j. Click OK three times to return to the Computer Management window.
k. Close the Computer Management window.
5. Set permissions for the following folders:
v C:\IBM\InformationServer\Server
v C:\Program Files\MKS Toolkit\fifos
v C:\Windows\%TEMP%
v C:\tmp
Complete the following steps for each of the listed folders.
a. Select the folder and click File > Properties.
b. In the Properties window, click the Security tab, and click Edit.
c. In the Permissions window, click Add.
d. In the Select Users or Groups window, click Locations.
Click the name of the local computer, and click OK.
In the Select Users or Groups window, click Advanced.
In the window that opens, click Find Now.
Click the name of the group that you want to set permissions for
(DataStage).
i. Click OK twice.
j. In the Permissions list, select to allow Modify, Read & execute, List folder
contents, Read, and Write Permissions. Click OK.
k. If you receive a message that asks you to confirm the changes, click Apply
changes to this folder, subfolders and files.
e.
f.
g.
h.

Configuring permissions and groups (Windows Server 2008 domain controller):
If Microsoft Windows Server 2008 is a domain controller, you must complete these
tasks to configure users and groups to access IBM InfoSphere Information Server.
This configuration is required only for the engine tier computer and is only
applicable to the users of the operating system where the engine tier components
are installed.
Procedure
Because you cannot add the built-in authenticated users group to a group that you
create in steps 3 and 2, you might prefer to skip steps 3 and 2 and use the
authenticated users group directly.
1. Log in to Microsoft Windows Server 2008 as an administrator.
2. Create a group.
a. Click Start > Control Panel > Administrative Tools > Active Directory and
Computers.
b. In the Active Directory and Computers window, click Users in the current
domain.
c. In the window that opens, click Action > New Group.
d. In the New Group window, type DataStage as the name for the group.
e. Leave Group scope as Global and Group type as Security.
f. Click OK
3. Configure the server to allow local users and the DataStage group to log in.
a. Click Start > Control Panel > Administrative Tools > Domain Security
Policy.
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b. In the Domain Security Policy window, expand Local Policies > User
Rights Assignment to display the policies.
c. In the Domain Security window, click the Allow log on Locally policy, and
click Actions > Properties.
d. In the Allow log on Locally Properties window, click Add User or Group.
e. Click Browse.
f. In the Select Users, Computers, or Groups window, click Advanced and then
click Find Now.
g. In the search results, click Authenticated Users and DataStage, and then
click OK three times to return to the Domain Security Policy window.
h. In the Domain Security window, click the Log on as a Batch Job policy, and
click Actions > Properties.
i. In the Log on as a Batch Job window, click Add User or Group.
j. Click Browse.
k. In the Select Users, Computers, or Groups window, click Advanced and
then click Find Now.
l. In the search results, click DataStage and click OK three times to return to
the Domain Security Policy window.
m. Close the Domain Security Policy window.
4. Add users to the group.
a. In the Users in the current domain window, click the name of the group
that you want to add users to (DataStage), and click OK. Authenticated
users are not available.
b. Click Action > Properties.
c. In the Properties window, click the Members tab, and then click Add.
d. In the window that opens, click Advanced, and then click Find Now.
e. Click the names of users that you want to add to the group, and then click
OK. Authenticated users are not available.
f. Click OK two times to save your results and to return to the Active
Directory and Computers window.
g. Close the Active Directory and Computers window.
5. Set permissions for the following folders:
v C:\IBM\InformationServer\Server
v C:\Program Files\MKS Toolkit\fifos
v C:\Windows\%TEMP%
v C:\tmp
Complete the following steps for each of the listed folders.
a. Select the folder and click File > Properties.
In the Properties window, click the Security tab, and click Edit.
In the Permissions window, click Add.
In the Select Users, Computers, or Groups window, click Locations.
In the window that opens, click Advanced, and then click Find Now.
Click the name of the group that you want to set permissions for
(DataStage).
g. Click OK twice.
h. In the Permissions list, select to allow Modify, Read & execute, List folder
contents, Read, and Write Permissions. Click OK.
b.
c.
d.
e.
f.
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i. If you receive a message to confirm your changes, confirm by clicking Apply
changes to this folder, subfolders and files.
Configuring write permission to the registered-servers.xml file:
The first time that a given services tier is accessed from a given client system, the
user that is currently logged into the operating system must have write permission
to the registered-servers.xml file to allow the application to add the host name
and port of the client system to the file. Once the information is added, any
subsequent login by any user by any InfoSphere Information Server application on
the client system only requires read access to the file.
About this task
When an InfoSphere Information Server client application logs into a services tier
for the first time, the application adds the services tier host name and port to the
local registered-servers.xml file. This file contains the list of services tiers to be
displayed as choices for subsequent client logins.
Be default, administrators have write permission to the registered-servers.xml
file. Write permission for the Users group must also be added for the application
to access the file.
Procedure
To give the Users group write permission to the file:
v Windows XP
1. In Microsoft Windows Explorer, locate the registered-servers.xml file. By
default, this file is located in the following directory: C:\IBM\
InformationServer\ASBNode\eclipse\plugins\com.ibm.iis.client
2. Right-click the file and select Properties
3. In the Properties window, click the Security tab.
4. Click Add.
5. In the Select Users or Groups window, click Locations.
6. Select the name of your local computer and click OK.
In the Select Users or Groups window, click Advanced.
Click Find Now and select the Users group.
Click OK twice.
With the Users group selected, click Allow for the Write permission, and
click OK.
11. If you receive a message to confirm your changes, confirm by clicking
Apply changes to this folder, subfolders and files.
v Windows 2008 and Windows 7
1. In Microsoft Windows Explorer, locate the registered-servers.xml file. By
default, this file is located in the following directory: C:\IBM\
InformationServer\ASBNode\eclipse\plugins\com.ibm.iis.client
2. Right-click the file and select Properties
7.
8.
9.
10.

3.
4.
5.
6.

In the Properties window, click the Security tab.
Click Edit.
In the Permissions window, click Add.
In the Select window, click Locations.
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Select the name of your local computer and click OK.
In the Select window, click Advanced.
Click Find Now and select the Users group.
Click OK twice.
With the Users group selected, click Allow for the Write permission, and
click OK.
12. If you receive a message to confirm your changes, confirm by clicking
Apply changes to this folder, subfolders and files.

7.
8.
9.
10.
11.

Assigning user roles
IBM InfoSphere Information Server supports role-based access control. User roles
determine which features users can use. For some suite components, user roles also
determine which projects a user can access.
User roles can be defined at several levels that build on one another. Users derive
authority from the combination of their role in InfoSphere Information Server (their
suite roles), their role in the suite component (for example, IBM InfoSphere
Information Analyzer or IBM InfoSphere FastTrack), and the permissions they have
to work in a given project (their project roles).

Suite
Suite-level roles are the basic roles that users need to access any part of InfoSphere
Information Server. Users who are not Suite Users cannot authenticate with
InfoSphere Information Server. All InfoSphere Information Server users must have
the Suite User role. A suite user can also have the Suite Administrator role to
complete administration tasks. Users with the Suite Administrator role must also
have the Suite User role assigned to their user names.
The common metadata component roles are also suite-level roles. These roles have
certain authority over metadata in the metadata repository.

Component
Component-level roles provide access to the features of a specific product module.
Users can be users or administrators of a product module. For example, you can be
an InfoSphere Information Analyzer user and an IBM InfoSphere DataStage
administrator.

Project
Project-level roles are defined in the product module and by the product module.
For example, in an information analysis project in the IBM InfoSphere Information
Server console, you can assign a user the Information Analyzer Data Steward role
for that project.

Assigning user roles
Typically, an InfoSphere Information Server administrator assigns suite-level roles
and component-level roles. Both roles are assigned by using the IBM InfoSphere
Information Server console or IBM InfoSphere Information Server Web console.
The InfoSphere Information Server console is available with IBM InfoSphere
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Information Analyzer and InfoSphere Information Services Director. The InfoSphere
Information Server Web console is available to all InfoSphere Information Server
users with the SuiteUser role.
After the security roles are configured, the administrator of each product module
further defines the project-level roles in the IBM InfoSphere Information Server
console or the IBM InfoSphere DataStage and QualityStage Administrator client. To
perform the actions of a particular project-level role, a user must also have
suite-level access and access to the product module that owns the project. For
example, to be an InfoSphere DataStage developer, a user must be assigned the
roles of suite user and component-level InfoSphere DataStage, as well as the
InfoSphere DataStage developer project role.

Security role overview
IBM InfoSphere Information Server supports role-based access control. Users derive
authority from the union of their roles in InfoSphere Information Server (the suite
roles), their roles in the suite component, such as IBM InfoSphere Information
Analyzer (the suite component roles), and the projects that they work with (the
project roles).
Security configuration is performed by two levels of administrators:
InfoSphere Information Server administrators
These administrators are in charge of assigning the suite and suite
component roles to users. These roles determine which suite components
the user can access and whether the user has component administrator or
component user access in those suite components. InfoSphere Information
Server administrators can also configure credential mappings for
InfoSphere Information Analyzer, IBM InfoSphere DataStage, and IBM
InfoSphere QualityStage users. InfoSphere Information Server
administrators must have, at least, the Suite Administrator and Suite User
role assigned to their user names. During installation, a default InfoSphere
Information Server administrator is created to perform the initial
installation tasks and configure the user registry. The default IBM
WebSphere Application Server administrator is always automatically
configured as an InfoSphere Information Server administrator when you
restart IBM WebSphere Application Server.
InfoSphere Information Server suite component administrators
These administrators are in charge of assigning the component project roles
to the users that were configured by the InfoSphere Information Server
administrator. These assignments are configured in the suite component.
For example, the InfoSphere Information Server component administrator
can assign the Information Analyzer Business Analyst role to a user in the
information analysis screens of the console. For InfoSphere DataStage
projects, these role assignments are configured in the InfoSphere DataStage
Administrator client. The InfoSphere DataStage and QualityStage
administrators can also use the IBM InfoSphere Information Server Web
console to configure credential mappings.

Suite roles
Suite User
Select to give the user general access to InfoSphere Information Server and
the suite components. A user must have this role to authenticate with
InfoSphere Information Server or any of the suite components.
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Suite Administrator
Select to give InfoSphere Information Server administration privileges to
the user. The Suite Administrator role includes additional permissions;
however, the Suite User role must also be assigned to the user for it to
authenticate.
The common metadata roles are also suite roles. See “InfoSphere Metadata Asset
Manager and common metadata roles” on page 96.
Common data rule roles:
You can assign data rule roles to a user.
Suite component roles
Rule Administrator
Sets up and administers who can access and run data rules and rule sets,
so that other users can find and run data rules and rule sets for projects.
Rule Author
Provides the ability to author data rule definitions and rule set definitions.
Rule Manager
Manages the creation and organization of data rules and rule sets. This role
manages who can create data rule definitions, rule set definitions, and
metrics, as well as who can run data rules, rule sets, and metrics.
Rule User
Provides the ability to run data rules and rule sets.
InfoSphere Data Click roles:
An IBM InfoSphere Information Server administrator sets up the roles for using
IBM InfoSphere Data Click. To use InfoSphere Data Click, users must have the role
of InfoSphere Data Click Author or InfoSphere Data Click User, as well as
additional InfoSphere Information Server suite roles.
InfoSphere Data Click roles
To use InfoSphere Data Click, users must have the role of InfoSphere Data Click
Author or InfoSphere Data Click User, as well as additional InfoSphere Information
Server suite roles. The Data Click Author role allows an enterprise architect to
create data movement flows that Data Click Users can run. This controls the data
that users can move into target assets. The Data Click User is a user who can
select assets from within the data sources that the Data Click Author specified, and
then move that set of data based on the policies that were defined by the Author.
Data Click Author
The Data Click Author role allows an enterprise architect to create data
movement flows that Data Click Users can run. This controls the data that
users can move into target assets.
Data Click User
The Data Click User is a user who can select assets from within the data
sources that the Data Click Author specified, and then move that set of
data based on the policies that were defined by the Author.
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Suite roles for InfoSphere Information Server administrators that are setting up
InfoSphere Data Click
An InfoSphere Information Server administrator creates InfoSphere Data Click
authors and users, and assigns roles on the Administration tab of the InfoSphere
Information Server Web console. An administrator needs the following roles:
Suite Administrator
Administrators need this role to create InfoSphere Data Click users and
grant them the roles they need to use InfoSphere Data Click.
DataStage and QualityStage Administrator
Administrators need this role if they want to:
v Change the workload manager settings for InfoSphere Data Click
v Assign InfoSphere Data Click authors the DataStage Developer role
v Assign InfoSphere Data Click users the DataStage Operator role
v Import InfoSphere Data Click job templates into the InfoSphere
DataStage projects
Suite roles for InfoSphere Data Click Authors
Authors need these additional roles to use InfoSphere Data Click.
Suite User
Authors need this role before they can create and run activities in
InfoSphere Data Click.
DataStage and QualityStage User
Authors need the DataStage and QualityStage User role to run InfoSphere
Data Click activities.
Common Metadata Importer
Authors need this role if they want to import metadata into the metadata
repository by using InfoSphere Metadata Asset Manager.
Suite roles for InfoSphere Data Click Users
Users need these additional roles to use InfoSphere Data Click.
Suite User
Users need this role before they can run activities in InfoSphere Data Click.
DataStage and QualityStage User
Users need this role to run activities in InfoSphere Data Click.
Common Metadata User
Users need this role if they want to browse, search for, and inspect assets
that are in the metadata repository
InfoSphere DataStage roles
You might need these additional InfoSphere DataStage roles to use InfoSphere Data
Click features.
DataStage Developer
InfoSphere Data Click authors need this role for the InfoSphere DataStage
project that they are going to work with. This role grants them full access
to all areas of the DataStage project that they might need to work with.
The role also allows them to view and manage DataStage jobs in the IBM
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InfoSphere DataStage and QualityStage Operations Console. You can assign
this role to users by using the DirectoryCommand tool.
DataStage Operator
InfoSphere Data Click users need this role for the InfoSphere DataStage
project that they will be working with in InfoSphere Data Click. This role
allows them to run and manage DataStage jobs. The role also allows them
to view and manage DataStage jobs in the IBM InfoSphere DataStage and
QualityStage Operations Console. You can assign this role to users by
using the DirectoryCommand tool.
InfoSphere Data Quality Console roles:
IBM InfoSphere Information Server administrators define user authority by
assigning suite component roles to IBM InfoSphere Data Quality Console users.
The user role determines the tasks that a user can complete and what the user sees
on each page of the data quality console.
You can assign suite component roles in the IBM InfoSphere Information Server
console or the IBM InfoSphere Information Server Web console.
Suite component roles
Administrator
Administrators ensure that exception information is collected and shown in
the data quality console. They also maintain the activity log.
Review manager
Review managers track all of the exception descriptors in the data quality
console and assign exception descriptors to reviewers.
Reviewer
Reviewers track the exceptions that are associated with the exception
descriptors that are assigned to them.
Business steward
Business stewards view exceptions to track the data quality of business
entities such as implemented data resources.
InfoSphere DataStage and InfoSphere QualityStage roles:
For IBM InfoSphere DataStage and IBM InfoSphere QualityStage, administrators
can further define user authority by assigning suite component and project roles to
InfoSphere DataStage and InfoSphere QualityStage users.
You can assign suite component roles in the console or the Web console. Project
roles can be assigned only in the Permissions page of the IBM InfoSphere
DataStage Administrator client.
Suite component roles
DataStage and QualityStage Administrator
Can perform the following tasks:
v Assign project roles to InfoSphere DataStage suite users in the
InfoSphere DataStage Administrator client
v Use the Administrator client to create, delete, and configure projects
v Mark projects as protected
v Unprotect protected projects
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v
v
v
v
v

Issue server engine commands
Use the Designer client to create and edit jobs and other objects
Use the Director client to run and schedule jobs
View the entire job log messages
Import objects into protected projects

v Change the work load manager (WLM) settings for InfoSphere Data
Click
With this role, the user cannot edit jobs or other objects in protected
projects.
DataStage and QualityStage User
Provides access to InfoSphere DataStage and InfoSphere QualityStage.
Additionally, this role is used to filter the lists of users and groups that are
shown in the InfoSphere DataStage Administrator client. If an IBM
InfoSphere Information Server user does not have this role, that user
cannot access any of the InfoSphere DataStage or InfoSphere QualityStage
product modules, even if that user has InfoSphere DataStage or InfoSphere
QualityStage project roles assigned to the user name.
Project roles
DataStage Developer
Can perform the following tasks:
v Use the Designer client to create and edit jobs and other objects
v Use the Director client to run and schedule jobs
v View entire job log messages
With this role, the user can also use the Administrator client to perform
limited tasks including changing project NLS settings and changing project
properties (not protect/unprotect).
With this role, the user cannot edit jobs or other objects in protected
projects, create, delete, or configure projects (can perform limited
configuration tasks), mark existing projects as protected, unprotect
protected projects, assign project roles to InfoSphere DataStage suite users
in the Administrator client, or import objects into protected projects.
DataStage Production Manager
Can perform the following tasks:
v Mark existing projects as protected
v
v
v
v
v

Unprotect protected projects
Use the Designer client to create and edit jobs and other objects
Use the Director client to run and schedule jobs
View entire job log messages
Import objects into protected projects

With this role, users can also use the InfoSphere DataStage Administrator
client to perform limited tasks including changing the project NLS settings,
issuing server engine commands, and changing project properties.
With this role, users cannot edit jobs or other objects in protected projects.
In addition, the role cannot create, delete, or configure projects (except for
limited configuration tasks), or assign project roles to InfoSphere DataStage
suite users in the Administrator client.
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DataStage Operator
Can perform the following tasks:
v Use the Director client to run and schedule jobs
v View entire job log messages (unless set to read first line only by
InfoSphere DataStage Administrator)
With this role, users can also use the Administrator client to perform
limited tasks including changing project NLS settings and changing project
properties (not protect/unprotect).
DataStage Super Operator
Can perform the following tasks:
v Use the Director client to run and schedule jobs
v View entire job log messages
v Use the Designer client to view jobs and view objects
This role can also use the Administrator client to perform limited tasks
including changing project NLS settings and changing project properties
(not protect/unprotect).
With this role, users cannot use the Designer client to create and edit jobs
and other objects, edit jobs or other objects in protected projects, create,
delete or configure projects, mark existing projects as protected, unprotect
protected projects, assign project roles to InfoSphere DataStage suite users
in the Administrator client, or import objects into protected projects.
DataStage and QualityStage® Operations Viewer
With this role, users can view information about job runs, services, system
resources, and workload management queues in the IBM InfoSphere
DataStage and QualityStage Operations Console.
For more information, see the IBM InfoSphere DataStage and QualityStage
Administrator Client Guide.
InfoSphere FastTrack roles:
For IBM InfoSphere FastTrack, administrators can further define user authority by
assigning suite component roles to InfoSphere FastTrack users.
Suite component roles
FastTrack Project Administrator
The InfoSphere FastTrack Project Administrator can create and manage
projects, and manage user and group access to projects.
FastTrack User
An InfoSphere FastTrack User can use InfoSphere FastTrack functions.
Users must be authorized to projects before they can use functions for
creating, managing, and viewing mapping specifications.
InfoSphere Information Analyzer roles:
IBM InfoSphere Information Server supports role-based authentication of users. By
using the IBM InfoSphere Information Server Web console, administrators can add
users and groups. By using the IBM InfoSphere Information Server console, project
administrators can assign the users and groups to projects and assign roles to those
users and groups.
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Users derive authority from the union of their role in InfoSphere Information
Server (the suite role), their role in the suite component (for example, IBM
InfoSphere Information Analyzer or IBM InfoSphere FastTrack), and the role that
they perform in an assigned project (the project role). The administrator creates a
security policy by performing the following tasks:
v Creating a user ID for each person who needs to access the suite
v Assigning suite and suite component roles to each user
v Assigning each user to specific projects within the suite component
v Assigning each user roles in that project
Roles are complementary and you can grant users greater responsibility by
assigning multiple roles.
Suite roles
Suite Administrator
Provides maximum administration privileges throughout the suite.
Suite User
Provides access to the suite and to suite components. If you assign a user
the role of suite administrator and not that of suite user, the user cannot
log on to any of the suite tools or component tools. This role is the default
role.
Suite component roles
Information Analyzer Data Administrator
Can import metadata, modify analysis settings, and add or modify system
sources.
Information Analyzer Project Administrator
Can administer projects including creating, deleting, and modifying
information analysis projects.
Information Analyzer User
Can log on to InfoSphere Information Analyzer, view the dashboard, and
open a project.
FastTrack Administrator
Can create and manage projects, and manage user and group access to
projects.
FastTrack User
Can use IBM InfoSphere FastTrack functions. A user must be authorized to
projects before using functions for creating, managing, and viewing
mapping specifications.
Project roles
Information Analyzer Business Analyst
Reviews analysis results. This role can set baselines and checkpoints for
baseline analysis, publish analysis results, delete analysis results, and view
the results of analysis jobs.
Information Analyzer Data Operator
Manages data analyses and logs. This role can run or schedule all analysis
jobs.
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Information Analyzer Data Steward
Provides read-only views of analysis results. This role can also view the
results of all analysis jobs.
Information Analyzer Drill Down User
Drills down into source data. This role is applicable when Enable Drill
Down Security is selected.
Information Governance Catalog roles:
IBM InfoSphere Information Governance Catalog security roles give users varying
levels of authority to perform tasks. Security roles determine what types of catalog
content a user can access and what kinds of changes a user can make to the
catalog. The IBM InfoSphere Information Server suite administrator assigns
security roles to users.
You assign security roles from the IBM InfoSphere Information Server web console.
Elements of the user interface are displayed to users who have authorization to do
the tasks provided by the interface. For example, only Information Governance
Catalog Glossary Administrators can see the Administration tab in the user
interface.
The following security roles are described in more detail:
Information Governance Catalog Glossary Basic User
“Information Governance Catalog User” on page 95
Information Governance Catalog Glossary Author
Information Governance Catalog Glossary Administrator
“Information Governance Catalog Information Asset Author” on page 95
“Information Governance Catalog Information Asset Administrator” on page 95
“Information Governance Catalog Information Asset Assigner” on page 95
Information Governance Catalog Glossary Basic User
Users with the Information Governance Catalog Glossary Basic User role can view
the terms, categories, and stewards in the glossary, but information about other
types of catalog assets is not available to them. Users with the Information
Governance Catalog Glossary Basic User role cannot view information governance
policies or information governance rules.
By excluding access to other types of assets, users who do not need to know about
the relationship of terms and categories to other assets are not presented with
unnecessary information. For example, the assets that are assigned to terms are not
shown in the display of term details to users with the Information Governance
Catalog Glossary Basic User role. In addition, when users with this role search for
assets, they can search only for terms and categories, and not other kinds of assets.
Finally, some views that are available to other user roles are not available. For
example, Information Governance Catalog Glossary Basic User cannot view the
data source tree or run business lineage reports.
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Information Governance Catalog Glossary Basic Users cannot be assigned to any
workflow roles.
The Information Governance Catalog Glossary Basic User role is the least
privileged role for glossary assets.
Information Governance Catalog User
Users with the Information Governance Catalog User role can view terms,
categories, information governance policies, information governance rules, and
stewards in the glossary, including details of the assets that are assigned to terms
and information governance rules.
If workflow is enabled, a user with the Information Governance Catalog User
security role can be assigned the Reviewer or Approver workflow roles.
Information Governance Catalog Glossary Author
Users with the Information Governance Catalog Glossary Author role can create
and edit glossary assets. This role is often assigned to users who will be assigned
as stewards.
If workflow is enabled, a user with the Information Governance Catalog Glossary
Author security role can be assigned the Editor, Reviewer, Approver, or Publisher
workflow roles.
Information Governance Catalog Glossary Administrator
The Information Governance Catalog Glossary Administrator role is the most
privileged role. Users with the Information Governance Catalog Glossary
Administrator role can set up and administer the glossary so that other users can
find and analyze the information they need. Most administrative tasks can be
accessed from the Administration tab.
Information Governance Catalog Information Asset Author
Users with this security role can work with queries, browse and search information
assets, make assignments to information assets, and run lineage reports.
Information Governance Catalog Information Asset Administrator
Users with the Information Governance Catalog Information Asset Administrator
must be familiar with the enterprise metadata and metadata that is imported into
the catalog. The administrator must also be familiar with the metadata that is used
in jobs.
Information Governance Catalog Information Asset Assigner
The Information Governance Catalog Information Asset Assigner is a security role
that is designed for users of other products within the InfoSphere Information
Server suite. Some of these products include features that enable users to interact
with glossary content directly from the other product, without requiring the user to
log in to InfoSphere Information Governance Catalog. If users of such a product
are assigned the Information Governance Catalog Information Asset Assigner role,
they can assign assets to terms from within the interface of the other product. For
example, users of IBM InfoSphere Information Analyzer can assign assets to terms
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and categories. As another example, users with this security role can work with
IBM InfoSphere Information Governance Catalog for Eclipse.
In addition to the ability to assign assets, users with the Information Governance
Catalog Information Asset Assigner role can also perform the same tasks as users
who have the Information Governance Catalog User role if they have direct access
to InfoSphere Information Governance Catalog.
Information Governance Catalog Information Asset Assigners cannot have any
workflow roles assigned to them.
InfoSphere Metadata Asset Manager and common metadata roles:
To use InfoSphere Metadata Asset Manager, you must have the role of Common
Metadata User, Common Metadata Importer, or Common Metadata Administrator.
To import or delete common metadata by using the istool command line, you must
have the role of Common Metadata Administrator.
A suite administrator can assign the following roles on the Administration tab of
the InfoSphere Information Server Web console.
Common Metadata User
This user can access the Repository Management tab to browse, search for,
and inspect assets that are in the metadata repository.
Common Metadata Importer
On the Import tab, this user can perform the following tasks:
v Create import areas
v Import metadata to the staging area
v Work with staged imports that this user creates, including analyzing,
previewing, reimporting, and sharing imports to the metadata repository
v View, work in, and delete only those import areas that this user creates
v Create and edit data connections.
On the Repository Management tab, this user can browse, search for, and
inspect assets that are in the metadata repository.
Common Metadata Administrator
On the Administration tab, this user can perform the following tasks:
v Specify import policies
v Configure metadata interchange servers
On the Import tab, this user has all the privileges of the Common
Metadata Importer. In addition, this user can view, work in, and delete
import areas that are created by any user.
On the Repository Management tab, this user can perform the following
tasks:
v Export databases and database schemas
v Merge and delete assets
v Delete data connections
v Set implementation relationships
v Browse, search for, and inspect assets that are in the metadata repository
v Edit and delete notes
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v Edit the long description, short description, and steward fields for
selected assets
The Common Metadata Administrator can also use the istool command
line to import or delete common metadata.u2
InfoSphere Information Services Director roles:
For IBM InfoSphere Information Services Director, administrators can further
define user authority by assigning suite component roles and project roles to
InfoSphere Information Services Director users.
Suite component roles
Information Services Director Administrator
Provides access to all of the InfoSphere Information Services Director
functions.
Information Services Director Consumer
Provides ability to invoke secured services.
Information Services Director Operator
Provides access to the InfoSphere Information Services Director runtime
functions. An operator can add and remove providers as well as configure
runtime parameters of a deployed application, service and operation. In
addition, an operator can deploy applications from the design time view.
Information Services Director User
Provides access to view a list of applications in the runtime environment.
This user can browse deployed applications, services, operations, and
providers.
Project roles
Information Services Director Designer
With the Information Services Director Designer role, users can access only
projects that it is authorized for at design time. At the project level at
design time, the ISD Designer can:
v View project details and the list of projects
v View the list of applications
v Update applications
v Export applications
v Import services into an existing application
v View, add, or remove services.
At run time, the Information Services Director Designer can view the list of
applications.
Information Services Director Project Administrator
Provides access to create and delete applications, add and remove users
and groups to projects, and edit project properties.
Operational metadata roles:
You can assign operational metadata component roles to a user.
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Suite component roles
Operational Metadata Administrator
Can import operational metadata into the repository. You can assign this
role to a suite user and edit the runimporter.cfg file to include the user
name and password of that user. When you run the runimporter file, it
uses those credentials to allow the user to import operational metadata
into the repository.
Operational Metadata Analyst
Can create and run reports on operational metadata in the Reporting tab of
the Web console.
Operational Metadata User
Can view reports on operational metadata.

Assigning security roles in the IBM InfoSphere Information
Server console
To create a secure project environment, you can define a security policy that is
based on user authentication and role identification. Users derive authority from
the union of their individual and group roles.

Before you begin
You must have IBM InfoSphere Information Analyzer or InfoSphere Information
Services Director installed to use the InfoSphere Information Server console.

About this task
In the InfoSphere Information Server console, you can specify which roles users
can perform in the suite. You can further define which suite components the users
have access to and what their roles are in those suite components.
Assigning security roles to a user in the IBM InfoSphere Information Server
console:
All users require authorization to access components and features of the IBM
InfoSphere Information Server. You can assign one or more suite and suite
component roles to a user.
Before you begin
You must have suite administrator authority.
About this task
Changing the roles that are assigned to a user does not affect any currently active
sessions for that user. The new role assignments will only be available the next
time the user logs in. You can use session administration to disconnect the user
and force the user to log in again.
Procedure
1. On the Home navigator menu, select Configuration > Users.
2. In the Users workspace, select a user.
3. In the Task pane, click Assign Roles.
4. In the Roles pane, select a suite role to assign to the user.

98

Administration Guide

5. In the Suite Component pane, select one or more suite component roles to
assign to the user.
6. Click Save > Save and Close to save the authorizations in the metadata
repository.
What to do next
Certain suite components, such as IBM InfoSphere DataStage and IBM InfoSphere
Information Analyzer, also require that you assign additional user roles in the
clients or projects.
Assigning security roles to a group in the IBM InfoSphere Information Server
console:
You can assign one or more suite and suite component roles to a group of users.
Before you begin
You must have suite administrator authority.
About this task
Changing the roles that are assigned to a group does not affect any currently active
sessions for the users in that group. The new role assignments will only be
available the next time the users log in. You can use session administration to
disconnect the users and force the users to log in again.
Procedure
1. On the Home navigator menu, select Configuration > Groups.
2. In the Groups workspace, select a group.
3. In the Task pane, click Assign Roles.
4. In the Roles pane, select a suite role to assign to the group.
5. In the Suite Component pane, select one or more suite component roles to
assign to the group.
6. Click Save > Save and Close to save the authorizations in the metadata
repository.
Viewing the roles that are assigned to a user or a group:
In the IBM InfoSphere Information Server console, you can view the suite and
suite component roles that are assigned to a user or group. If an administrator
assigned project roles to the user or group, you can also view the project roles.
Before you begin
You must have suite administrator authority.
Procedure
1. On the Home navigator menu, select Configuration > Users, or select
Configuration > Groups.
2. Select a user or group and click Open.
3. In the Roles pane, view the list of assigned suite, suite component, or assigned
project roles. Project roles are assigned in the context of a project in IBM
InfoSphere DataStage, or in the IBM InfoSphere Information Server console.
Chapter 6. Managing security

99

Assigning users to a project and assigning roles
When you create a project, you can specify which users can access that project. You
can also specify which actions users can perform in that project.

About this task
To add users to a project and assign roles, you use different tools. The tool you use
depends upon the product module in which you are working:
v For IBM InfoSphere Information Analyzer and IBM InfoSphere Information
Services Director, use the IBM InfoSphere Information Server console as
described in this procedure.
v For IBM InfoSphere DataStage and IBM InfoSphere QualityStage, use the IBM
InfoSphere DataStage and QualityStage Administrator. See the IBM InfoSphere
DataStage and QualityStage Administrator Client Guide.
v For IBM InfoSphere FastTrack, use the IBM InfoSphere FastTrack console. See the
IBM InfoSphere FastTrack Tutorial.

Procedure
1. In the IBM InfoSphere Information Server console, open the project that you
want to assign users and roles to.
2. On the Overview navigator menu in the IBM InfoSphere Information Server
console, select Project Properties.
3. On the Project Properties workspace, select the Users tab.
4. In the Users pane, click Browse to add users to the project.
5. On the Add Users window, select the users that you want to add to the project,
click Add, then click OK.
6. On the Project Roles pane, select a project role to assign to the selected user. A
user can be assigned one or more roles in a project.
7. Click Save All.

Assigning groups to a project and specifying roles
When you create a project, you can specify which groups can access that project.
You can also specify which actions they can perform in that project.

About this task
To assign groups to a project and select roles, you use different tools. The tool you
use depends on the product module in which you are working:
v For IBM InfoSphere Information Analyzer and IBM InfoSphere Information
Services Director, use the IBM InfoSphere Information Server console as
described in this procedure.
v For IBM InfoSphere DataStage and IBM InfoSphere QualityStage, use the IBM
InfoSphere DataStage and QualityStage Administrator. See the IBM InfoSphere
DataStage and QualityStage Administrator Client Guide.
v For IBM InfoSphere FastTrack, use the IBM InfoSphere FastTrack console. See the
IBM InfoSphere FastTrack Tutorial.

Procedure
1. In the IBM InfoSphere Information Server console, open the project that you
want to assign groups to.
2. On the Overview navigator menu in the IBM InfoSphere Information Server
console, select Project Properties.
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3. On the Project Properties workspace, select the Groups tab.
4. In the Groups pane, click Browse to add groups to the project.
5. On the Add Groups window, select the groups that you want to add to the
project, click Add, then click OK.
6. On the Project Roles pane, select a role to assign to the selected group. A group
can be assigned one or more roles in a project.
7. Click Save All.

Assigning security roles in the IBM InfoSphere Information
Server Web console
To create a secure project environment, you define a security policy that is based
on user authentication and roles. Users derive authority from the union of their
individual and group roles.

About this task
In the IBM InfoSphere Information Server Web console, you can specify which
roles users can perform in the suite. You can further define which suite
components the users have access to and what their roles are in those suite
components.
Assigning security roles to a user in the IBM InfoSphere Information Server
Web console:
All users require authorization to access components and features of IBM
InfoSphere Information Server. You can assign one or more suite and suite
component roles to a user.
Before you begin
You must have suite administrator authority.
About this task
Changing the roles that are assigned to a user does not affect any currently active
sessions for that user. The new role assignments will only be available the next
time the user logs in. You can use session administration to disconnect the user
and force the user to log in again.
Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Users and Groups > Users.
3. In the Users pane, select a user and click Open User.
Note: You can assign roles to more than one user at a time by clicking Add
Roles to Multiple Users.
4. In the Roles pane, select a suite role to assign to the user.
5. In the Suite Component pane, select one or more suite component roles to
assign to the user.
6. Click Save and Close to save the authorizations in the metadata repository.
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What to do next
Certain suite components, such as IBM InfoSphere DataStage and IBM InfoSphere
Information Analyzer, also require that you assign additional user roles in the
clients or projects.
Assigning security roles to a group in the IBM InfoSphere Information Server
Web console:
You can assign one or more suite and suite component roles to a group of users.
Before you begin
You must have suite administrator authority.
About this task
Changing the roles that are assigned to a group does not affect any currently active
sessions for the users in that group. The new role assignments will only be
available the next time the users log in. You can use session administration to
disconnect the users and force the users to log in again.
Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Users and Groups > Groups.
3. In the Users pane, select a group and click Open Group.
Note: To assign roles to more than one group at a time, click Add Roles to
Multiple Groups.
4. In the Roles pane, select a suite role to assign to the group.
5. In the Suite Component pane, select one or more suite component roles to
assign to the group.
6. Click Save and Close to save the authorizations in the metadata repository.
What to do next
Certain suite components, such as IBM InfoSphere DataStage and IBM InfoSphere
Information Analyzer, also require that you assign additional group roles in the
clients or projects.
Viewing the roles that are assigned to a user or a group:
You can view the suite and suite component roles that are assigned to a user or
group. If an administrator assigned project roles to the user or group, you can also
view the project roles.
Before you begin
You must have suite administrator authority.
Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
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2. In the Navigation pane
v Select Users and Groups > Users.
v Or, select Users and Groups > Groups.
3. Select a user or group.
4. Click Open User or Open Group.
5. In the Roles pane, view the list of assigned suites, suite component, or project
roles. Project roles are assigned in the context of a project in IBM InfoSphere
DataStage or in the IBM InfoSphere Information Server console.

Engine security configuration
The IBM InfoSphere Information Server engine performs user authentication
separately from other InfoSphere Information Server components. Depending upon
your user registry configuration, you might have to map credentials between the
InfoSphere Information Server user registry and the local operating system user
registry on the computer where the engine is installed.
InfoSphere Information Server product modules, such as IBM InfoSphere
DataStage, IBM InfoSphere QualityStage, and IBM InfoSphere Information
Analyzer require access to the engine and require that engine credentials be
configured.
The InfoSphere Information Server engine requires valid user credentials for each
InfoSphere Information Server user that needs to access the engine. User
credentials are stored in a user registry.
If the InfoSphere Information Server engine can share the user registry that
InfoSphere Information Server uses, such as an external LDAP registry, then the
user credentials for both InfoSphere Information Server and the engine can come
from this user registry. If the user registry cannot be shared, you create a mapping
between credentials in the user registry that InfoSphere Information Server uses
and valid user credentials that exist in the local operating system user registry on
the computer where the engine is installed.
Configuring engine security is optional. By default the installation program uses
the internal user registry for InfoSphere Information Server and already creates a
credential mapping between the InfoSphere Information Server user (isadmin by
default) and the engine administrator user (dsadm by default in the dstage group).
To use the engine, only one engine user is required. You can assign InfoSphere
Information Server users various DataStage roles if you want them to be able to
access engine features.
The services tier and the engine can share a local operating system user registry if
they are installed on the same computer. If they are installed on separate
computers, they can share an external user registry such as a Lightweight
Directory Access Protocol (LDAP) or Windows Active Directory user registry. The
services tier and the engine cannot share the InfoSphere Information Server
internal user registry.
In an installation with more than one InfoSphere Information Server engine, you
choose the authentication method on a per InfoSphere Information Server engine
basis.
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Shared user registry overview
If you configure IBM InfoSphere Information Server to use an external user
registry, you might be able to share the user registry between InfoSphere
Information Server and the InfoSphere Information Server engine.
Sharing the user registry allows the application server, InfoSphere Information
Server, and the InfoSphere Information Server engine to access the same user
names, passwords, and group definitions. When the user registry is shared,
authentication to the engine occurs silently by using the same credentials (user ID
and password) that the user uses to authenticate with InfoSphere Information
Server. In this mode, no credential mapping is required.
You can share the user registry in any of the following scenarios:
v The engine tier and the services tier are installed on the same computer, and
InfoSphere Information Server is configured to use the local operating system
user registry. In this case, they can share the local operating system user registry.
Note: Sharing of the local operating system user registry is not supported in
installations that include WebSphere Application Server clustering.
v

The engine tier and the services tier both use the same
Lightweight Directory Access Protocol (LDAP) user registry for authentication.
In this scenario, you must configure Pluggable Authentication Module (PAM) for
the engine.

v

Windows
The engine tier and the services tier are installed on separate
computers, but both use the same Microsoft Windows Active Directory user
registry (which is an LDAP user registry) for authentication.

v

The engine tier and the services tier are installed on separate
computers, but the computers are within the same domain. This configuration
may have performance issues, and is not recommended.

Linux

UNIX

Windows

Note: This configuration is not supported in installations that include
WebSphere Application Server clustering.
If the engine tier and services tier cannot share a user registry, you must create a
mapping between credentials in the user registry that InfoSphere Information
Server is using and valid user credentials that exist in the local operating system
user registry on the computer where the engine is installed.
The engine tier cannot use the InfoSphere Information Server internal user registry.
If InfoSphere Information Server is configured to use the internal user registry, you
must configure credential mapping.
The following figure shows a configuration in which the engine tier and services
tier are installed on the same computer. They both share the local operating system
user registry. Specifically, the InfoSphere Information Server engine is configured to
use the local operating system user registry. InfoSphere Information Server is
configured to use the WebSphere Application Server user registry and then access
the same operating system user registry.
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IBM InfoSphere Information Server Clients
Console, Web Console, InfoSphere DataStage and QualityStage
Designer, InfoSphere DataStage and QualityStage Administrator,
InfoSphere DataStage and QualityStage Director

Services tier, engine tier, and metadata repository tier computer
IBM InfoSphere Information
Server Directory Service

Metadata
repository

IBM InfoSphere
Information Server
User Registry
Security roles
User attributes
Email addresses
Business addresses

WebSphere Application
Server User Registry

IBM InfoSphere Information
Server Engine

Local Operating
System User Registry
User names
Passwords
Groups

Figure 19. Example of architecture that uses a shared local operating system user registry

The following figure shows a configuration in which the engine tier and services
tier are installed on separate UNIX computers. They both share a common LDAP
user registry. Specifically, the InfoSphere Information Server engine is configured to
use the LDAP user registry. InfoSphere Information Server is configured to use the
WebSphere Application Server user registry and then access the LDAP user
registry. To provide the interface between the engine and the LDAP user registry,
Pluggable Authentication Module (PAM) is configured on the engine tier computer.
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IBM InfoSphere Information Server Clients
Console, Web Console, InfoSphere DataStage and QualityStage
Designer, InfoSphere DataStage and QualityStage Administrator,
InfoSphere DataStage and QualityStage Director

Engine tier computer
IBM InfoSphere Information
Server Engine

Pluggable Authentication
Module (PAM)

Services tier and metadata repository tier computer
IBM InfoSphere Information
Server Directory Service

WebSphere Application
Server User Registry

External User Registry
LDAP

Metadata
repository

IBM InfoSphere Information Server
User Registry
Security roles
User attributes
Email addresses
Business addresses

User names
Passwords
Groups

Figure 20. Example of architecture that uses a shared LDAP user registry
Windows
After you share the user registry, you must still grant the engine tier
operating system users the required permissions. See Permissions and groups
configuration.

Credential mapping overview
If IBM InfoSphere Information Server and the InfoSphere Information Server
engine do not share the user registry, you create a mapping between credentials in
the user registry that InfoSphere Information Server uses and user credentials that
exist in the local operating system user registry on the engine tier computer.
Use credential mapping in the following scenarios:
v InfoSphere Information Server is configured to use the internal user registry. The
InfoSphere Information Server engine cannot use the internal user registry.
v InfoSphere Information Server is configured to use LDAP, but you are unable to
configure the engine to use LDAP (through PAM).
v

The services tier and engine tier are installed on separate
computers. They do not share a user registry.

v

Windows
The services tier and engine tier are installed on separate computers.
The computers are not in the same domain.

Linux

UNIX

The installation program automatically creates a user mapping between the
InfoSphere Information Server administrator user (isadmin by default) and the
engine administrator user name (dsadm by default). If this is the only mapping that
you will use, no further credential mapping is necessary. However, if you want to
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assign other users engine access, then the InfoSphere Information Server user must
grant the other user names the required roles and establish credential mappings
with engine user names.
The credential mappings are stored with the internal user registry in the metadata
repository. The passwords are strongly encrypted for increased security.
You can create individual user mappings, so that each InfoSphere Information
Server user is associated with exactly one engine user. You also can create a default
user mapping, so that all InfoSphere Information Server users who do not have
individual credential mappings can access the engine through a shared user name.
In the following figure, the services tier and engine tier are installed on the same
computer. However, InfoSphere Information Server is configured to use the
internal user registry. Because the engine tier computer cannot use this user
registry, credential mapping is configured between the internal user registry and
the local operating system user registry.

IBM InfoSphere Information Server Clients
Console, Web Console, InfoSphere DataStage and QualityStage
Designer, InfoSphere DataStage and QualityStage Administrator,
InfoSphere DataStage and QualityStage Director

Services tier, engine tier, and metadata repository tier computer
IBM InfoSphere Information
Server Directory Service

Metadata
repository

Credential
Mappings

WebSphere Application
Server User Registry

IBM InfoSphere Information Server
User Registry
stores:
User names
Passwords
Groups
Security roles

User attributes
Email addresses
Business addresses

IBM InfoSphere Information
Server Engine

Local Operating
System User Registry
User names
Passwords
Groups

Figure 21. Example of architecture where internal user registry is used. Credential mapping is configured

In the following figure, the services tier and engine tier are installed on separate
computers. InfoSphere Information Server is configured to use the local operating
system user registry. Since the engine tier computer cannot share this user registry,
credential mapping is configured between the local operating system user registry
on the services tier computer and the local operating system user registry on the
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engine tier computer.

IBM InfoSphere Information Server Clients
Console, Web Console, InfoSphere DataStage and QualityStage
Designer, InfoSphere DataStage and QualityStage Administrator,
InfoSphere DataStage and QualityStage Director

Engine tier computer
IBM InfoSphere Information
Server Engine

Local Operating
System User Registry
User names
Passwords
Groups

Services tier, metadata repository tier computer
IBM InfoSphere Information
Server Directory Service

Metadata
repository

Credential
Mappings

WebSphere Application
Server User Registry

IBM InfoSphere
Information Server
User Registry
Security roles
User attributes
Email addresses
Business addresses

Local Operating
System User Registry
User names
Passwords
Groups

Figure 22. Example of architecture with separate services tier and engine tier computer. Credential mapping is
configured

Indicating to InfoSphere Information Server that the user registry
is shared
After you have configured the shared user registry, use the IBM InfoSphere
Information Server Web console to indicate the new configuration to InfoSphere
Information Server.

Before you begin
v You must have suite administrator authority.
v You must ensure that the user registry that you are sharing is the same for both
the services tier and the engine tier, and that no credential mapping is required.

Procedure
1. In the InfoSphere Information Server Web console, click the Administration
tab.
2. In the Navigation pane, select Domain Management > Engine Credentials.
3. Select the InfoSphere Information Server engine that you have configured to
use the same user registry as InfoSphere Information Server.
4. Click Open Configuration.

108

Administration Guide

5. In the configuration pane, select Share User Registry between InfoSphere
Information Server and its engine.
6. Click Save and Close.

What to do next
Grant your users access to IBM InfoSphere DataStage and IBM InfoSphere
QualityStage. After you indicate to InfoSphere Information Server that the user
registry is shared, all credential mapping menus are disabled and you do not need
to define any additional mappings. The same user name and password that is used
to log in to InfoSphere Information Server is used to run data integration jobs in
the engine.

Credential mapping
Do these tasks to map credentials.
An administrator can perform credential mappings for a group of users.
Alternatively, users can map their own credentials. The following table describes
the credential mapping-related tasks that different types of users can complete:
Table 6. Credential mapping-related tasks for different user types
User type

Permitted credential mapping-related tasks

InfoSphere Information Server suite
administrators, IBM InfoSphere DataStage
administrators, and IBM InfoSphere
QualityStage administrators

These users can define default engine tier
operating system credentials to use for all
users that are trying to connect to
InfoSphere Information Server engine and
that do not have a specific credential
mapping defined.
For each individual InfoSphere Information
Server user, these administrators can define
specific engine tier operating system
credentials to map to the InfoSphere
Information Server user credentials.

InfoSphere DataStage and InfoSphere
QualityStage users

These users can define their own credential
mappings in the Web console. Users can
only define credentials for their user names.

Defining default credentials:
You can define a default user name and password for the suite to map to each
user's engine tier operating system user credentials.
Before you begin
You must have suite administrator authority or IBM InfoSphere DataStage and
IBM InfoSphere QualityStage administrator authority.
About this task
The default credentials are used for any users who do not have their own
credential mappings. If you do not want users who do not have mapped
credentials to access the server, do not add default mapping credentials.
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Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigator pane, select Domain Management > Engine Credentials.
3. Select the InfoSphere Information Server engine for which you want to specify
the default credentials.
4. Click Open Configuration.
5. In the User Name field, type the user name to be used by all InfoSphere
Information Server users for whom a specific mapping is not defined.
6. In the Password field, type the corresponding password. The user name and
password that you provide must be a valid user name and password for the
operating system where the engine tier components are installed.
7. Confirm the password.
8. Click Save and Close.
Configuring your credentials:
As a suite administrator or suite user, you can map the credentials for your own
user account.
Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Domain Management > Engine Credentials.
3. Select the InfoSphere Information Server engine that you want to configure.
4. Click Open My Credentials.
5. Type the user name and password that you want to use to connect to the IBM
InfoSphere Information Server engine. The user name and password that you
provide must be a valid user name and password for the operating system
where the engine tier components are installed.
6. Click Save and Close.
Mapping user credentials:
You can map one or more user credentials to engine tier operating system user
credentials.
About this task
If you use the IBM InfoSphere Information Server user registry, you must create
credential mappings before you can use IBM InfoSphere DataStage and IBM
InfoSphere QualityStage clients. Create users and groups in the Web console before
you begin this task.
Suite users can configure their own credential mappings.
Procedure
1. Log in to the IBM InfoSphere Information Server Web console by using
Administrator credentials.
2. On the Administration tab, expand the Domain Management section and
click Engine Credentials.
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3. Select the InfoSphere Information Server engine for which you want to map
user credentials.
4. Click Open User Credentials.
5. Click Browse to search for suite users.
6. Optional: Specify additional search criteria, and click Filter to display a list of
users.
7. From the search results, select the suite users that you want to map to the
engine tier operating system local credentials and click OK.
8. On the Map User Credentials pane, select one or more users to map to the
credentials. If you want to map some suite users to one user and map other
suite users to a different user, select one subset of users and continue.
9. In the Assign User Credentials pane, specify the local operating system user
credentials. The user name and password that you provide must be a valid
user name and password for the operating system where the engine tier
components are installed. If you want to preserve credential mappings that
users have already configured, select the Apply Only to Users without
Credentials check box.
10. Click Apply.
11. To map credentials for additional suite users, do one of the following:
v Repeat steps 8 through 10 to map credentials for additional users displayed
in the Map User Credentials pane.
v Repeat steps 5 through 10 to select from a new filtered list of users and map
credentials for those users.
What to do next
After you map the credentials, any suite user or group that is assigned an IBM
InfoSphere DataStage and QualityStage user or administrator security role can log
in to an InfoSphere DataStage and QualityStage client.

Granting access to IBM InfoSphere DataStage and QualityStage
users
After you share the user registry or define credential mappings, you must give
your users access to IBM InfoSphere DataStage and IBM InfoSphere QualityStage.

Procedure
1. Ensure that the operating system user has the proper file access permissions to
InfoSphere DataStage, InfoSphere QualityStage, and the relevant files.
When you create, compile, or import a job in InfoSphere DataStage, files are
created using the operating system user on the engine that the InfoSphere
Information Server user is mapped to. The InfoSphere DataStage engine
processes are run with a umask set to 002; therefore, files are created with write
permission to the primary group of the operating system user. If you later need
to update, compile, or re-import the job with another user, it will fail if the
operating system user that the user is mapped to is not in the same primary
group as the last operating system user that updated the job. Therefore, all
credential-mapped operating system users to be used to update or import jobs
should belong to the same primary group.
2. Grant the required suite and suite component roles to the user in the Web
console.
a. Using a role that has administrative privileges, log in to the IBM InfoSphere
Information Server Web console.
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b.
c.
d.
e.

Select the Administration tab.
In the Navigation pane, select Users and Groups > Users.
Select the user that you want to grant access to and click Open User.
In the Roles pane, assign the following roles to the user.
Suite User
Required for all users in order to log in to any of the suite
components.
DataStage and QualityStage User
Required for any user in order log in to any of the InfoSphere
DataStage and InfoSphere QualityStage product modules.

DataStage and QualityStage Administrator
Optional. Grants full access to all projects and the administrative
capability of InfoSphere DataStage and InfoSphere QualityStage.
3. If you did not grant the DataStage and QualityStage Administrator authority,
you must use the IBM InfoSphere DataStage and QualityStage Administrator
client to grant project level roles to the user. If the user has only the DataStage
and QualityStage user role and no specific project roles, that user cannot log in
to the InfoSphere DataStage clients.

Configuring alternate security modes for WebSphere
Application Server
You can configure WebSphere Application Server to work with various security
standards, which are typically used to meet security requirements required by the
US government.
By default, IBM WebSphere Application Server runs in non-FIPS security mode.
However, you can configure it to work with various security standards. For more
information, see WebSphere Application Server security standards configurations.
To configure alternate security modes for IBM WebSphere Application Server
Network Deployment or IBM WebSphere Application Server Liberty Core,
complete the tasks that correspond to profile of IBM WebSphere Application Server
that you installed and the security mode that you want to enable.

Configuring security modes for WebSphere Application Server
Network Deployment
You can configure WebSphere Application Server Network Deployment to work
with various security standards, which are typically used to meet security
requirements required by the government.
By default, the IBM WebSphere Application Server Network Deployment runs in
non-FIPS security mode. However, you can configure it to work with various
security standards. For more information, see WebSphere Application Server
security standards configurations.
To configure alternate security modes for IBM WebSphere Application Server
Network Deployment, complete the tasks that correspond to the security mode
that you want to enable.
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Configuring FIPS140-2 security mode for WebSphere Application Server
Network Deployment:
You can configure WebSphere Application Server Network Deployment to use
Federal Information Processing Standard (FIPS) Java Secure Socket Extension files.
To configure Federal Information Processing Standard (FIPS) Java Secure Socket
Extension files, see Configuring Federal Information Processing Standard Java
Secure Socket Extension files.
Configuring SP800-131 security mode for WebSphere Application Server
Network Deployment:
You can configure WebSphere Application Server Network Deployment to use the
SP800-131 standard strict mode.
The US National Institute of Standards and Technology (NIST) Special Publications
(SP) 800-131 standard strengthens algorithms and increases the key lengths to
improve security. The standard also provides for a transition period to move to the
new standard.
To configure WebSphere Application Server Network Deployment to use the
SP800-131 standard strict mode, see Configuring WebSphere Application Server for
SP800-131 standard strict mode.
Configuring Suite B security mode for WebSphere Application Server Network
Deployment:
You can configure WebSphere Application Server Network Deployment to use the
Suite B security standard.
The US National Security Agency (NSA) created a cryptographic interoperability
strategy called Suite B. It places specific requirements on the US National Institute
of Standards and Technology (NIST) SP800-131 standard.
To configure WebSphere Application Server Network Deployment to use the Suite
B security standard, see Configuring WebSphere Application Server for the Suite B
security standard

Configuring security modes for WebSphere Application Server
Liberty Core
You can configure the WebSphere Application Server Liberty profile to use various
security standards, which are typically used to meet security requirements required
by the US government.
By default, IBM WebSphere Application Server Liberty runs in non-FIPS security
mode. However, you can configure it to use various security standards. For more
information, see WebSphere Application Server security standards configurations.
To configure alternate security modes for IBM WebSphere Application Server
Liberty Core, complete the tasks that correspond to the security mode that you
want to enable.
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Configuring the WebSphere Application Server Liberty profile to use the
FIPS140-2 security standard:
You can configure the WebSphere Application Server Liberty profile to meet the
FIPS140-2 security standard that is originated by the US National Institute of
Standards and Technology (NIST).
To configure the WebSphere Application Server Liberty profile to meet the
FIPS140-2 security standard that is originated by the US National Institute of
Standards and Technology (NIST), see Running IBMJSSE2 in FIPS mode.
Configuring the WebSphere Application Server Liberty profile to run in
SP800-131 mode:
You can configure a WebSphere Application Server Liberty profile to meet the
SP800-131 requirement that is originated by the US National Institute of Standards
and Technology (NIST).
To configure a WebSphere Application Server Liberty profile to meet the SP800-131
requirement that is originated by the US National Institute of Standards and
Technology (NIST), see Setting up a Liberty profile to run in SP800-131.
Configuring the WebSphere Application Server Liberty profile to use the Suite
B security standard:
You can configure the WebSphere Application Server Liberty profile to use the
Suite B security standard.
About this task
The US National Security Agency (NSA) created a cryptographic interoperability
strategy called Suite B. It places specific requirements on the US National Institute
of Standards and Technology (NIST) SP800-131 standard. Suite B can be run in
128-bit or 192-bit mode. To configure WebSphere Application Server Liberty to use
the Suite B security standard, follow the instructions below.
Suite B requirements
WebSphere Application Server must be compliant with the following Suite B
requirements:
v SSL configuration must use the TLSv1.2 protocol.
v The com.ibm.jsse.suiteb system property must be set to 128 or 192.
v Certificates running in 128-bit mode must have a minimum length of 256-bit
curve and must be created with the SHA256withECDSA signature algorithm.
v Certificates running in 192-bit mode must have a minimum length of 256-bit
curve and must be created with the SHA384withECDSA signature algorithm.
Note: To run in 192-bit mode, the unrestricted policy files must be in place on
the JDK.
v Suite B approved cipher suites must be used.
Procedure
1. Make sure you are running a level of the IBMJDK that supports Suite B.
2. Make sure your server certificates meet the criteria for Suite B.
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v They have a minimum length of 256-bit curve
v They are signed with the appropriate signature algorithm
– For 128-bit, use the SHA256withECDSA signature algorithm.
– For 192-bit, use the SHA384withECDSA signature algorithm.
Note: To run in 192-bit mode, the unrestricted policy files must be in place on the
JDK.
3. Configure your SSL Configuration to use the TLSv1.2 using the protocol
attribute. Once you change your protocol to use TLSv1.2 make sure you are
using a browser that supports TLSv1.2.
4. Configure your SSL Configuration to use the appropriate cipher using the
enabledCiphers attribute. For more information on these attributes, see
Enabling SSL comminication for the Liberty Profile and Liberty profile: SSL
configuration attributes.
v For 128-bit, use the TLS_ECDHE_ECDSA_WITH_AES_128_GCM_SHA256 cipher.
v For 192-bit, use the TLS_ECDHE_ECDSA_WITH_AES_256_GCM_SHA384 cipher.
5. Enable the JSSE to run in Suite B 128-bit mode by setting the system property
com.ibm.jsse2.suiteb to the appropriate bit length. For more information, see
Customizing the Liberty profile environment. For example:
v You use com.ibm.jsse2.suiteb=128 for 128-bit.
v You use com.ibm.jsse2.suiteb=192 for 192-bit.

Managing certificates
The installation program creates a certificate for you. You can change the
certificate, such as if you want to certify it with a certificate authority or update
the certificate when it expires. After you change a certificate, you can run the
UpdateSignerCerts.sh command to permanently accept the certificate to prevent
other command line tools to prompt to accept the certificate. Clients then use the
certificate to establish a secure connection.

About SSL communication in InfoSphere Information Server
Starting with version 11.3 of IBM InfoSphere Information Server, all communication
between the client and services tier is done over HTTPS (SSL). This includes all
clients that access the services tier, whether a rich desktop client, a browser-based
client, or a command-line client.
When a client accesses the services tier over SSL, the server is authenticated by the
client: the services tier presents to the client its SSL certificate and the client
decides if it is valid.
A valid SSL certificate is a certificate that is signed and the signer is trusted by the
client. The signer of the certificate is the entity that signed the certificate to assert
that it is a valid certificate issued for this particular site. To be precise, what the
server presents to the client is a chain of signed certificates: the certificate of the
server itself with its signature and the certificate of the signer of the server
certificate. The signer certificate can itself be signed by another signer certificate
and so on. A given client decides that a server SSL certificate is valid if the client
trusts any of the signer certificates present in the server certificate chain.
Remote clients have a trust store that contains the trusted signer certificates. When
the client connects to the server, if the server certificate is signed by a trusted
signer (a signer for which its certificate is in the client trust store), then the server
is recognized as valid and no certificate prompt is displayed. If the client trust
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store does not contain the signer certificate that was used to sign the server SSL
certificate (such as when the client first connects to the server), the server is
considered untrusted and the user is prompted to validate and accept the SSL
certificate.

Certificate signing
For both IBM WebSphere Application Server Network Deployment and IBM
WebSphere Application Server Liberty Profile, the default installation uses a
self-signed SSL certificates (an SSL certificate that is signing itself instead of using a
separate signer certificate). Specifically, in the case of WebSphere Application
Server Network Deployment, a signer certificate is generated at the WebSphere cell
level and a separate SSL certificate is created for each WebSphere server profile and
signed by the cell level certificate. This means that client browsers will never
automatically trust the services tier SSL certificates, because they are not signed by
a well-known certificate authority (CA).
You can replace the default self-signed SSL certificate by a signed certificate that
you purchase and obtain from a CA (such as Symantec, Thawte, and others). You
could then deploy the CA-signed certificates in your desktop and browser trust
stores as part of your IT policy and process. Web browsers normally have signer
certificates from well-known CAs in their trust store by default.

Certificate storage for clients
For Java-based clients, the SSL configuration (and especially the trust store
configuration) is specified in the ASBServer/conf/iis.client.site.properties and
ASBNode/eclipse/plugins/com.ibm.iis.client/iis.client.site.properties
property files. These files contain the path to the trust store file, its encrypted
password, and the type of the trust store. The files also provide the level of SSL
that is used and supported.
During InfoSphere Information Server installation, the services tier certificate is
automatically added to the ASBServer trust store for a services tier installation and
the ASBNode trust store for an engine tier installation. Therefore, you will not be
prompted to accept the SSL certificate for the Java-based clients. Also, because the
trust store is specific to the entire node, a Java client that is installed on the same
computer as the engine will not prompt for you to accept the certificate, because it
shares the same trust store.
In a client tier only installation, however, there are no services tier SSL certificates
in the ASBNode trust store and you will be prompted to accept the certificate for
each first time connection to a new services tier. The reason for this is that a client
tier can be used to connect to different services tiers and no specific services tier is
specified as part of the installation interview process.
For browser-based clients, the trust store is specific to the web browser (such as
with Mozilla Firefox), or it can be more global in the case of Internet Explorer
where the trust store is a Microsoft Windows operating system level trust store. As
long as you use the same browser, you will not be prompted to accept the
certificate after you permanently accept the certificate the first time.
The IBM InfoSphere DataStage and QualityStage Designer client is unique,
however, in that it uses both the Windows .NET HTTP API to communicate with
the services tier as well as a Java based HTTPS communication layer. The
Windows .NET HTTPS API uses the Microsoft Windows operating system trust
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store, which means that installing the certificate from the Designer client or from
Microsoft Internet Explorer would remove any future prompt for the Designer
client and browser based client access through Microsoft Internet Explorer. The
Java based HTTPS communication layer uses the ASBNode trust store that used by
all Java clients, but it is updated automatically if the certificate prompt for the
.NET HTTPS API is accepted.

Certificate acceptance for clients
If you accept the certificate just for the session, the client side trust store on disk is
not modified. The SSL certificate is accepted only for this particular client instance.
If you close and reopen the client and start a new one, you will be prompted
again.
If you accept the certificate permanently, the signer of the certificate (all the signers
in the chain) is added to the client trust store and no certificate prompt is required
in the future.
The default certificate is not signed by an official certificate authority. You can,
however, use the default certificates within your organization. The certificate
prompt displays a hash of the certificate, and you could notify your end-users
through another secure channel the value of this hash so that the certificate can be
validated by users before they accept the certificate. Another option for the
browser-based clients is to distribute to all end-users the signer certificate to be
loaded into the web browser trust store before they connect so that no certificate
prompt is required. Or, you can choose to obtain a certificate from a CA.

Certificate removal for clients
For browser-based clients, you remove the certificate through the SSL options of
your web browser.
For rich clients, you can delete the client trust store file. The client trust store is
IS_install_path/ASBNode/conf/iis-client-truststore.p12 or
IS_install_path/ASBServer/conf/iis-client-truststore.p12. It is re-created
automatically if deleted.

SSL certificates for WebSphere Application Server Network
Deployment
After installation, you can change the SSL server key for IBM WebSphere
Application Server Network Deployment through the WebSphere Application
Server administrative console. You can generate a new key and self-signed
certificate, such as when your current certificate expires. You can have an existing
certificate signed with a trusted certificate authority (CA).
For more details about WebSphere Application Server Network Deployment SSL
configurations see Default chained certificate configuration in SSL.
If you install WebSphere Application Server Network Deployment during the
installation of IBM InfoSphere Information Server, the SSL key and self-signed
certificate is generated with the following information:
subject_name
The key subject and issuer distinguished name. They are both identical since
the certificate is self-signed. The default value is as follows:
CN=current_host_name,OU=Software Group,O=IBM,C=US
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validity_days
The number of days that the key is valid. The default value is 2920 (8 years).
key_password
The keystore password and key password. A different keystore password and
key password is not currently supported; both are identical. The default value
is iiskeypass.
Replacing WebSphere Application Server Network Deployment certificates:
To replace a certificate before it expires, or to use your own certificate, you can
replace an IBM WebSphere Application Server Network Deployment certificate by
specifying a different certificate for each node.
About this task
In clustered IBM InfoSphere Information Server installations, all signer certificates
must be stored in the CellDefaultTrustStore truststore. In stand-alone InfoSphere
Information Server installations, all signer certificates must be stored in the
NodeDefaultTrustStore truststore. These trust stores are the default locations for
WebSphere Application Server Network Deployment signer certificates.
In WebSphere Application Server, Version 8.5.5.1, you can renew certificates.
WebSphere Application Server generates a new certificate that replaces the old
certificate.
Alternatively, you can replace a certificate with your own certificate, or you can
use a certificate signed by a certificate authority. Refer to the WebSphere
Application Server documentation for details.
Procedure
1. Start the application server if it is not already started.
Stand-alone installation:
v

Linux

v

Windows

UNIX

MetadataServer.sh

MetadataServer.bat

Clustered installation:
Start the deployment manager: startManager
2. Log in to the WebSphere Application Server administrative console.
3. Renew or replace the WebSphere Application Server certificate. See the
WebSphere Application Server documentation for more information on how to
renew the certificate:
v For Version 8.5.5.1, go to the WebSphere Application Server information
center and read “Replacing an existing personal certificate”.
4. Stop and restart all IBM WebSphere Application Server Network Deployment
processes. For more information about restarting application server processes,
see the IBM InfoSphere Information Server Administration Guide.
5. Retrieve the signer certificate for the WebSphere Application Server client trust
store. If the WebSphere Application Server client trust store does not include a
signer certificate, the application server might fail.
By default, WebSphere Application Server prompts you to accept the certificate
if it is not trusted when you run the WebSphere Application Server command
line utility, such as the serverStatus command or the stopServer command.
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Ensure that you accept the certificate before you stop or start WebSphere
Application Server by using any other application, such as Microsoft Windows
Services.
See the WebSphere Application Server documentation for more information on
retrieving the signer certificate and establishing trust for your certificate:
v For Version 8.5.5.1, go to the WebSphere Application Server information
center and read “Secure installation for client signer retrieval in SSL”.
What to do next
Run the UpdateSignerCerts tool on the client tiers, engine tiers, and services tiers.
For more information, refer to “Running the UpdateSignerCerts command” on
page 122.

SSL certificates for WebSphere Application Server Liberty Profile
After installation, you can change the SSL server key for IBM WebSphere
Application Server Liberty Profile. You can generate a new key and self-signed
certificate, such as when your current certificate expires. You can have an existing
certificate signed with a trusted certificate authority (CA).
The SSL key that is used by the application server is stored in the
IS_install_path/wlp/usr/servers/iis/resources/security/iis-serverkeystore.p12 file.
The keystore configuration is defined in the IS_install_path/wlp/usr/servers/
iis/server.xml file:
<keyStore id="iis-server-keystore"
location="${server.config.dir}/resources/security/iis-server-keystore.p12"
password="${iis.keystore.password}" type="${iis.keystore.type}"/>

For more details about WebSphere Application Server Liberty Profile SSL
configurations see Securing communications with the Liberty profile.
During installation, the SSL key and self-signed certificate is generated as follows:
IS_install_path/jdk/bin/keytool -genkeypair -alias iisSSL -keyalg RSA ⇒
-keysize 2048 -sigalg SHA512withRSA -dname subject_name -validity ⇒
validity_days -storetype PKCS12 -keypass key_password ⇒
-storepass key_password -keystore IS_install_path/wlp/usr/⇒
servers/iis/resources/security/iis-server-keystore.p12

Where the following values are replaced by the ones that are provided during the
installation interview or from the response file:
subject_name
The key subject and issuer distinguished name. They are both identical since
the certificate is self-signed. The default value is as follows; however, you can
change the information to be more specific for your organization during
installation:
CN=current_host_name,OU=Software Group,O=IBM,C=US

validity_days
The number of days that the key is valid. The default value is 2920 (8 years).
key_password
The keystore password and key password. A different keystore password and
key password is not currently supported; both must be identical. The default
value is iiskeypass, which you can change during installation.
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Generating a new key and self-signed certificate for WebSphere Application
Server Liberty Profile:
Complete this task when a certificate expires or if you want to update information
in the certificate.
Procedure
1. Determine the information that you want to use for the certificate. If you are
updating a certificate and want to use the same information as the existing
certificate, but have forgotten what this information is, you can view the
existing certificate.
Microsoft Internet Explorer
a. Open the IBM InfoSphere Information Server Web console in the
browser and log in.
https://<hostname>:9443/ibm/iis/console

b. Click the lock icon next to the secure URL and click View
certificates in the pop-up window.
c. On the Details tab, select Subject and capture the information in the
Field Value area. This is the information that is used to construct
the distinguished name.
Mozilla Firefox
a. Open the IBM InfoSphere Information Server Web console in the
browser and log in.
https://<hostname>:9443/ibm/iis/console

b. Click the lock icon next to the secure URL and click More
information in the pop-up window.
c. Click View Certificate.
d. On the Details tab, select Subject and capture the information in the
Field Value area. This is the information that is used to construct
the distinguished name.
2. Stop the application server:
v

Linux

UNIX

MetadataServer.sh stop

Windows
net stop InfoSvr
v
3. Create a new keystore file with a newly generated key and self-signed
certificate. (The ⇒ character indicates a line continuation.)

cd IS_install_path/wlp/usr/servers/iis/resources/security
IS_install_path/jdk/bin/keytool -genkeypair ⇒
-dname distinguished_name -keystore ./iis-server-keystore.p12 ⇒
-keypass key_password -storepass key_password -validity validity_days ⇒
-alias iisSSL -keyalg RSA -keysize 2048 -sigalg SHA512withRSA ⇒
-storetype PKCS12

where:
distinguished_name
Defines the organizational information for the certificate. Refer to the
information you collected in the first step, if you want to use the same
information as before. Example:
CN=host.example.com,OU=MyOrganization,O=MyCompany,C=US
If you do not provide the -dname parameter and value, you will be
prompted for the information.
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Important: Set the Common Name (CN) field to the value of the
InfoSphere Information Server host name, to be used by remote clients to
access the server. As part of the SSL handshake, clients verify that the host
name that is used to access the server matches the certificate CN value (or
one of the values if there are multiple values).
key_password
Password for the keystore. The password can be made up of only printable
characters from the US-ASCII character set. In IBM WebSphere Application
Server Liberty Profile, both the key password and store password must be
set to the same value.
validity_days
The number of days that the certificate is valid before it expires. When it
expires, you must generate another certificate.
Depending on your environment and browser, not all key algorithms (set by
-keyalg and -keysize) might be supported.
For more information on the keytool utility, see Keytool.
4. If you use different values than in the original certificate for the key password
(-storepass and -keypass), keystore type (-storetype), or key alias (-alias),
then you must update the iis.keystore.type, iis.keystore.password, and
iis.ssl.serverKeyAlias properties in the IS_install_path/wlp/usr/servers/
iis/bootstrap.properties file to match the new values: For example
iis.keystore.type=PKCS12
iis.keystore.password={aes}AG0caBXHAvGL+YXDfsSJ2CA4y2vWPm7FNZgPp7377Ry9
iis.ssl.serverKeyAlias=iisSSL

The password value must be specified as an encrypted string. To create this
value, enter the following command:
IS_install_path/wlp/bin/securityUtility encode --encoding=aes

You are prompted for the password. Copy the output value and paste it into
the IS_install_path/wlp/usr/servers/iis/bootstrap.properties file.
For more information on the securityUtility command, see securityUtility.
It's not recommended to change the location of the keystore file.
5. If you change the iis.keystore.password value, you must update the trust
store password. By default, the iis.keystore.password property in the
IS_install_path/wlp/usr/servers/iis/bootstrap.properties file is also used
to specify the password of the Liberty profile trust store, which is used for
outbound SSL requests from the application server). This trust store is defined
as follows in the IS_install_path/wlp/usr/servers/iis/server.xml file:
<keyStore id="iis-server-truststore"
location="${server.config.dir}/resources/security/iis-server-trust⇒
store.jks"
password="${iis.keystore.password}" type="${iis.truststore.type}"/>

To update the trust store password, run the following command. (The ⇒
character indicates a line continuation.)
IS_install_path/jdk/bin/keytool -storepasswd -storepass old_password ⇒
-new new_password -keystore IS_install_path/wlp/usr/servers/iis/re⇒
sources/security/iis-server-truststore.jks

6. Start the application server:
v

Linux

v

Windows

UNIX

MetadataServer.sh run

net start InfoSvr
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Obtaining and importing a signed-certificate from a trusted certificate authority
(CA):
Complete this task if you want to have a certificate signed. Certificates that are
trusted by a certificate authority are more easily accepted by client browsers and
provide a better overall user experience. To have a certificate signed, you start with
an existing self-signed certificate, generate a request, and send the request to the
CA. You then import the signed certificate into the application server keystore.
Before you begin
You start with an existing self-signed certificate, either the one created by the
installation program or one generated as described in “Generating a new key and
self-signed certificate for WebSphere Application Server Liberty Profile” on page
120.
Procedure
1. Create a certificate request from the Liberty profile SSL keystore:
cd IS_install_path/wlp/usr/servers/iis/resources/security
IS_install_path/jdk/bin/keytool -certreq -alias key_alias -storetype PKCS12
-storepass key_password -keystore ./iis-server-keystore.p12 -file certreq.req -v

Where:
key_alias
The alias of the key. If you are using the one generated by the installation
program, the alias is iisSSL.
key_password
The default password is iiskeypass, unless you changed it during
installation or after updating the key and certificate.
This command creates a file called certreq.req. Send that file through your
organization's channels to have it signed by a trusted CA or, if your
organization has a signing certificate, have it signed internally.
2. When you have received the signed certificate, import it into the Liberty profile
SSL keystore. (The ⇒ character indicates a line continuation.)
cd IS_install_path/wlp/usr/servers/iis/resources/security
IS_install_path/jdk/bin/keytool -importcert -alias key_alias -storetype ⇒
PKCS12 -storepass key_password -keystore ./iis-server-keystore.p12 -file ⇒
signed_certificate_file

Use the same values as the first step for the key_alias and key_password.
3. Restart the application server:
v

Linux

UNIX

MetadataServer.sh restart
v

Windows

net stop InfoSvr
net start InfoSvr

Running the UpdateSignerCerts command
For command-line tools to use an updated certificate, you can run the
UpdateSignerCerts command so that the certificate is accepted permanently, and
other tools can run without a prompt, making sure that non-attended script
executions don't fail or wait for user input for the certificate prompt.
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About this task
Run this command on each computer in your environment where the services,
engine, and client tiers are installed. The command is found in the following
locations:
Tier

Location

Services

IS_install_path/ASBServer/bin

Engine, Client

IS_install_path/ASBNode/bin

Procedure
1. Run the command:
UpdateSignerCerts.sh -url https://hostname:port -user IS_admin_user
-password IS_admin_password
hostname
The host name of the IBM InfoSphere Information Server server, as
specified in the common name of the certificate.
port
The port number of the IBM InfoSphere Information Server server, specified
during installation. The default port number is 9443.
IS_admin_user
The InfoSphere Information Server administrator user name (isadmin).
IS_admin_password
The password for the InfoSphere Information Server administrator user.
2. If the SSL certificate has been properly changed on the server, you are
prompted to accept the new certificate. After the prompt, enter 1 to accept the
certificate permanently. An example prompt:
The following certificate could not be verified:
Owner: CN=server1.example.com, OU=Software Group, O=IBM, C=US
Issuer: CN=server1.example.com, OU=Software Group, O=IBM, C=US
Serial number: 12A67955
Valid from: Oct 23 2013
Expired to: Oct 21 2014
SHA1 fingerprint: D2:57:88:57:AE:FD:E2:5D:B8:9B:7E:9D:B4:6F:64:46:15:42:D0:0E
MD5 fingerprint: 39:9C:82:52:9C:CE:14:64:26:50:E2:F6:2A:19:B3:21
Do you want to accept this certificate permanently (1), for this session only
(2), or reject (3) it? (1/2/3):

UpdateSignerCerts command syntax:
You use the UpdateSignerCerts command to retrieve the SSL certificate from the
server.
Syntax
IS_install_path/[ASBServer|ASBNode]/bin/UpdateSignerCerts.[bat|sh]
[-{verbose | v}]
[-{results | res} value ]
[-{log | l} value ]
[-{logerror | error} value ]
[-{loginfo | info} value ]
[-{loglevel | level} value ]
[-{log | l} value]
[-{help | ?} ]
[-{url | url} value]
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[-{user | u} value]
[-{password | pw} value]
[-{silent | s}]
[-{serverStore | ss}]

Parameters
[-{verbose | v}]
Display detailed runtime output, except for the runtime logging messages.
[-{results | res} value ]
Print all the enabled runtime output to the specified file.
[-{log | l} value ]
Print the runtime logging messages to the specified file. This option is used
with loglevel.
[-{logerror | error} value ]
Print all ERROR and FATAL runtime logging messages to the specified file.
[-{loginfo | info} value ]
Print all INFO, WARN, DEBUG, and TRACE runtime logging messages to the
specified file.
[-{loglevel | level} value]
The level at which runtime logging messages are enabled.
[-{log | l} value]
Print all runtime log messages to the specified file. Use this option with the
loglevel option.
[-{help | ?} ]
Displays the usage message.
[-{user | u} value]
User name of the application server user.
[-{url | url} value]
URL to include the server and port to use.
[-{password | pw} value]
Password for the application server user, if the username is specified.
[-{silent | s} value]
Use this option to if you want the SSL certificate to be accepted automatically.
[-{serverStore | ss}]
Use this option to download the SSL certificate for the URL specified with the
-url option and add it to the trust store from the server to allow outbound
SSL calls from the services tier to the specified site. If the site is not already
trusted and if the -silent is not used, you are prompted to accept the
certificate.
Examples
You have an installation of IBM InfoSphere Information Server and you want to
update the certificates across the single-server installation. You want to update the
certificates because you created a new keystore with the keytool command, for
example when the keystore that was created during installation has expired. In this
example, your InfoSphere Information Server host name is server1.example.com,
the application server user name is mapped to isadmin, with a password of
my_pa55w0rd
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IS_install_path/ASBServer/bin/UpdateSignerCerts.sh -url https://
server1.example.com:9443 -user isadmin -password my_pa55w0rd

Storing certificates for client applications
When you log in to client applications that access the services tier, such as the IBM
InfoSphere DataStage Designer client or Director client, you can store the certificate
in the trusted store to prevent having to accept the certificate in subsequent logins.

Procedure
After you log into the client for the first time, you will be asked to accept the
certificate.
v For the IBM InfoSphere DataStage clients:
1. To view the security certificate, click View Certificate.
2. Click the Certification Path tab, and then select the root certificate.
3. Click the General tab.
4. Click Install Certificate, and then click Next.
5. Select Place all certificates in the following store.
6. Click Browse, and then select Trusted Root Certification Authorities.
7. Click Next, and then click Finish to import the certificate.
v For browser based clients: Accept the certificate according to the procedures of
your browser.
v For command line utilities: The utility will prompt automatically for you to
validate and store the certificate as in the following example. (The ⇒ character
indicates a line continuation.)
# ./SessionAdmin.sh -user admin -password myPass -lus -url ⇒
https://localhost:9446/
The following certificate could not be verified:
Owner: CN=localhost, OU=localhostNode02Cell, OU=localhostNode03, ⇒
O=IBM, C=US
Issuer: CN=localhost, OU=Root Certificate, OU=localhostNode02Cell, ⇒
OU=localhostNode03, O=IBM, C=US
Serial number: 10E9ACBD921C
Valid from: Mar 25 2014
Expired to: Mar 25 2015
SHA1 fingerprint: 73:10:92:1A:12:AE:E5:0C:92:47:94:BF:A3:47:51:06:FF:⇒
07:28:47
MD5 fingerprint: 91:E9:91:19:5B:15:FA:E6:63:B3:CF:C1:5C:0B:D1:B4
Do you want to accept this certificate permanently (1), for this session ⇒
only (2), or reject (3) it? (1/2/3):

Related concepts:
“About SSL communication in InfoSphere Information Server” on page 115
Starting with version 11.3 of IBM InfoSphere Information Server, all communication
between the client and services tier is done over HTTPS (SSL). This includes all
clients that access the services tier, whether a rich desktop client, a browser-based
client, or a command-line client.

Configuring WebSphere Application Server for non-root
administration (Linux, UNIX)
By default, the IBM WebSphere Application Server runs as root. However, it can
also be run by using a non-root user ID. The following instructions describe the
steps required to configure and set appropriate file system permissions for
WebSphere Application Server to run as a non-root user ID.
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You must rerun the post-installation steps (go to “Running post-installation
commands to enable non-root administration (Linux, UNIX)” on page 128) after
either of the following actions:
v You install any add-on components to the services tier. Certain installations
might have changed permissions.
v If you restarted any of the application servers as the root user and you want to
start them again as the non-root user. Certain files might now have root
ownership and must be changed.
Important: Do not start IBM WebSphere Application Server as root after you
configured it for non-root administration. Starting IBM WebSphere Application
Server as root after you configured it for non-root administration might affect
the successful execution of certain IBM InfoSphere Information Server
operations. If a root startup was done, be sure to stop IBM WebSphere
Application Server, rerun the post-installation steps, and restart IBM WebSphere
Application Server as the non-root administrator before doing any further IBM
InfoSphere Information Server operations. For a non-clustered configuration,
always use MetadataServer.sh as the non-root user to start and stop the
application server, when configured for non-root administration. Using
MetadataServer.sh assures the appropriate non-root operation.
Restrictions
v If you are using the local operating system as the user registry, WebSphere
Application Server must be run as root. WebSphere Application Server must be
run as root in this case, because of system permissions that are required for
credential checking.
v If the IBM InfoSphere Information Server services tier is configured to use PAM
authentication and a local operating system PAM module is used in the PAM
configuration, such as the /etc/passwd and /etc/group files, then WebSphere
Application Server must be run as root. When a local operating system PAM
module is not configured, WebSphere Application Server can be run as non-root
as long as the non-root user has read permission on the configured files.
v If a front-end web server is running on a managed node of the cluster, you must
ensure that the web server directory is owned by the non-root user. For more
information, see http://www.ibm.com/support/knowledgecenter/
SSZJPZ_11.3.0/com.ibm.swg.im.iis.found.admin.common.doc/topics/
appsvconfig_nonrootadmin_chownplugin.html.
v The task of starting and stopping WebSphere Application Server must be
designated to one non-root user only. If you are using MetadataServer.sh, this
restriction does not apply.
v Avoid assigning the dsadm user to manage WebSphere Application Server.
Using the dsadm user to manage WebSphere Application Server might cause
overwrite issues for the InfoSphere Information Server environment settings. The
non-root user selected for running WebSphere must not source dsenv.

Setting up a new non-root user for WebSphere Application
Server (Linux, UNIX)
If you have IBM InfoSphere Information Server installed, you can create a user
who can manage WebSphere Application Server processes. These steps need to be
completed only once.
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Before you begin
Make sure to read the restrictions in “Configuring WebSphere Application Server
for non-root administration (Linux, UNIX)” on page 125.
Important: Before you begin this task, back up your system so that the backup can
be used to restore the original state if necessary. See Chapter 14, “Backing up and
restoring IBM InfoSphere Information Server,” on page 237.

About this task
The general purpose in these instructions is to transfer the ownership of some of
the files under WebSphere Application Server and InfoSphere Information Server to
the new non-root user, at which point the new user would be able to take over the
management of the WebSphere Application Server process. This one-time setup
task describes the steps for creating the user. The post installation instructions
describe the steps that must be performed after you install any add-on components
to the services tier or if any of the application servers were restarted as the root
user and you want them to be started again as the non-root user.
These steps use wasadmin as the new non-root user. However, this is just an
example user name; you can use any user name that you want, or use an existing
user.
To complete this task, you must be a system administrator with root access.

Procedure
1. If the non-root user that you want to run the application server with does not
exist, create it:
Note: The wasadmin user is used as an example.
useradd -m -d /home/wasadmin wasadmin

2. Set the umask of this user to 0022 by typing: umask 0022

What to do next
Proceed to the post-installation tasks for either a stand-alone environment or
cluster environment to configure the settings in InfoSphere Information Server for
the non-root user: “(Stand-alone environment) Running post-installation commands
to enable non-root administration (Linux, UNIX)” on page 129 or “(Cluster
environment) Running post-installation commands to enable non-root
administration (Linux, UNIX)” on page 131

(Cluster environment) Changing ownership of the web server
directory and plugin-cfg.xml
If a front-end web server is running on a managed node of the cluster, you must
ensure that plugin-cfg.xml and the directory that contains it are owned by the
non-root user.

Before you begin
v These steps apply to cluster environments only, using IBM WebSphere
Application Server Network Deployment, where a front-end web server is
running on a managed node of the cluster.
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v These steps are only required for the initial configuration of WebSphere
Application Server Network Deployment for non-root support. It is not
necessary to perform these steps after an append install or uninstall.
v If you have multiple web servers on managed nodes, you must perform these
steps for each web server. If your web servers are not on managed nodes, these
steps are not necessary.

About this task
v Whenever plugin-cfg.xml is updated, such as when an application is updated
or a new application is deployed, the node agent on the managed node of the
cluster propagates the plugin to the web servers configured on the cluster. If the
web server is installed on a managed node, the node agent attempts to copy
plugin-cfg.xml to the HTTPServer_installation_directory/conf/plugins
directory. Therefore, the node agent must have write access to the
HTTPServer_installation_directory/conf/plugins directory. When WebSphere
Application Server is configured to run as a non-root user, the node agent also
runs as the non-root user. Therefore, the HTTPServer_installation_directory/
conf/plugins directory must be owned by the non-root user.
If the web server is remote or not on a managed node, the plugin is transferred
using the web server administration process.
v The non-root user name, wasadmin, is an example that is used throughout the
documentation. If you have a different non-root user name, make sure to use
that one instead and replace every instance of wasadmin in the commands that
you run.
v

Procedure
1. Determine the location of plugin-cfg.xml and its containing folder by
examining the value of the of the WebSpherePluginConfig property in the
httpd.conf configuration file.
a. Open the httpd.conf configuration file. The file is in the configuration
directory: HTTPServer_installation_directory/conf/httpd.conf.
b. Examine the value of the WebSpherePluginConfig property.
In the following example, the web server directory is in
/opt/IBM/HTTPServer/Plugins/config. (The ⇒ character indicates a line
continuation.)
WebSpherePluginConfig /opt/IBM/HTTPServer/Plugins/config/Clust⇒
er01WebServer01/plugin-cfg.xml

2. Run the following command to change ownership of your web server directory
and plugin-cfg.xml to the non-root user. In the example above, you would set
non-root ownership of the Cluster01WebServer01 directory and the
plugin-cfg.xml file.
cd plugin_directory
chown wasadmin web_server_directory/plugin-cfg.xml

For example:
cd /opt/IBM/HTTPServer/Plugins/config
chown wasadmin Cluster01WebServer01
chown wasadmin Cluster01WebServer01/plugin-cfg.xml

Running post-installation commands to enable non-root
administration (Linux, UNIX)
After installing IBM InfoSphere Information Server or adding components, run
these commands to enable non-root administration. The steps differ depending
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upon whether IBM WebSphere Application Server is set up in a clustered
configuration or stand-alone configuration.
(Stand-alone environment) Running post-installation commands to enable
non-root administration (Linux, UNIX):
You must run these tasks every time you install IBM InfoSphere Information Server
where IBM WebSphere Application Server is set up in a stand-alone configuration.
You must also run these tasks after you install any new add-on components on the
services tier. You must also run these tasks any time the application server is
restarted as the root user and you now want to start it again as the non-root user.
Before you begin
v If you have more than one add-on InfoSphere Information Server product to
install, install all the add-on products before you begin these steps.
v Stop all InfoSphere Information Server processes, including WebSphere
Application Server, the server engine, JobMonApp, and ASB agents. See
“Shutting down services (Linux, UNIX)” on page 253.
– The applications should be stopped while logged in as the user who started
the application.
– If WebSphere Application Server is already running as a non-root user, you
must log in as that non-root user to stop WebSphere Application Server.
– If the ASB agent is started as root, you must log in as root to stop the agent.
About this task
v These steps apply to stand-alone (non-cluster) environments only. If you have a
cluster configuration, see “(Cluster environment) Running post-installation
commands to enable non-root administration (Linux, UNIX)” on page 131.
v The non-root user name, wasadmin, is an example that is used throughout the
documentation. If you have a different non-root user name, make sure to use
that one instead and replace every instance of wasadmin in the commands that
you run.
Procedure
1. Remove *.jar and *.lck files from the temporary directory by running the
commands:
rm /tmp/*.jar
rm /tmp/*.lck

Note: The operating system-defined temporary directory, tmp, is either /tmp or
/var/tmp. Change the file path above accordingly.
Note: Alternatively, you can move these files to a backup directory. Third party
applications might have dependencies on the .jar or .lck files in this temporary
directory and you might want the option to restore them later.
2. If WB_vrdata or BG_vrdata exist in the temporary directory, run the following
commands:
rm –rf /tmp/WB__vrdata
rm –rf /tmp/BG__vrdata

Note:
v The operating-system-defined temporary directory is either /tmp or /var/tmp.
Change the file path accordingly.
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v If your system was configured to relocate the temporary directory used by
IBM InfoSphere Information Governance Catalog as described in the
following technote, follow the instructions in the following technote to assure
that appropriate permissions are assigned to the WB__vrdata and BG__vrdata
directories: http://www.ibm.com/support/docview.wss?rs=3291
&uid=swg21413637.
3. Either wasadmin must be a member of the group assigned to the Reporting
workspace directories and below with rwx permission, or you must set
wasadmin as the owner of the Reporting workspace directories and below. Run
these commands to set the wasadmin user as the owner of the Reporting
workspace directories:
cd /tmp
chown -R wasadmin informationServer

Note:
v The operating-system-defined temporary directory is either /tmp or /var/tmp.
Change the file path accordingly.
v If you relocated the Reporting workspace directory as described in the
technote http://www.ibm.com/support/docview.wss?rs=14
&uid=swg21317914, assign appropriate permissions to that directory instead.
4. Run the command to set your desired user as the owner of the InfoSphere
Information Server profile of WebSphere Application Server:
IBM WebSphere Application Server Network Deployment
cd WAS_installation_path/profiles
chown -R wasadmin InfoSphere

WebSphere Application Server Liberty Profile
cd IS_install_path/wlp/usr/servers
chown -R desired_user iis

Note: Where WAS_installation_path is the path where WebSphere Application
Server is installed. The default installation path is /opt/IBM/WebSphere/
AppServer. InfoSphere is the default name for the InfoSphere Information Server
profile installed under WebSphere Application Server. If you installed
InfoSphere Information Server to a profile name other than InfoSphere, use that
profile name instead.
5. Start the WebSphere Application Server process as wasadmin and start all
InfoSphere Information Server processes. See “Starting services (Linux, UNIX)”
on page 258.
Important:
v From now on, you should always start the application server as the non-root
user. If you ever start the server as root, you must complete the
post-installation steps again before you can restart the application server as
the non-root user.
v When you restart InfoSphere Information Server processes, ASBAgent is
started as root. To configure this agent as the non-root user, you must
complete the following procedure: “Starting IBM InfoSphere Information
Server node agent as a non-root user” on page 133.
If the agent is ever started by root and then started by a non-root user, you
must delete the process output files, such as *.out and *.err files that are
located in the IS_installation_path/ASBNode/logs folder, to allow the new
owners of the agent processes to regenerate those output files. This could
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have occurred during an installation process if the agent also had been
configured to run under a non-root user and were restarted as root during
the installation.
(Cluster environment) Running post-installation commands to enable non-root
administration (Linux, UNIX):
You must run these tasks every time you install IBM InfoSphere Information Server
and after you install any new add-on components to the services tier. You must
also run these tasks any time the application server, nodeagent, or deployment
manager is restarted as the root user and you now want to start it again as the
non-root user.
Before you begin
v
v If you have more than one add-on InfoSphere Information Server product to
install, install all the add-on products before you begin these steps.
v Stop all InfoSphere Information Server processes, including WebSphere
Application Server, the server engine, JobMonApp, and ASB agents. See
“Shutting down services (Linux, UNIX)” on page 253.
– The applications should be stopped while logged in as the user who started
the application.
– If WebSphere Application Server is already running as a non-root user, you
must log in as that non-root user to stop WebSphere Application Server.
– If the ASB agent is started as root, you must log in as root to stop the agent.
About this task
v These steps apply to cluster environments only. If you have a stand-alone
(non-clustered) configuration, see “(Stand-alone environment) Running
post-installation commands to enable non-root administration (Linux, UNIX)” on
page 129.
v The non-root user name, wasadmin, is an example that is used throughout the
documentation. If you have a different non-root user name, make sure to use
that one instead and replace every instance of wasadmin in the commands that
you run.
v This procedure must be repeated on all systems where IBM WebSphere
Application Server Network Deployment is installed. This includes the computer
that hosts the Deployment Manager and the computers that host the various
managed nodes.
Procedure
1. Remove *.jar and *.lck files from the temporary directory by running the
commands:
Note: The operating system-defined temporary directory, tmp, is either /tmp or
/var/tmp. Change the file path below accordingly.
Note: Alternatively, you can move these files to a backup directory. Third party
applications might have dependencies on the .jar or .lck files in this temporary
directory and you might want the option to restore them later.
rm /tmp/*.jar
rm /tmp/*.lck
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2. If WB_vrdata or BG_vrdata exist in the temporary directory, run the following
commands:
Note: The operating-system-defined temporary directory is either /tmp or
/var/tmp. Change the file path below accordingly.
rm –rf /tmp/WB__vrdata
rm –rf /tmp/BG__vrdata

Note:
v The operating-system-defined temporary directory is either /tmp or /var/tmp.
Change the file path accordingly.
v If your system was configured to relocate the temporary directory used by
IBM InfoSphere Information Governance Catalog as described in the
following technote, follow the instructions in the following technote to assure
that appropriate permissions are assigned to the WB__vrdata and BG__vrdata
directories: http://www.ibm.com/support/docview.wss?rs=3291
&uid=swg21413637.
3. Either wasadmin must be a member of the group assigned to the Reporting
workspace directories and below with rwx permission, or you must set
wasadmin as the owner of the Reporting workspace directories and below. Run
these commands to set the non-root user as the owner of the Reporting
workspace directories:
cd /tmp
chown -R wasadmin informationServer

Note:
v The operating-system-defined temporary directory is either /tmp or /var/tmp.
Change the file path accordingly.
v If you relocated the Reporting workspace directory as described in the
technote http://www.ibm.com/support/docview.wss?rs=14
&uid=swg21317914, assign appropriate permissions to that directory instead.
4. Assign wasadmin ownership to all WebSphere Application Server profiles
participating in the InfoSphere Information Server cluster.
Note: There are multiple WebSphere Application Server profiles potentially on
different machines.
a. For each profile in the cluster, run the following command to change
ownership to the non-root user.
cd WAS_installation_path/profiles
chown -R wasadmin Custom01

WAS_installation_path is the path where WebSphere Application Server is
installed. The default installation path is /opt/IBM/WebSphere/AppServer.
Custom01 is the default name for the InfoSphere Information Server profile
installed under WebSphere Application Server. If you installed InfoSphere
Information Server to a profile name other than Custom01, use that profile
name instead.
Repeat this step on each custom profile. (A custom profile is a WebSphere
Application Server profile that hosts a managed node.)
b. Run the commands to assign ownership to the non-root user of the
Deployment Manager profile. In this example, the profile is named Dmgr01.
cd WAS_installation_path/profiles
chown -R wasadmin Dmgr01
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WAS_installation_path is the path where WebSphere Application Server is
installed. The default installation path is /opt/IBM/WebSphere/AppServer.
Dmgr01 is the default profile name for the Deployment Manager profile.
5. Start all WebSphere Application Server processes as wasadmin user and start
all InfoSphere Information Server processes. See “Starting services (Linux,
UNIX)” on page 258.
Important: When you restart InfoSphere Information Server processes,
ASBAgent is started as root. To configure this agent as the non-root user, you
must follow the procedure in “Starting IBM InfoSphere Information Server
node agent as a non-root user.”
If the agent is ever launched by root and then started by a non-root user, you
must delete the process output files, such as *.out and *.err files that are
located in the IS_installation_path/ASBNode/logs folder, to allow the new
owners of the agent processes to regenerate those output files. The situation
could have occurred during an installation process if the agent also had been
configured to run under a non-root user and were restarted as root during the
installation.
What to do next
If this is the first time that you completed this task for this installation, ensure that
you also complete “(Cluster environment) Changing ownership of the web server
directory and plugin-cfg.xml” on page 127.

Starting IBM InfoSphere Information Server node agent as a
non-root user
The node agent (the ASB agent) can be started as the IBM InfoSphere DataStage
administrator user. Do this procedure after you create an installation of InfoSphere
Information Server. Repeat this procedure after you add additional product
modules or fix packs. You must also rerun steps 6-13 any time you have restarted
the node agent as the root user and you now want to start it again as the non-root
InfoSphere DataStage administrator user.

Before you begin
Before doing these steps, back up your system so that you can restore the original
state if necessary. See Chapter 14, “Backing up and restoring IBM InfoSphere
Information Server,” on page 237.

About this task
Do these steps on all engine tier computers. You must be a system administrator
who has root access.
Instructions in this procedure use the default InfoSphere Information Server
installation locations. Your path varies if you installed InfoSphere Information
Server in a different location.
The following directory is the default InfoSphere Information Server installation
location: /opt/IBM/InformationServer
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Procedure
1. If you added additional product modules or fix packs to an existing
InfoSphere Information Server installation, skip to step 6. If you are modifying
a fresh installation, continue with step 2.
2. Verify that the InfoSphere DataStage administrator account that originally
installed the engine tier exists. Verify that it belongs to the InfoSphere
DataStage primary group. The InfoSphere DataStage administrator account is
typically named dsadm. The InfoSphere DataStage primary group is typically
named dstage.
Note: If you did not install InfoSphere DataStage or IBM InfoSphere
Information Analyzer, you can choose any trusted user.
AIX
Make sure that the stack_hard variable in the /etc/security/limits
file is set to -1 for the user that was selected in step 2.
4. Make sure that the user can write to the temporary directory.
5. Configure the node agent to start as the non-root user when a computer
restarts. To do so, locate and change the content of the ISFAgents files on the
engine tier computers.

3.

Note: The location and file name are different for each operating system, but
the content of the file is the same.
a. Find the ISFAgents file that must be modified.
v

HPUX

Run this command: cd /sbin

AIX
Linux
Solaris
Run this command: cd /etc
v
b. Run the command: find . -name "*ISFAgents*"

Note: This step might return multiple files with various prefixes in the
name. Some files might link to other files and might reflect your change to
the original file. You do not have to edit the linked files. The main file is
typically located in the rc.d/init.d/ISFAgents directory.
c. Change the content of the file. The file contains information such as these
lines:
#!/bin/sh
# chkconfig: 2345 85 60
# description: Information Services Framework server.
IS_INIT_D=true;export IS_INIT_D
"/opt/IBM/InformationServer/ASBNode/bin/NodeAgents.sh" "$@"

Change as follows:
#!/bin/sh
# chkconfig: 2345 85 60
# description: Information Services Framework server.
IS_INIT_D=true;export IS_INIT_D
/usr/bin/su - dsadm -c "/opt/IBM/InformationServer/ASBNode/bin/NodeAgents.sh $*"

Note: If you did not install InfoSphere DataStage or InfoSphere
Information Analyzer, in place of dsadm in the file, specify the alternate
user that was selected in step 2.
6. Log in as a system administrator with root access.
7. Change to the /opt/IBM/InformationServer/ASBNode/bin directory.
8. Run this command to stop the node agent:
./NodeAgents.sh stop
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Note: If you use IBM InfoSphere Information Services Director, verify that all
related jobs are stopped. Typically, stopping the node agent stops all
InfoSphere Information Services Director jobs.
9. Remove any remaining root-owned *.out, *.err, and *.pid files from the
/opt/IBM/InformationServer/ASBNode/logs directory. You must always
complete this step before you first start the node agent as a non-root user, if
you previously started the node agent as root.
10. Change the ownership of the /opt/IBM/InformationServer/ASBNode directory
to the trusted user that was selected in step 2 on page 134. To change the
ownership, run this command:
chown -R user /opt/IBM/InformationServer/ASBNode

where user is the trusted user.
11. Log in as dsadm or as the user that you selected in step 2 on page 134.
12. Change to the following directory:
/opt/IBM/InformationServer/ASBNode/bin
13. Run the following command to start the node agent:
./NodeAgents.sh start

What to do next
To ensure that your system is configured correctly, run the following commands. If
the commands succeed, restart your system. Then run the commands again to
make sure that the startup scripts were correctly modified.
v If the default ports for the ASB agent is 31533, as specified during the initial
installation, run this command:
netstat –a | grep 3153

If the agent is not running, you must stop and start the node agent again.
v Run the following command to verify that the agent is up and running as the
specified user:
ps –ef | grep Agent

Automatic login from web-based applications
The login page of the IBM InfoSphere Information Server console and web-based
applications contain an option that enables you to log in automatically in your
subsequent attempts.
You can select the Automatically log in option after you specify the username and
password, to automatically connect to IBM InfoSphere Information Server console
and web-based applications. The Automatically log in option is enabled by default
after installation. Make sure that you enable the browser cookies. When this option
is enabled, you are automatically logged in when you connect to the IBM
InfoSphere Information Server console from the same URL and from the same web
browser, unless you clicked the Logout link in the previous session to log out.
You can log in to IBM InfoSphere Information Server without specifying your login
details for 14 days by default. However, the IBM InfoSphere Information Server
administrator can modify the maximum number of days a user is remembered.
To disable this feature or to log in with a different username and password, you
must click the Logout link to log out of the session. When you explicitly log out of
a session, the browser cookie is removed and you are prompted to specify the
username and password when you log in the next time.
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Managing the automatic login feature
If you are an IBM InfoSphere Information Server administrator user, you can use
the iisAdmin command to manage the capability of IBM InfoSphere Information
Server web-based applications to remember the previously logged in user.
You can use the iisAdmin command to manage the following activities:
To enable or disable the remembering of logins
v

IS_install_path/ASBServer/bin/iisAdmin.sh -set
-key com.ibm.iis.isf.security.RememberMe -value value

v

Windows
IS_install_path/ASBServer/bin/iisAdmin.bat -set -key
com.ibm.iis.isf.security.RememberMe -value value

Linux

UNIX

Use this command to enable or disable the Automatically log in option.
v Set value to false to disable the option.
v Set value to true to enable the option. The option is enabled by default
after installation.
You must restart the application server for the changes to take effect.
To set the number of days a login is remembered
v

IS_install_path/ASBServer/bin/iisAdmin.sh -set
-key com.ibm.iis.isf.security.RememberMeCookieMaxAge -value time
in seconds

v

Windows
IS_install_path/ASBServer/bin/iisAdmin.bat -set -key
com.ibm.iis.isf.security.RememberMeCookieMaxAge -value time in
seconds

Linux

UNIX

Use this command to set the number of days the login information is
remembered for a user who selects the Automatically log in option. This
takes effect the next time a cookie is generated or updated by a new login.
By default a user can log in to IBM InfoSphere Information Server without
specifying login details for 14 days. However, the IBM InfoSphere
Information Server administrator can set the maximum number of days a
user is remembered to any desired value.
You can use the -display option in the iisAdmin command to verify if the
Automatically log in option is enabled and also to check the maximum number of
days a user is remembered. For more information about iisAdmin command, see
“iisAdmin command” on page 148.

Administrator account password changing
After running the installation program, you can change the passwords for
administrator accounts that you created during installation.
You can change the following administrator account passwords:
v An IBM InfoSphere Information Server administrator password.
v An IBM WebSphere Application Server administrator password.
v IBM InfoSphere Information Analyzer analysis database owner account
credentials.
v IBM DB2 passwords.
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Changing an IBM InfoSphere Information Server administrator
password
You can change an InfoSphere Information Server administrator account password
after installation.

About this task
InfoSphere Information Server administrator accounts are the main administration
accounts for InfoSphere Information Server.
You can create as many InfoSphere Information Server administrator accounts as
you need. Any users with the suite administrator role assigned to them are
InfoSphere Information Server administrators. The IBM WebSphere Application
Server default administrator account also has this role.

Procedure
1. Change the password. Use the method that matches your user registry setup:
Option

Description

If your system uses the operating system
user registry

Change the password by using standard
operating system utilities.

If your system uses a Lightweight
Directory Access Protocol (LDAP) user
registry

Change the password by using LDAP
utilities.

If your system uses the internal user
registry

Change the password by using the IBM
InfoSphere Information Server Web console.

2. If the credentials that you change are also the WebSphere Application Server or
IBM DB2 administrator credentials, run the AppServerAdmin command to
propagate the new password across your configuration. See “IBM WebSphere
Application Server Network Deployment administrator password changing” on
page 138 and “Metadata repository database and staging area owner password
changing” on page 141.

Changing passwords by using the IBM InfoSphere Information
Server Web console
If your system is configured to use the internal user registry, change passwords by
using the IBM InfoSphere Information Server Web console.

Before you begin
To change a suite administrator or suite component user password, you need
suite-level administrator authority.

About this task
Use this procedure to change passwords if all of the following statements are true:
v Your system is configured to use the internal user registry.
If your system is configured to use the local operating system user registry, do
not use this procedure. Instead, change passwords by using standard operating
system utilities.
If your system uses a Lightweight Directory Access Protocol (LDAP) user
registry, do not use this procedure. Instead, change passwords by using LDAP
utilities.
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v If your installation includes a stand-alone implementation of IBM WebSphere
Application Server, you are changing a password other than the WebSphere
Application Server administrator password.
If you are changing the WebSphere Application Server administrator password
in a stand-alone implementation, do not use this procedure. Instead, follow the
procedure in “IBM WebSphere Application Server Network Deployment
administrator password changing.”
v You can log in to the IBM InfoSphere Information Server Web console.
If you cannot log in to the Web console, use the DirectoryAdmin tool as
described in “DirectoryAdmin tool” on page 153 to change passwords.
Individual users can also change their passwords by logging in to the IBM
InfoSphere Information Server Web console and clicking the Change Password
link.

Procedure
1. Log in to the IBM InfoSphere Information Server Web console. Use an account
with administrator access.
2. In the Web console, click the Administration tab.
3. In the navigation pane, select Users and Groups > Users.
4. In the Users pane, select the check box for the WebSphere Application Server
administrator.
5. In the right pane, click Open User.
6. In the Password field, type the new password.
7. In the Confirm Password field, retype the new password.
8. In the lower right corner of the page, click Save and Close.

IBM WebSphere Application Server Network Deployment
administrator password changing
The procedure for changing the WebSphere Application Server Network
Deployment administrator password differs depending on whether WebSphere
Application Server clustering is implemented within your installation. This
procedure does not apply to Liberty Profile because it does not have an
administrator user.

Changing the IBM WebSphere Application Server administrator
password in a stand-alone installation
You can change the WebSphere Application Server administrator password after
installation. Follow this procedure if your implementation includes a stand-alone
installation of WebSphere Application Server.

Procedure
1. Stop WebSphere Application Server. See “Stopping IBM WebSphere Application
Server (Windows)” on page 251 or “Stopping IBM WebSphere Application
Server (Linux, UNIX)” on page 254.
2. Log in to the services tier computer. Use an account with administrator
credentials.
Linux
UNIX
The account must have execution permission for the tools
in the ASBServer/bin directory within the InfoSphere Information Server
installation directory.
3. Change the password:
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v If your system is configured to use the internal user registry, change the
password by using the DirectoryAdmin command:
Windows

C:\IBM\InformationServer\ASBServer\bin\DirectoryAdmin.bat -user
-userid wasadmin -password password
Linux

UNIX

/opt/IBM/InformationServer/ASBServer/bin/DirectoryAdmin.sh -user
-userid wasadmin -password password

In the command, wasadmin is the WebSphere Application Server
administrator user name, and password as the new password.
Tip: The value for the -password parameter can be either plain text or an
encrypted string that has been created with the encrypt command.
Do not use the IBM InfoSphere Information Server Web console to change
the WebSphere Application Server administrator password.
v If your system uses an operating system user registry, change the password
by using standard operating system utilities.
v If your system uses a Lightweight Directory Access Protocol (LDAP) user
registry, change the password by using LDAP utilities.
4. Run the AppServerAdmin command with the -was option to update the
credentials across your configuration.
For example, to update your configuration with user name wasadmin1 and
password mypassword, run the following command:
v

Linux

UNIX

/opt/IBM/InformationServer/ASBServer/bin/AppServerAdmin.sh -was
-user wasadmin1 -password mypassword

v

Windows

C:\IBM\InformationServer\ASBServer\bin\AppServerAdmin.bat -was
-user wasadmin1 -password mypassword

Tip: The -password parameter is optional. If not provided, you will be
prompted for a password. If you do provide a password, it can be either plain
text or an encrypted string that has been created with the encrypt command.
This command updates the WebSphere Application Server user registry
configuration. You do not have to use the WebSphere Application Server
administrative console.
5. Restart WebSphere Application Server. See “Starting IBM WebSphere
Application Server (Linux, UNIX)” on page 258 or “Starting IBM WebSphere
Application Server (Windows)” on page 256.
6. When restarting WebSphere Application Server, regardless of the method that
you use, the startup method returns before the application server is fully
started. To verify that WebSphere Application Server has started, monitor the
log files. See “Checking the status of IBM WebSphere Application Server
startup (stand-alone installation)” on page 262.

Changing the IBM WebSphere Application Server administrator
password in a clustered installation
You can change the WebSphere Application Server administrator password after
installation. Follow this procedure if WebSphere Application Server clustering is
implemented for your installation.
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Procedure
1. Make sure that all node agents are running. See Checking the status of IBM
WebSphere Application Server node agents.
2. Change the user password:
v If your system uses the internal user registry, change the password by using
the IBM InfoSphere Information Server Web console. See “Changing
passwords by using the IBM InfoSphere Information Server Web console” on
page 137.
v If your system uses a Lightweight Directory Access Protocol (LDAP) or an
operating system user registry, change the password by using those external
utilities. If a stand-alone LDAP registry is used and the Server identity that
is stored in the repository option is selected, then after the password is
changed in the LDAP registry, you must also update the password in the
Users and Groups > Manage users page of the WebSphere Application
Server administrative console. See Standalone LDAP registry settings in the
WebSphere Application Server documentation for more information.
v If your cluster uses the federated user registry with the built-in WebSphere
Application Server file based registry, then change the password in the Users
and Groups > Manage users page of the WebSphere Application Server
administrative console.
3. Log in to the computer that hosts the WebSphere Application Server
Deployment Manager.
v

Linux

Log in as root.

UNIX

Windows
Use an account with administrator privileges.
v
4. Make sure that all node agents are still running after the password change. See
“Checking the status of IBM WebSphere Application Server node agents” on
page 266.
5. If one of the node agents was not running when you changed the password in
step 2, the user cannot start that node agent because the passwords no longer
match at the Deployment manager and node level. To fix this problem, run the
WebSphere Application Server syncNode command to synchronize the node
with the Deployment manager. To run the syncNode command:
a. Log into the node.
b. Run the syncNode command.

v

Linux

UNIX

opt/IBM/WebSphere/AppServer/profiles/custom_profile/bin/syncNode.sh
dmgr_hostname dmgr_port -user was_admin_username -password
was_admin_password

v

Windows

C:\IBM\WebSphere\AppServer\profiles\custom_profile\bin\syncNode
dmgr_hostname dmgr_port -user was_admin_username -password
was_admin_password

In the command:
v dmgr_hostname is the host name of the computer where the Deployment
Manager is running.
v dmgr_port is the port number of the Deployment Manager (default is
8879).
v was_admin_username is the user name of the WebSphere Application
Server administrator.
v was_admin_password is the administrator password.
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c. Restart the node agent. See “Starting IBM WebSphere Application Server
(Windows)” on page 256 and “Starting IBM WebSphere Application Server
(Linux, UNIX)” on page 258.
6. When restarting WebSphere Application Server, regardless of the method that
you use, the startup method returns before the application server is fully
started. To verify that WebSphere Application Server has started, monitor the
log files. See “Checking the status of IBM WebSphere Application Server
startup (clustered installation)” on page 265.

Metadata repository database and staging area owner
password changing
The procedure for changing the metadata repository database owner password or
the staging area owner differs depending upon whether IBM WebSphere
Application Server clustering is implemented within your installation.

Changing the metadata repository owner password or the
staging area repository owner password in a stand-alone IBM
WebSphere Application Server installation
You can change the metadata repository owner account password or the staging
area repository owner account password after installation. Follow this procedure if
your implementation includes a stand-alone installation of WebSphere Application
Server.

About this task
Follow this procedure to change either the metadata repository database owner
password or the staging area repository owner password. The metadata repository
database owner and staging area repository user names cannot be changed.

Procedure
1. Stop WebSphere Application Server. See “Stopping IBM WebSphere Application
Server (Windows)” on page 251 or “Stopping IBM WebSphere Application
Server (Linux, UNIX)” on page 254.
2. Change the metadata repository owner account password or the staging area
owner account password on the computer:
v If your database is implemented within IBM DB2, change the password by
using standard operating system utilities.
v If your database is implemented within another database management
system, refer to the database management system documentation for
information about changing the password.
3. Log in to the services tier computer. Use an account with administrator
credentials.
Linux
UNIX
The account must have execution permission for the tools
in the ASBServer/bin directory within the InfoSphere Information Server
installation directory.
4. Run the AppServerAdmin command to update the password across your
configuration.
For example, to update your configuration with password mypassword, run the
following command:
v To update the metadata repository database owner account password, use
the -db option. For example:

–

Linux

UNIX
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cd /opt/IBM/InformationServer/ASBServer/bin
./AppServerAdmin.sh -db -user xmeta -password mypassword

–

Windows

cd \IBM\InformationServer\ASBServer\bin
AppServerAdmin.bat -db -user xmeta -password mypassword

v To update the staging area repository owner account password, use the -dbs
option. For example:
–

Linux

UNIX

cd /opt/IBM/InformationServer/ASBServer/bin
./AppServerAdmin.sh -dbs -user xmetasr -password mypassword

–

Windows

cd \IBM\InformationServer\ASBServer\bin
AppServerAdmin.bat -dbs -user xmetasr -password mypassword

Tip: The -password parameter is optional. If not provided, you will be
prompted for a password. If you do provide a password, it can be either plain
text or an encrypted string that has been created with the encrypt command.
This command updates the WebSphere Application Server user registry
configuration. You do not have to use the WebSphere Application Server
administrative console.
5. Restart WebSphere Application Server. See “Starting IBM WebSphere
Application Server (Linux, UNIX)” on page 258 or “Starting IBM WebSphere
Application Server (Windows)” on page 256.
6. When restarting WebSphere Application Server, regardless of the method that
you use, the startup method returns before the application server is fully
started. To verify that WebSphere Application Server has started, monitor the
log files. See “Checking the status of IBM WebSphere Application Server
startup (stand-alone installation)” on page 262.

Changing the metadata repository owner password or the
staging area repository owner password in a clustered IBM
WebSphere Application Server installation
You can change the metadata repository owner password or the staging area
repository owner password after installation. Follow this procedure if IBM
WebSphere Application Server clustering is implemented within your installation.

About this task
Follow this procedure to change the metadata repository database owner password
or staging area repository owner password. The metadata repository database
owner and staging area repository user names cannot be changed.

Procedure
1. Stop all WebSphere Application Server processes, including the Deployment
Manager, node agents and cluster members.
2. Change the metadata repository owner account password or the staging area
repository owner account password on the computer:
v If your database is implemented within IBM DB2, change the password by
using standard operating system utilities.
v If your database is implemented within another database management
system, refer to the database management system documentation for
information about changing the password.
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3. Log in to the computer that hosts the WebSphere Application Server
Deployment Manager.
v

Linux

UNIX

Log in as root.

Windows
v
Use an account with administrator privileges.
4. Run the AppServerAdmin command to update the password across your
configuration.
For example, to update your configuration with password mypassword, run the
following command:
v To update the metadata repository database owner account password, use
the -db option. For example:

–

Linux

UNIX

cd /opt/IBM/InformationServer/ASBServer/bin
./AppServerAdmin.sh -db -user xmeta -password mypassword

–

Windows

cd \IBM\InformationServer\ASBServer\bin
AppServerAdmin.bat -db -user xmeta -password mypassword

v To update the staging area repository owner account password, use the -dbs
option. For example:
–

Linux

UNIX

cd /opt/IBM/InformationServer/ASBServer/bin
./AppServerAdmin.sh -dbs -user xmetasr -password mypassword

–

Windows

cd \IBM\InformationServer\ASBServer\bin
AppServerAdmin.bat -dbs -user xmetasr -password mypassword

Tip: The -password parameter is optional. If not provided, you will be
prompted for a password. If you do provide a password, it can be either plain
text or an encrypted string that has been created with the encrypt command.
This command updates the WebSphere Application Server user registry
configuration. You do not have to use the WebSphere Application Server
administrative console.
5. Restart the Deployment Manager. See “Starting the IBM WebSphere Application
Server Deployment Manager (Windows)” on page 257 or “Starting the IBM
WebSphere Application Server Deployment Manager (Linux, UNIX)” on page
260.
Do not restart the node agents and cluster members yet.
6. On each managed node, run the WebSphere Application Server syncNode
command to resynchronize the nodes with the Deployment Manager. (The ⇒
character indicates a line continuation.)
v

Linux

UNIX

cd /opt/IBM/WebSphere/AppServer/profiles/custom_profile/bin
./syncNode.sh dmgr_hostname dmgr_port -user was_admin_username ⇒
-password was_admin_password

v

Windows

cd \IBM\WebSphere\AppServer\profiles\custom_profile\bin
syncNode.bat dmgr_hostname dmgr_port -user was_admin_username ⇒
-password was_admin_password

In the command:
v dmgr_hostname is the host name of the computer where the Deployment
Manager is running.
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v dmgr_port is the port number of the Deployment Manager (default is 8879).
v was_admin_username is the user name of the WebSphere Application Server
administrator.
v was_admin_password is the administrator password.
7. Restart the node agents and cluster members. See “Starting IBM WebSphere
Application Server (Windows)” on page 256 or “Starting IBM WebSphere
Application Server (Linux, UNIX)” on page 258.
8. When restarting WebSphere Application Server, regardless of the method that
you use, the startup method returns before the application server is fully
started. To verify that WebSphere Application Server has started, monitor the
log files. See “Checking the status of IBM WebSphere Application Server
startup (clustered installation)” on page 265.

Changing the analysis database owner account credentials
You can change your IBM InfoSphere Information Analyzer analysis database
owner account credentials after installation.

Before you begin
You must have InfoSphere Information Analyzer administrator authority.

About this task
The analysis database owner account has ownership authority over the analysis
database. By default, the user name of this account is iauser.
Follow this procedure to change the analysis database owner account credentials.

Procedure
1. Change the analysis database owner credentials on the computer. If your
database is implemented within IBM DB2, change the credentials by using
standard operating system utilities. If your database is implemented within
another database management system, refer to the database management
system documentation for information about changing the credentials.
2. Log in to the IBM InfoSphere Information Server console. Specify a user name
and password of an account with InfoSphere Information Analyzer
administrator authority.
3. From the Home navigator menu in the console, select Configuration >
Analysis Settings. If these items do not appear in the Home menu, log out of
the console and log in with an account with InfoSphere Information Analyzer
administrator authority.
4. Click the Analysis Database tab.
5. Change the information in the fields.
6. Click Save All.

Changing IBM DB2 passwords
You can change the DB2 administrator account or other DB2 account passwords
after installation.
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About this task
The DB2 administrator account owns the DB2 database management system for
IBM InfoSphere Information Server. DB2 runs under this account.
An InfoSphere Information Server installation also requires a
non-fenced instance user and a fenced user.
Linux

UNIX

Procedure
To change a DB2 password, see the IBM DB2 documentation:
v DB2 10.5: publib.boulder.ibm.com/infocenter/db2luw/v10r1/topic/
com.ibm.db2.luw.admin.sec.doc/doc/c0007253.html

Administration commands and tools
Administration tasks can be done from the console, the command line, or both.
This section contains IBM InfoSphere Information Server administration commands
and tools that you can use to complete administration tasks from the command
line, such as updating new credentials across your configuration and searching for
users in a configured user registry, and to troubleshoot your security configuration.
This list is not exhaustive. Some commands are described in other sections.

AppServerAdmin command
If you change the administration credentials of the application server or the
repository credentials, use the AppServerAdmin command to update the new
credentials across your configuration.

Location
The AppServerAdmin command is in the following locations:
v

UNIX

v

Windows

Linux

IS_install_path/ASBServer/bin/AppServerAdmin.sh

IS_install_path\ASBServer\bin\AppServerAdmin.bat

Primary options
The AppServerAdmin command has the following options:
-was option
If you change the IBM WebSphere Application Server administrator user
name and password, this command updates the user name and password
throughout the WebSphere Application Server configuration.
This option applies only to a WebSphere Application Server Network
Deployment stand-alone installation. It does not apply to a clustered
installation or to WebSphere Application Server Liberty Profile.
You can change the stand-alone WebSphere Application Server
administrator user name and password in the following cases:
v If you change the WebSphere Application Server user registry
configuration in the WebSphere Application Server Administration
Console and the server ID and password for the current user registry is
changed or a new user registry is configured.
v If the WebSphere Application Server administrator is deleted from the
user registry or if that user's password is changed or expired.
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You must run the -was option each time the stand-alone WebSphere
Application Server default administrator credentials are changed.
-db option
The repository user credentials are used by the application server to
connect to the IBM InfoSphere Information Server metadata repository. The
user account for the metadata repository is typically called "xmeta." If you
change the repository user password, this command updates the password
throughout the application server and the InfoSphere Information Server
configuration, irrespective of the database used.
You must run this command each time the repository user password is
changed.
You cannot specify a new user name for the metadata repository with this
command. The user name must match the schema of the database.
-dbs option
The staging repository user credentials are used by the application server
to connect to the IBM InfoSphere Information Server metadata staging
repository. The user account for the metadata staging repository is typically
called "xmetasr." If you change the staging repository user password, this
command updates the password throughout the application server and the
InfoSphere Information Server configuration, irrespective of the database
used.
You must run this command each time the staging repository user
password is changed.
You cannot specify a new user name for the staging repository with this
command. The user name must match the schema of the database.

Password prompting
To avoid the display of passwords, you can either provide an encrypted password
with the -password option, or you can run the command without the -password
option. Without this option, you are prompted to provide a password (which is not
displayed). You will be asked to provide the password again for verification. To
provide an encrypted password, use the string generated from the encrypt
command.

Full syntax
AppServerAdminCommand[.sh|.bat]
[-{verbose | v}]
[-{results | res} value ]
[-{log | l} value ]
[-{logerror | error} value ]
[-{loginfo | info} value ]
[-{loglevel | level} value ]
[-{help | ?} ]
[-{changeWasUserInfo | was}]
[-{changeDbUserInfo | db}]
[-{changeDbStagingUserInfo | dbs}]
[-{test | t}]
[-{password | pw} value ]
[-{waitDatabase | w}]
[-{time | tm} value ]
[-{password | pw} value ]
[-{user | ur} value]
[-{waitServer | wsvr} value]
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Parameters
[-{verbose | v}]
Display detailed runtime output, except for the runtime logging messages.
[-{results | res} value ]
Print all the enabled runtime output to the specified file.
[-{log | l} value ]
Print the runtime logging messages to the specified file. This option is used
with loglevel.
[-{logerror | error} value ]
Print all ERROR and FATAL runtime logging messages to the specified file.
[-{loginfo | info} value ]
print all INFO, WARN, DEBUG, and TRACE runtime logging messages to the
specified file.
[-{loglevel | level} value]
The level at which runtime logging messages are enabled.
[-{help | ?} ]
Displays the usage message.
[-{changeWasUserInfo | was}]
Updates the new user credentials throughout the WebSphere Application
Server configuration. WebSphere Application Server does not need to be up
and running to run this command. If WebSphere Application Server is running,
it must be restarted after this command is run.
-user

The new WebSphere Application Server user name.

-password
Optional. The new password of the WebSphere Application Server
user. You can provide the password as plain text or as a string that has
been encrypted with the encrypt command. You will be prompted for a
password if one is not provided.
[-{changeDbUserInfo | db}]
Updates the new user password throughout the application server
configuration and the InfoSphere Information Server configuration irrespective
of the database used. The application server does not need to be up and
running to run this command. If the application server is running, it must be
restarted after you run this command.
-user

The repository user name, which matches the schema name. You
cannot change the user name with this command.

-password
Optional. The new password of the repository user. You can provide
the password as plain text or as a string that has been encrypted with
the encrypt command. You will be prompted for a password if one is
not provided.
[-{changeDbStagingUserInfo | dbs}]
Updates the new user password throughout the application server
configuration and the InfoSphere Information Server configuration irrespective
of the database used. The application server does not need to be up and
running to run this command. If the application server is running, it must be
restarted after you run this command.
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-user

The staging repository user name, which matches the schema name.
You cannot change the user name with this command.

-password
Optional. The new password of the staging repository user. You can
provide the password as plain text or as a string that has been
encrypted with the encrypt command. You will be prompted for a
password if one is not provided.
[-{test | t} ]
Test connection to the Metadata Server and its repository.
[-{waitDatabase | w}]
Wait for the SQL repository to be available.
[-{time | tm} ]
Time in minutes to wait.
[-{password | pw} ]
Password for the user.
[-{user | ur} ]
User ID of the user.
[-{waitServer | wsvr}]
Wait for the application server to be available and fully initialized.

iisAdmin command
Use the iisAdmin command to set configuration properties. Because some of the
configuration properties can cause major product behavior changes or even break
some components if not properly set, use this command only for those
configuration properties that are documented. Consult with someone from the IBM
Software Support team before setting other properties.

Location
The iisAdmin command is installed on the services tier in the following location:
v

Linux

v

Windows

UNIX

IS_install_path/ASBServer/bin/iisAdmin.sh

IS_install_path\ASBServer\bin\iisAdmin.bat

Syntax
iisAdmin
[-{verbose | v}]
[-{results | res} value ]
[-{log | l} value ]
[-{logerror | error} value ]
[-{loginfo | info} value ]
[-{loglevel | level} value ]
[-{log | l} value]
[-{help | ?} ]
[-{url | url}value]
[-{display | d}]
[-{set | s}]
[-{unset | u}]
[-{key | k} value]*
[-{value | val} value]*
[-{load | loa} value]*
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Parameters
[-{verbose | v}]
Display detailed runtime output, except for the runtime logging messages.
[-{results | res} value ]
Print all the enabled runtime output to the specified file.
[-{log | l} value ]
Print the runtime logging messages to the specified file. This option is used
with loglevel.
[-{logerror | error} value ]
Print all ERROR and FATAL runtime logging messages to the specified file.
[-{loginfo | info} value ]
print all INFO, WARN, DEBUG, and TRACE runtime logging messages to the
specified file.
[-{loglevel | level} value]
The level at which runtime logging messages are enabled.
[-{log | l} value]
Print all runtime log messages to the specified file. Use this option with the
loglevel option.
[-{help | ?} ]
Displays the usage message.
[-{display | d}]
Display the value of properties that are specified by the -key option. Use the *
wildcard in the -key option to display multiple properties. If the -key option
is not specified, all properties are displayed. Use multiple key options to
display multiple keys.
[-{set | s}]
Set the values of properties. Use multiple -set and -key options to set the
values for multiple properties. When you set each key-value pair, it is
considered as an individual transactional unit. If one key-value pair is not set
correctly, a message is logged and the transaction proceeds with other
key-value pairs.
[-{unset | u}]
Remove the value of properties. Use multiple key options to remove multiple
keys. When a key is removed, it is considered as an individual transactional
unit. If removal of one key fails, then a message is logged and the transaction
proceeds to remove other keys.
[-{key | k} value]*
Specify the name of the property. You can specify multiple key options.
[-{value | val} value]*
Specify the value of the property. You can specify multiple value options.
[-{load | loa} value]*
Load properties from the specified properties file. You can specify multiple
load options to load multiple property files at the same time. If one property
file fails to load, then a message is logged and the transaction proceeds to load
other property files.
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Automatic login from web-based applications
The login page of the IBM InfoSphere Information Server console and web-based
applications contain an option that enables you to log in automatically in your
subsequent attempts.
You can select the Automatically log in option after you specify the username and
password, to automatically connect to IBM InfoSphere Information Server console
and web-based applications. The Automatically log in option is enabled by default
after installation. Make sure that you enable the browser cookies. When this option
is enabled, you are automatically logged in when you connect to the IBM
InfoSphere Information Server console from the same URL and from the same web
browser, unless you clicked the Logout link in the previous session to log out.
You can log in to IBM InfoSphere Information Server without specifying your login
details for 14 days by default. However, the IBM InfoSphere Information Server
administrator can modify the maximum number of days a user is remembered.
To disable this feature or to log in with a different username and password, you
must click the Logout link to log out of the session. When you explicitly log out of
a session, the browser cookie is removed and you are prompted to specify the
username and password when you log in the next time.

Managing the automatic login feature
If you are an IBM InfoSphere Information Server administrator user, you can use
the iisAdmin command to manage the capability of IBM InfoSphere Information
Server web-based applications to remember the previously logged in user.
You can use the iisAdmin command to manage the following activities:
To enable or disable the remembering of logins
v

Linux
UNIX
IS_install_path/ASBServer/bin/iisAdmin.sh -set
-key com.ibm.iis.isf.security.RememberMe -value value

v

Windows
IS_install_path/ASBServer/bin/iisAdmin.bat -set -key
com.ibm.iis.isf.security.RememberMe -value value

Use this command to enable or disable the Automatically log in option.
v Set value to false to disable the option.
v Set value to true to enable the option. The option is enabled by default
after installation.
You must restart the application server for the changes to take effect.
To set the number of days a login is remembered
v

IS_install_path/ASBServer/bin/iisAdmin.sh -set
-key com.ibm.iis.isf.security.RememberMeCookieMaxAge -value time
in seconds

v

Windows
IS_install_path/ASBServer/bin/iisAdmin.bat -set -key
com.ibm.iis.isf.security.RememberMeCookieMaxAge -value time in
seconds

Linux

UNIX

Use this command to set the number of days the login information is
remembered for a user who selects the Automatically log in option. This
takes effect the next time a cookie is generated or updated by a new login.
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By default a user can log in to IBM InfoSphere Information Server without
specifying login details for 14 days. However, the IBM InfoSphere
Information Server administrator can set the maximum number of days a
user is remembered to any desired value.
You can use the -display option in the iisAdmin command to verify if the
Automatically log in option is enabled and also to check the maximum number of
days a user is remembered. For more information about iisAdmin command, see
“iisAdmin command” on page 148.

SessionAdmin command
The Session Administration service is used to manage and monitor the active
InfoSphere Information Server sessions. You must have suite administrator
authority to run the SessionAdmin command.

Location
The SessionAdmin command is in the following locations:
v

UNIX

Linux

IS_install_path/ASBServer/bin/SessionAdmin.sh
IS_install_path/ASBNode/bin/SessionAdmin.sh
v

Windows

IS_install_path\ASBServer\bin\SessionAdmin.bat
IS_install_path\ASBNode\bin\SessionAdmin.bat

Syntax
SessionAdmin
[-{verbose | v}]
[-{results | res} value ]
[-{log | l} value ]
[-{logerror | error} value ]
[-{loginfo | info} value ]
[-{loglevel | level} value ]
[-{help | ?} ]
[-{url | url} value ]
[-{host | h} value ]
[-{port | p} value ]
[-{user | ur} value ]
[-{password | pw} value ]
[-{authfile | af} value ]
[-{list-user-sessions | lus}]
[-{list-system-sessions | lss}]
[-{kill-user-sessions | kus} ]
[-{kill-system-sessions | kss}]
[-{kill-session | ks} ]*
[-{get-maint-mode | gmm}]
[-{set-maint-mode | smm} value ]
[-{auto_update | au} value]

Parameters
[-{verbose | v}]
Display detailed runtime output, except for the runtime logging messages.
[-{results | res} value ]
Print all the enabled runtime output to the specified file.
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[-{log | l} value ]
Print the runtime logging messages to the specified file. This option is used
with loglevel.
[-{logerror | error} value ]
Print all ERROR and FATAL runtime logging messages to the specified file.
[-{loginfo | info} value ]
print all INFO, WARN, DEBUG, and TRACE runtime logging messages to the
specified file.
[-{loglevel | level} value]
The level at which runtime logging messages are enabled.
[-{help | ?} ]
Displays the usage message.
[-{url | url}value ]
Server URL in the protocol://host:port format. The protocol can be HTTP or
HTTPS. However, the default product installation requires HTTPS as the
protocol.
An example URL is https://localhost:9443.
Use this option instead of -host and -port options to specify the InfoSphere
Information Server to connect to.
[-{host | h} value ]
The host name of the InfoSphere Information Server. This option is deprecated.
Use the -url option instead.
[-{port | p} value ]
The port number of the InfoSphere Information Server. This option is
deprecated. Use the -url option instead.
[-{user | ur} value ]
The administrator user ID to run this command. If not specified and if the
-authfile parameter is not specified, you are prompted for a user ID.
[-{password | pw} value ]
The password of the administrator user ID specified in the -user parameter.
This parameter cannot be specified without the -user parameter. If the -user
parameter is specified without the -password parameter, you are prompted for
a password.
[-{authfile | af} value ]
The path for the credentials file that contains the administrator user ID and
password to run this command. If the -user parameter is also specified, the
credentials file is ignored and you are prompted for a password.
[-{list-user-sessions | lus}]
List all the user sessions, such as in the following example. (The ⇒ character
indicates a line continuation.)
<admin><5a795986-52a1-426f-8579-8c7af5d3e324><Fri Aug 09 14:55:08 CEST ⇒
2013><Fri Aug 09 14:55:08 CEST 2013><192.0.2.0><WEB>

The format is as follows:
<session owner ID><session ID><session creation date><session update
date><hostname or IP address of the system><client type of the session>
<session owner ID>
The user ID of the owner or creator of the session.
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<session ID>
The unique session ID.
<session creation date>
The date of creation of the session.
<session update date>
The date when the last session update was made.
<hostname or IP address of the system>
The hostname or IP address of the system from where the session was
created.
<client type of the session>
The client type of the session. This information indicates the tool that was
used to create the session.
[-{list-system-sessions | lss}]
List all system sessions in the following format: <session owner ID><session
ID><session creation date><session update date><hostname or IP address of the
system><client type of the session>.
[-{kill-user-sessions | kus} ]
Terminate all user sessions. You must specify the ID of the user session to be
terminated.
[-{kill-system-sessions | kss}]
Terminate all the system sessions. You must specify the ID of the system
session to be terminated.
[-{kill-session | ks} ]*
Terminate the specified session. You must specify the ID of the session to be
terminated. You can specify this parameter multiple times. This parameter
cannot be used with any of the other options.
[-{get-maint-mode | gmm}]
Display the current maintenance mode setting.
[-{set-maint-mode | smm} value ]
Set the maintenance mode. Acceptable values are ON or OFF.
[-{auto_update | au} value]
Automatically update new sessions in the specified frequency (in seconds). You
must use this option with any of the list options. When you use -auto_update
with one of the list options, the current session is listed and the list is updated
periodically with new sessions that are added.

DirectoryAdmin tool
The DirectoryAdmin tool provides a command-line interface that you can use to
interact with the metadata repository and complete a variety of IBM InfoSphere
Information Server user registry tasks. You should only use this tool and these
commands for advanced configuration, such as configuring the InfoSphere
Information Server internal user registry or cleaning up the repository if you are
changing a registry configuration on a system that has been in production, or for
troubleshooting or recovery tasks.
The tool is available in the ASBServer\bin directory of your InfoSphere
Information Server directory, for example C:\IBM\InformationServer\ASBServer\
bin.
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Creating a user in the IBM InfoSphere Information Server user
registry
Use the following command to create a user in the IBM InfoSphere Information
Server internal user registry. This command should only be used for
troubleshooting or recovery, or if it is specified in other procedures in the
documentation.
The application server does not need to be running to run this command.

Syntax
Windows

DirectoryAdmin.bat -user -userid username -password password
Linux

UNIX

DirectoryAdmin.sh -user -userid username -password password

Parameters
The following parameters are available for the DirectoryAdmin command.
-user
The command line option that specifies that this task is to work with users.
-userid username
Specifies the name of the user that you want to create.
-password password
Specifies the password of the user that you want to create. You can provide the
password as plain text or as a string that has been encrypted with the encrypt
command.

Resetting the password of a user
If you use the IBM InfoSphere Information Server internal user registry, you can
use this command to set or reset the credentials of a user. This command should
only be used for troubleshooting or recovery, or if it is specified in other
procedures in the documentation.
The application server does not need to be running to run this command.

Syntax
Windows

DirectoryAdmin.bat -user -userid username -password password
Linux

UNIX

DirectoryAdmin.sh -user -userid username -password password

Parameters
The following options are available for the DirectoryAdmin command.
-user
The command line option that specifies that this task is to work with users.
-userid username
Specifies the name of the user whose password needs to be reset.
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-password password
Specifies the user password that you want to set. You can provide the
password as plain text or as a string that has been encrypted with the encrypt
command.

Assigning the IBM InfoSphere Information Server administrator
role to a user
Use the following command to add the IBM InfoSphere Information Server Suite
Administrator role to a user. Only use this command if you are fixing your user
registry configuration, or if it is specified in other procedures in the
documentation.
The application server does not have to be running to run this command unless
the -checkid option is also used.

Syntax
Windows

DirectoryAdmin.bat -user -userid username
Linux

-admin [-checkid]

UNIX

DirectoryAdmin.sh -user -userid username -admin [-checkid]

Parameters
The following parameters are available for the DirectoryAdmin command.
-user
The command line option that specifies that this task is to work with users.
-userid username
Specifies the name of the user that you want to make a Suite Administrator.
Note that the user ID syntax differs depending on the type of user registry that
is configured in the application server.
Local OS on UNIX
Provide the UNIX user ID, such as "isadmin."
Local OS on Windows
COMPUTER_NAME\userid, such as MYSERVER\isadmin where
MYSERVER is the name of the Microsoft Windows computer. If the
Microsoft Windows computer is registered in a domain, the syntax
might also be DOMAIN_NAME\userid. The name must be uppercase.
LDAP The full distinguished name (DN) must be provided in the proper case.
For more information on retrieving the DN, refer to “LDAP
distinguished name (DN) determination” on page 70.
Note: To add users with long and composed user IDs, such as LDAP fully
qualified names, surround the user IDs with double quotation marks when
using the command.
-admin
Assigns the InfoSphere Information Server Suite Administrator role to the user.
-checkid
(Optional) Ensures that the given user ID exists before applying the Suite
Administrator role to that user.
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Checking to see if a user exists in the configured user registry
Use this command to see if a user name exists in the configured user registry. Use
this command only for troubleshooting or recovery, or if it is specified in other
procedures in the documentation.
The application server must be running to run this command.

Syntax
Windows

DirectoryAdmin.bat -user -userid username -checkid [-admin]
Linux

UNIX

DirectoryAdmin.sh -user -userid username -checkid [-admin]

Parameters
The following options are available for the DirectoryAdmin command.
-user
The command line option that specifies that this task is to work with users.
-userid username
Specifies the name of the user to search for. Note that the user ID syntax
differs depending on the type of user registry that is configured in the
application server.
Local OS on UNIX
Provide the UNIX user ID, such as "isadmin."
Local OS on Windows
COMPUTER_NAME\userid, such as MYSERVER\isadmin where
MYSERVER is the name of the Microsoft Windows computer. If the
Microsoft Windows computer is registered in a domain, the syntax
might also be DOMAIN_NAME\userid. The name must be uppercase.
LDAP The full distinguished name (DN) must be provided in the proper case.
For more information on retrieving the DN, refer to “LDAP
distinguished name (DN) determination” on page 70.
Note: To include users with long and composed user IDs, like LDAP fully
qualified names, surround the user IDs with double quotation marks when
using the command.
-checkid
Ensures that the given user ID already exists in the configured directory before
creating or updating the user in the security directory.
-admin
(Optional) Assigns theIBM InfoSphere Information Server Suite Administrator
role to the user, if the user exists.

Configuring the IBM InfoSphere Information Server user registry
to use the internal user registry
Use this command to point the IBM InfoSphere Information Server user registry to
the internal user registry.
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The application server does not need to be running to run this command. If the
application server is up and running, it must be restarted for these changes to take
effect.
Use this command only for troubleshooting. If there are some errors in the
auto-configuration mechanism during startup of the application server, then you
can use the DirectoryAdmin command to force the provider change. This command
can be used as a recovery or resolution mechanism.

Syntax
Windows

DirectoryAdmin.bat -set_provider ISF
Linux

UNIX

DirectoryAdmin.sh -set_provider ISF

Parameters
The following options are available for the DirectoryAdmin command.
-set_provider
The command line option that sets a provider to active.
ISF
Indicates that the tool should configure the InfoSphere Information Server user
registry to use the internal user registry.

Configuring the IBM InfoSphere Information Server user registry
to use the application server registry
Use this command to point the IBM InfoSphere Information Server user registry to
the application server registry.
The application server does not need to be running to run this command. If it is
running, it must be restarted for these changes to take effect.
Use this command only for troubleshooting. If there are errors in the
auto-configuration mechanism during application server startup, you can use the
DirectoryAdmin command to force the provider change. This command can be
used as a recovery or resolution mechanism.

Syntax
Windows

DirectoryAdmin.bat -set_provider J2EE
Linux

UNIX

DirectoryAdmin.sh -set_provider J2EE

Parameters
The following options are available for the DirectoryAdmin command.
-set_provider
The command line option that sets a provider to active.
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J2EE
Indicates that the tool should configure the InfoSphere Information Server user
registry to use the application server user registry.

Deleting users from the IBM InfoSphere Information Server user
registry
Use this command to delete users from the IBM InfoSphere Information Server
user registry. This command deletes all the users in the InfoSphere Information
Server user registry. If you are using an external user registry, such as LDAP, this
command deletes only the proxies of the users that were created in the internal
repository and their role assignments.
The application server does not need to be running to run this command. This
command should only be used for troubleshooting or recovery.
You can use this command when changing the user registry configuration after the
system has been in production. This command removes all security settings for all
users. You can then safely switch to a different user registry.
Attention: This command deletes all the users in the InfoSphere Information
Server user registry. From the IBM InfoSphere Information Server Web console, you
can delete users selectively.
Use this command only for troubleshooting.

Syntax
Windows

DirectoryAdmin.bat -delete_users
Linux

UNIX

DirectoryAdmin.sh -delete_users

Parameters
The following options are available for the DirectoryAdmin command.
-delete_users
Deletes all the users in the IBM InfoSphere Information Server user registry.

Deleting groups from the IBM InfoSphere Information Server user
registry
Use this command to delete groups from the IBM InfoSphere Information Server
user registry. This command deletes all the groups in the InfoSphere Information
Server user registry. If you are using an external registry, such as LDAP, this
command deletes only the proxies of the groups that were created in the internal
repository and their role assignments.
The application server does not need to be running to run this command. This
command should only be used for troubleshooting or recovery.
You can use this command when changing the user registry configuration after the
system has been in production. This command removes all security settings for all
groups which allows for a safe switch to a different registry.
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Attention: This command deletes all the groups in the InfoSphere Information
Server user registry. From the IBM InfoSphere Information Server Web console, you
can delete groups selectively.
Use this command only for troubleshooting.

Syntax
Windows

DirectoryAdmin.bat -delete_groups
Linux

UNIX

DirectoryAdmin.sh -delete_groups

Parameters
The following options are available for the DirectoryAdmin command.
-delete_groups
Deletes all the groups in the InfoSphere Information Server user registry.

Searching for users in the configured user registry
Use this command to specify a user name criterion and return a list of users that
meet that criterion in the configured user registry. This command should only be
used for troubleshooting or recovery.
IBM WebSphere Application Server must be running to run this command.

Syntax
Windows

DirectoryAdmin.bat -user -search -idp userid_pattern -max_count maxcount
Linux

UNIX

DirectoryAdmin.sh -user -search -idp userid_pattern -max_count maxcount

Parameters
The following options are available for the DirectoryAdmin command.
-user
The command line option that specifies that this task is to work with users.
-search
Specifies that the DirectoryAdmin command should perform a search.
-idp
Specifies the user name pattern to search for. The pattern must contain either
the full user name or, if the full user name is not used, a part of the user name
with a prepended or appended asterisk (*). For example, you might want to
use DirectoryAdmin -user -search -idp a* -max_count 4 to search for all
users whose user names start with "a".
-max_count
Limits the number of users that are returned as part of the search.
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Searching for groups in the configured user registry
Use this command to specify a group name criterion and return a list of groups
that meet that criterion in the configured user registry. This command should only
be used for troubleshooting or recovery.
IBM WebSphere Application Server must be running to run this command.

Syntax
Windows

DirectoryAdmin.bat -group -search -idp groupid_pattern -max_count maxcount
Linux

UNIX

DirectoryAdmin.sh -group -search -idp groupid_pattern -max_count maxcount

Parameters
The following options are available for the DirectoryAdmin command.
-group
The command line option that specifies that this task is to work with groups.
-search
Specifies that the DirectoryAdmin command should perform a search.
-idp
Specifies the group ID pattern to search for. The pattern must contain either
the full group name or, if the full group name is not used, a part of the group
name with a prepended or appended asterisk (*). For example, you might want
to set -idp group* to return all groups that start with group, such as
"groupname" or "grouplogin".
-max_count
Limits the number of groups that are returned as part of the search.

Displaying user details
Use this command to query for detailed information about a user, such as the
security roles that are assigned to the user name or the groups that the user
belongs to. This command should only be used for troubleshooting or recovery.
The application server must be running to run this command.

Syntax
Windows

DirectoryAdmin.bat -user -userid username -display
Linux

UNIX

DirectoryAdmin.sh -user -userid username -display

Parameters
The following options are available for the DirectoryAdmin command.
-user
The command line option that specifies that this task is to work with users.
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-userid username
Specifies the name of the user to look up the details for. Note that the user ID
syntax differs depending on the type of user registry that is configured in the
application server.
Local OS on UNIX
Provide the UNIX user ID, such as "isadmin."
Local OS on Windows
COMPUTER_NAME\userid, such as MYSERVER\isadmin where
MYSERVER is the name of the Microsoft Windows computer. If the
Microsoft Windows computer is registered in a domain, the syntax
might also be DOMAIN_NAME\userid. The name must be uppercase.
LDAP The full distinguished name (DN) must be provided in the proper case.
For more information on retrieving the DN, refer to “LDAP
distinguished name (DN) determination” on page 70.
Note: To add users with long and composed user ids, like LDAP fully
qualified names, surround the user IDs with double quotation marks when
using the tool.
-display
Displays the detailed information associated with that user name.

Troubleshooting examples that use the DirectoryAdmin tool
If you run into the following problems while administering IBM InfoSphere
Information Server, you can use the DirectoryAdmin tool to help you determine
and address the problem.

Lost user password
This example is only applicable to internal user registry configuration. From the
command line, enter the following command:
DirectoryAdmin.bat -user -userid admin_user_id -password new_password

You can provide the password as plain text or as a string that has been encrypted
with the encrypt command.
Note: If you have multiple InfoSphere Information Server Suite Administrators,
you could instead ask one of these administrators to log in to the IBM InfoSphere
Information Server Web console and reset the lost user password in the IBM
InfoSphere Information Server Web console.

User registry configuration is not working and you cannot log in to the
IBM InfoSphere Information Server Web console
To reset the user registry configuration to use the IBM InfoSphere Information
Server internal user registry:
1. From the command line, set the InfoSphere Information Server to use the
InfoSphere Information Server internal user registry by entering the following
command:
DirectoryAdmin.bat -set_provider ISF

2. Create the default InfoSphere Information Server Suite administrator user by
using the following command:
DirectoryAdmin.bat -user -userid default_isadmin_userid -password password
-admin
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You can provide the password as plain text or as a string that has been
encrypted with the encrypt command.
3. Log in to the IBM WebSphere Application Server Administrator console and set
the application server user registry to the InfoSphere Information Server
internal user registry.
To reset the user registry configuration to use the application server user registry:
1. Ensure that the application server user registry is configured to use the local
operating system user registry or LDAP user registry of your choice.
2. From the command line, set InfoSphere Information Server to use the
application server user registry by entering the following command:
DirectoryAdmin.bat -set_provider J2EE

3. Assign a user the necessary security roles to make that user the default
InfoSphere Information Server Suite Administrator by entering the following
command:
DirectoryAdmin.bat -user -userid default_isadmin -admin

The default InfoSphere Information Server administrator user syntax differs
depending on the user registry that is configured in the application server.
Local OS on UNIX
Provide the UNIX user ID, such as "isadmin."
Local OS on Windows
COMPUTER_NAME\userid, such as MYSERVER\isadmin where
MYSERVER is the name of the Microsoft Windows computer. If the
Microsoft Windows computer is registered in a domain, the syntax
might also be DOMAIN_NAME\userid. The name must be uppercase.
LDAP The full distinguished name (DN) must be provided in the proper case.
For more information on retrieving the DN, refer to “LDAP
distinguished name (DN) determination” on page 70.

DirectoryCommand tool
You can use the DirectoryCommand tool to run some of the same operations that
can be from the Web Console. With the tool, you can add users, add groups, add
users to groups, add roles to users, add roles to groups, and so on.

Usage
On the services tier, the command is installed in the following location:
v

Linux

v

Windows

UNIX

IS_install_path/ASBServer/bin/DirectoryCommand.sh

IS_install_path\ASBServer\bin\DirectoryCommand.bat

On the engine and client tiers, the command is installed in the following location:
v

Linux

v

Windows

UNIX

IS_install_path/ASBNode/bin/DirectoryCommand.sh

IS_install_path\ASBNode\bin\DirectoryCommand.bat

The command has many options that control a separate operation. The tool
supports multiple operations to be specified at the same time. For example, you
could specify both the -add_user and the -add_group options in the same run of
the tool. The operations can be run in batch by using the -file option, or they can
be run in a script. See the examples at the bottom of this topic.
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Syntax
DirectoryCommand
[-{add_ds_credentials | ds_cred} value]
[-{add_group | a_grp} value]*
[-{add_user | a_usr} value]*
[-{add_users_group | a_usr_grp} value]*
[-{assign_group_roles | grp_roles} value]*
[-{assign_user_roles | usr_roles} value]*
[-{assign_project_group_roles | proj_grp_roles} value]
[-{assign_project_user_roles | proj_usr_roles} value]
[-authfile value]
[-{datastage_server | ds_svr} value]
[-{delete_group | del_grp} value]
[-{delete_user | del_usr} value]
[-{details | det}]
[-{file | f} value]
[-force]
[-{get_default_ds_credentials | get_dflt_ds_cred}]
[-{help | ?}]
[-host value]
[-list value]
[-{log | l} value]
[-{logerror | error} value]
[-{loginfo | info} value]
[-{loglevel | level} value]
[-{password | pwd} value]
[-port value]
[-primary]
[-{remove_group_roles | rm_grp_roles} value]
[-{remove_project_group_roles | rm_proj_grp_roles} value]
[-{remove_project_user_roles | rm_proj_usr_roles} value]
[-{remove_user_roles | rm_usr_roles} value]
[-{remove_users_group | rm_usr_grp} value]
[-{results | res} value]
[-{separator | sep} value]
[-{set_default_ds_credentials | set_dflt_ds_cred} value]
[-{set_shared_registry | shr_reg} value]
[-{sub_list_separator | sub_list_sep} value]
[-{update_group | upd_grp} value]
[-{update_user | upd_usr} value]
[-{user | usr} value]
[-{verbose | v}]

Parameters
Command parameter syntax
The {x | y} syntax of the parameters indicates that you can enter either the
long form of the parameter (x) or the shortcut parameter name (y). The
value indicates that a value must be specified. Each parameter description
that follows indicates the syntax of the parameters and associated values.
The asterisk (*) on the specification means that the command parameter
can be repeated multiple times in the same command line.
Value lists and sublists
Most of the operational parameters have values that consist of lists and
sublists.
v In the value list syntax, [~value]* means that you can optionally specify
a list of the indicated values separated by the separator character, a tilde
() by default
v A list is a set of values separated by a character, a tilde (~) by default. In
some lists, the actual value assigned is determined by the position of the
value in the list, such as in the -add_group and -add_user options. For
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each value in the list, if not all values are assigned between values, at
least the separator character must be specified so that the position can be
determined. Any trailing separators, however, should be omitted.
ListValue1~ListValue2~~~ListValue5

For example, the following list is used to add a new user and assign the
user ID, password, first name, last name, job title, and business phone
number:
-add_user "jsmith~pa55word~John~Smith~DS Admin~~~~~408-555-0122"

v A sublist is a set of values also separated by a character. Sublists differ
from lists in that they are accompanied by another sublist, separated by
a different character, a dollar sign ($) by default. For sublists, the values
are not positional. The values of each sublist are assigned to the values
of the accompanying sublists.
Sublist1Value1~Sublist1Value2$Sublist2Value1$Sublist3Value1~Sublist3Value2

For example, the following sublists are used to assign the roles in the
right sublist to the user in the left sublist:
-assign_user_roles adminUser$SuiteUser~DataStageAdmin

Note: On Linux and UNIX, the dollar sign ($) is a special character that
must be escaped with a backslash (\). The above example would be
specified as follows:
Sublist1Value1~Sublist1Value2\$Sublist2Value1\$Sublist3Value1~Sublist3Value2

Alternatively, you can specify the entire list in quotation marks ("):
"Sublist1Value1~Sublist1Value2$Sublist2Value1$Sublist3Value1~Sublist3Value2"

[-{add_ds_credentials | ds_cred} value ]
Maps one or more user credentials to the specified operating system user
credentials for the engine, which is specified with the -datastage_server
parameter, which must be included with this one. Specify the value as one
string with the following syntax:
userID[~userID]*$credUserID~credPassword

The value must contain at least one sublist separator character ($). If multiple
user IDs are specified, they are all assigned the specified credentials. The
password value can be specified as plain text or as text encrypted with the
encrypt command.
To clear the credentials, pass a quoted exclamation mark ("!") as either the
credUserId or credPassword values.
[-{add_group | a_grp} value]*
Create a group. Multiple instances of this option can be specified. Specify the
value as one string with the following syntax:
groupId~name~groupType~webAddress
~location~officePhoneNumber~cellPhoneNumber
~pagerNumber~faxNumber~emailAddress
~businessAddress~organization

Each entry in the value must contain at least one separator character (~).
[-{add_user | a_usr} value]*
Create a user. Multiple instances of this option can be specified. Specify the
value as one string with the following syntax:
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userId~password~firstName~lastName
~title~jobTitle~homePhoneNumber~imName
~location~officePhoneNumber~cellPhoneNumber
~pagerNumber~faxNumber~emailAddress
~businessAddress~organization

Each entry in the value must contain at least one separator character (~). The
password value can be specified as plain text or as text encrypted with the
encrypt command.
[-{add_users_group | a_usr_grp} value]*
Add users to groups. Multiple instances of this option can be specified. Specify
the value as one string with the following syntax:
userId[~userId]*$groupId[~groupId]*

The value must contain at least one sublist separator character ($). For sublists
that contain multiple entries, each entry of one sublist is assigned to each entry
of the other sublist.
[-{assign_group_roles | grp_roles} value]*
Assign roles to groups. Multiple instances of this option can be specified.
Specify the value as one string with the following syntax:
groupId[~groupID]*$roleID[~roleID]*

The value must contain at least one sublist separator character ($). For sublists
that contain multiple entries, each entry of one sublist is assigned to each entry
of the other sublist.
[-{assign_user_roles | usr_roles} value]*
Assign roles to users. Multiple instances of this option can be specified. Specify
the value as one string with the following syntax:
userId[~userId]*$roleId[~roleId]*

The value must contain at least one sublist separator character ($). For sublists
that contain multiple entries, each entry of one sublist is assigned to each entry
of the other sublist.
[-{assign_project_group_roles | proj_grp_roles} value]
Assign project group roles. Multiple instances of this option can be specified.
Specify the value as one string with the following syntax:
projectName[~projectName]*$groupId[~groupId]*$roleId

The value must contain 2 sublist separator characters ($). For sublists that
contain multiple entries, each entry of each sublist is assigned to each entry of
the other sublists. The projectName values are case sensitive and must be in
the format of DSServer/projectID, where DSServer must match the registered
engine name. The name could be registered as the short host name or as the
fully qualified host name with a domain. Whichever way it is registered, this is
how it must be specified here. You can see a list of project names by using the
-list DSPROJECTS option. The roleID must be an InfoSphere DataStage project
role.
[-{assign_project_user_roles | proj_usr_roles} value]
Assign project user roles. Multiple instances of this option can be specified.
Specify the value as one string with the following syntax:
projectName[~projectName]*$userId[~userId]*$roleId
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The value must contain 2 sublist separator characters ($). For sublists that
contain multiple entries, each entry of each sublist is assigned to each entry of
the other sublists. The projectName values are case sensitive and must be in
the format of DSServer/projectID, where DSServer must match the registered
engine name. The name could be registered as the short host name or as the
fully qualified host name with a domain. Whichever way it is registered, this is
how it must be specified here. You can see a list of project names by using the
-list DSPROJECTS option. The roleID must be an InfoSphere DataStage project
role.
[-authfile value]
Use the specified credentials file for the credentials of the administrator user
ID running this command. Either the -authfile option or the -user and
-password options are required.
[-{datastage_server | ds_svr} value]
Specifies the host name or configured alias name of the InfoSphere Information
Server engine to use when setting the shared registry and when setting and
getting the engine credentials. The value cannot contain a forward slash
character (/). The value is validated against the engines that are registered
with IBM InfoSphere Information Server.
You must specify this -datastage_server parameter when you use following
parameters:
v
v
v
v

-add_ds_credentials
-get_default_ds_credentials
-set_default_ds_credentials
-set_shared_registry

[-{delete_group | del_grp} value]
Delete existing groups. Specify the value as one string with the following
syntax:
groupID[~groupID]*

You will be prompted to confirm the delete unless the -force option is
specified. If a specified group does not exist, it will be ignored.
[-{delete_user | del_usr} value]
Delete existing users. Specify the value as one string with the following syntax:
userID[~userID]*

You will be prompted to confirm the delete unless the -force option is
specified. If a specified user does not exist, it will be ignored.
[-{details | det}]
Provides additional information in the output when used with the -list option
for USERS and GROUPS.
For users, the following information is provided:
v detailed user information
v groups that the user is a member of
v suite and product roles that are assigned to the user
v mapped engine credentials for this user
For groups, the following information is provided:
v detailed group information
v suite and product roles that are assigned to the group
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[-{file | f} value]
Read the commands from a file. When you specify the -file option, other
specified command options are ignored. See the end of this topic for an
example of how to use the -file option. If you intend to load a large number of
users with the file option, break them up so that each file contains about 100
users to avoid server time outs.
In a file, each command must be specified on a separate line and must end
with a semicolon (;). This is true even for command options that have
additional required options, such as -separator, -sublist_separator,
-datastage_server, -details, and -force. The commands with these options must
also each be on a separate line, and the line must be terminated with a
semicolon. The value specified for these applies to all commands included in
the file.
[-force]
Suppress the confirmation prompt for the -delete_user and -delete_group
options.
[-{get_default_ds_credentials | get_dflt_ds_cred}]
Retrieve the default credentials for the InfoSphere Information Server engine
that is specified with the -datastage_server option.
[-{help | ?}]
Display usage information.
[-host value]
The host name of the services tier computer. The default value is localhost.
[-list value]
List the existing users, groups, InfoSphere DataStage projects, or
system-defined roles. Specify the value as one string with the following syntax:
type[~type]*

The type values can be USERS, GROUPS, ROLES, DSPROJECTS, or ALL.
[-{log | l} value]
Print all runtime output to the specified file.
[-{logerror | error} value]
Print all ERROR and FATAL runtime logging messages to the specified file.
[-{loginfo | info} value]
Print all INFO, WARN, DEBUG, and TRACE runtime logging messages to the
specified file.
[-{loglevel | level} value]
The level at which runtime logging messages are enabled. The value can be
FATAL, ERROR, INFO, WARN, DEBUG, TRACE, or ALL.
[-{password | pwd} value]
The password for the suite administrator user ID running this command.
[-port value]
The HTTPS port of the services tier computer. The default value is 9443.
[-primary]
Log in to the primary services host if one is available. If this option is used, the
-host and -port options are ignored.
[-{remove_group_roles | rm_grp_roles} value]
Removes roles from groups. Multiple instances of this option can be specified.
Specify the value as one string with the following syntax:
Chapter 6. Managing security

167

groupId[~groupId]*$roleId[~roleId]*

The value must contain at least one sublist separator character ($). For sublists
that contain multiple entries, each entry of the role sublist is removed from
each entry of the group sublist.
[-{remove_project_group_roles | rm_proj_grp_roles} value]
Removes project user roles. Multiple instances of this option can be specified.
Specify the value as one string with the following syntax:
projectName[~projectName]*$groupId[~groupId]*$roleId[~roleId]*

For sublists that contain multiple entries, each entry of the group and role
sublists are removed from each entry of the project sublist. The projectName
values are case sensitive and must be in the format of DSServer/projectID,
where DSServer must match the registered engine name. The name could be
registered as the short host name or as the fully qualified host name with a
domain. Whichever way it is registered, this is how it must be specified here.
You can see the list of project names by using the -list DSPROJECTS option.
[-{remove_project_user_roles | rm_proj_usr_roles} value]
Removes project user roles. Multiple instances of this option can be specified.
Specify the value as one string with the following syntax:
projectName[~projectName]*$userId[~userId]*$roleId[~roleId]*

For sublists that contain multiple entries, each entry of the user and role
sublists are removed from each entry of the project sublist. The projectName
values are case sensitive and must be in the format of DSServer/projectID,
where DSServer must match the registered engine name. The name could be
registered as the short host name or as the fully qualified host name with a
domain. Whichever way it is registered, this is how it must be specified here.
You can see the list of project names by using the -list DSPROJECTS option.
[-{remove_user_roles | rm_usr_roles} value]
Removes roles from users. Multiple instances of this option can be specified.
Specify the value as one string with the following syntax:
userId[~userId]*$roleId[~roleId]*

The value must contain at least one sublist separator character ($). For sublists
that contain multiple entries, each entry of the role sublist is removed from
each entry of the user sublist.
[-{remove_users_group | rm_usr_grp} value]
Removes users from groups. Multiple instances of this option can be specified.
Specify the value as one string with the following syntax:
groupId[~groupId]*$userId[~userId]*

The value must contain at least one sublist separator character ($). For sublists
that contain multiple entries, each entry of the user sublist is removed from
each entry of the group sublist.
[-{results | res} value]
Print all the runtime output to the specified file.
[-{separator | sep} value]
Overrides the default list separator (~). The value can be any single character
other than those listed:
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^ (caret)
& (ampersand)
* (asterisk)
- (dash or hyphen)
| (pipe)
" (quotation mark)
< (less than)
> (greater than)
If you want to specify a character value that has special
meaning to the command shell (for example, # or !), specify the character in
single quotes, such as: -separator '#'. Then, when used in the command shell,
ensure that the special character is escaped, such as \#, or specify the list
within quotation marks.
Linux

UNIX

[-{set_default_ds_credentials | set_dflt_ds_cred} value]
Sets the default InfoSphere Information Server engine credentials. Specify the
value as one string with the following syntax:
credUserId~credPassword

The value must contain at least one separator character (~). The credentials are
set for the server specified by the -datastage_server option. The specified
engine must be registered with InfoSphere Information Server. The password
value can be specified as plain text or as text encrypted with the encrypt
command.
To clear the default credentials, pass a quoted exclamation mark ("!") as either
the credUserId or credPassword values.
[-{set_shared_registry | shr_reg} {ON|OFF}]
Sets the flag that indicates whether InfoSphere Information Server and
InfoSphere DataStage share the same user registry. The valid values are ON or
OFF.
[-{sub_list_separator | sub_list_sep} value]
Overrides the default list separator ($). The value can be any single character
other than those listed:
^ (caret)
& (ampersand)
* (asterisk)
- (dash or hyphen)
| (pipe)
" (quotation mark)
< (less than)
> (greater than)
Linux
UNIX
If you want to specify a character value that has special
meaning to the command shell (for example, # or !), specify the character in
single quotes, such as: -separator '#'. Then, when used in the command shell,
ensure that the special character is escaped, such as \#, or specify the list
within quotation marks.

[-{update_group | upd_grp} value]*
Update an existing group. Multiple instances of this option can be specified.
The group being updated must exist. Specify the value as one string with the
following syntax:
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groupId~name~groupType~webAddress
~location~officePhoneNumber~cellPhoneNumber
~pagerNumber~faxNumber~emailAddress
~businessAddress~organization

Each entry in the value must contain at least one separator character (~). A
value of ‘!‘ specified for a group setting will clear the setting.
[-{update_user | upd_usr} value]
Update an existing user. Multiple instances of this option can be specified. The
user being updated must exist. Specify the value as one string with the
following syntax:
userId~password~firstName~lastName
~title~jobTitle~homePhoneNumber~imName
~location~officePhoneNumber~cellPhoneNumber
~pagerNumber~faxNumber~emailAddress
~businessAddress~organization

Each entry in the value must contain at least one separator character (~). A
value of ‘!‘ specified for a user setting other than password will clear the
setting. The password value can be specified as plain text or as text encrypted
with the encrypt command.
[-{user | usr} value]
The suite administrator user ID running this command. Either the -authfile
option or the -user and -password options are required.
[-{verbose | v}]
Display detailed runtime output other than logging messages.

Example: Writing a script to quickly add users to a typically used
project
Suppose you regularly add new InfoSphere DataStage users to multiple projects
with various group assignments. You could create a script for these operations:
UNIX

Linux

#!/bin/sh
echo Adding a typical DataStage user with the default password.
npass={iisenc}HEf6s6cG+Ee6NdGDQppQNg==
nrole=DataStageUser
prole=DataStageOperator
cmd=/opt/IBM/InformationServer/ASBNode/bin/DirectoryCommand.sh
af=/opt/IBM/InformationServer/ASBNode/conf/isadmin.credentials
echo
read
echo
read
echo
read

New user ID to create:
nuser
First name for the user:
fname
Last name for the user:
lname

$cmd -authfile $af -a_usr $nuser~$npass~$fname~$lname
$cmd -authfile $af -usr_roles $nuser\$$nrole
$cmd -authfile $af -a_usr_grp $nuser\$dsusr~qsusr
$cmd -authfile $af -proj_usr_roles \
HOSTNAME/DSProd~HOSTNAME/DSDev\$$nuser\$$prole
Windows
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@echo off
setlocal
echo Adding a typical DataStage user with the default password.
set
set
set
set
set

npass={iisenc}HEf6s6cG+Ee6NdGDQppQNg==
nrole=DataStageUser
prole=DataStageOperator
cmd=C:\IBM\InformationServer\ASBNode\bin\DirectoryCommand.bat
af=C:\IBM\InformationServer\ASBNode\conf\isadmin.credentials

echo New user ID to create
set /p nuser="--> "
echo First name for the new user
set /p fname="--> "
echo Lastname for the new user
set /p lname="--> "
call %cmd% -authfile %af% -a_usr %nuser%~%npass%~%fname%~%lname%
call %cmd% -authfile %af% -usr_roles %nuser%$%nrole%
call %cmd% -authfile %af% -a_usr_grp %nuser%$dsusr~qsusr
call %cmd% -authfile %af% ^
-proj_usr_roles HOSTNAME/DSProd~HOSTNAME/DSDev$%nuser%$%prole%

In this example, the following values would need to be replaced with actual
values. The groups and projects must be created before running the command.
v dsusr and qsusr: groups that the user is being added to
v HOSTNAME: the registered engine host name or configured DSAlias for the engine.
v DSProd and DSDev: project names that the user is being added to as an InfoSphere
DataStage operator.
This script would create the specified user ID and assign the default password,
which has been encrypted with the encrypt command and pasted into the script.
(You could send e-mail with the plain text password to the user with a request to
change it upon first login.) The DirectoryCommand then assigns the user to the
DataStageUser role. It then assigns the user to the dsusr and qsusr groups. It then
assigns the user to the DSProd and DSDev projects on the InfoSphere Information
Server engine, indicated here as HOSTNAME. And, in the same command, assigns
the user to the DataStageOperator project role.

Example: Using the -file option to migrate users
1. Create the list of users:
DirectoryCommand -authfile admin.creds
-host original_services_tier_host
-port original_services_tier_port
-list ALL -details -results userlist.txt

2. Edit the list of users into a format that the -file option can use:
-add_user TestOper~TempP4ss~TestOperFirst~TestOperLast;
-add_user TestSuOper~TempP4ss~TestSuOperFirst~TestSuOperLast;
-add_user TestProMan~TempP4ss~TestProManFirst~TestProManLast;
-add_user adminUser~TempP4ss~adminUserFirst~adminUserLast;
-add_user wasUser~TempP4ss~wasUserFirst~wasUserLast;
-assign_user_roles TestOper$SuiteUser~DataStageUser~FastTrackUser~GlossaryUser;
-assign_user_roles TestSuOper$SuiteUser~DataStageUser;
-assign_user_roles TestProMan$SuiteUser~DataStageUser;
-assign_user_roles adminUser$SuiteUser~DataStageAdmin;
-assign_user_roles wasUser$SuiteAdmin~DataStageAdmin;
-add_group TestGroup~TestGroup~TestGroup;
-add_users_group TestOper~TestSuOper~TestProMan~adminUser$TestGroup;
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-proj_usr_roles dshost/dstage1~dshost/dstage2$TestOper$DataStageOperator;
-proj_usr_roles dshost/dstage1~dshost/dstage2$TestSuOper$DataStageSuperOperator;
-proj_usr_roles dshost/dstage1~dshost/dstage2$TesProMan$DataStageProductionManager;

3. Run the directory command to migrate the users to the new server:
DirectoryCommand -authfile admin.creds -host new_server
-port new_port -file userlist.txt

Encrypt command
The encrypt command provides a method to encrypt user credentials. The
encrypted strings can be stored in a credentials file or used on the command line
with many IBM InfoSphere Information Server tools.
The command uses Advanced Encryption Standard (AES) 128-bit encryption as the
default provider, which meets US export regulation requirements. You might also
choose to provide your own password encryption algorithm.

Running the encrypt command
You run the encrypt command in a command window to encrypt text strings. The
encrypted and encoded strings can then be used for user credentials in a
credentials file for later use. You can also use the command to encrypt any data
that you want to encrypt. You can use the provided default encryption provider, or
you can set up your own custom encryption provider.

About this task
You run the encrypt command with no parameters or with the text to encrypt as
the first and only parameter. The second option is less secure, especially if your
shell command history is enabled. When you run the encrypt command with no
parameter, you are prompted for a text string, which is hidden from the terminal.
The string that you provide is encrypted with the configured encryption provider,
and the encrypted output is displayed in base64-encoded format, prefixed with an
alias. You then copy and paste the encoded string–including the alias prefix–to
your desired location. The location could be a credentials file or a value for the
password parameter in some commands. When the string is decrypted, the alias
name is used to determine the type of encryption provider that was used.
When you run the encrypt command, use the full path name. The encrypt
command is located in the following locations, depending on which tiers are
installed on your computer:
v

Linux

UNIX

– install_root/InformationServer/ASBNode/bin/encrypt.sh
– install_root/InformationServer/ASBServer/bin/encrypt.sh
v

Windows

– install_root\InformationServer\ASBNode\bin\encrypt.bat
– install_root\InformationServer\ASBServer\bin\encrypt.bat

Procedure
1. Optional: If you have configured your own custom encryption provider, ensure
that you have specified the provider in the appropriate
iis.crypto.site.properties file. You must create the properties file in the conf
directory, under the same parent directory as the encrypt command that you
will run.
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Command location:
install_root\InformationServer\ASBNode\bin\encrypt.bat
Its properties file location:
install_root\InformationServer\ASBNode\conf\iis.crypto.site.properties
Command location:
install_root\InformationServer\ASBServer\bin\encrypt.bat
Its properties file location:
install_root\InformationServer\ASBServer\conf\iis.crypto.site.properties
The contents of the iis.crypto.site.properties file is one entry:
iis.crypto.default.provider=class_of_custom_provider

2. Using the full path name, run the encrypt command, with or without the text
to be encrypted as a parameter. If the text contains spaces, enclose it in
quotation marks.
v Running the encrypt command with the text provided on the command line:
bash$: /opt/IBM/InformationServer/ASBNode/bin/encrypt.sh myPa$$w0rd
bash$: {iisenc}PvqKLr7z3QOLJCQ4QhbrrA==

v Running the encrypt command with a prompt to hide the text:
bash$:
bash$:
bash$:
bash$:

/opt/IBM/InformationServer/ASBNode/bin/encrypt.sh
Enter the text to encrypt:
Enter the text again to confirm:
{iisenc}PvqKLr7z3QOLJCQ4QhbrrA==

3. Copy the encrypted string to a credentials file or as a value to the password
parameter for any of the commands that support it. For example:
v Used in a credentials file:
user=dsadm
password={iisenc}PvqKLr7z3QOLJCQ4QhbrrA==

v Used on the command line:
AppServerAdmin -username isadmin -password {iisenc}YJD9OKOxT2otQvTQFcA1qg==

The credentials file
The credentials file contains user credentials that can be used by many IBM
InfoSphere Information Server commands that support the -authfile option, such
as dsjob, DirectoryCommand, and others.
Attention: Because the credentials file is used to run commands that require a
password, it is essential to store the credentials file in a secure location and hide its
contents. The file must not be readable, writeable, or executable by anyone other
than a user or group with administrator access. Also, users that run commands
that use the credentials file must have the same access as the file.
The credentials file has the following format:
v It must be encoded with your platform default character set or ASCII characters
only.
v Each entry must occupy a whole line without leading and trailing white space.
v The file must contain a user and password entry, although some tools, such as
dsjob support additional name-value pairs, such as domain and server.
v The name and value pairs are separated by an equals sign (=). For example:
name=value

v When a value is specified in encrypted text, it must have been encrypted with
the encrypt command. The encrypted string is prefixed with '{alias}', where alias
is the alias of the encryption provider.
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v When a value is specified in plain, non-encrypted text, the value must not start
with an opening brace ({) nor contain a closing brace (}) in the plain text string.
v You can add comment lines, which must start with the number sign (#).
v If the same key name exists multiple times in the file, the first name-value pair
is used.
A sample credentials file:
# dsadm credentials
user=dsadm
password={iisenc}HEf6s6cG+Ee6NdGDQppQNg==
domain=[2002:920:c000:217:9:32:217:32]:9080
server=RemoteServer

Adding a custom encryption provider
You can create and configure your own encryption provider. If you want to
provide your own encryption, you can do so by creating an implementation of the
EncryptionProvider interface.

Procedure
1. In the JAR file containing your custom class, create a file named
META-INF\services\com.ibm.iis.spi.security.crypto.EncryptionProvider,
which must list the class name of your encryption provider implementation.
The encryption provider is loaded as a service provider. See the Java
documentation for information about service providers.
2. Deploy your class files in the class path of the Java runtime environment.
a. Copy your JAR file to the following directories, depending on the tiers
installed on the computer.
v IS_install_path/ASBNode/lib/java
v IS_install_path/ASBServer/lib/java
b. Add the full paths to these JAR files to the ISF_UTIL_EXT_CP environment
variable. The value of this environment variable is added to the class path
when the encrypt command is run from either of these directories:
v IS_install_path/ASBNode/bin
v IS_install_path/ASBServer/bin
3. To use your new custom encryption provider when you run the encrypt
command, create a file named iis.crypto.site.properties in the following
directories, depending on the tiers installed on the computer.
IS_install_path/ASBNode/conf
IS_install_path/ASBServer/conf
Include the following one-line entry in the file:
iis.crypto.default.provider=class_name_of_your_custom_provider

Results
With these changes, when you run the encrypt command, your custom encryption
provider is used to encrypt the text.
Note: If you have previously created a different custom encryption provider, then
it can still be used to decrypt text that has been encrypted with it. To continue to
use a previous provider along with the new one, you must keep both sets of JAR
files in the class path. You must also ensure that the providers use unique aliases.
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EncryptionProvider interface:
Reference for the interface implemented by encryption providers.
public interface com.ibm.iis.spi.security.crypto.EncryptionProvider

The encrypt and decrypt methods are the encryption and decryption methods for
the provider.
The getAlias method must return a short name (usually an acronym) that uniquely
identifies the encryption provider. This alias can be used by callers to mark the
encrypted data with a prefix in braces ({}) to determine which provider was used
to encrypt the data.IBM InfoSphere Information Server uses the standard Java
service provider mechanism to load the encryption provider from the classpath.
Therefore, the META-INF/services/
com.ibm.iis.spi.security.crypto.EncryptionProvider configuration file must be
created and bundled. The location of the JAR file to use for compilation is
IS_install_path/ASBNode/eclipse/plugins/com.ibm.iis.client/iis_util.jar. See
the Java documentation for information about service providers.
Method summary
Returns

Method

byte[]

decrypt(byte[] encryptedBytes)
The decrypt method takes an encrypted
array of bytes and returns a decrypted array
of bytes.

byte[]

encrypt(byte[] clearBytes)
The encrypt method takes an array of bytes
and returns an encrypted array of bytes.

java.lang.String

getAlias()
Returns the encryption provider alias.

void

initialize(java.util.HashMap initData)
Reserved for future use.

Method detail
getAlias
getAlias()
Returns the encryption provider alias. The encryption provider alias is
alphanumeric ASCII characters, which can contain only [0-9][a-z][A-Z]. It must
uniquely identify the encryption provider. The return value of this method is
used by callers to prefix the encrypted data with {alias_value}. The alias itself
cannot contain opening brace ({) or closing brace (}) characters.
Returns:
String
initialize
initialize(java.util.HashMap initData) throws InitializationException
Reserved for future use.
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Parameters:
java.util.HashMap - initData
Throws:
InitializationException
encrypt
encrypt(byte[] clearBytes)
The encrypt method takes an array of bytes and returns an encrypted array of
bytes.
Parameters:
byte[] - clearBytes
Returns:
byte[]
decrypt
decrypt(byte[] encryptedBytes)
The decrypt method takes an encrypted array of bytes and returns a decrypted
array of bytes.
Parameters:
byte[] - encryptedBytes
Returns:
byte[]
Enabling stronger encryption:
IBM provides Java Cryptography Extension (JCE) unlimited jurisdiction policy files
that allow the use of stronger (longer) key sizes for Java encryption. If you want to
create a custom encryption provider using these stronger key sizes, download and
install the IBM unlimited jurisdiction policy files using the following steps.
About this task
These Java JCE unlimited jurisdiction policy files contain keys that are longer than
128 bits. You can find more information about the encryption algorithms and key
sizes of the IBM JRE and these policy files in Appendixes A, B, and E of the JCE
API Specification & Reference at developerWorks® (http://
publib.boulder.ibm.com/infocenter/javasdk/v6r0/topic/
com.ibm.java.security.component.60.doc/security-component/JceDocs/jce.html).
Procedure
1. From the Security information page at http://publib.boulder.ibm.com/
infocenter/javasdk/v6r0/topic/com.ibm.java.doc.60_26/vm626/
GenericWrapper/securityguide.html, click the IBM SDK Policy files link.
2. Log in with your IBM user ID and password.
3. Select Unrestricted JCE Policy files for Java 5.0 SR16, Java 6 SR13, Java 7 SR4
and later versions and click Continue.
4. Select Unrestricted JCE Policy files and click Continue.
5. If you accept the license, download unrestrict142.zip and extract the
local_policy.jar and US_export_policy.jar files.
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6. Save these two files to the IS_install_path/jdk/jre/lib/security directory
and IS_install_path/jdk/jre/lib/security directories, and replace the
existing files of the same names.
7. Restart the JRE for the new policy to be effective.
What to do next
Create and add a custom implementation of the EncryptionProvider interface that
uses these policy files.

Chapter 6. Managing security

177

178

Administration Guide

Chapter 7. Licensed IBM InfoSphere DataStage editions and
feature packs activation and deactivation
If your entitlement to IBM InfoSphere DataStage editions, trade-up, or feature
packs changes after you have installed IBM InfoSphere Information Server, you
must activate any newly entitled items before you can use them. If you no longer
have entitlements for items, you must deactivate them.
When you install IBM InfoSphere DataStage by using the InfoSphere Information
Server installation program, the program prompts you to select the InfoSphere
DataStage editions and feature packs to install and activate. Each item in the
selection list enables associated InfoSphere DataStage canvases and job features.
Select the items for which you have a valid Proof of Entitlement from IBM. The
installation program activates the features that are associated with the items that
you select. Any other editions or feature packs are deactivated and cannot be used.
If you later acquire entitlements for an additional InfoSphere DataStage edition or
feature pack, to use the features that are included in the item you must activate the
item within InfoSphere Information Server. If you no longer have entitlement for
an item, you must deactivate it. When you deactivate the edition or feature pack,
the features within the item are no longer available for use.
To activate or deactivate an edition or feature pack, use the iisAdmin command.
If you installed InfoSphere DataStage, the full product with all optional features
was installed. However, the installation program activated only the features that
are associated with the edition and features that you selected at install time. If you
acquire entitlements for additional InfoSphere DataStage features, enable them by
using the iisadmin command. Also use the command if you are entitled to an
additional edition or trade up to a different edition.
For example, a company is entitled to IBM InfoSphere DataStage Server, and
enables this item. At a later time, they become entitled to the full functionality of
IBM InfoSphere DataStage from DataStage Server Trade Up. They use the iisadmin
command to enable the full functionality of InfoSphere DataStage.
As another example, a company is entitled to InfoSphere DataStage, and enables
this item. At a later time, they become entitled to the IBM InfoSphere DataStage
Balanced Optimization feature pack. They enable these editions and features by
using the iisadmin command.
The following table lists the InfoSphere DataStage editions and feature packs that
the InfoSphere Information Server installation program can install. The table also
lists the features that are included within each item.
Table 7. InfoSphere DataStage editions and feature packs
Installable item

Features

IBM InfoSphere DataStage

v InfoSphere DataStage job features
v Parallel canvas
v Server canvas

© Copyright IBM Corp. 2007, 2014

179

Table 7. InfoSphere DataStage editions and feature packs (continued)
Installable item

Features

IBM InfoSphere DataStage Server Edition

v InfoSphere DataStage job features
v Server canvas

IBM InfoSphere DataStage Pack for SAS

v SAS features

IBM InfoSphere DataStage Balanced
Optimization

v InfoSphere DataStage balanced
optimization features

If jobs are created that depend upon certain editions or feature packs, and those
editions or feature packs are deactivated, the jobs remain in the repository.
However, they cannot be opened, or cause an error message when opened.

Viewing a list of activated IBM InfoSphere DataStage editions and
feature packs
Run the iisAdmin command to list the activated IBM InfoSphere DataStage editions
and feature packs within your suite.

Before you begin
You must have at least Suite User authority.

About this task
To view a list of activated IBM InfoSphere DataStage editions and feature packs,
use the iisAdmin command. For more information, see iisAdmin command. The
format of the command is as follows:
Linux

UNIX

<IS_install_path>/ASBServer/iisAdmin.sh -display -key
com.ibm.iis.datastage.license.*
Windows

<IS_install_path>\ASBServer\iisAdmin.bat -display -key
com.ibm.iis.datastage.license.*
The command displays a list of the IBM InfoSphere DataStage editions and feature
packs that are installed. If a license key is not shown in the display, then the
capability/product module is not installed. If a license key is listed and the value
is set to 1, then the edition or feature pack is activated. If a license key is listed and
the value is set to 0, then the edition or feature pack is deactivated.
In the following example, com.ibm.iis.datastage.license.option.parallel and
com.ibm.iis.datastage.license.option.qualitystage are installed, but only
com.ibm.iis.datastage.license.option.parallel is activated:
[isadmin ~]$ cd /opt/IBM/InformationServer/ASBServer/bin
[isadmin bin]$ ./iisAdmin.sh -display -key com.ibm.iis.datastage.license.*
com.ibm.iis.datastage.license.option.parallel=1
com.ibm.iis.datastage.license.option.qualitystage=0
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Activating and deactivating IBM InfoSphere DataStage editions and
feature packs
Run the iisAdmin command to change the InfoSphere DataStage features that were
activated when the services tier was installed. The iisAdmin command can activate
or deactivate InfoSphere DataStage editions and feature packs within your suite if
InfoSphere DataStage is installed.

Before you begin
You must have suite administrator authority.

About this task
InfoSphere DataStage
To activate or deactivate an InfoSphere DataStage edition or feature pack
(for example, if you are no longer entitled to an item), you do not use the
IBM InfoSphere Information Server software removal program. Instead,
deactivate them by using the iisAdmin command. For more information,
see iisAdmin command. The format of the command is as follows:
Linux

UNIX

<IS_install_path>/ASBServer/iisAdmin.sh -set -key
<license_key> -value [0,1]
Windows

<IS_install_path>\ASBServer\iisAdmin.bat -set -key
<license_key> -value [0,1]
Table 8. Value of the license key for each product edition or feature pack
Product edition or feature
pack

<license_key> value

InfoSphere DataStage
(parallel and server
engine)

com.ibm.iis.datastage.license.option.parallel

Server engine only

com.ibm.iis.datastage.license.option.server

IBM InfoSphere
QualityStage

com.ibm.iis.datastage.license.option.qualitystage

Balanced Optimization

com.ibm.iis.datastage.license.feature.BAL_OPT

SAS Pack

com.ibm.iis.datastage.license.feature.SAS_PACK

To deactivate an edition or feature pack, set the value of the -value option to 0. To
activate an edition or feature pack, set the value of the -value option to 1
For example, to deactivate InfoSphere DataStage (parallel and server engine), use
the following command:
<IS_install_path>\ASBServer\iisAdmin.bat -set -key
com.ibm.iis.datastage.license.option.parallel -value 0
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Chapter 8. Managing active sessions
In the IBM InfoSphere Information Server Web console, you can view a list of all
the users that are currently connected to the server that you logged in to.

About this task
You can view the starting time of each session and the timestamp of the most
recent action that each user performed. You can force active sessions to end
immediately, which is useful when preparing to stop the system.

Viewing all active sessions
In the IBM InfoSphere Information Server Web console, you can view and manage
the active user sessions.

Before you begin
You must have suite administrator authority.

About this task
A user session is an instance of a user with a connection to the IBM InfoSphere
Information Server. You might want to view all of the active sessions to determine
if you need to set thresholds for the maximum amount of user sessions to allow, to
disconnect one or more users, or to view details about the user who is connecting.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Session Management > Active Sessions. The
Active Sessions pane shows the users who are currently connected to the
server.

Setting session limits
You can set the maximum number of active sessions on the server. You can also
specify how long a session can remain inactive before it is automatically
disconnected and how often the sessions are polled for inactivity.

Before you begin
You must have suite administrator authority.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Session Management > Active Sessions.
3. In the Active Sessions pane, click Global Session Properties.
4. Optional: Specify settings for inactive sessions and maximum number of
sessions.
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5. Click Save and Close.

Opening user details
To view information about a current session that includes the user record, the
duration of the session, and the security roles that are assigned to the user, you can
open the details of a user session.

Before you begin
You must have suite administrator authority.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Session Management > Active Sessions.
3. In the Active Sessions pane, select a user session.
4. Click Open. The Open User Details pane shows detailed information about the
user session.

Disconnecting all sessions
To force all of the active sessions to end immediately, you can disconnect all of the
user sessions. You might want to disconnect all users to prepare for a system
shutdown.

Before you begin
You must have suite administrator authority.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Session Management > Active Sessions.
3. In the Active Sessions pane, click Disconnect All.
4. In the Disconnect All window, click Yes to immediately end all sessions.

Disconnecting a session
You can disconnect an individual user session.

Before you begin
You must have suite administrator authority.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Session Management > Active Sessions.
3. In the Active Sessions pane, select a session. If multiple users signed in with
the same user account, only the selected session is disconnected.
4. Click Disconnect.
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5. Click Yes to immediately end the session.
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Chapter 9. Managing data stores
You can centrally manage the installed data stores that are used by various tools
and product modules in IBM InfoSphere Information Server.
When you install InfoSphere Information Server, you create and register the data
stores needed for the various product modules. The product modules' data stores
are located within one or more databases on one or more database servers.
Regardless of the location of a data store, its name must be unique across all
database servers in InfoSphere Information Server. Likewise, database names must
also be unique.
Although you register data stores during installation of the repository tier, there
might be cases where you want to change and manage the data stores, for
example, if you are moving from test into production or if you want to add
another operations database for an additional engine. There are various tasks for
managing data stores and various reasons for doing each.
Note: The tool to administer data stores is called the RepositoryAdmin tool. In the
following topics, data stores are referred to as repositories to match the name of
the tool.

RepositoryAdmin tool reference
Metadata about the repositories that are used in IBM InfoSphere Information
Server is stored in the metadata repository. The RepositoryAdmin tool is provided
for you to define and manage this metadata for some of the repositories.

Purpose
You can use the installation program to create the repositories used by InfoSphere
Information Server. You can also choose to create some of the repositories as a
post-installation step, for example if you are not using the DB2 database system. If
you do not use the installation program to create a particular repository, you can
use the RepositoryAdmin tool to create the SQL scripts necessary to create and
configure the repository. You also use the tool to register the repository (and its
hosting database, database platform, and database server) with the metadata
repository.
Even after installation, there might be times when you need to manage the
repository registration, such as when you relocate a repository to another server or
if you need to change the connection properties.
You cannot manage the following repositories with the RepositoryAdmin tool:
v Metadata repository
v IBM InfoSphere Metadata Asset Manager staging area
v IBM InfoSphere Information Analyzer analysis databases

Syntax
RepositoryAdmin{.bat|.sh}
[-{connectionManagedDSN | cm} <value>]
[-{connectionName | cn} <value>]
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[-{connectionPassword | cw} <value>]
[-{connectionProperties | cp} <value>]
[-{connectionURL | cr} <value>]
[-{connectionUser | cu} <value>]
[-{databaseType | dt} <value>]
[-{databaseVersion | dv} <value>]
[-{dbName | dn} <value>]
[-{displayDatabase | dd} [<value>]]
[-{displayDatabasePlatform | dp} [<value>]]
[-{displayDatabaseServer | ds} [<value>]]
[-{displayRepository | dr} [<value>]]
[-{displayRepositoryConnection | dc} [<value>]]
[-{help | ?}]
[-{listDatabasePlatforms | lp} [<value>]]
[-{listDatabaseServers | ls} [<value>]]
[-{listDatabases | ld} [<value>]]
[-{listRepositories | lr} [<value>]]
[-{listSQLScripts | lt} [<value>]]
[-{log | l} <value>]
[-{logerror | error} <value>]
[-{loginfo | info} <value>]
[-{loglevel | level} <value>]
[-{propertyFile | pf} <value>]
[-{registerDatabase | rd} [<value>]]
[-{registerDatabaseServer | rs} [<value>]]
[-{registerRepository | rr} [<value>]]
[-{reposContext | ct} <value>]
[-{reposDescription | de} <value>]
[-{reposName | rn} <value>]
[-{reposSchema | sc} <value>]
[-{reposTool | to} <value>]
[-{results | res} <value>]
[-{saveSQLScripts | sss} [<value>]]
[-{scriptLocation | sl} <value>]
[-{scriptName | sn} <value>]
[-{scriptTool | sto} <value>]
[-{scriptType | st} <value>]
[-{serverBinPath | sb} <value>]
[-{serverHost | sh} <value>]
[-{serverPassword | sw} <value>]
[-{serverPort | sp} <value>]
[-{serverUser | su} <value>]
[-{testRepositoryConnection | tc} [<value>]]
[-{unregisterDatabase | urd} [<value>]]
[-{unregisterDatabaseServer | urs} [<value>]]
[-{unregisterRepository | urr} [<value>]]
[-{updateDatabaseServer | us} [<value>]]
[-{updateRepository | ur} [<value>]]
[-{updateRepositoryConnection | uc} [<value>]]
[-{verbose | v}]

Usage
Some of the commonly-used parameters are listed in the topics that follow. The
RepositoryAdmin tool must be run from the services tier. In each of the following
topics, the RepositoryAdmin tool is displayed with just the name of the command
with the Microsoft Windows .bat extension. However, when you run the
command, provide the correct extension for the operating system and the full path
to the command (or include the directory that contains the command in your
PATH environment variable). The full path and extension of the command is as
follows:
Windows

is_install_dir\ASBServer\bin\RepositoryAdmin.bat
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Linux

UNIX

is_install_dir/ASBServer/bin/RepositoryAdmin.sh

List and display options
Use the following options to list and display information about your registered
repositories, databases, database platforms, database servers, and SQL scripts.
The list options list the entities that are registered with the metadata repository.
The display options display information about a particular entity. The display
options can be used to create the properties files that are required for the
registration options.
-listDatabasePlatforms
Shorthand: -lp
Lists the database platforms supported by the current version of IBM
InfoSphere Information Server.
Example command string:
RepositoryAdmin.bat -listDatabasePlatforms

Example output:
DB2 10.5
DB2 10.1
DB2 9.7
DB2 9.5
ORACLE 11g
ORACLE 10g
SQLSERVER 2005
SQLSERVER 2012
SQLSERVER 2008

-listDatabaseServers -databaseType type -databaseVersion version
Shorthand: -ls -dt type -dv version
Lists each of the database servers that are registered with a given database
platform. You can obtain the available database platforms with the
-listDatabasePlatforms option.
Example command string:
RepositoryAdmin.bat -listDatabaseServers -dt DB2 -dv 10.5

Example output:
DB2 10.5 on localhost:50000
DB2 10.5 on host25:1433

-listDatabases
Shorthand: -ld
Lists the registered databases.
Example command:
RepositoryAdmin.bat -listDatabases

Example output:
odb
odb_engine1
odb_engine2
srd
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-listRepositories
Shorthand: -lr
Lists the registered repositories. A repository is implemented as a separate
schema in a given database and has its own set of tablespaces and associated
user connections. In that sense multiple repositories can be collocated in the
same database or be created in separate databases. If the repository context
information was provided when the repository was registered or updated, it
will be displayed next to the repository, as in the first line of the following
example output.
Example command:
RepositoryAdmin.bat -listRepositories

Example output::
odb (production)
srd

-listSQLScripts -databaseType type -databaseVersion version [-scriptTool
tool]
Shorthand: -lt -dt type -dv version [-sto tool]
Lists each of the SQL scripts that are registered with a given tool for a given
database platform. The tool name is optional; if not provided, all available
scripts for the database type and version are listed. You can obtain the
available database platforms with the -listDatabasePlatforms option. The
following tools are available:
DataQualityConsole
DataStage
StandardizationRulesDesigner

Example command string:
RepositoryAdmin.bat -listSQLScripts -dt DB2 -dv 10.5 -sto DataStage

Example output:
dsodb_db_creation
dsodb_drop_tables
dsodb_grant_permissions_newdb
dsodb_grant_permissions_newschema
dsodb_remove_db
dsodb_remove_functions
dsodb_remove_schema
dsodb_remove_user
dsodb_table_creation
dsodb_tablespace_creation
dsodb_upgrade_87to91
dsodb_user_config

-displayDatabasePlatform -databaseType type -databaseVersion version
[-results filename]
Shorthand: -dp -dt type -dv version [-res filename]
Displays details about a particular database platform. The values that you
provide for the type and version must match exactly that which is displayed
with the -listDatabasePlatforms option. The -results option can be used for
all command options to redirect the results to a file; however, it is most useful
for the -display* options to create files to use when registering objects.
Example command:
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RepositoryAdmin.bat -displayDatabasePlatform -dt DB2 -dv 10.5

Example output:
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabasePlatform.jdbcDriverClass=com.ibm.db2.jcc.DB2Driver
DatabasePlatform.jdbcJarFiles=db2jcc.jar,db2jcc_license_cu.jar

-displayDatabaseServer -databaseType type -databaseVersion version
-serverHost hostname [-results filename]
Shorthand: -ds -dt type -dv version -sh hostname [-res filename]
Displays details about a particular database server. The values that you
provide for the type, version, and host name must match exactly that which is
displayed with the -listDatabaseServers option. The -results option can be
used for all command options to redirect the results to a file; however, it is
most useful for the -display* options to create files to use when registering
objects.
Example command:
RepositoryAdmin.bat -displayDatabaseServer -dt DB2 -dv 10.5 -sh localhost

Example output:
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=localhost
DatabaseServer.port=50000
DatabaseServer.binPath=C:\IBM\SQLLIB\BIN
DatabaseServer.adminUser=db2admin
DatabaseServer.adminPassword={iisenc}fwGPejos3/I1QmTGHExwGc==

-displayDatabase -dbName name [-results filename]
Shorthand: -dd -dn name [-res filename]
Displays details about a particular database. The value that you provide for the
name must match exactly that which is displayed with the -listDatabases
option. The -results option can be used for all command options to redirect
the results to a file; however, it is most useful for the -display* options to
create files to use when registering objects.
Example command:
RepositoryAdmin.bat -displayDatabase -dn odb

Example output:
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=localhost
DatabaseServer.port=50000
Database.name=odb
Database.alias=odb
Database.location=C:\

-displayRepository -reposName name [-results filename]
Shorthand: -dr -rn name [-res filename]
Displays details about a particular repository. The name that you provide for
the repository must match exactly the name that is displayed with the
-listRepositories option. The -results option can be used for all command
options to redirect the results to a file; however, it is most useful for the
-display* options to create files to use when registering objects.
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Example command:
RepositoryAdmin.bat -displayRepository -rn odb

Example output:
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=localhost
DatabaseServer.port=50000
Database.name=odb
Database.alias=odb
Database.location=C:\
Repository.name=odb
Repository.description=Production engine ODB.
Repository.tool=DataStage
Repository.context=production
Repository.schema=odb
RepositoryConnection.name=odb
RepositoryConnection.userName=odb
RepositoryConnection.password={iisenc}gwFQseoj24I/SnCFEH+cWg==
RepositoryConnection.connectionURL=jdbc:db2://localhost:50000/odb
RepositoryConnection.managedDataSourceName=odb
Tablespace.name=DSODBSPACE

Tip: You can capture the output produced by the -displayRepository option
to create a properties file that you can use as a starting point to register
another repository. To capture the output, either redirect to a file or provide a
filename with the -results option.
Example:
RepositoryAdmin.bat -displayRepository -rn odb -res odb.properties

Make edits, such as changing the server from 'localhost' to 'testserver' and the
database from 'odb' to 'odb1', then register the new repository.
RepositoryAdmin.bat -registerRepository -propertyFile odb.properties

-displayRepositoryConnection -reposName name [-connectionName name]
[-results filename]
Shorthand: -dc -rn name [-cn name] [-res filename]
Displays details about the connection for a repository. The connection name is
optional as there is only one connection per repository. The -results option
can be used for all command options to redirect the results to a file; however,
it is most useful for the -display* options to create files to use when
registering objects.
Example command:
RepositoryAdmin.bat -displayRepositoryConnection -cn odb -rn odb

Example output:
RepositoryConnection.name=odb
RepositoryConnection.userName=odb
RepositoryConnection.password={iisenc}gwFQseoj24I/SnCFEH+cWg==
RepositoryConnection.connectionURL=jdbc:db2://localhost:50000/odb
RepositoryConnection.managedDataSourceName=odb

Note: Currently, RepositoryConnection.managedDataSourceName is not used
and is optional.
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The option to save SQL scripts
Use the following option to save SQL scripts.
-saveSQLScripts [-databaseType type -databaseVersion version -reposTool
name | -reposName name] [-scriptLocation path]
Shorthand: -sss [-dt type -dv version -to name | -rn name] [-sl path]
Retrieves the SQL scripts associated with a specified tool for a given database
platform. You can provide the tool and database platform as parameters or you
can provide a repository name. If you provide the tool and database platform,
the original scripts will be saved as registered. If you provide a repository
name, the formal script parameters will be replaced with the respective
repository registration properties before the scripts are saved. If you provide a
script location, the files will be saved there.
Example command, using the tool and database platform as parameters:
RepositoryAdmin.bat -saveSQLScripts -dt DB2 -dv 10.5 -to DataStage

This command saves the SQL scripts as they were originally registered without
performing any parameter substitution.
Example command, using the repository and optional script location as
parameters:
RepositoryAdmin.bat -saveSQLScripts -rn odb -sl C:\tmp

This command saves the SQL scripts after first substituting the formal
parameters with the respective repository registration properties. The scripts
are saved in C:\tmp.

Registration options
Use the following options to register repositories, databases, and servers with the
metadata repository.
Each of the registration options requires the use of the -propertyFile option and a
properties file. Some product modules provide property file templates that you can
edit, such as one for an IBM InfoSphere DataStage operations database. Or, if a
repository similar to the one that you want to register has already been registered,
then you can use a display option with the -results parameter to redirect the
output to a file and edit the resulting file. You can also, of course, create the
properties file from scratch. Each of the following options shows an example
properties file with the entries that are required for the particular entity to be
registered.
-registerRepository -propertyFile filename [-saveSQLScripts
[-scriptLocation directory_path]]
Shorthand: -rr -pf filename [-sss [-sl directory_path]]
Registers a repository with the metadata repository. A repository is typically
registered by the installation program during its corresponding tool
installation, or manually as part of an upgrade. New repositories can also be
registered for any given tool after installation, for tools that support multiple
repositories, or as part of the process of relocating an existing repository to a
different database.
The properties file that you provide with the command must contain at least
the properties identifying the database with which the repository is to be
registered, in addition to the full set of required repository properties.
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Example command:
RepositoryAdmin.bat -registerRepository -pf odb.properties

Example of a properties file with the properties needed for repository
registration:
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=localhost
DatabaseServer.port=50000
Database.name=odb
Database.alias=odb
Database.location=C:\
Repository.name=odb
Repository.description=Production engine ODB.
Repository.tool=DataStage
Repository.context=production
Repository.schema=odb
RepositoryConnection.name=odb
RepositoryConnection.userName=odb
RepositoryConnection.password={iisenc}gwFQseoj24I/SnCFEH+cWg==

Tip: It is best to provide the password as an encrypted string by using the
encrypt command, or you can provide a plain text password. The password is
stored in encrypted form, however, and will always be shown as an encrypted
string when you display the repository.
If you have not yet registered a server or database, these will also be registered
when you register the repository. In such a case, however, your properties file
must contain the necessary information associated with the database and
server to be registered.
In this example, a new repository named odb is registered with a database
named odb. If the database is not already registered, then the database is first
registered with the database server on the host localhost for the DB2 10.5
platform. If the database server is not already registered, the database server is
registered so that the new database and repository can be registered with it.
The repository connection is also registered.
If you are registering a new repository, you can provide the -saveSQLScripts
parameter at the same time that you register a repository. By specifying this
parameter, the SQL scripts necessary to create and set up the repository, with
replaced parameters, are saved to disk. For example:
RepositoryAdmin.bat -rr -pf odb.properties -saveSQLScripts

Saving the SQL scripts here is a shortcut to avoid the need to run the
RepositoryAdmin tool again with the -saveSQLScripts parameter.
-registerDatabase -propertyFile filename
Shorthand: -rd -pf filename
Registers a database with the metadata repository. The database is typically
registered by the installation program as part of the repository registration
during the installation process. You can register a database on its own,
independently of any tool after installation, and then register new repositories
with the database later.
The properties file that you provide with the command must contain at least
the properties identifying the database server with which the database is to be
registered, in addition to the full set of required database properties.
Example command:
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RepositoryAdmin.bat -registerDatabase -propertyFile dbsrv.properties

Example properties file:
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=localhost
DatabaseServer.port=50000
Database.name=odb
Database.alias=odb
Database.location=C:\

-registerDatabaseServer -propertyFile filename
Shorthand: -rs -pf filename
Registers a database server with the metadata repository. The database server
is typically registered by the installation program as part of the repository
registration during the installation process. You can register a server on its
own, independently of any tool after installation, and then register new
databases with the server later.
The properties file that you provide with the command must contain at least
the properties identifying the database platform with which the database
server is to be registered, in addition to the full set of required database server
properties.
Example command:
RepositoryAdmin.bat -registerDatabaseServer -propertyFile dbsrv.properties

Example properties file:
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=localhost
DatabaseServer.port=50000
DatabaseServer.binPath=C:\IBM\SQLLIB\BIN
DatabaseServer.adminUser=db2admin
DatabaseServer.adminPassword={iisenc}fwGPejos3/I1QmTGHExwGc==

Tip: It is best to provide the password as an encrypted string by using the
encrypt command, or you can provide a plain text password. The password is
stored in encrypted form, however, and will always be shown as an encrypted
string when you display the database server.

Update options
Use the following options to update registrations of the database repositories,
database servers, and repository connections.
-updateRepository -reposName name [-reposContext name] [-reposTool
tool_name] [-reposSchema schema_name] [-reposDescription "description"]
Shorthand: -ur -rn name [-ct name] [-to name] [-sc name] [-de
"description"]
Updates a repository registration with the information provided. If specified,
the repository tool must match the tool that the repository is used for and the
schema must match the schema of the repository. The repository context and
description can be any string that is useful to you. For example, if you have
multiple operations databases, you might want to add keywords to indicate
the context in which each is used and more fully describe each repository in
the description.
Example command:
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RepositoryAdmin.bat -updateRepository -rn odb -ct QA -de "QA engine ODB"

-updateRepositoryConnection -reposName name [-connectionName name]
[-connectionUser username] [-connectionPassword "password"] [-connectionURL
URL] [-connectionManagedDSN dsnname] [-connectionProperties
{property=value}...]
Shorthand: -uc -rn name [-cn name] [-cw "password"] [-cr URL] [-cm
dsnname] [-cp {property=value}...]
Updates the repository connection registration with the information provided.
The connection name is optional and is a parameter that is used to identify the
connection. It is not a value that can be changed by this command option. The
connection managed DSN name is currently not used. If you are updating a
password, you can provide the plain text password or a string encrypted by
the encrypt command. You can add or modify other connection properties as
well by providing the properties and values. The properties can be specific to a
database or JDBC driver and are intended to be used to handle special cases,
as needed. If you provide more than one property and value combination,
separate them by a semi-colon (;). It's good practice to always test the
connection after updating the connection properties.
Example command that updates a password and sets some additional
properties:
RepositoryAdmin.bat -updateRepositoryConnection -cn odb -rn odb
-cw "{iisenc}gwFQseoj24I/SnCFEH+cWg==" -cp traceFileSize=2621440;traceOption=1

If you want to remove a property, provide the property name without a value
as in the following example.
Example command that removes a property:
RepositoryAdmin.bat -updateRepositoryConnection -cn odb -rn odb -cp traceOption=

The connection URL is normally derived from other registration properties at
runtime, such as when an application attempts to retrieve it to connect to the
repository or when the repository properties are displayed. But you can choose
to explicitly specify the connection URL yourself.
Example command that updates a connection URL:
RepositoryAdmin.bat -updateRepositoryConnection -cn odb -cr
jdbc:db2://localhost:50000/odb
You can also remove the explicitly set connection URL by providing a blank
space as a value. When you do this, the connection URL is again derived from
other properties.
Example command that removes an explicit connection URL:
RepositoryAdmin.bat -updateRepositoryConnection -cn odb -rn odb -cr " "

-updateDatabaseServer -databaseType type -databaseVersion version
-serverHost hostname [-serverPort portnum] [-serverBinPath path]
[-serverUser username] [-serverPassword "password"]
Shorthand: -us -dt type -dv version -sh hostname [-sp portnum] [-sb
path] [-su username] [-sw "password"]
Updates a database server registration with the information provided. You can
update the server port, server bin path, administrator credentials with this
command. Note that the administrator credentials are not required for
registration or by the tool's runtime operations to access the repositories.

196

Administration Guide

However, the credentials might be needed by other processes, such as
migration, and can be set or updated at any time after registration.
Example command:
RepositoryAdmin.bat -updateDatabaseServer -dt DB2 -dv 10.5
-sh localhost -sw "{iisenc}fwGPejos3/I1QmTGHExwGc=="

Tip: It is best to provide the password as an encrypted string by using the
encrypt command, or you can provide a plain text password.

Unregistration options
Repositories, connections, and database servers will be unregistered from the
metadata repository during a normal uninstallation process. However, there are
situations where you can unregister these entities using the RegistrationAdmin
tool, for example, if you relocate a repository.
-unregisterRepository -reposName name
Shorthand: -urr -rn name
Unregisters a repository from the metadata repository. A repository must be
unregistered when its corresponding tool is uninstalled or as part of the
relocation of a registered repository to another database.
Example command:
RepositoryAdmin.bat -unregisterRepository -rn odb

-unregisterDatabase -dbName name
Shorthand: -urd -dn name
Unregisters a database from the metadata repository. A database can be
unregistered only if it does not have any repositories registered with it. To
unregister a database, you must first unregister each of its repositories. You
might want to manually unregister a database when you are relocating all of
its repositories to another database server.
Example command:
RepositoryAdmin.bat -unregisterDatabase -dn odb

-unregisterDatabaseServer -databaseType type -databaseVersion version
-serverHost hostname
Shorthand: -urs -dt type -dv version -sh hostname
Unregisters a database server from the metadata repository. A database server
can be unregistered only if it does not have any databases registered with it. To
unregister a database server, you must first unregister each of its databases.
You might want to manually unregister a database server when you are
relocating all of its databases to another server.
Example command:
RepositoryAdmin.bat -unregisterDatabaseServer -dt DB2 -dv 10.5 -host localhost

The option to test a repository connection
Use the following option to test a repository connection. It's good practice to
always test the connection after updating the connection properties.
-testRepositoryConnection -reposName name -connectionName name
Shorthand: -tc -rn name -cn name
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Tests a repository connection. Provide the names of the repository and
repository connection.
Example command:
RepositoryAdmin.bat -testRepositoryConnection -rn odb -cn odb

RepositoryAdmin tool examples
The following topics show you, step-by-step, how to use the ReposAdmin tool for
different scenarios.

Example: Changing connection properties
In this scenario, you want to update the password for the database user that is
used in the connection.

Before you begin
This procedure only changes the password used in the connection. For the
connection to succeed, first change the password in the database itself. This
example updates the connection password for the IBM InfoSphere QualityStage
standardization rules designer database repository.

Procedure
1. If you do not know the name of the repository to change, first list the
repositories:
cd \IBM\InformationServer\ASBServer\bin
RepositoryAdmin.bat -listRepositories
DSODB
QSSRDDB
ESDB

2. Create a new password by using the encrypt command and copy the returned
string to the clipboard.
encrypt.bat
Enter the text to encrypt:
Enter the text again to confirm:
{iisenc}PsqKLr7z3JOLJCQ4QhbrrA==

3. Update the connection, providing the repository name and password that you
paste from the clipboard.
RepositoryAdmin.bat -updateRepositoryConnection
-cn QSSRDDB -rn QSSRDDB -cw "{iisenc}PsqKLr7z3JOLJCQ4QhbrrA=="

Results
The connection password for the IBM InfoSphere QualityStage standardization
rules designer database is changed. If you are following this example to change the
connection password for the IBM InfoSphere DataStage operations database or IBM
InfoSphere Data Quality Console exceptions database, you must also change its
repository connection file.

Example: Manually registering a repository
In this scenario, you want to manually register a new repository. For example, the
upgrade of an application might require that its repository be manually registered
and created. Using the RepositoryAdmin tool, you register the repository and
generate SQL scripts to use to create and set up the repository.
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About this task
This example assumes that you have done an upgrade and that the upgrade
process requires that you create and register a new repository. This example uses
the Standardization Rules Designer database as an example.

Procedure
1. Create and edit a new repository properties file with the complete information
needed for the new repository. For the Standardization Rules Designer
database, specify the following properties and values in the file.
Property name

Value description

DatabasePlatform.databaseType

Specify the type of database platform to use. The
value must match one of the supported database
platforms, as displayed in the first value on a row of
output from the RepositoryAdmin -ls command.

DatabasePlatform.version

Specify the version of the database platform. The
value must match one of the supported database
platform versions, as displayed in the second value on
a row of output from the RepositoryAdmin -ls
command.

DatabaseServer.host

Specify the hostname of the database server where the
Standardization Rules Designer repository is to be
located.

DatabaseServer.port

Specify the port number of the database server where
the Standardization Rules Designer repository is to be
located.

Database.name

Specify the name of the database where the
Standardization Rules Designer repository is to be
located.

Database.alias

Specify the alias of the database where the
Standardization Rules Designer repository is to be
located. This must match the database name.

Database.location

Specify the file system path location where the
Standardization Rules Designer repository is to be
located.

Repository.name

Specify the name to give the Standardization Rules
Designer repository.

Repository.tool

Specify StandardizationRulesDesigner

Repository.schema

Set this value to match the Repository.userName
value.

RepositoryConnection.name

Set this value to match the Repository.name

RepositoryConnection.userName

Specify the owner user name for the Standardization
Rules Designer repository. Do not use the metadata
repository owner user name (typically xmeta).

RepositoryConnection.password

Specify the password for the repository connection
user name.
Tip: The connection password can be provided as
plain text or as a string encrypted with the encrypt
command.
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Property name

Value description

RepositoryConnection.properties

For Oracle, specify:
SID=Oracle_SID;batchPerformanceWorkaround=true
The Oracle_SID is the unique name of the Oracle
database instance.
You can leave this value blank for other database
systems.

Tablespace.name

Specify QSSRDSPACE.

Example contents of a properties file, which is here called srd.properties:
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=prod1
DatabaseServer.port=50000
Database.name=srd
Database.alias=srd
Database.location=C:\
Repository.name=QSSRDDB
Repository.description=Production Standardization Rules Designer db.
Repository.tool=StandardizationRulesDesigner
Repository.schema=srduser
RepositoryConnection.name=QSSRDDB
RepositoryConnection.userName=srduser
RepositoryConnection.password={iisenc}gwFQseoj24I/SnCFEH+cWg==
Tablespace.name=QSSRDSPACE

2. On the services tier computer, register the new repository and save the SQL
scripts that are required to create and set up the new repository.
RepositoryAdmin.bat -registerRepository -pf srd.properties

3. Generate the SQL scripts that you will use to create the repository. When
complete, search for password entries in the SQL scripts and change the values.
RepositoryAdmin.bat -saveSQLScripts -rn QSSRDDB

The scripts are saved for the respective registered database platform. Relevant
parameters in the scripts are replaced with appropriate values as specified in
the registration, with the exception of password values.
4. If the computer to host the repository is different than the services tier
computer, copy the SQL scripts to the computer to contain the new repository.
5. Run the scripts. For the Standardization Rules Designer database, run the
scripts as indicated in the following steps:
IBM DB2
As the DB2 instance owner, complete the following steps:
a. If you want to create the Standardization Rules Designer repository
in a database that is separate from the metadata repository, run the
following script:
db2 -tf qssrd_db_creation.sql

b. Run the following scripts to create the table space, schema, and
tables that are required for the repository, connecting to the
database as indicated:
db2 -tf qssrd_tablespace_creation.sql
db2 -tf qssrd_permissions_schema_creation.sql
db2 connect to SRD_db_name user SRD_db_user_name
using SRD_db_user_password
db2 -tf qssrd_table_creation.sql
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Oracle Run the following scripts to create the table space, schema, and tables
that are required for the repository:
sqlplus -L system/password@SID @qssrd_tablespace_creation.sql
sqlplus -L system/password@SID @qssrd_user_config.sql SRD_user_password
sqlplus -L system/password@SID @qssrd_table_creation.sql

Microsoft SQL Server
a. If the server to host the Standardization Rules Designer repository
does not host the metadata repository and is not set up for XA
transactions, enable XA transactions by completing steps 1 - 3 in the
topic for your SQL Server version:
v Steps for SQL Server 2008
v Steps for SQL Server 2012
b. If you want to create the Standardization Rules Designer repository
in a database that is separate from the metadata repository, run the
following script:
sqlcmd -b -i qssrdb_db_creation.sql

c. Run the following scripts to set up the repository:
sqlcmd -b -i qssrd_user_config.sql -vPASSWORD=SRD_db_user_password
sqlcmd -b -i qssrdb_table_creation.sql

6. From the services tier, test the connection to the new repository.
RepositoryAdmin.bat -testRepositoryConnection -cn QSSRDDB -rn QSSRDDB

Example: Upgrading the schema of an existing repository
If you are upgrading IBM InfoSphere Information Server, the schema of some of
the databases might require an upgrade. For example, in version 9.1, the IBM
InfoSphere DataStage operations database schema has changed and requires an
upgrade.

About this task
This scenario assumes that you are upgrading the schema for an existing
operations database. You have already run the installation tool to upgrade the
product. You have also manually registered the repository with the metadata
repository. To complete the upgrade, you create and run the SQL scripts to update
the repository with new tables and new columns.

Procedure
1. From the services tier computer, save the SQL scripts related to the operations
database.
RepositoryAdmin.bat -saveSQLScripts -rn odb

2. If the computer that hosts the operations database is different than the services
tier computer, copy the SQL scripts to the computer that contains the database.
To upgrade the schema of the operations database, run the scripts that pertain
to an upgrade operation.

Relocating repositories examples
Follow the examples in this section to relocate the DSODB, QSSRRDB, or ESDB
repositories.
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Example: Relocating DSODB
In this scenario, you want to relocate an InfoSphere DataStage and QualityStage
operations database (DSODB) to a different computer. Perhaps you have just
acquired a computer with more resources and want move the repository to the
new server, using a different host name.

About this task
This scenario assumes that you are relocating the repository from one computer to
another and you are using the same services tier to manage repository registration
in the same metadata repository. In this example, the names of the computers are
different, but the credentials and database properties remain the same. It is also
assumed that you have already relocated the physical database, including the data,
to the new computer using standard backup and restore operations. In addition, it
is assumed that this repository is the only schema in the database. If there are
additional repositories in the database, repeat the process for each repository. The
following process describes the steps that are necessary to update the registration
of the relocated repository.
Note: If this repository schema is located in the metadata repository database and
you are relocating the metadata repository database itself, you would instead
follow the procedures under Changing the metadata repository database host name
and port.

Procedure
1. Log into the services tier computer.
2. If you do not know the name of the existing repository, first list the
repositories: For example:
cd \IBM\InformationServer\ASBServer\bin
RepositoryAdmin.bat -listRepositories
DSODB
QSSRDDB
ESDB

3. Create a repository properties file to use as a template by displaying the
properties and redirecting the output to a file. You need a properties file in
subsequent steps to register the new repository. For example
RepositoryAdmin.bat -displayRepository -rn DSODB -res DSODB.properties

Example contents of the DSODB.properties file:
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=server1
DatabaseServer.port=50000
Database.name=DSODB
Database.alias=DSODB
Database.location=C:\
Repository.name=DSODB
Repository.description=Operations Database repository.
Repository.tool=DataStage
Repository.context=operations
Repository.schema=DSODB
RepositoryConnection.userName=DSODB
RepositoryConnection.password={iisenc}gwFQseoj24I/SnCFEH+cWg==
RepositoryConnection.connectionURL=jdbc:db2://test1:50000/DSODB

4. Edit the DSODB.properties file with the values to use for the new computer. In
this example, only the host name is changed. If you have also renamed the
database or repository, change those values as well. If the database is not
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configured for high availability, remove the connection URL property. The tool
can derive the URL from other properties in the file.
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=server2
DatabaseServer.port=50000
Database.name=DSODB
Database.alias=DSODB
Database.location=C:\
Repository.name=DSODB
Repository.description=Operations Database repository.
Repository.tool=DataStage
Repository.context=operations
Repository.schema=DSODB
RepositoryConnection.userName=DSODB
RepositoryConnection.password={iisenc}gwFQseoj24I/SnCFEH+cWg==

5. Unregister the existing repository. Because your new repository will have the
same name as the existing registered repository, you must first unregister the
existing repository. Repository names must be unique.
RepositoryAdmin.bat -unregisterRepository -rn DSODB

6. Register the new server, database, and repository by using the edited properties
file. For this step, you need only register the repository. When you register a
repository with the RepositoryAdmin tool, if the server and database have not
yet been registered, they will be registered during the same operation.
RepositoryAdmin.bat -registerRepository -pf DSODB.properties

7.

On each engine tier, update the connection configuration file with the
connection information for the new repository. Run the RegistrationCommand
tool from the directory that corresponds to the repository as in the following
example:
cd /opt/IBM/InformationServer/Server/DSODB
../../ASBNode/bin/RegistrationCommand.sh -get_config
-authfile isadmin.credentials -rp DSODB -cf DSODBConnect.tmpl
-res DSODBConnect.cfg

With the -cf option, the connection details for the repository that correspond to
the parameters in the configuration template file (.tmpl file) replace the
variable names in the template, and the result is written to the output file (.cfg
file). The following parameters will be replaced if values for them are found:
@DBTYPE@, @DRIVER_CLASS@, @DRIVER_JARFILES@, @CONNECTION_URL@,
@DATABASE_USER@, @PASSWORD@.
8. From the services tier, test the connection to the new repository.
RepositoryAdmin.bat -testRepositoryConnection -rn DSODB -cn DSODB

Note: For more information about testing this command, refer to the following
topic Checking the configuration of the monitoring system
9. Repeat the procedure for each repository that you want to relocate. If you are
migrating all of your repositories from one or more databases to others or from
one or more servers to others, unregister the original databases or servers, and
drop the original databases. Use caution, though, because when you unregister
a database, it unregisters all repositories in the database. Likewise, when you
unregister a server, it unregisters all databases on the server. For example, the
following command will unregister server1 and all databases and repositories
on that server; therefore, you would want to first register all of your
repositories on the new server before running the command.
RepositoryAdmin.bat -unregisterDatabaseServer -dt DB2 -dv 10.5 -sh server1

Chapter 9. Managing data stores

203

However, if you do unregister an old repository before registering the new one,
it only means that you would need to create a properties file from scratch to
register the new repository. Completing the unregistration process last means
that you can first use the -displayRepository command option to create a
template file to work with and save you some work, as described in this task.

Example: Relocating QSSRDDB
In this scenario, you want to relocate IBM InfoSphere QualityStage Standardization
Rules Designer database (QSSRDDB) to a different computer. Perhaps you have
just acquired a computer with more resources and want move the database to the
new server, using a different host name.

About this task
This scenario assumes that you are relocating the repository from one computer to
another and you are using the same services tier to manage repository registration
in the same metadata repository. In this example, the names of the computers are
different, but the credentials and database properties remain the same. It is also
assumed that you have already relocated the physical database, including the data,
to the new computer using standard backup and restore operations. In addition, it
is assumed that this repository is the only schema in the database. If there are
additional repositories in the database, repeat the process for each repository. The
following process describes the steps that are necessary to update the registration
of the relocated repository.
Note: If this repository schema is located in the metadata repository database and
you are relocating the metadata repository database itself, you would instead
follow the procedures under Changing the metadata repository database host name
and port.

Procedure
1. Log into the services tier computer.
2. If you do not know the name of the existing repository, first list the
repositories: For example:
cd \IBM\InformationServer\ASBServer\bin
RepositoryAdmin.bat -listRepositories
DSODB
QSSRDDB
ESDB

3. Create a repository properties file to use as a template by displaying the
properties and redirecting the output to a file. You need a properties file in
subsequent steps to register the new repository.
RepositoryAdmin.bat -displayRepository -rn QSSRDDB -res QSSRDDB.properties

Example contents of the QSSRDDB.properties file:
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=server1
DatabaseServer.port=50000
Database.name=QSSRDDB
Database.alias=QSSRDDB
Database.location=C:\
Repository.name=QSSRDDB
Repository.description=Standardization Rules Designer repository.
Repository.tool=StandardizationRulesDesigner
Repository.context=rules designer
Repository.schema=QSSRDDB
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RepositoryConnection.userName=QSSRDDB
RepositoryConnection.password={iisenc}gwFQseoj24I/SnCFEH+cWg==
RepositoryConnection.connectionURL=jdbc:db2://test1:50000/QSSRDDB

4. Edit the QSSRDDB.properties file with the values to use for the new computer.
In this example, only the host name is changed. If you have also renamed the
database or repository, change those values as well. If the database is not
configured for high availability, remove the connection URL property. The tool
can derive the URL from other properties in the file.
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=prod1
DatabaseServer.port=50000
Database.name=QSSRDDB
Database.alias=QSSRDDB
Database.location=C:\
Repository.name=QSSRDDB
Repository.description=Standardization Rules Designer repository.
Repository.tool=StandardizationRulesDesigner
Repository.context=rules designer
Repository.schema=QSSRDDB
RepositoryConnection.userName=QSSRDDB
RepositoryConnection.password={iisenc}gwFQseoj24I/SnCFEH+cWg==

5. .Unregister the existing repository Because your new repository will have the
same name as the existing registered repository, you must first unregister the
existing repository. Repository names must be unique.
RepositoryAdmin.bat -unregisterRepository -rn QSSRDDB

6. Register the new server, database, and repository by using the edited properties
file.For this step, you need only register the repository. When you register a
repository with the RepositoryAdmin tool, if the server and database have not
yet been registered, they will be registered during the same operation.
RepositoryAdmin.bat -registerRepository -pf QSSRDDB.properties

7. From the services tier, test the connection to the new repository.
RepositoryAdmin.bat -testRepositoryConnection -rn QSSRDDB -cn QSSRDDB

Note: For more information about testing this command, refer to the following
topic Checking the configuration of the monitoring system
8. Modify the connection properties in the WebSphere Application Server
administrative console so that the repository database can be found when
WebSphere Application Server starts. Follow the instructions in to complete this
step.
9. Repeat the procedure for each repository that you want to relocate. If you are
migrating all of your repositories from one or more databases to others or from
one or more servers to others, unregister the original databases or servers, and
drop the original databases. Use caution, though, because when you unregister
a database, it unregisters all repositories in the database. Likewise, when you
unregister a server, it unregisters all databases on the server. For example, the
following command will unregister server1 and all databases and repositories
on that server; therefore, you would want to first register all of your
repositories on the new server before running the command.
RepositoryAdmin.bat -unregisterDatabaseServer -dt DB2 -dv 10.5 -sh server1

However, if you do unregister an old repository before registering the new one,
it only means that you would need to create a properties file from scratch to
register the new repository. Completing the unregistration process last means
that you can first use the -displayRepository command option to create a
template file to work with and save you some work, as described in this task.
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Example: Relocating ESDB
In this scenario, you want to relocate an IBM InfoSphere Data Quality Console
exceptions database (ESDB) to a different computer. Perhaps you have just
acquired a computer with more resources and want move the database to the new
server, using a different host name.

About this task
This scenario assumes that you are relocating the repository from one computer to
another and you are using the same services tier to manage repository registration
in the same metadata repository. In this example, the names of the computers are
different, but the credentials and database properties remain the same. It is also
assumed that you have already relocated the physical database, including the data,
to the new computer using standard backup and restore operations. In addition, it
is assumed that this repository is the only schema in the database. If there are
additional repositories in the database, repeat the process for each repository. The
following process describes the steps that are necessary to update the registration
of the relocated repository.
Note: If this repository schema is located in the metadata repository database and
you are relocating the metadata repository database itself, you would instead
follow the procedures under Changing the metadata repository database host name
and port.

Procedure
1. Log into the services tier computer.
2. If you do not know the name of the existing repository, first list the
repositories: For example:
cd \IBM\InformationServer\ASBServer\bin
RepositoryAdmin.bat -listRepositories
DSODB
QSSRDDB
ESDB

3. Create a repository properties file to use as a template by displaying the
properties and redirecting the output to a file. You need a properties file in
subsequent steps to register the new repository.
RepositoryAdmin.bat -displayRepository -rn ESDB -res ESDB.properties

Example contents of the ESDB.properties file:
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=server1
DatabaseServer.port=50000
Database.name=ESDB
Database.alias=ESDB
Database.location=C:\
Repository.name=ESDB
Repository.description=Exception Stage repository
Repository.tool=DataQualityConsole
Repository.context=test
Repository.schema=ESDB
RepositoryConnection.userName=ESDB
RepositoryConnection.password={iisenc}gwFQseoj24I/SnCFEH+cWg==
RepositoryConnection.connectionURL=jdbc:db2://test1:50000/ESDB

4. Edit the ESDB.properties file with the values to use for the new computer. In
this example, only the host name is changed. If you have also renamed the
database or repository, change those values as well. If the database is not
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configured for high availability, remove the connection URL property. The tool
can derive the URL from other properties in the file.
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=server2
DatabaseServer.port=50000
Database.name=ESDB
Database.alias=ESDB
Database.location=C:\
Repository.name=ESDB
Repository.description=Exception Stage repository.
Repository.tool=DataQualityConsole
Repository.context=
Repository.schema=ESDB
RepositoryConnection.userName=ESDB
RepositoryConnection.password={iisenc}gwFQseoj24I/SnCFEH+cWg==

5. Unregister the existing repository. Because your new repository will have the
same name as the existing registered repository, you must first unregister the
existing repository. Repository names must be unique.
RepositoryAdmin.bat -unregisterRepository -rn ESDB

6. Register the new server, database, and repository by using the edited properties
file. For this step, you need only register the repository. When you register a
repository with the RepositoryAdmin tool, if the server and database have not
yet been registered, they will be registered during the same operation.
RepositoryAdmin.bat -registerRepository -pf ESDB.properties

7. On each engine tier, update the connection configuration file with the
connection information for the new repository. Run the RegistrationCommand
tool from the directory that corresponds to the repository as in the following
example:
cd /opt/IBM/InformationServer/Server/ESDB
../../ASBNode/bin/RegistrationCommand.sh -get_config
-authfile isadmin.credentials -rp ESDB -cf ESDBConnect.tmpl
-res ESDBConnect.cfg

With the -cf option, the connection details for the repository that correspond to
the parameters in the configuration template file (.tmpl file) replace the
variable names in the template, and the result is written to the output file (.cfg
file). The following parameters will be replaced if values for them are found:
@DBTYPE@, @DRIVER_CLASS@, @DRIVER_JARFILES@, @CONNECTION_URL@,
@DATABASE_USER@, @PASSWORD@.
8. From the services tier, test the connection to the new repository.
RepositoryAdmin.bat -testRepositoryConnection -rn ESDB -cn ESDB

9. Repeat the procedure for each repository that you want to relocate. If you are
migrating all of your repositories from one or more databases to others or from
one or more servers to others, unregister the original databases or servers, and
drop the original databases. Use caution, though, because when you unregister
a database, it unregisters all repositories in the database. Likewise, when you
unregister a server, it unregisters all databases on the server. For example, the
following command will unregister server1 and all databases and repositories
on that server; therefore, you would want to first register all of your
repositories on the new server before running the command.
RepositoryAdmin.bat -unregisterDatabaseServer -dt DB2 -dv 10.5 -sh server1

However, if you do unregister an old repository before registering the new one,
it only means that you would need to create a properties file from scratch to
register the new repository. Completing the unregistration process last means
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that you can first use the -displayRepository command option to create a
template file to work with and save you some work, as described in this task.

Example: Changing host name configuration for repositories
If the host name of the server that hosts certain repositories changes, you must
modify the configuration for the repositories that are associated with that host.

About this task
Follow these instructions for repositories that are managed by the RepositoryAdmin
tool.
Do not follow this procedure if you are changing the host name of the server that
hosts the metadata repository or any other repositories that exist in the metadata
repository database. If you want to change the host name for the metadata
repository database, follow the steps under Changing the metadata repository
database host name and port.

Procedure
1. List the repositories that are registered to the server. For example:
cd \IBM\InformationServer\ASBServer\bin
RepositoryAdmin.bat -listRepositories
DSODB
QSSRDDB
ESDB

2. For each repository that was listed in step 1, create a repository properties file.
By inspecting the values in the properties file, you can determine which
repositories are registered to the host name that you are changing. You create a
properties file by displaying the properties and redirecting the output to a file.
For example:
RepositoryAdmin.bat -displayRepository -rn DSODB -res DSODB.properties

Contents of the DSODB.properties file:
DatabasePlatform.databaseType=DB2
DatabasePlatform.version=10.5
DatabaseServer.host=server1
DatabaseServer.port=50000
Database.name=DSODB
Database.alias=DSODB
Database.location=C:\
Repository.name=DSODB
Repository.description=Test engine DSODB.
Repository.tool=DataStage
Repository.context=test
Repository.schema=DSODB
RepositoryConnection.userName=DSODB
RepositoryConnection.password={iisenc}gwFQseoj24I/SnCFEH+cWg==
RepositoryConnection.connectionURL=jdbc:db2://test1:50000/DSODB

The host name is represented by the DatabaseServer.host parameter. In this
example, the host name for the DSODB repository is server1.
Run this command for each repository that was listed in step 1
3. Review the value of the DatabaseServer.host parameter in each properties file
to determine whether the repository is registered to the host that is changing.
4. Edit the properties files for each repository that is registered to the host that is
being changed to specify the new host name. Make the following changes in
each properties file:
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a. Modify DatabaseServer.host to specify the new host name.
b. Remove the entry for the RepositoryConnection.connectionURL property.
This property will be automatically regenerated with the new hostname.
Note: If the RepositoryConnection.connectionURL was a custom URL
previously created for use in a high-availability database configuration, then
edit the value of the URL in the properties file, instead of removing the
entry altogether.
5. Unregister all databases and repositories registered to the server by
unregistering the host. See unregister the server host. For example:
RepositoryAdmin.bat -unregisterDatabaseServer -dt DB2 -dv 10.5 -sh server1

6. Reregister each repository with the RepositoryAdmin tool, using the modified
properties files. The reregistration process also registers the new host and
associated database. For example:
RepositoryAdmin.bat -registerRepository -pf DSODB.properties

7. On the engine tier, complete the following actions, depending on the type of
repository that is affected:
For DSODB or ESDB:
Run the RegistrationCommand tool to recreate the .cfg file with the new
hostname and connection URL. (DSODBConnection.cfg or
ESDBConnection.cfg). For example:
cd /opt/IBM/InformationServer/Server/DSODB
../../ASBNode/bin/RegistrationCommand.sh -get_config
-authfile isadmin.credentials -rp DSODB -cf DSODBConnect.tmpl
-res DSODBConnect.cfg

For QSSRDDB:
Modify the connection properties in the WebSphere Application Server
administrative console so that the repository database can be found
when WebSphere Application Server starts. Follow the instructions in to
complete this step.
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Chapter 10. Managing clusters and high availability
configurations
If you have implemented clustering or other high availability configurations within
your IBM InfoSphere Information Server installation, administer them by using
administration tools.

Active-passive configuration administration
If your engine tier (or all tiers) is set up in an active-passive configuration,
administer the cluster by using the administration tools that are provided with
your high availability software.
For more information about active-passive configurations, see "Creating a
two-server active-passive high availability topology" in the IBM InfoSphere
Information Server Planning, Installation, and Configuration Guide.

Administering an active-passive configuration based on Tivoli
System Automation for Multiplatforms
For information about managing an active-passive configuration that is based on
Tivoli® System Automation for Multiplatforms, refer to the Tivoli documentation.
For documentation for Tivoli System Automation for Multiplatforms, see the Tivoli
System Automation for Multiplatforms documentation page at
www.ibm.com/developerworks/wikis/display/tivolidoccentral/
Tivoli+System+Automation+for+Multiplatforms.

WebSphere Application Server cluster administration
Administer and maintain your IBM WebSphere Application Server clusters after
you have installed or updated IBM InfoSphere Information Server in a clustered
environment. This documentation assumes that you understand WebSphere
Application Server clustering.
Important: The IBM InfoSphere Information Server documentation assumes that
you are already familiar with distributed computing, particularly with WebSphere
Application Server clustering. You must familiarize yourself with the IBM
WebSphere Application Server Network Deployment documentation.

WebSphere Application Server cluster administration tools
You use the following tools to install, configure, and administer IBM WebSphere
Application Server clusters.
This information assumes that you have completed the required procedures for
installing a highly available clustered configuration. For more information, refer to
the IBM InfoSphere Information Server Planning, Installation, and Configuration Guide.
WebSphere Application Server administrative console
The WebSphere Application Server administrative console is a Web
interface that provides configuration, operation, and administration
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capabilities. You can use the administrative console to start and stop an
application, deploy an application, configure resources, and implement
security configurations.
Use this tool to create a cluster and configure its members, nodes, and
processes. If you are interested in using scripts to accomplish these tasks,
see the IBM WebSphere Application Server Network Deployment
documentation:
v For IBM WebSphere Application Server Network Deployment, Version
8.5: http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/
index.jsp?topic=/com.ibm.websphere.nd.multiplatform.doc/ae/
welc6topscripting.html
WebSphere Application Server Launchpad
The WebSphere Application Server Launchpad identifies components on
the WebSphere Application Server product media (disk or download) that
you can install. It is the single point of reference for installing the
WebSphere Application Server environment, an integrated platform that
contains an application server, a Web server, a set of Web development
tools, and additional supporting software and documentation.
Use this tool to install WebSphere Application Server and a front-end Web
server if you are creating a clustered WebSphere Application Server
configuration.
WebSphere Edge Components Launchpad
The WebSphere Application Server Edge Components Launchpad contains
a software load balancer. You can use this tool to front an IBM WebSphere
Application Server Network Deployment cluster instead of using the IBM
HTTP Server.
For information about WebSphere Edge Components, Version 8.5, refer to:
http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/topic/
com.ibm.websphere.edge.doc/lb/welcome_edge.html
Profile Management tool
The Profile Management tool performs the initial setup of WebSphere
Application Server cells and nodes. The Profile Management tool creates
batch jobs, scripts, and data files that you can use to do WebSphere
Application Server customization tasks.
Use this tool to create a deployment manager profile and a custom profile.
InfoSphere Information Server installation program
The InfoSphere Information Server installation program detects the
deployment manager process that is installed as a prerequisite on your
computer and prompts you for the information that it needs to run a
cluster installation.
Use this tool during the installation process to specify the WebSphere
Application Server directory location, deployment manager profile, and the
host name and port number of the front-end Web server or load balancer.
For more information about WebSphere Application Server, see the WebSphere
Application Server documentation:
v IBM WebSphere Application Server, Version 8.5: publib.boulder.ibm.com/
infocenter/wasinfo/v8r5/topic/com.ibm.websphere.nd.multiplatform.doc/ae/
welcome_ndmp.html
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Propagating the plugin-cfg.xml file to the front-end Web server
The plugin-cfg.xml file is used by the front-end Web server at runtime to perform
workload management across the cluster. You must update and propagate this file
to the Web server when a new member is added to the cluster or when a new J2EE
application is deployed in the cluster.

Before you begin
If you are unfamiliar with HTTP servers in an IBM WebSphere Application Server
Network Deployment environment, read the following IBM WebSphere Application
Server Network Deployment information center topic:
v For IBM WebSphere Application Server Network Deployment, Version 8.5:
http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=/
com.ibm.websphere.nd.doc/ae/twsv_plugin.html

About this task
The plugin-cfg.xml file is a configuration file that is generated by IBM WebSphere
Application Server Network Deployment. It is in the
<webserver_plugin_install_path>/config/<webserver_definition> path, for
example, C:/IBM/HTTPServer/Plugins/config/webserver1.
It is used at run time by the front-end Web server to perform workload
management across the cluster. The file is on the computer where the Web server is
installed. This file must be kept up-to-date at all times in order for Workload
Management to be correctly implemented at the Web level. Regenerate and
propagate the plugin-cfg.xml file when the following events occur:
v The services tier of the suite is installed for the first time.
v A product of the suite is newly installed as an add-on.
v A product of the suite is removed after an uninstallation.
v A new member is added to the cluster.
v A new IBM InfoSphere Information Services Director application is generated
and deployed in the cluster.
v The front-end Web server is replaced by another Web server.
To facilitate the management of this configuration file, IBM WebSphere Application
Server Network Deployment can automatically propagate the plugin-cfg.xml file
to the Web server. Depending on your Web server topology, this automation might
not always be possible. You might have to regenerate and propagate this file to the
Web server computer manually. There are three possible scenarios:
v Scenario 1: The Web server is installed in a managed node.
In this case, the plugin-cfg.xml file is automatically regenerated and propagated
by the IBM WebSphere Application Server Network Deployment to the managed
node hosting the Web server. It might take a few minutes for WebSphere
Application Server to regenerate and propagate the plugin file to the Web server.
You do not need to propagate the plugin-cfg.xml file because this step is
completed for you.
v Scenario 2: The Web server is installed in an unmanaged node (in other words,
there is no node agent to manage the Web server definition).
In this case, IBM WebSphere Application Server Network Deployment can not
automatically propagate the plugin-cfg.xml file to the Web server, so you need
to manually propagate it.
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v Scenario 3: The Web server is installed in an unmanaged node and is the IBM
HTTP Server (IHS).
In this special case, the plugin-cfg.xml file also is automatically propagated by
IBM WebSphere Application Server Network Deployment to the unmanaged
node that hosts IHS. This functionality is achieved because of the IHS
administration process that runs on the Web server computer, which can act as a
node agent for the Web server.

Procedure
To manually propagate the plugin-cfg.xml file:
For the appropriate topology (either a remote distributed installation scenario or a
local distributed installation scenario), refer to the sections about regenerating the
plugin-cfg.xml file and propagating the plugin-cfg.xml file in the following topic:
v IBM WebSphere Application Server Network Deployment 8.5:
http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=/
com.ibm.websphere.nd.doc/ae/tins_road_plugins.html
For more information about managed and unmanaged nodes in IBM WebSphere
Application Server Network Deployment, see the following resource:
v Information about Nodes in the IBM WebSphere Application Server Network
Deployment 8.5 information center: http://publib.boulder.ibm.com/infocenter/
wasinfo/v8r5/index.jsp?topic=/com.ibm.websphere.nd.multiplatform.doc/ae/
cagt_node.html

Creating and reconfiguring new cluster members
When IBM InfoSphere Information Server is installed within a cluster, it configures
the cluster with appropriate settings required for proper InfoSphere Information
Server operation. When additional cluster members are added, these settings are
automatically copied to the new cluster members so that they are properly enabled
for use by InfoSphere Information Server. If you remove all members from your
cluster, additional manual steps are required to then create new cluster members
that are properly configured for use by InfoSphere Information Server.

About this task
To create new cluster members, you use the IBM_Information_Server_template to
create the cluster member and, if necessary, you run the reconfigure_was_cluster
script to add the required settings.
You can create a cluster by using either the server or cluster option. If you use the
server option, all the data sources are propagated properly. If you use the cluster
option, then all the key resources will be deleted, and the
reconfigure_was_cluster script is used to recover some of the deleted resources,
but not all of them. Therefore, it is recommended to use the server option.
Important: The server option is the only option that guarantees that the system is
in the proper state.
Follow this task only to add cluster members when all existing cluster members
have been removed subsequent to an InfoSphere Information Server installation.
However, it is assumed that no other configured InfoSphere Information Server
resources have been removed. If any of the following resources have been
removed, you must instead reinstall InfoSphere Information Server to restore them.
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v The InfoSphere Information Server shared library:
Environment > Shared Libraries > IBM_Information_Server_iis
v The InfoSphere Information Server security domain:
Security > Security Domains > IBM_Information_Server_sd
v The actual cluster on which InfoSphere Information Server has been installed:
Servers > Clusters > WebSphere application server clusters > <cluster_name>
v The InfoSphere Information Server applications:
Applications > All applications > <list_of_applications>
(applications such as isf-launchpad, isf-server-rest2, and isf-servlets)

Procedure
1. Log in to he IBM WebSphere Application Server administrative console and
select Servers > Clusters > WebSphere application server clusters. Select the
cluster that currently contains no cluster members.
2. Begin the process of creating a new cluster member by selecting one of the
following options to determine how the server resources are promoted to the
cluster:
v Server - Select this option to maintain the server resources at the new cluster
member level. The cluster resources remain unchanged.
v Cluster - Select this option to move the resources of the first cluster member
to the cluster level. The resources of the first cluster member replace the
resources of the cluster.
Note: You would later run the reconfigure_was_cluster script only if you
choose the Cluster option.
For more information on adding new cluster members, see Adding members to
a cluster in the WebSphere Application Server documentation.
3. If you selected the Server option, complete the following steps:
a. Create a new cluster member by clicking New. Use the WebSphere
Application Server administrator credentials.
b. Start the cluster by navigating to Servers > Clusters > WebSphere
application server clusters and clicking Start.
c. If the web server is on a managed node, stop the server, generate a plug-in,
propagate the plug-in, and then start the selected web server from Servers >
Server Types > Web servers.
d. Log in to the IBM InfoSphere Information Server Web console
https://<hostname>:<port>/ibm/iis/console

Note: If you are using an HTTP server as the front-end dispatcher for your
cluster, regenerate and propagate the plugin-cfg.xml file. You need this for
the front-end web server workload management plug-in to take into
account the new cluster member. Regenerate and propagate the
plugin-cfg.xml file to the front-end Web server as described in Propagating
the plugin-cfg.xml file to the front-end web server.
4. If you selected the Cluster option, complete the following steps:
Note: When this option is selected, all the JDBC resources defined at the
cluster level are gone. In this case, the reconfigure_was_cluster script can be
used to recreate the minimum required data sources and JDBC sources.
a. Create a new cluster member by clicking New. Use the WebSphere
Application Server administrator credentials.
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b. Run the reconfigure_was_cluster script with the WebSphere Application
Server administrator credentials. (The ⇒ character indicates a line
continuation.)
Linux

UNIX

cd IS_install_path/ASBServer/bin
./reconfigure_was_cluster.sh -username <was_admin_user> ⇒
-password <was_admin_pass>
Windows

cd IS_install_path\ASBServer\bin
reconfigure_was_cluster.bat -username <was_admin_user> ⇒
-password <was_admin_pass>

Note: This step is mandatory to map the required InfoSphere Information
Server data sources present at the server level to the cell level. Without this
step, accessing the IBM InfoSphere Information Server Web console might
give an exception.
c. Start the cluster by navigating to Servers > Clusters > WebSphere
application server clusters and clicking Start.
d. If the web server is on a managed node, stop the server, generate a plug-in,
propagate the plug-in, and then start the selected web server from Servers
> Server Types > Web servers.
e. Log in to the IBM InfoSphere Information Server Web console
https://<hostname>:<port>/ibm/iis/console

Note: If you are using an HTTP server as the front-end dispatcher for your
cluster, regenerate and propagate the plugin-cfg.xml file. You need this for
the front-end web server workload management plug-in to take into
account the new cluster member. Regenerate and propagate the
plugin-cfg.xml file to the front-end Web server as described in Propagating
the plugin-cfg.xml file to the front-end web server.

Adding a new managed node
You create a new managed node to expand the scope of a cluster.This procedure is
horizontal clustering or scaling out.

Before you begin
v Ensure that the Deployment Manager is running. If it is not running, start it as
described in “Starting the IBM WebSphere Application Server Deployment
Manager (Windows)” on page 257 or “Starting the IBM WebSphere Application
Server Deployment Manager (Linux, UNIX)” on page 260.
Important: Ensure that the clock of the system where you want to create a new
managed node is synchronized with the Deployment Manager system clock and
the other node systems. When the clocks of the various node computers are not
synchronized, multiple problems can arise at run time. Verify that the clocks on
all systems are synchronized by using the universal date and time.

Procedure
1.
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Linux
Configure file descriptor resources on the node as described in
“Configuring file descriptor resources for IBM WebSphere Application Server
(Linux)” on page 261.

2.

AIX
Unset the LDR_CNTRL variable on the node as described in
“Configuring memory allocation for IBM WebSphere Application Server (AIX)”
on page 261.

3. Create a custom profile on the node agent computer by using the Profile
Management Tool. Follow the steps in the IBM InfoSphere Information Server
Planning, Installation, and Configuration Guide.
Remember: When you create a custom profile, on the Federation page, specify
a WebSphere Application Server administrator user name and password to
connect to the Deployment Manager.
Note: Do not select the Federate this node later check box.
4. Create a cluster member (for example, "server3") on the node agent machine.
Follow the steps in the IBM InfoSphere Information Server Planning, Installation,
and Configuration Guide.
Note: When selecting the node to create the cluster member, on the Create
additional cluster members page, make sure to select the new managed node
that you created in the previous step.
5. Synchronize the new managed node. Run the syncNode WebSphere Application
Server command from the computer that hosts the managed node. You must
specify the host name and port of the Deployment Manager and the WebSphere
Application Server administrator user name and password as input arguments.
Note: Do not start the node agents yet. The syncNode operation takes a couple
of minutes to complete.
Refer to the IBM WebSphere Application Server Network Deployment
documentation for complete reference information about the syncNode
command.
v For Version 8.5: http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/
topic/com.ibm.websphere.nd.multiplatform.doc/ae/rxml_syncnode.html
The following shows the syntax for the syncNode command, followed by an
example of the syncNode command log file found under the custom profile
directory.
syncNode dmgr_hostname dmgr_port -username was_admin_username
-password was_admin_password
C:\IBM\WebSphereND70\AppServer\profiles\Custom01\bin>syncNode myDmgr01 8879
-username wasadmin -password *******
ADMU0116I: Tool information is being logged in file
C:\IBM\WebSphereND70\AppServer\profiles\Custom01\logs\syncNode.log
ADMU0128I: Starting tool with the Custom01 profile
ADMU0401I: Begin syncNode operation for node myNode01 with Deployment
Manager localhost: 8879
ADMU0016I: Synchronizing configuration between node and cell.
ADMU0402I: The configuration for node myNode01 has been synchronized
with Deployment Manager myDmgr01: 8879

When the synchronization is complete, verify that the custom profile contains
both newly created directories: the classes directory and the
informationServer directory. These two directories and the files they contain
are the result of the synchronization operation.
Note: If the synchronization fails, you can review the syncNode command log
file (syncNode.log) in the custom profile directory.
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6. Start the new node agent on the node agent computer by using the startNode
WebSphere Application Server command.
Refer to the IBM WebSphere Application Server Network Deployment
documentation for information about the startNode command.
v For Version 8.5: http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/
index.jsp?topic=/com.ibm.websphere.nd.multiplatform.doc/ae/
rxml_startnode.html
7. Start the newly created cluster member from the WebSphere Application Server
administrative console.
8. Enable last participant support (LPS). LPS must be enabled on the new node
for IBM InfoSphere Metadata Asset Manager to function properly. To enable
LPS:
a. In the WebSphere Application Server administrative console, select Servers
> Server Types > WebSphere application servers and select the server
associated with the new node.
b. Under Container Setting on the right side, expand Container Services and
click Transaction service A page opens with the configuration for the
Transaction service of the new node you just added.
c. Select the Accept heuristic hazard option under General Properties and
click OK
d. Save your changes.
e. Propagate the changes to other nodes by selecting System Administration >
Save changes to master repository, checking Synchronize changes with
Nodes, and clicking Save.
f. Restart the application server for the changes to take effect by selecting
Servers > Server Types > WebSphere application servers, checking the
server name for your new node, and clicking Restart.
9. Propagate the plugin-cfg.xml to the front-end Web server WLM plug-in to take
into account the new cluster member. See “Propagating the plugin-cfg.xml file
to the front-end Web server” on page 213.

Synchronizing nodes after changing the master repository
configuration
When you change the master repository configuration, synchronize the nodes to
ensure that changes are propagated to all nodes in the cell.

About this task
WebSphere Application Server synchronizes nodes internally on a regular and
automatic basis. However, you can also synchronize the nodes whenever you need
to, instead of waiting for WebSphere Application Server. For example, change the
master repository configuration when you add a new cluster member or change a
security setting.
Important: Nodes need to be synchronized whenever there is a change to the
master repository configuration, including updates to the topology or cell
configurations.

Procedure
1. Log in to the WebSphere Application Server administrative console.
2. Expand the System administration section and then click Nodes.
3. Select the nodes that you want to synchronize (most likely all of them).
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4. Click Synchronize or Full Synchronize.
For information about the difference between Synchronize and Full
Synchronize, refer to the IBM WebSphere Application Server Network
Deployment section about synchronizing the node configuration:
v 8.5: http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/
index.jsp?topic=/com.ibm.websphere.nd.doc/ae/tagt_svr_conf_nodes.html

Restarting application server processes
When you change a configuration at the cell-level, you must restart all IBM
WebSphere Application Server Network Deployment processes to make the
changes effective. You should restart the application servers, node agents, and
deployment manager on each machine in a specific order.

About this task
You must restart all IBM WebSphere Application Server Network Deployment
processes when you modify anything at the cell-level (deployment manager-level).
For example, restart application server processes after you do any of the following
tasks:
v Change security at the cell-level (for example, when you enable SSL, replace SSL
certificates, or switch user registry)
v Modify configurations for a data source
v Change other cell-level settings
For information about how to do the tasks involved in each of these steps in this
topic, refer to the following tables.
Note: The simplest way to restart node agents and application servers (clusters) is
through the WebSphere Application Server administrative console. If you use the
command line tools instead, make sure to specify a WebSphere Application Server
administrator user name and password.

Procedure
1. Stop all WebSphere Application Server processes in the following order:
a. Stop all application servers on every computer.
b. Stop all node agents on every computer.
c. Stop the deployment manager.
To stop application servers, node agents, and deployment managers for IBM
WebSphere Application Server Network Deployment, refer to the following
table.
Table 9. Stopping WebSphere Application Server processes
WebSphere Application Server Process

Stopping the process in Version 8.5

Application server (stopping)

Go to:http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/
index.jsp?topic=/com.ibm.websphere.nd.doc/ae/
trun_wlm_cluster_stop.html

Node agent (stopping)

Go to:http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/
index.jsp?topic=/com.ibm.websphere.nd.multiplatform.doc/ae/
rxml_stopnode.html

Deployment manager (stopping)

Go to:http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/
index.jsp?topic=/com.ibm.websphere.nd.multiplatform.doc/ae/
rxml_stopmanager.html
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2. After you have stopped all WebSphere Application Server processes, you can
proceed to restart them. Start all WebSphere Application Server processes in the
following order:
a. Start the deployment manager.
b. Start all node agents on every machine.
c. Start all application servers on every machine.
To start application servers, node agents, and deployment managers for IBM
WebSphere Application Server Network Deployment, refer to the following
table.
Table 10. Starting WebSphere Application Server processes
WebSphere Application Server Process

Starting the process in Version 8.5

Deployment manager (starting)

Go to:http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/
index.jsp?topic=/com.ibm.websphere.nd.multiplatform.doc/ae/
rxml_startmanager.html

Node agent (starting)

Go to:http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/
index.jsp?topic=/com.ibm.websphere.nd.multiplatform.doc/ae/
rxml_startnode.html

Application server (starting)

Go to:http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/
index.jsp?topic=/com.ibm.websphere.nd.doc/ae/
trun_wlm_cluster_start.html

Note: For more information about node agents:
v For Version 8.5: http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/
index.jsp?topic=/com.ibm.websphere.nd.doc/ae/uagt_rnodeagent.html.

Setting up HTTP session database persistence
When you install IBM InfoSphere Information Server in a cluster environment,
HTTP session management is configured to use memory-to-memory replication.
To configure for database session persistence, use the instructions in the IBM
WebSphere Application Server information center:
v For WebSphere Application Server, Version 8.5: http://publib.boulder.ibm.com/
infocenter/wasinfo/v8r5/index.jsp?topic=/com.ibm.websphere.base.doc/ae/
tprs_cnfp.html

IBM DB2 high availability configuration administration
These tasks outline how to administer an IBM InfoSphere Information Server
database in an IBM DB2 cluster or high availability disaster recovery (HADR)
configuration.
Use these procedures if your metadata repository or IBM InfoSphere Information
Analyzer analysis database is set up in one of these configurations.
For detailed information about DB2 cluster or HADR administration, see the
following resources:
v DB2 10.5: publib.boulder.ibm.com/infocenter/db2luw/v10r1/topic/
com.ibm.db2.luw.admin.ha.doc/doc/t0051382.html
v IBM Redbooks® publication: High Availability and Disaster Recovery Options for
DB2 on Linux, UNIX, and Windows available at www.redbooks.ibm.com/
abstracts/SG247363.html
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Failover in an IBM DB2 HADR configuration
If the primary database fails in a DB2 HADR configuration, IBM InfoSphere
Information Server can continue functioning by using the standby database.
To start using the standby database, the following things must occur:
v The services tier (IBM WebSphere Application Server) must reconnect to the
standby server. The DB2 automatic client reroute (ACR) feature automatically
reconnects the services tier to the standby server.
v The database administrator must run the TAKEOVER HADR command on the
standby database.
Attention:

A failure might cause a loss of data.

If a user writes data to a database and a failure occurs during the data replication
to the backup server, the updates might be lost. In most cases, the user can redo
the edit or import operation to restore the data after the switchover to the standby
database is complete.
The likelihood and extent of transaction loss depends on the synchronization mode
in which HADR is configured. The following table lists synchronization modes and
data loss scenarios.
Table 11. HADR synchronization modes and data loss scenarios
HADR synchronization mode

Data loss scenarios

SYNC

Least risk of data loss.

NEARSYNC

The standby database can lose transactions if
both the primary and standby databases fail
at the same time.

ASYNC

The standby database can lose transactions
in cases like these:
v The standby database does not receive all
the log records for the transactions before
the takeover operation is performed.
v Both the primary and standby databases
fail at the same time.

If the primary database fails while in remote catchup pending state, transactions
that the standby database has not processed are lost.
Note: Any log gap shown in the database snapshot represents the gap at the last
time the primary and standby databases communicated. The primary database
might have processed many transactions since that time.

Recovering from failover in a DB2 HADR scenario
If your installation includes an IBM DB2 database that is configured with high
availability disaster recovery (HADR), the database administrator must complete
the failover process manually.

About this task
If the primary HADR database fails, follow this procedure to restore service.
Attention:

A failure might cause a loss of data.
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Procedure
1. If the DB2 fault monitor feature (db2fm) is enabled on the primary database
server, the database might automatically restart on the primary server. Direct
the user to try the transaction again to see if the database is operational. If the
database is operational, no further action is required.
2. Deactivate the primary database or stop its instance, if possible. If the primary
database is still running, but cannot communicate with the standby database,
running the takeover operation could result in two primary databases (a
"split-brain" scenario).
3. Start the takeover operation by using one of the following administration
interfaces:
v The DB2 command-line processor (CLP).
v The Manage High Availability Disaster Recovery window in the DB2 Control
Center.
v The db2HADRTakeover application programming interface (API).

Recovering from a failover in a DB2 clustered configuration
If your IBM InfoSphere Information Server databases are set up in an IBM DB2
clustered configuration, failover is automatic.
If the primary node fails in such a configuration, the passive node connects to the
database file system, and continues. If you have automatic client reroute (ACR)
configured, the services tier (IBM WebSphere Application Server) reconnects to the
passive node. No database administrator intervention is required.
Any transactions other than read-only transactions are stopped and rolled back.
Users must resubmit the transactions.
Refer to the DB2 documentation for more detailed information.

Engine tier failover recovery
If the engine tier (and possibly other tier software as well) is set up in an
active-passive configuration, hardware or network errors cause a failover to the
passive server. You can also force a failover to occur to free the active server for
maintenance or upgrade tasks.
The high availability (HA) software that is installed on the servers manages the
fault detection and failover process.
During a failover, the sequence of events differs depending on whether the failover
is due to a failure or is forced.

Failover due to a failure
When the active server hardware or network fails, the heartbeat mechanism
between the nodes signals the passive server that the active server has failed. The
HA software restores service on the passive server by doing the following actions:
v Ensures that the primary server is no longer running.
v Assigns the IP address that is associated with the resource group to the new
server.
v Mounts the floating mount point for the software on the new server.
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v Starts the engine tier software on the new server by calling the InfoSvrEngine
script with the start option.
v If other tier software is installed on the server, the HA software starts it by
calling the InfoSvrServices script with the start option. This script starts the
services tier. It also starts the metadata repository tier if the tier is installed with
the engine tier.

Forced failover
When you force a failover, the HA software shuts down the software before
starting it up on the other node. The HA software does the following steps:
v If software is installed for tiers other than the engine tier, the HA software stops
it by calling the InfoSvrServices script with the stop option. This script stops
the services tier. It also stops the metadata repository tier if the tier is installed
with the engine tier.
v Stops the engine tier software on the server by calling the InfoSvrEngine script
with the stop option.
v Unmounts the floating mount point for the software.
v Unmounts the data files mount point.
v Unassigns the IP address associated with the resource group from the old server.
v Reassigns the resource group IP address and mounts the floating mount point.
v Starts the engine tier software on the new server by calling the InfoSvrEngine
script with the start option.
v If other tier software is installed on the server, the HA software starts it by
calling the InfoSvrServices script with the start option. This script starts the
services tier. It also starts the metadata repository tier if the tier is installed with
the engine tier.

Recovery process
In a production system, if server engine services did not shut down normally, the
DSHARestart tool starts automatically on the passive server. The tool checks and
repairs dynamic files that are associated with any jobs that were running on the
primary server when the failover occurred. The state of these jobs is set to crashed
for easy identification.
In a development system where users were creating, editing, or compiling projects
when a failover occurred, the restart might leave projects in an inconsistent state.
You can use the SyncProject tool to resolve any inconsistencies in these projects.
Note: Once the recovery process is complete, you must restart any clients that
have an active connection to the engine tier. For web clients, log out and log in
again for the changes to take effect.

Recovering from an engine tier failover
When an engine tier failover occurs, follow this procedure to recover projects and
restart any interrupted jobs.
If IBM InfoSphere Information Server engine services did not shut down normally
(for example, if a failover occurred due to a failure), the DSHARestart tool starts
automatically on the passive server. The tool checks and repairs dynamic files that
are associated with any jobs that were running on the primary server when the
failover occurred. The state of these jobs is set to crashed for easy identification.
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The tool is intended to handle unattended failover events on a production system.
No user interaction is required to ensure that running jobs can be restarted.
InfoSphere Information Server engine services do not start up fully until the
DSHARestart tool has completed its tasks. While the tool is running, users cannot
connect and use the InfoSphere Information Server engine. This design ensures
that jobs are not further corrupted during the recovery process.
While the DSHARestart tool runs, it records its actions in the HARestart.log file. If
an issue arises during the recovery process, refer to this file for more information.
This file is located in the following directory:
v

Linux

v

Windows

UNIX

/opt/IBM/InformationServer/Server/DSEngine

C:\IBM\InformationServer\Server\DSEngine

After the DSHARestart tool has finished, recover projects by using the SyncProject
tool. Then restart any interrupted jobs. Replace the server and bring the new server
online.

Recovering projects by using the SyncProject tool
After a failover, you can run the SyncProject tool to repair inconsistencies in your
projects.

About this task
After a failure, the repository that holds design-time assets for a project can be left
out of step with the repository that holds the runtime assets. This situation can
cause the project, or assets contained with the project, to become unusable. You can
run the SyncProject tool to check for inconsistencies, and repair inconsistencies if
any are detected.

Procedure
Run the SyncProject tool to analyze and recover projects.

Example
The following example command displays a consistency report for all projects. The
SyncProject tool also writes the report to the /tmp/myprojrep.txt file.
SyncProject -ISHost R101:9080 -IAUser admin -IAPassword pword -project
-report /tmp/myprojrep.txt

In this case, the SyncProject tool returns results for four projects. It finds two
inconsistencies in the project named dstage9, as shown in the following example.
DSEngine Restorer Report
Feb 05, 2009 9:39:00 AM
IS Host = R101
IS Port = 9080
IS User = admin
DS Host = R101
DS Port = 31538
DataStage Project: dstage3
-------------------------0 Issues Found.
DataStage Project: dstage4
-------------------------0 Issues Found.
DataStage Project: dstage5
-------------------------0 Issues Found.
DataStage Project = dstage9
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--------------------------2 Issues Found.
DS Engine Job ’testJob’ is missing.
DS Engine Job ’testJob2’ category ’incorrectCategory’ should be ’correctCategory’
Overall Summary
--------------2 Issues found.

The following command causes the SyncProject tool to try to fix the dstage9
project.
SyncProject -ISFile islogin -project dstage9 -Fix

The command makes the necessary repairs and outputs the following report:
DSEngine Restorer Fix Results
Feb 05, 2009 9:39:00 AM
IS Host = R101
IS Port = 9080
IS User = admin
DS Host = R101
DS Port = 31538
DataStage Project: dstage9
-------------------------RESOLVED: DS Engine Job ’testJob’ is missing.
RESOLVED: DS Engine Job ’testJob2’ category ’incorrectCategory’ should be ’correctCategory’.
2 Issues resolved.
0 Issues remaining.
Overall Summary
--------------2 Issues resolved.
0 Issues remaining.

Identifying and restarting crashed jobs
After the DSHARestart tool finishes, restart jobs by using the dsjob tool.

About this task
After the DSHARestart tool finishes, recovered job sequences are left in one of two
states:
v Crashed/Restartable. You can run these job sequences from where they stopped,
or reset and run them.
v Crashed. You must reset these jobs before you can run them.

Procedure
Use any of the following tools to identify jobs that are in a crashed/restartable or
crashed state.
The dsjob tool
To use the dsjob tool:
1. Log in to the computer that hosts the engine tier. Use an account with
administrator or IBM InfoSphere DataStage user privileges.
2. Change to the directory that contains the dsenv file. This directory is
specified in the $DSHOME environment variable. By default, the
directory is /opt/IBM/InformationServer/Server/DSEngine.
3. Source the dsenv file:
. dsenv

4. Run the dsjob tool. Specify the -status option with a value of 96.
dsjob –ljobs –status 96 project

5. To restart checkpointed job sequences that are in the crashed/restartable
state, specify the -mode option with a value of RESTART, and specify the
job sequence.
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dsjob –run –mode RESTART project jobsequence

The IBM InfoSphere DataStage and QualityStage Director client
To use the InfoSphere DataStage and QualityStage Director client, start the
client and view jobs. Look for jobs where the Status column reads Crashed
or Crashed/Restartable.
The C or DSBasic Job Control API DSRunJob function.
For information about the C or DSBasic Job Control API DSRunJob function,
see the IBM InfoSphere DataStage documentation.

What to do next
After you identify and restart crashed jobs, investigate and resolve the cause of the
primary server failure.
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Chapter 11. Configuring WebSphere Application Server logs
You configure logging to enable logging features beyond the defaults.

About this task
Use the IS_install_path/wlp/usr/servers/iis/server.xml configuration file to
configure logging messages for WebSphere Application Server Liberty Core. The
log files are produced in the IS_install_path/wlp/usr/servers/iis/logs folder.
For more information about configuring logging for WebSphere Application Server
Liberty Core, see Trace and logging.

Procedure
1. WebSphere Application Server Network Deployment:
a. Log in to the WebSphere Application Server administrative console.
b. Go to Troubleshooting > Logs and trace > <servername>
c. Configure the logging options that you desire. For more information, see
Configuring Java logging using the administrative console.
d. Save your changes to the master configuration.
2. WebSphere Application Server Liberty Profile:
a. Open the IS_install_path/wlp/usr/servers/iis/server.xml configuration
file.
b. Configure logging related information. Use the comments in the server.xml
file to add or change what types of messages are logged.
c. Save your changes.

What to do next
Restart WebSphere Application Server server for the configuration changes to take
effect.
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Chapter 12. Configuring ASBAgent logging
You must configure ASBAgent logging to define the log level, location of the log
output file, and to set the rolling log file configurations.

About this task
Use the ASBNode/conf/asbagent-logging.properties file to define the ASBAgent
logging configuration. The ASBAgent uses standard Java logging configuration.
The format of the ASBNode/conf/asbagent-logging.properties file is the standard
format of a Java logging configuration file. For more information about Java
logging, see the Java Logging Overview documentation.

Procedure
1. Open the ASBNode/conf/asbagent-logging.properties configuration file.
2. Set the log level, location of the log output file, and configure the rolling log
file.
3. Save your changes.
4. Optional: You do not need to restart the ASBAgent server for the configuration
changes to take effect. However, if you change the rolling log file configuration
to set its maximum size or its file location, then you do need to restart the
ASBAgent process.
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Chapter 13. Managing schedules
In the IBM InfoSphere Information Server Web console, you can query all of the
schedules that are defined across all of the suite components, check their status,
history, and forecast, perform maintenance tasks such as purging the schedule
execution history, and stop or start existing schedules to prevent system overload.
Many of the suite components use scheduling capabilities. For example, a report
run and an analysis job in IBM InfoSphere Information Analyzer are scheduled
tasks. Typically, you create, update, and manage these schedules in the suite
component. For example, you create a schedule for a column analysis job to run
weekly in an InfoSphere Information Analyzer project in the IBM InfoSphere
Information Server console.
As a suite administrator, you might also want to have a global view of all of the
scheduled activities that are created by each of the suite components to ensure that
enough resources are available to process these schedules and to monitor who is
scheduling tasks and with what frequency.

Criteria for schedule views
You access schedules from a view, which filters the events based on criteria that
you set.
To create views, you can filter messages by the following criteria:
Name You can filter tasks of a schedule by their names. Two wild cards are
supported:
v An asterisk (*) finds one or more characters.
v A question mark (?) finds any single character at the current position.
Description
You can filter tasks of a schedule by their descriptions.
Schedule status
A schedule has three statuses: Complete, Started, and Paused.
Task Run status
Each task instance can have one of four statuses: Abnormally Ended,
Finished, Canceled by User, or Running.
Creators
You can filter schedules by users.
Dates You can filter schedules by three sets of dates:
v The dates on which schedules are created.
v The dates on which any task executions of the schedule were started.
v The updates, such as run start or completion, of any task executions for
the schedule.
Origin
You can filter tasks based on the application components that originated
the tasks.
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Shared and private views
A view can be private or shared. A suite administrator or suite user who creates a
private view has exclusive access to the view.
The following table describes the levels of access, based on the creator and type of
view.
Table 12. Access to views
Type of view

Created by

Who can access

Private

Suite administrator

Creator can edit, view, and delete.

Shared

Suite administrator

Creator and other suite administrators can
edit, view, and delete.
Suite users can view.

Private

Suite user

Creator can edit, view, and delete.

Shared

Suite user

Creator can edit, view, and delete.
Suite administrators can view and delete.
Other suite users can view.

Creating a schedule view
You create a schedule view to access and manage a list of schedules and scheduled
tasks.

Before you begin
You must have suite administrator or suite user authority.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Schedule Monitoring > Views of Schedules.
3. In the Views of Schedules pane, click New Scheduling View.
4. Specify the name, description, and access level of the view.
5. Optional: In the Filters pane, specify criteria for filtering schedules.
6. Click Save and Close to save the schedule view.

What to do next
You can now view all of the schedules that are captured by this schedule view.

Creating a schedule view from a copy
To create a schedule view that is based on the configuration details of another
schedule, you can create a copy of a schedule view.

Before you begin
You must have suite administrator or suite user authority.
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Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Schedule Monitoring > Views of Schedules.
3. In the Views of Schedules pane, select a view.
4. Click Copy.
5. In the Copy pane, type a new name and description for the schedule view.
6. Optional: Change the criteria of the view.
7. Click Save and Close.

Viewing the schedules that are captured by a schedule view
You can view the schedules that are captured by a schedule view. From this view,
you can then manage the schedules and scheduled tasks.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Schedule Monitoring > Views of Schedules.
3. In the Views of Schedules pane, select a view.
4. Click View Schedules. A list of schedules that fit the criteria of the view opens.

Pausing all the schedules in a view
To pause a set of schedules, you can pause all of the schedules that are captured
by a schedule view.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Schedule Monitoring > Views of Schedules.
3. In the Views of Schedules pane, select a view.
4. Click Pause. The schedules that are captured by the view are paused. All tasks
in them will not run until the schedules are resumed.

Resuming all the schedules in a view
After you pause all of the schedules in a schedule view, you can resume all of the
schedules that are captured by the scheduled view.

Procedure
To reuse all of the schedules in a schedule view:
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Schedule Monitoring > Views of Schedules.
3. In the Views of Schedules pane, select a view.
4. Click Resume. The schedules that are captured by the view are resumed.
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Purging the history for all the schedules in a view
To quickly purge the run history of a number of schedules, you can purge the
history of a schedule view. The run history for all of the schedules that are
captured by the schedule view are purged from the metadata repository.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Schedule Monitoring > Views of Schedules.
3. In the Views of Schedules pane, select a view.
4. Click Purge Run History.
5. In the Purge window, specify an action.
Option

Description

Purge all run history

Select All.

Purge run history in a date range

1. Select Range.
2. Type dates and times or use the calendar
to specify a start date and an end date.

6. Click Yes. The run history is deleted from the metadata repository.

Working with the scheduled tasks in a view
After you create a schedule view, you can access the individual schedules and
scheduled tasks that are captured by the view. You can stop and start the
individual tasks. You can also view a summary of the completed tasks, the running
tasks, or the future tasks that are captured by that view.

Stopping a scheduled task
While you are viewing the schedules that are captured by a schedule view, you can
stop a scheduled task.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Schedule Monitoring > Views of Schedules.
3. In the Views of Schedules tab, select a view.
4. Click View Schedules.
5. In the View Schedules pane, select a scheduled task.
6. Click Stop. The task is stopped.

Purging the history of a scheduled task
You can remove the run history of a scheduled task from the metadata repository.
The task and its schedule remain in the metadata repository.

Procedure
1. In the IBM InfoSphere Information Server Web console, click the
Administration tab.
2. In the Navigation pane, select Schedule Monitoring > Views of Schedules.
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3.
4.
5.
6.

In the Views of Schedules pane, select a view.
Click View Schedules.
In the View Schedules pane, select a task.
Click Purge. The run history of the scheduled task is deleted from the metadata
repository.

Viewing a list of completed schedules
If you are viewing an ongoing scheduled task, you can view a summary of all
instances of this scheduled task that have completed.

Procedure
1. In the View Schedules pane, select a schedule.
2. Click View Complete.

Viewing a list of running schedules
For a scheduled task, you can view which instances of the schedule are currently
running.

Procedure
1. In the View Schedules pane, select a schedule.
2. Click View Running.

Viewing a list of upcoming scheduled tasks
If you are viewing an ongoing scheduled task, you can view the tasks that will run
in the future.

Procedure
1. In the View Schedules pane, select a schedule.
2. Click View Forecast.
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Chapter 14. Backing up and restoring IBM InfoSphere
Information Server
To prevent the loss of data and to prepare for disaster recovery, you can back up
and restore the components and system elements that are associated with IBM
InfoSphere Information Server.

About this task
You need to back up only the services tier, engine tier, and repository tier, and not
the client tier.
Because only local, user-specific customizations are stored on the client computers
(that run Microsoft Windows), you do not need to back up the client tier. The
procedures that are documented here do not cover backing up and restoring
InfoSphere Information Server clients that are running on Microsoft Windows
computers. Backup and restore is typically not required for client-only installations
as only local, user-specific customizations are stored on client computers.
You must back up several system elements in the services tier, engine tier, and
repository tier. For example, files, configuration data, and projects in the engine tier
and services tier are linked to the metadata repository in the repository tier, all of
which you must back up. Also, cross-database references often exist among the
databases in the repository tier, which also require backing up.

Backing up IBM InfoSphere Information Server components
You can back up the components of IBM InfoSphere Information Server so that
you can recover your data in the event of hardware failure or other system issue.

Before you begin
Because you need to stop the services before backing up the system, you need to
view all active user sessions and disconnect those user sessions.
Before you can stop the services, you need to determine whether any jobs are
running and if any jobs are scheduled to run then pause those scheduled jobs.
For information about backing up DB2 databases, see Backup overview in the DB2
10.5 for Linux, UNIX, and Windows in the Knowledge Center. For other supported
database systems, refer to your vendor documentation.

Procedure
1. Place IBM InfoSphere Information Server in maintenance mode.
2. Stop the InfoSphere Information Server services and IBM WebSphere
Application Server services. For more information, see Administering IBM
InfoSphere Information Server and IBM WebSphere Application Server
services.
3. Back up the metadata repository database.
4. If InfoSphere Information Analyzer is installed, back up the analysis
databases.
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5. Optional: If InfoSphere DataStage and QualityStage are installed, back up the
InfoSphere DataStage and QualityStage operations database. However, this
step is not necessary. Instead, if you want to continue monitoring data after a
restore, you can re-create the operations database when you restore InfoSphere
Information Server components.
6. Optional: If InfoSphere QualityStage is installed, back up the results database.
However, this step is not necessary. Instead, if you want to continue to refine
or develop match specifications after a restore, you can re-create the Match
Designer database when you restore InfoSphere Information Server
components.
7. Optional: If InfoSphere QualityStage is installed, back up the Standardization
Rules Designer database.
8. Optional: If IBM InfoSphere Data Quality Console is installed, back up the
IBM InfoSphere Data Quality Console exceptions database.
9. Back up all system elements that are listed in “System elements and databases
that require backing up.”
10. Back up external files or libraries that are used by InfoSphere DataStage and
QualityStage jobs. External files are data sets, file sets, sequential files, hashed
files, and other similar files that run InfoSphere Information Server tasks, such
as InfoSphere DataStage jobs. External libraries can be custom-written C++
functions that are called by the parallel engine.
11. Start the InfoSphere Information Server services and WebSphere Application
Server services. For more information, see Administering IBM InfoSphere
Information Server and IBM WebSphere Application Server services.

System elements and databases that require backing up
When you back up IBM InfoSphere Information Server, all file system-based
elements that change after installation and all databases must be backed up
simultaneously. The backup must occur while all services and IBM WebSphere
Application Server are shut down.

Special considerations
Your backup must meet the following criteria:
v User ownership of files and directories is retained
v Group ownership of files and directories is retained
v File names with special characters, such as asterisk (*), ampersand (&), dollar
sign ($), and exclamation point (!) are handled
v Hidden files are copied. On Linux or UNIX, these files start with a period (.)
v Zero length files are copied.

File system elements that change after installation
The following tables identify file system elements that change after installation.
The paths in these tables use the default installation directory. Your path varies if
you installed InfoSphere Information Server in a different location.
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Table 13. File system elements that change after installation (Windows)
Element

Description

Changed by

C:\IBM\InformationServer

The base installation directory for
InfoSphere Information Server.
Includes all files that are associated
with the InfoSphere Information
Server installation instance. By
default, this directory also stores
InfoSphere DataStage and
InfoSphere QualityStage projects.

All InfoSphere Information Server
installation actions, running of
analysis jobs, InfoSphere DataStage
and InfoSphere QualityStage
activities, configuration changes
such as application of license files,
and various other activities.

The InfoSphere profile includes all
IBM WebSphere Application Server
installed services tier components
Network Deployment
of InfoSphere Information Server.
C:\IBM\WebSphere\AppServer\
profiles\InfoSphere The
InfoSphere profile can be
located outside of the base
installation directory for IBM
WebSphere Application Server if
you preinstalled and configured
it before you installed
InfoSphere Information Server.
.

All IBM WebSphere Application
Server or InfoSphere Information
Server installation actions,
configuration changes that are
made through the IBM IBM
WebSphere Application Server or
InfoSphere Information Server
administrative consoles or external
tools that modify configuration
values.

InfoSphere DataStage and QualityStage
server project directories. By default:
C:\IBM\InformationServer\Server\
Projects
Note: You can create project directories
anywhere on the server's file system.

Stores compiled InfoSphere
DataStage and InfoSphere
QualityStage jobs and routines and
metadata that is associated with
running InfoSphere DataStage and
InfoSphere QualityStage jobs.

Whenever a user creates a new
InfoSphere DataStage and
InfoSphere QualityStage project, a
corresponding server directory is
created to hold its runtime
metadata.

Table 14. File system elements that change after installation (Linux, UNIX)
Element

Description

Changed by

/opt/IBM/InformationServer

The base installation directory for
InfoSphere Information Server.
Includes all files that are associated
with the InfoSphere Information
Server installation instance. By
default, this directory also stores
InfoSphere DataStage and InfoSphere
QualityStage projects.

All InfoSphere Information Server
installation actions, running of
analysis jobs, InfoSphere DataStage
and InfoSphere QualityStage
activities, configuration changes such
as application of license files, and
various other activities.

The base installation directory for
InfoSphere Information Server which
includes all installed services tier
components of InfoSphere
Information Server.

All InfoSphere Information Server
installation actions, configuration
changes that are made through the
IBM WebSphere Application Server
or InfoSphere Information Server
administrative consoles or external
tools that modify configuration
values.

IBM WebSphere Application Server
Network Deployment
/opt/IBM/WebSphere/
AppServer

Server project directories. By default: Stores compiled InfoSphere DataStage
/opt/IBM/InformationServer/Server/ and InfoSphere QualityStage jobs and
Projects
routines and metadata that is
associated with running InfoSphere
Note: You can create project
DataStage and InfoSphere
directories anywhere on the server's
QualityStage jobs.
file system.

Whenever a user creates a new
InfoSphere DataStage or InfoSphere
QualityStage project, a corresponding
server directory is created to hold its
runtime metadata.
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File system elements that do not change or rarely change after
installation
Table 15. File system elements that do not change or rarely change after installation (Windows)
Element

Description

Changed by

C:\Windows\.nifregistry

Installation information for IBM
WebSphere Application Server.

Not changed by use of InfoSphere
Information Server. Might be changed
if WebSphere Application Server fixes
or fix packs are installed separately.

C:\IBM\SQLLIB

The base installation directory for
IBM DB2 when installed as part of
InfoSphere Information Server.

Not changed by use of InfoSphere
Information Server. Installation of
DB2 fixes or fix packs modify files in
this directory.

C:\Program Files\MKS Toolkit

UNIX emulation tools that are used
by InfoSphere Information Server.

Not changed by use of InfoSphere
Information Server. Installation of
InfoSphere Information Server fixes
or fix packs that identify they update
MKS Toolkit modifies files in this
directory.

The base installation directory for
IBM WebSphere Application Server
which includes all installed services
tier components of InfoSphere
Information Server.

Changed by any IBM WebSphere
Application Server fix pack
installation.

C:\os_install_dir\vpd.properties,
where os_install_dir is the installation
directory of the operating system. For
example, C:\WINNT, C:\Windows, or
user_home

IBM WebSphere Application Server
Network Deployment
C:\IBM\WebSphere\AppServer
Note: You can exclude any
profiles under the
C:\IBM\WebSphere\
AppServer\profiles
directory that are used by
other applications.
AIX

Linux

Table 16. File system elements that do not change or rarely change after installation (Linux, UNIX)
Element
AIX

On AIX platforms:

/usr/.ibm/.nif/.nifregistry or
non_root_home/.ibm/.nif/
.nifregistry
/root/vpd.properties or
/usr/lib/objrepos/
vpd.properties
Linux

On Linux:

/opt/.ibm/.nif/.nifregistry
/root/vpd.properties or
/user_home/vpd.properties
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Description

Changed by

Installation information for IBM
WebSphere Application Server.

Not changed by use of InfoSphere
Information Server. Might be changed
if IBM WebSphere Application Server
fixes or fix packs are installed
separately.

Table 16. File system elements that do not change or rarely change after installation (Linux, UNIX) (continued)
Element

Description

Changed by

/etc/services

Not changed after initial installation
Port assignments for the computer.
When DB2 or InfoSphere Information of InfoSphere Information Server.
Server are installed, the following
entries are added:
DB2_db2inst1 60000/tcp
DB2_db2inst1_1 60001/tcp
DB2_db2inst1_2 60002/tcp
DB2_db2inst1_END 60003/tcp
dsrpc 31538/tcp # RPCdaemon
DSEngine@/u1/IBM/
InformationServer/Server/
DSEngine
Port assignments might be different
in your installation.
Services to be started on system boot. Not changed after initial installation
of InfoSphere Information Server.
If you installed DB2 as part of
InfoSphere Information Server, this
file is modified to add the following
entry:

/etc/inittab

fmc:234:respawn:/u1/IBM/
db2/V10/bin/db2fmcd #DB2
Fault
Monitor Coordinator
Scripts that are used to start and shut Not changed after initial installation
down the services that are associated of InfoSphere Information Server.
You can determine the scripts to back with InfoSphere Information Server.
up and restore by using these
The SISFAgents script and DSEngine
commands:
scripts are present only when engine
components are installed. The
cd /etc
SISFServer script is present only
find . -name "SISFServer*"
-print
when the services tier is installed.
find . -name "SISFAgents*"
-print
find . -name "*"
-print | xargs grep
-i DSEngine
Startup and shutdown scripts.

Not changed by use of InfoSphere
Information Server. Installation of
DB2 fixes or fix packs modify files in
this directory.

/opt/IBM/db2/V10

The base installation directory for
DB2 when installed as part of
InfoSphere Information Server.

/home/dasusr1

Not changed by use of InfoSphere
The home directory of the DB2
Information Server. Installation of
database administrator account.
Contains files that are required to run DB2 fixes or fix packs might modify
files in this directory.
DB2.

/home/db2inst1

The home directory of the DB2
database instance owner. Contains
files that are required to run DB2.

Not changed by use of InfoSphere
Information Server. Installation of
DB2 fixes or fix packs might modify
files in this directory.

Databases that must be backed up
You can use several tools to complete the backup process. For more information
about backing up DB2 databases, see Backup overview in the DB2 10.5 for Linux,
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UNIX, and Windows in the Knowledge Center. For other supported database
systems, refer to your vendor documentation.
Table 17. Databases that must be backed up
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Default database
name/schema name

Repository or database

Description

Metadata repository

Stores the metadata about
external data sources that are
governed, managed, and
analyzed by InfoSphere
Information Server
components.

Default database name:
XMETA
Default schema name:
User-defined schema user
name, typically XMETA
Note: Database must be the
same as the database that is
used for the staging area
data store.

Staging area

Stores metadata that is
imported from external data
sources so that it can be
examined before it is moved
to the active metadata
repository.

Default database name:
XMETA
Default schema name:
User-defined schema user
name, typically XMETASR
Note: Database must be the
same as the database that is
used for the metadata
repository.

Analysis database

Stores results of information
analysis by InfoSphere
Information Analyzer.

Default database name:
IADB
Default schema name:
User-defined schema user
name, typically IAUSER
Note: Database cannot be
the same as the database that
is used for the metadata
repository.

Optional: Operations
database

Stores monitoring data that
is displayed by the
InfoSphere DataStage and
QualityStage Operations
Console.

Default database name:
XMETA
Default schema name:
User-defined schema user
name, typically DSODB
Note: Database can be the
same or different from the
database that is used for the
metadata repository.

Optional: Match Designer
database

Stores the results of match
test passes by InfoSphere
QualityStage Match Designer,
a component of InfoSphere
QualityStage. This database
is an ODBC data source that
is used as a staging area
before match designs are
checked in to the active
metadata repository.

User-defined database name
and schema name. No
default, but typically MDDB.
Note: Database cannot be
the same as the database that
is used for the metadata
repository.
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Table 17. Databases that must be backed up (continued)
Default database
name/schema name

Repository or database

Description

Optional: Standardization
Rules Designer database

Stores a copy of revisions to
InfoSphere QualityStage rule
sets that were made in the
IBM InfoSphere QualityStage
Standardization Rules
Designer .

Default database name:
XMETA
Default schema name:
User-defined schema user
name, typically SRDUSER
Note: Database can be the
same or different from the
database that is used for the
metadata repository.

Optional: Exceptions
database

Stores exceptions that are
generated by InfoSphere
DataStage and QualityStage
product components.

Default database name:
XMETA
Default schema name:
User-defined schema user
name, typically ESDB
Note: Database can be the
same or different from the
database that is used for the
metadata repository.

Critical files that are unique to each installation
The following tables identify critical files that are unique to each installation.
Windows
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Table 18. Critical files that are unique to each installation (Windows)
Element
IBM WebSphere
Application Server Liberty
C:\IBM\
InformationServer\
wlp\usr\servers\
iis\lib\iis\
15properties\isfserver.keystore

Description

Changed by

On the service tier, the
Not changed after the initial
keystore that contains the
installation of InfoSphere
Information Server.
InfoSphere Information
Server engine private key. If
you want to restore a backup
in a new installation, you
must back up the keystore
files.

IBM WebSphere
Application Server Network
Deployment
C:\IBM\WebSphere\
AppServer\
profiles\
InfoSphere\
classes\isfserver.keystore
Note: A duplicate of
isf-server.keystore is used
as a deployment source to
install isf-server.keystore
into the IBM WebSphere
Application Server profile. It
is in the following location,
which is based on your
installation of IBM
WebSphere Application
Server:
IBM WebSphere
Application Server Liberty
C:\IBM\
InformationServer\
ASBServer\apps\
lib\iis\
15properties
IBM WebSphere
Application Server Network
Deployment
C:\IBM\
InformationServer\
ASBServer\apps\
lib\iis\classes
C:\IBM\InformationServer
\ASBNode\eclipse\plugins
\com.ibm.iis.client\isfnode.keystore
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Not changed after initial
On the engine tier, the
installation of InfoSphere
keystore that contains the
Information Server.
private key and certificate
that is generated when nodes
are created. This keystore is
updated with the InfoSphere
Information Server engine
public certificate during
registration. If you want to
restore a backup in a new
installation, you must back
up the keystore files.

Table 19. Critical files that are unique to each installation (Linux, UNIX)
Element
IBM WebSphere
Application Server Liberty
/opt/IBM/
InformationServer/
wlp/usr/servers/
iis/lib/iis/
15properties/isfserver.keystore

Description

Changed by

On the service tier, the
Not changed after initial
keystore that contains the
installation of InfoSphere
Information Server.
InfoSphere Information
Server engine private key. If
you want to restore a backup
in a new installation, you
must back up the keystore
files.

IBM WebSphere
Application Server Network
Deployment
/opt/IBM/
WebSphere/
AppServer/
profiles/
InfoSphere/
classes/isfserver.keystore
Note: A duplicate of
isf-server.keystore is used
as a deployment source to
install isf-server.keystore
into the IBM WebSphere
Application Server profile. It
is in the following location,
which is based on your
installation of IBM
WebSphere Application
Server:
IBM WebSphere
Application Server Liberty
/opt/IBM/
InformationServer/
ASBServer/apps/
lib/iis/
15properties
IBM WebSphere
Application Server Network
Deployment
/opt/IBM/
InformationServer/
ASBServer/apps/
lib/iis/classes
/opt/IBM/InformationServer
/ASBNode/eclipse/plugins
/com.ibm.iis.client/
isf-node.keystore

Not changed after initial
On the engine tier, the
installation of InfoSphere
keystore that contains the
Information Server.
private key and certificate
that is generated when nodes
are created. This keystore is
updated with the InfoSphere
Information Server engine
public certificate during
registration. If you want to
restore a backup in a new
installation, you must back
up the keystore files.
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Other elements that must be backed up
On Windows installations, the registry stores various values that are
used by InfoSphere Information Server. You must back up and restore the
following registry keys with a full system backup:
Windows

HKEY_CURRENT_USER\Software\Wow6432Node\Ascential Software
HKEY_CURRENT_USER\Software\Wow6432Node\IBM\InformationServer
For more information about importing and exporting registry keys, see Import or
Export Keys.

Additional files to back up
You must back up several files in addition to the databases and file system-based
elements that changed after installation.
The following table shows additional files that must be backed up.
Table 20. Additional files to back up
Product

Data that must be backed up

InfoSphere DataStage and QualityStage

v Data sets
v Run-time log files
v Operational metadata
v Job schedules or job invocations
v InfoSphere DataStage hash files that are
not saved in a project directory
v Data files that are accessed by InfoSphere
DataStage and QualityStage with the
sequential file method
v Data files used by InfoSphere DataStage
that contain user-defined SQL statements
for writing data to databases

InfoSphere QualityStage modules

v Postal validation reference files
v Geocoding reference files

InfoSphere Information Server Enterprise
Packs

v Reference files

Restoring IBM InfoSphere Information Server components
You can restore the files, directories, and databases that are associated with IBM
InfoSphere Information Server and its components to recover from an event in
which data was lost.

Before you begin
This task assumes that you are recovering InfoSphere Information Server on a
system where InfoSphere Information Server was previously installed and that a
good backup was previously performed. It also assumes that the host name of the
computer is identical to that of the computer on which the backup was taken and
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that all components are being restored in the exact same location that they
originally were in. If a different host name is used, the system is inoperable.
When you restore an installation, all of the same elements that were backed up
must be restored before you start the InfoSphere Information Server and IBM
WebSphere Application Server services.
For more information about restoring DB2 databases, see Restore overview in the
DB2 10.5 for Linux, UNIX, and Windows in the Knowledge Center. For other
supported database systems, refer to your vendor documentation.

Procedure
1. Disconnect all user sessions. Do not allow users to log in to the system at any
point during the restore. Otherwise, it is possible that the restore might fail or
users might lose data, which is overwritten when the metadata repository is
restored.
2. Stop the InfoSphere Information Server services and WebSphere Application
Server services. For more information, see Administering IBM InfoSphere
Information Server and IBM WebSphere Application Server services.
3. Restore the metadata repository.
4. If IBM InfoSphere Information Analyzer was installed, restore the analysis
database that is used by InfoSphere Information Analyzer.
5. If you use the InfoSphere DataStage and QualityStage and have a backup of
the operations database that is used for storing monitoring data that is
displayed by the InfoSphere DataStage and QualityStage Operations Console,
restore the operations database. Otherwise, you can re-create the operations
database.
6. If you use IBM InfoSphere QualityStage and have a backup of the Match
Designer database that is used for refining or developing match specifications,
restore it from backup. Otherwise, you can re-create the Match Designer
database.
7. If you use InfoSphere QualityStage Standardization Rules Designer and have a
backup of the Standardization Rules Designer database that contains rule sets
that are under revision or have changes that are not published, restore the
Standardization Rules Designer database. Otherwise, if all the rule sets are
published, you can re-create the Standardization Rules Designer database.
8. If you use InfoSphere DataStage and QualityStage and have a backup of the
IBM InfoSphere Data Quality Console exceptions database that is used for
storing exceptions that are generated by InfoSphere DataStage and
QualityStage product components, restore the exceptions database. Otherwise,
you can rerun your exception stage jobs to generate new exception descriptors
and their details.
9. Restore the system elements that are listed in “System elements and databases
that require backing up” on page 238.
10. Restore the additional files that are listed in “Additional files to back up” on
page 246.
11. Restore external files or libraries that are used by IBM InfoSphere DataStage
and InfoSphere QualityStage jobs. External files are data sets, file sets,
sequential files, hashed files, and other similar files that run InfoSphere
Information Server tasks, such as InfoSphere DataStage jobs. External libraries
can be custom-written C++ functions that are called by the parallel engine.
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12. Restart the InfoSphere Information Server services and WebSphere Application
Server services. For more information, see Administering IBM InfoSphere
Information Server and IBM WebSphere Application Server services.
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Chapter 15. Administering services
Follow these procedures to administer IBM InfoSphere Information Server services
and IBM WebSphere Application Server services. For example, check the status of
services and stop and restart them when you back up or restore your system, or to
do other maintenance tasks.Commands to start and stop services are listed here.
For further information about the WebSphere Application Server tools and
processes mentioned in these procedures, see the WebSphere Application Server
Information Center:
v IBM WebSphere Application Server Network Deployment 8.5:
http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/index.jsp
For further information about various tools to use to manage a WebSphere
Application Server, see the following topics in the WebSphere Application Server
documentation:
WebSphere Application Server 8.5
Starting the Deployment Manager by using the startManager tool:
http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=/
com.ibm.websphere.nd.multiplatform.doc/ae/rxml_startmanager.html
Stopping the Deployment Manager by using the stopManager tool:
http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=/
com.ibm.websphere.nd.multiplatform.doc/ae/rxml_stopmanager.html
Starting a node agent by using the startNode tool: http://
publib.boulder.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=/
com.ibm.websphere.nd.multiplatform.doc/ae/rxml_startnode.html
Stopping a node agent by using the stopNode tool: http://
publib.boulder.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=/
com.ibm.websphere.nd.multiplatform.doc/ae/rxml_stopnode.html
Starting cluster members: http://publib.boulder.ibm.com/infocenter/
wasinfo/v8r5/index.jsp?topic=/com.ibm.websphere.nd.doc/ae/
trun_wlm_cluster_start.html
Stopping cluster members: http://publib.boulder.ibm.com/infocenter/
wasinfo/v8r5/index.jsp?topic=/com.ibm.websphere.nd.doc/ae/
trun_wlm_cluster_stop.html
Starting stand-alone application servers and cluster members by using the
startServer tool: http://publib.boulder.ibm.com/infocenter/wasinfo/
v8r5/index.jsp?topic=/com.ibm.websphere.nd.doc/ae/
rxml_startserver.html

Placing IBM InfoSphere Information Server in maintenance mode
When you do routine maintenance of InfoSphere Information Server such as
applying a fix pack or backing up the system, you can place the InfoSphere
Information Server in maintenance mode. To prevent users from authenticating to
IBM InfoSphere Information Server during maintenance, you can place it into
maintenance mode by using the SessionAdmin command.
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Before you begin
You must have suite administrator authority.

About this task
When IBM InfoSphere Information Server is placed in maintenance mode, users
who do not have the suite administrator authority are prevented from logging in
to the server. All user sessions on the server are then disconnected to prevent any
activity on the system during maintenance. The SessionAdmin is in the following
location:
v

UNIX

Linux

IS_install_dir/ASBServer/bin/SessionAdmin.sh
IS_install_dir/ASBNode/bin/SessionAdmin.sh
v

Windows

IS_install_dir\ASBServer\bin\SessionAdmin.bat
IS_install_dir\ASBNode\bin\SessionAdmin.bat
Specify the host name and port number where the product is installed. Also,
specify your administrator user name and password that allows you to run this
command on the server. Instead of specifying the -user and -password options,
you can use the -authfile option.

Procedure
1. Close all active products sessions by issuing the following command:
SessionAdmin -url https://server_hostname:server_port -user username
-password plaintext_password -kill-user-sessions
2. Place the product in maintenance mode by issuing the following command:
SessionAdmin -url https://server_hostname:server_port -user username
-password plaintext_password -set-maint-mode ON
3. Take the product out of maintenance mode by issuing the following command:
SessionAdmin -url https://server_hostname:server_port -user username
-password plaintext_password -set-maint-mode OFF
4. Determine the current maintenance mode of the product by using the following
command:
SessionAdmin -url https://server_hostname:server_port -user username
-password plaintext_password -get-maint-mode

Shutting down services (Windows)
Follow this procedure to shut down the IBM InfoSphere Information Server
services and IBM WebSphere Application Server services in a Microsoft Windows
installation. Shut down services before you back up or restore your system, or do
other maintenance tasks.

Before you begin
If your metadata repository tier is set up in a clustered configuration, make sure
that the databases are shut down last, if you shut them down at all.
Note: To perform a cold backup, you must shut down the databases.
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About this task
The paths shown in this task assume that WebSphere Application Server and
InfoSphere Information Server are installed in the default locations. Your paths and
profile names are different if you installed these products in different locations.

Procedure
1. Stop the following services: IBM InfoSphere DataStage Telnet Service,
InfoSphere DataStage Engine Resource Service, InfoSphere DataStage
AppWatcher Service, DSRPC Service, and ASB Agent. To stop the services:
a. On each computer that hosts an engine tier, log in as a user that has local
administrator privileges.
b. Use the Services Administrative Tool or the sc command-line tool to stop
the services. Stop the services in the order in which they appear in the table.
Table 21. Services to stop, in the order in which they must be stopped
Service full name

Service short name

Process name

DataStage Telnet Service

dstelnet

tl_dsservice.exe

DataStage Engine Resource
Service

DSEngine

dsservice.exe

DataStage AppWatcher
Service
Note: This service is
optional. It may not be
running if you have not
configured and started it.

DSAppWatcher

DSAppWatcher.exe

DSRPC Service

dsrpc

dsrpcd.exe

ASB Agent

ASBAgent

ASBAgent.exe

2. Stop WebSphere Application Server.

Stopping IBM WebSphere Application Server (Windows)
Follow this procedure to shut down WebSphere Application Server services in a
Microsoft Windows installation.

Procedure
Do either of the following tasks, depending on whether you have a stand-alone or
clustered configuration:
Stopping a WebSphere Application Server Liberty Profile installation:
1. On the computer that hosts the services tier, log in as a user with local
administrator privileges.
2. At a Windows command prompt, enter: net stop InfoSvr.
Stopping a stand-alone WebSphere Application Server configuration:
1. On the computer that hosts the services tier, log in as a user that has
local administrator privileges.
2. On the Windows desktop, click All Programs > IBM WebSphere >
Application Server > Profiles > InfoSphere > Stop the server.
InfoSphere is the profile name where InfoSphere Information Server is
installed.
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3. When prompted, enter a user name and password for an account that
has WebSphere Application Server administrator privileges.
4. Verify that WebSphere Application Server processes have stopped. See
“Checking the status of IBM WebSphere Application Server Network
Deployment (stand-alone installation)” on page 263.
Stopping a clustered WebSphere Application Server configuration:
1. Start the WebSphere Application Server administrative console.
2. In the console navigation tree, click Servers > Clusters. The Server
Cluster page appears.
Note: Depending on the WebSphere Application Server version, you
might have to click Servers > Clusters > WebSphere Application
Server clusters to access the Server Cluster page.
3. Select the cluster.
4. Click Stop. This command allows each application server to finish
existing requests and allows failover to another member of the cluster.
When the stop operation begins, the cluster status changes to partially
stopped. After all application servers stop, the cluster status becomes
Stopped.
5. On each node, log in as a user with local administrator privileges.
6. On the node, run the stopNode command to stop the node agent:
C:\IBM\WebSphere\AppServer\profiles\Custom01\bin\stopNode -user wasadmin
-password password

In the command, Custom01 is the WebSphere Application Server custom
profile that hosts a node of theIBM InfoSphere Information Server
cluster. wasadmin and password are the WebSphere Application Server
administrator user name and password.
Control returns to the command line after the node agent shuts down.
Note: If the node agent runs as a Windows service, the stopNode
command stops the associated Windows service and the node agent.
7. Verify that all cluster members and node agents are stopped. See
“Checking the status of IBM WebSphere Application Server cluster
members” on page 266 and “Checking the status of IBM WebSphere
Application Server node agents” on page 266.
8. Stop the Network Deployment manager process. See “Stopping the IBM
WebSphere Application Server Deployment Manager (Windows).”

Stopping the IBM WebSphere Application Server Deployment
Manager (Windows)
Follow this procedure to stop the IBM WebSphere Application Server Network
Deployment Deployment Manager in a Microsoft Windows installation with
WebSphere Application Server clustering.

Procedure
1. On the node that hosts the Deployment Manager, log in as a user with local
administrator privileges.
2. On the node, run the stopManager command to stop the Network Deployment
manager process:
C:\IBM\WebSphere\AppServer\profiles\Dmgr01\bin\stopManager
-user wasadmin -password password
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Dmgr01 is the WebSphere Application Server Deployment Manager profile.
wasadmin and password are the WebSphere Application Server administrator
user name and password.
Note: If the Deployment Manager is running as a Windows service, the
stopManager command stops the associated Windows service and also stops the
Deployment Manager.
3. Verify that the Deployment Manager has stopped by using the WebSphere
Application Server serverStatus command-line tool.
For more information, see the serverStatus documentation:
v WebSphere Application Server 8.5: http://publib.boulder.ibm.com/
infocenter/wasinfo/v8r5/index.jsp?topic=/com.ibm.websphere.nd.doc/ae/
rxml_serverstatus.html

Shutting down services (Linux, UNIX)
Follow this procedure to shut down the IBM InfoSphere Information Server
services and application server services in a Linux or UNIX installation. Shut down
services before you back up or restore your system, or do other maintenance tasks.

Before you begin
If your metadata repository tier is set up in a clustered configuration, make sure
that the databases are shut down last, if you shut them down at all.
Note: To perform a cold backup, you must shut down the databases.

About this task
The paths shown in this task assume that the application server and InfoSphere
Information Server are installed in the default locations. Your paths and profile
names are different if you installed these products in different locations.

Procedure
1. Stop the following services: Metadata Server services, ASB Agent, and DSRPC
Server.
a. Log in to each computer that hosts an engine tier. Use the following
credentials:
v If you have configured the InfoSphere Information Server agents for
non-root administration, and the services were started and are currently
running under this non-root user, use the credentials for the administrator
user that you previously configured.
v If you have not configured the agents in this manner, log in as root.
b. Run the following command to source the dsenv file:
. /opt/IBM/InformationServer/Server/DSEngine/dsenv

c. Make sure that the /.dshome file contains the current engine location. UNIX
systems support multiple instances of InfoSphere DataStage.
d. Run the following commands to stop the InfoSphere DataStage services. The
bin/uv -admin -stop command stops the instance of InfoSphere DataStage
that is in the /.dshome file.
cd /opt/IBM/InformationServer/Server/DSEngine
bin/uv –admin –stop

e. Run the following commands to stop the agents:
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cd /opt/IBM/InformationServer/ASBNode/bin
./NodeAgents.sh stop

f. Run the top command to verify that the processes have stopped.
2. Stop the AppWatcher process. For more information, see Starting and stopping
the AppWatcher process
Note: This process is optional and should only be running if it has been
configured and started.
3. Stop the application server.

Stopping IBM WebSphere Application Server (Linux, UNIX)
Follow this procedure to shut down WebSphere Application Server services in a
Linux or UNIX installation.

Procedure
Do either of the following tasks, depending on whether you have a stand-alone or
clustered configuration:
Stopping a WebSphere Application Server Liberty Profile or Network
Deployment stand-alone configuration:
1. Log in to the computer that hosts the services tier. Use the following
credentials:
v If you have configured WebSphere Application Server for non-root
administration, use the credentials for the non-root user that is
configured to administer WebSphere Application Server.
v If you have not configured WebSphere Application Server in this
manner, log in as root.
2. Run the following commands:
cd /opt/IBM/InformationServer/ASBServer/bin
./MetadataServer.sh stop

3. Verify that WebSphere Application Server processes have stopped. See
“Checking the status of IBM WebSphere Application Server (Liberty
Profile installation)” on page 265 or “Checking the status of IBM
WebSphere Application Server Network Deployment (stand-alone
installation)” on page 263.
Stopping a clustered WebSphere Application Server Network Deployment
configuration:
1. Log in to the node that hosts the Deployment Manager. Use the
WebSphere Application Server administrator credentials.
2. In the console navigation tree, click Servers > Clusters to access the
Server Cluster page.
Note: Depending on your WebSphere Application Server version, you
might have to click Servers > Clusters > WebSphere Application
Server clusters to access the Server Cluster page.
3. Select the cluster.
4. Click Stop. This command allows each application server to finish
existing requests and allows failover to another member of the cluster.
When the stop operation begins, the cluster status changes to partially
stopped. After all application servers stop, the cluster status becomes
Stopped.
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5. On each node, log in by using WebSphere Application Server
administrator credentials.
6. On the node, run the stopNode command to stop the node agent.
Specify the correct profile:
/opt/IBM/WebSphere/AppServer/profiles/Custom01/bin/stopNode.sh
-user wasadmin -password mypassword

Custom01 is the WebSphere Application Server custom profile that hosts
a node of the IBM InfoSphere Information Server cluster. wasadmin is
the user name of the WebSphere Application Server administrator.
password is the password.
7. Verify that all cluster members and node agents are stopped. See
“Checking the status of IBM WebSphere Application Server cluster
members” on page 266 and “Checking the status of IBM WebSphere
Application Server node agents” on page 266.
8. Stop the Deployment Manager. See “Stopping the IBM WebSphere
Application Server Deployment Manager (Linux, UNIX).”

Stopping the IBM WebSphere Application Server Deployment
Manager (Linux, UNIX)
Follow this procedure to stop the WebSphere Application Server Deployment
Manager in a Linux or UNIX installation with WebSphere Application Server
clustering.

Procedure
1. Log in to the node that hosts the Deployment Manager by using WebSphere
Application Server administrator credentials.
2. On the node, run the stopManager command to stop the Deployment Manager
process:
/opt/IBM/WebSphere/AppServer/profiles/Dmgr01/bin/stopManager.sh -user wasadmin
-password password

In the command, Dmgr01 is the WebSphere Application Server Deployment
Manager profile. wasadmin is the user name of the WebSphere Application
Server administrator. password is the password.
Control returns to the command line after the Deployment Manager process
shuts down.
3. Verify that the Deployment Manager has stopped.
To verify that the processes have stopped, run the WebSphere Application
Server serverStatus.sh command. For more information, see the
serverStatus.sh documentation:
v WebSphere Application Server 8.5: http://publib.boulder.ibm.com/
infocenter/wasinfo/v8r5/index.jsp?topic=/com.ibm.websphere.nd.doc/ae/
rxml_serverstatus.html

Starting services (Windows)
Follow this procedure to start the IBM InfoSphere Information Server services and
IBM WebSphere Application Server services in a Microsoft Windows installation.

Before you begin
Make sure that the database is operational before you do this procedure.
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About this task
The paths in this task assume that WebSphere Application Server and InfoSphere
Information Server are installed in the default location. Your paths and profile
names are different if you installed these products in a different location.

Procedure
1. Start WebSphere Application Server. See “Starting IBM WebSphere Application
Server (Windows).”
2. When WebSphere Application Server is fully started, log in to each computer
that hosts an engine tier.
3. On each computer, start the following services: ASB Agent, DSRPC Service,
DataStage AppWatcher Service,IBM InfoSphere DataStage Telnet Service, and
InfoSphere DataStage Engine Resource Service. You can use the Services
Administrative Tool or the sc command-line tool to start the services.
Start these services in the order shown in the following table.
Table 22. Order in which services must be started
Service full name

Service short name

ASB Agent

ASBAgent

DSRPC Service

dsrpc

InfoSphere DataStage Engine Resource
Service

DSEngine

InfoSphere DataStage Telnet Service

dstelnet

DSAppWatcher
Optional:DataStage AppWatcher Service
Note: It is only necessary to start this
service if you have configured it. Otherwise,
you may see an error when starting the
service.

Starting IBM WebSphere Application Server (Windows)
Follow this procedure to start the IBM WebSphere Application Server services in a
Microsoft Windows installation.

Procedure
Do either of the following tasks, depending on whether you have a stand-alone or
clustered configuration:
Starting a WebSphere Application Server Liberty Profile installation:
1. On the computer that hosts the services tier, log in as a user with local
administrator privileges.
2. At a Windows command prompt, enter: net start InfoSvr.
3. Verify that the application server has started. See “Checking the status
of IBM WebSphere Application Server startup (Liberty Profile
installation)” on page 264.
Starting a stand-alone WebSphere Application Server configuration:
1. On the computer that hosts the services tier, log in as a user with local
administrator privileges.
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2. On the Windows desktop, click All Programs > IBM WebSphere >
Application Server > Profiles > InfoSphere > Start the server.
InfoSphere is the profile name where InfoSphere Information Server is
installed.
3. Even though the status of a might show as Started within the IBM
InfoSphere Information Server Web console, it might still not be
available for use by InfoSphere Information Server until the InfoSphere
Information Server applications are fully initialized. To verify that
WebSphere Application Server has started, monitor the log files. See
“Checking the status of IBM WebSphere Application Server startup
(stand-alone installation)” on page 262.
Starting a clustered WebSphere Application Server configuration:
1. Start the Deployment Manager. See “Starting the IBM WebSphere
Application Server Deployment Manager (Windows).”
2. On each node, run the startNode command to start the node agent:
C:\IBM\WebSphere\AppServer\profiles\Custom01\bin\startNode

where Custom01 is the WebSphere Application Server custom profile
that hosts a node of the IBM InfoSphere Information Server cluster.
3. Start the WebSphere Application Server administrative console.
4. In the console navigation tree, click Servers > Clusters to access the
Server Cluster page.
Note: Depending on the WebSphere Application Server version, you
might have to click Servers > Clusters > WebSphere Application
Server clusters to access the Server Cluster page.
5. Select the cluster.
6. Click Start. This command starts the server process of each member of
the cluster by calling the node agent for each server to start the
application servers. After all application servers are running, the state
of the cluster changes to running. If the call to a node agent for an
application server fails, the application server does not start.
7. Even though the status returned by the serverStatus command
indicates STARTED, it might still not be available for use by InfoSphere
Information Server until the InfoSphere Information Server applications
are fully initialized. To verify that WebSphere Application Server has
started, monitor the log files. See “Checking the status of IBM
WebSphere Application Server startup (clustered installation)” on page
265.

Starting the IBM WebSphere Application Server Deployment
Manager (Windows)
Follow this procedure to start the IBM WebSphere Application Server Deployment
Manager in a Microsoft Windows installation with WebSphere Application Server
clustering.

Procedure
1. On the node that hosts the Deployment Manager, log in as a user with local
administrator privileges.
2. On the node that hosts the Deployment Manager, run the startManager
command to start the Network Deployment manager process:
C:\IBM\WebSphere\AppServer\profiles\Dmgr01\bin\startManager
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where Dmgr01 is the WebSphere Application Server Deployment Manager
profile.
If the Deployment Manager runs as a Windows service, the startManager
command starts the associated Windows service and the Deployment Manager.

Starting services (Linux, UNIX)
Follow this procedure to start the IBM InfoSphere Information Server services and
application server services in a Linux or UNIX installation.

Before you begin
Ensure that the database is operational before you do this procedure.
IS_install_path refers to the location where InfoSphere Information Server has been
installed. The default location is /opt/IBM/InformationServer.

Procedure
1. Start the application server. See “Starting IBM WebSphere Application Server
(Linux, UNIX).”
2. On each computer, start the engine service and ASB Agent.
a. Wait until the application server is fully started.
b. Log in to each computer that hosts an engine tier. Use the following
credentials:
v If you configured the InfoSphere Information Server agents for non-root
administration, use the credentials for the administrator user that you
selected.
v If you did not configure the agents in this manner, log in as root.
c. Run the following command as the InfoSphere DataStage administrator
(dsadm by default) to source the dsenv file:
su - dsadm
. IS_install_path/Server/DSEngine/dsenv

d. Make sure that the /.dshome file contains the current engine location. UNIX
systems support multiple instances of InfoSphere DataStage. The bin/uv
-admin -start command starts the instance of InfoSphere DataStage that is
in the /.dshome file.
e. As the InfoSphere DataStage administrator user, run the following
commands to start the InfoSphere DataStage services and exit the su session
for the InfoSphere DataStage administrator:
cd IS_install_path/Server/DSEngine
./bin/uv -admin -start
exit

f. Run the following commands to start the ASB Agent:
cd IS_install_path/ASBNode/bin
./NodeAgents.sh start

3. Optional: Start the AppWatcher process. For more information, see Starting and
stopping the AppWatcher process.

Starting IBM WebSphere Application Server (Linux, UNIX)
Follow this procedure to start the IBM WebSphere Application Server services in a
Linux or UNIX installation.
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Before you begin
For cluster environments:
v

If you did not configure file descriptor resources for WebSphere
Application Server before you installed IBM InfoSphere Information Server,
make sure that WebSphere Application Server is stopped and configure your
managed nodes as described in “Configuring file descriptor resources for IBM
WebSphere Application Server (Linux)” on page 261.

v

AIX
If you did not unset the LDR_CNTRL variable before you installed
IBM InfoSphere Information Server, make sure that WebSphere Application
Server is stopped and configure your cluster computers as described in
“Configuring memory allocation for IBM WebSphere Application Server (AIX)”
on page 261.

Linux

For stand-alone environments, these settings are automatically configured by the
MetadataServer script.

Procedure
Do either of the following tasks, depending upon whether you have a stand-alone
or clustered configuration:
Starting a WebSphere Application Server Liberty Profile or Network
Deployment stand-alone configuration:
1. Log in to the computer that hosts the services tier. Use the following
credentials:
v If you configured WebSphere Application Server for non-root
administration, use the credentials for the non-root user that is
configured to administer WebSphere Application Server.
v If you did not configure WebSphere Application Server in this
manner, log in as root.
2. Run the following commands:
cd /opt/IBM/InformationServer/ASBServer/bin
./MetadataServer.sh run

Note: The run argument echoes all output to the console.
Alternatively, if you want to embed this script in another script, use the
MetatdataServer.sh start command to launch the start process in the
background:
cd /opt/IBM/InformationServer/ASBServer/bin
./MetadataServer.sh start

If you configured WebSphere Application Server for non-root
administration, you can use this line in your script:
/usr/bin/su - wasadmin -c "/opt/IBM/InformationServer/ASBServer/bin/
MetadataServer.sh start"

where wasadmin is the non-root user that is configured to administer
WebSphere Application Server.
3. Even though the WebSphere Application Server status might show as
Started within the IBM InfoSphere Information Server Web console, it
might still not be available for use by InfoSphere Information Server
until the InfoSphere Information Server applications are fully
initialized. To verify that WebSphere Application Server has started,
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monitor the log files. See “Checking the status of IBM WebSphere
Application Server startup (stand-alone installation)” on page 262.
Starting a clustered WebSphere Application Server Network Deployment
configuration:
1. Start the Deployment Manager. See “Starting the IBM WebSphere
Application Server Deployment Manager (Linux, UNIX).”
2. Log in to each node. Use the same credentials that you used to log in
to the Deployment Manager node.
3. On each node, run the startNode command to start the node agent:
/opt/IBM/WebSphere/AppServer/profiles/Custom01/bin/startNode.sh

where Custom01 is the WebSphere Application Server custom profile
that hosts a node of the IBM InfoSphere Information Server cluster.
Control returns to the command line when the node agent startup is
complete.
4. Log in to the WebSphere Application Server administrative console.
5. In the console navigation tree, click Servers > Clusters. The Server
Cluster page appears.
Note: Depending upon your WebSphere Application Server version,
you might need to click Servers > Clusters > WebSphere Application
Server clusters to access the Server Cluster page.
6. Select the cluster.
7. Click Start. This command starts the server process of each member of
the cluster. To do so, it calls the node agent for each server to start the
application servers. After all application servers are running, the state
of the cluster changes to running. If the call to a node agent for an
application server fails, the application server does not start.
8. Even though the status returned by the serverStatus command
indicates STARTED, it might still not be available for use by InfoSphere
Information Server until the InfoSphere Information Server applications
are fully initialized. To verify that WebSphere Application Server has
started, monitor the log files. See “Checking the status of IBM
WebSphere Application Server startup (clustered installation)” on page
265.

Starting the IBM WebSphere Application Server Deployment
Manager (Linux, UNIX)
Follow this procedure to start the IBM WebSphere Application Server Deployment
Manager in a Linux or UNIX installation with WebSphere Application Server
clustering.

Procedure
1. Log in to the node that hosts the Deployment Manager. Use the following
credentials:
v If you have configured WebSphere Application Server for non-root
administration, use the credentials for the non-root user that is configured to
administer WebSphere Application Server.
v If you have not configured WebSphere Application Server in this manner, log
in as root.
2. On the node, run the startManager command to start the Network Deployment
manager process:

260

Administration Guide

/opt/IBM/WebSphere/AppServer/profiles/Dmgr01/bin/startManager.sh

where Dmgr01 is the WebSphere Application Server Deployment Manager
profile.

Configuring file descriptor resources for IBM WebSphere
Application Server (Linux)
On Linux, the default setting for the maximum number of file descriptors allowed
is not sufficient to run WebSphere Application Server. You must configure the file
descriptor resources for WebSphere Application Server to run correctly.

About this task
If your installation includes a stand-alone instance of WebSphere Application
Server, configure the file descriptor resources on the computer on which
WebSphere Application Server is installed. For cluster environments, you must
configure the file descriptor resources on each computer where WebSphere
Application Server is installed (Deployment Manager and managed nodes). The
resources can be permanently configured if appropriate for your environment.

Procedure
1. Make sure all WebSphere Application Server processes are stopped. See
“Stopping IBM WebSphere Application Server (Linux, UNIX)” on page 254.
2. Configure the computer to support a large number of file descriptors. Refer to
your system administrator if you are unsure about this process.
The following example shows how to set the number of file descriptors to
10240 if your login shell is /bin/bash. WebSphere Application Server requires a
value over 10000 to run properly.
v To apply the settings to the entire system, add the following to the
/etc/profile file:
ulimit -n 10240

v To set the soft and hard limits for all users, add the following to the
/etc/security/limits.conf file:
* soft nofile 10240
* hard nofile 10240

If you do not want to permanently configure these values as shown in the
example, you can instead run the ulimit -n command just before you start a
WebSphere Application Server process. All WebSphere Application Server
processes must be stopped before you run these commands.
3. Start all WebSphere Application Server processes. See “Starting IBM WebSphere
Application Server (Linux, UNIX)” on page 258.
4. In a cluster environment, repeat this procedure on all systems where
WebSphere Application Server is installed.

Configuring memory allocation for IBM WebSphere Application
Server (AIX)
On AIX, the LDR_CNTRL environment variable controls the way AIX handles the
memory space available to programs and the page sizes used in each segment. To
provide sufficient memory allocation for WebSphere Application Server, you must
unset this environment variable for WebSphere Application Server to run correctly.
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About this task
If your installation includes a stand-alone instance of WebSphere Application
Server, unset the LDR_CNTRL environment variable on the computer on which
WebSphere Application Server is installed. For cluster environments, you must
unset the LDR_CNTRL environment variable on each computer where WebSphere
Application Server is installed (Deployment Manager and managed nodes). The
change can be permanently configured if appropriate for your environment.

Procedure
To unset the LDR_CNTRL environment variable:
1. Make sure all WebSphere Application Server processes are stopped. See
“Stopping IBM WebSphere Application Server (Linux, UNIX)” on page 254.
2. Configure the LDR_CNTRL environment variable. Refer to your system
administrator if you are unsure about this process.
The following example shows how to unset the LDR_CNTRL environment
variable if your login shell is /bin/bash.
v To apply the setting to all users on the system, add the following line to the
/etc/profile file:
unset LDR_CNTRL

v To apply the setting to a specific user, add the line to the ~/.profile file for
the user. The user to configure is typically root unless you reconfigured
WebSphere Application Server for non-root administration.
If you do not want to permanently configure the environment variable as
shown in the example, you can run the unset LDR_CNTRL command just before
you start a WebSphere Application Server process. All WebSphere Application
Server processes must be stopped before you run these commands.
3. Start the WebSphere Application Server processes. See “Starting IBM
WebSphere Application Server (Linux, UNIX)” on page 258.
4. In a clustered environment, repeat this procedure on all computers where
WebSphere Application Server is installed.

Checking the status of the application server processes
Follow these procedures to check the status of a WebSphere Application Server
Liberty Profile or Network Deployment stand-alone installation, or of clustered
Network Deployment cluster members, node agents, and the Deployment
Manager.

Checking the status of IBM WebSphere Application Server
startup (stand-alone installation)
Whenever you restart WebSphere Application Server, make sure that the
application server is fully started before you take any further action. This
procedure applies to a stand-alone installation of WebSphere Application Server.

About this task
Even though the status of an application server might show as STARTED, it might
still not be available for use by IBM InfoSphere Information Server because the
InfoSphere Information Server applications not yet fully initialized. The InfoSphere
Information Server applications typically complete initialization within two to four
minutes after the application server status first changes to STARTED.

262

Administration Guide

If you started WebSphere Application Server by running startServer or
MetadataServer.sh run, control returns when WebSphere Application Server has
completed starting all applications but before InfoSphere Information Server has
completed application initialization. Running serverStatus at this point shows a
status of STARTED. However, initialization is not yet complete.
If you started WebSphere Application Server by running MetadataServer.sh start,
control returns immediately before WebSphere Application Server starts any
applications. After a delay, running serverStatus will show a status of STARTING.
After a few minutes, running serverStatus will show a status of STARTED. This
status indicates that WebSphere Application Server has completed starting all
applications. However, it does not indicate that InfoSphere Information Server has
completed application initialization.

Procedure
Follow this procedure to determine if the InfoSphere Information Server
applications have completed initialization.
1. Log in to the services tier computer.
2. Locate the SystemOut.log file. The file is located in the following directory:
WAS_install_path/profiles/profile/logs/serverx
In the directory path:
v WAS_install_path is the location where WebSphere Application Server is
installed. The default installation path is:
–

UNIX

Linux

/opt/IBM/WebSphere/AppServer

Windows
C:\IBM\WebSphere\AppServer
–
v profile is the profile name in which InfoSphere Information Server is running.
The default profile name is InfoSphere.
v serverx is the name of the application server instance. The default server
name is server1.

3. In the SystemOut.log file, in the timeframe in which the application server is
being started, look for the following line. This line indicates that InfoSphere
Information Server is fully initialized and ready for operation:
Initialization: EJB Initializations complete

The SystemOut.log file might contain log entries that span multiple application
server restarts. For this reason, the file might contain multiple lines that read
EJB Initializations complete. Use the timestamps of the log entries to
determine if this message is associated with the application server startup that
you want.

Checking the status of IBM WebSphere Application Server
Network Deployment (stand-alone installation)
In a WebSphere Application Server stand-alone installation, use the serverStatus
command to check the status of the application server startup.

Procedure
For more information about the serverStatus command, see the WebSphere
Application Server documentation.
v Version 8.5: http://publib.boulder.ibm.com/infocenter/wasinfo/v8r5/
index.jsp?topic=/com.ibm.websphere.nd.doc/ae/rxml_serverstatus.html
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What to do next
When an application server is starting up, even when the status returned by the
serverStatus command indicates that the application server is STARTED, it is not
ready for use by IBM InfoSphere Information Server until all InfoSphere
Information Server applications have completed initialization. See “Checking the
status of IBM WebSphere Application Server startup (stand-alone installation)” on
page 262 for more information.

Checking the status of IBM WebSphere Application Server
startup (Liberty Profile installation)
Whenever you restart WebSphere Application Server Liberty Profile, make sure
that the application server is fully started before you take any further action. This
procedure applies to a WebSphere Application Server Liberty Profile installation.

About this task
Even though the status of an application server might show as STARTED, it might
still not be available for use by IBM InfoSphere Information Server because the
InfoSphere Information Server applications not yet fully initialized. The InfoSphere
Information Server applications typically complete initialization within two to four
minutes after the application server status first changes to STARTED.
If you started WebSphere Application Server by running server start or
MetadataServer.sh run, control returns when WebSphere Application Server has
completed starting all applications but before InfoSphere Information Server has
completed application initialization. Running server status at this point shows a
status of STARTED. However, initialization is not yet complete.
If you started WebSphere Application Server by running MetadataServer.sh start,
control returns immediately before WebSphere Application Server starts any
applications. After a delay, running server status will show a status of
STARTING. After a few minutes, running server status will show a status of
STARTED. This status indicates that WebSphere Application Server has completed
starting all applications. However, it does not indicate that InfoSphere Information
Server has completed application initialization.

Procedure
Follow this procedure to determine if the InfoSphere Information Server
applications have completed initialization.
1. Log in to the services tier computer.
2. Locate the messages.log file. The file is located in the following directory:
IS_install_path/wlp/usr/servers/iis/logs/
3. In the messages.log file, in the timeframe in which the application server is
being started, look for the following line. This line indicates that InfoSphere
Information Server is fully initialized and ready for operation:
Initialization: EJB Initializations complete

The messages.log file might contain log entries that span multiple application
server restarts. For this reason, the file might contain multiple lines that read
EJB Initializations complete. Use the timestamps of the log entries to
determine if this message is associated with the application server startup that
you want.
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Checking the status of IBM WebSphere Application Server
(Liberty Profile installation)
In a WebSphere Application Server Liberty Profile installation, use the server
command to check the status of the application server startup.

Procedure
Run the server command with the status option.
cd IS_install_path/wlp/bin
./server status

For more information about the server command, see the WebSphere Application
Server documentation.
v Version 8.5: http://www.ibm.com/support/knowledgecenter/SSAW57_8.5.5/
com.ibm.websphere.wlp.nd.multiplatform.doc/ae/twlp_admin_script.html

Checking the status of IBM WebSphere Application Server
startup (clustered installation)
Whenever you start a cluster member, make sure the application server associated
with that cluster member is fully started before you take any further action. This
procedure applies to a clustered installation of WebSphere Application Server.

About this task
Even though the status of a cluster member might show as Started within the IBM
InfoSphere Information Server Web console, or the status returned by the
serverStatus command indicates that the application server is STARTED, it might
still not be available for use by InfoSphere Information Server until the InfoSphere
Information Server applications are fully initialized. The InfoSphere Information
Server applications typically complete initialization within two to four minutes
after the application server status first changes to Started.

Procedure
Follow this procedure to determine if the InfoSphere Information Server
applications have completed initialization.
1. Log in to each computer that hosts a cluster member.
2. On the computer, locate the SystemOut.log file. The file can be found in the
following directory:
WAS_install_path/profiles/profile/logs/serverx
In the directory path:
v WAS_install_path is the location where WebSphere Application Server is
installed. The default installation path is:
–

UNIX

Linux

/opt/IBM/WebSphere/AppServer

Windows
C:\IBM\WebSphere\AppServer
–
v profile is the profile name of the managed node in which InfoSphere
Information Server is running. The default profile name is Custom01.
v serverx is the name of the application server instance. The default value is
serverx, where x is the number of one of the application server instances.
3. Check the SystemOut.log file in each server instance:
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a. In the SystemOut.log file, in the timeframe in which the application server
is being started, look for the following line. This line indicates that
InfoSphere Information Server is fully initialized and ready for operation:
Initialization: EJB Initializations complete

The SystemOut.log file might contain log entries that span multiple
application server restarts. For this reason, the file might contain multiple
lines that read EJB Initializations complete. Use the timestamps of the
log entries to determine if this message is associated with the application
server startup that you want.
4. Repeat this procedure for each computer that hosts a cluster member.

What to do next
InfoSphere Information Server can be used as soon as one cluster member is fully
initialized. However, for best performance, wait until all members of the cluster are
fully initialized. Allowing all the members of the cluster to initialize fully also
maximizes the number of members that can take over in case of a failover.

Checking the status of IBM WebSphere Application Server
cluster members
In a WebSphere Application Server cluster installation, use the WebSphere
Application Server administrative console to check the status of cluster members.

Procedure
1. Log in to the WebSphere Application Server administrative console.
2. Access the cluster list in the console. In the navigation pane, expand Servers,
expand Clusters, and click WebSphere application server clusters.
3. In the workspace, click the cluster name. The cluster page appears.
4. Click Cluster members. The Cluster members page appears. Each cluster
member is listed on the page. The Status column indicates the status of each
cluster member.

What to do next
When an application server is starting up, even when the status of the cluster
member in the WebSphere Application Server administrative console shows as
Started or when the status returned by the serverStatus command indicates that
the application server is STARTED, it is not ready for use by IBM InfoSphere
Information Server until all InfoSphere Information Server applications have
completed initialization. See Checking the status of IBM WebSphere Application
Server startup (clustered installation) for details on how to tell when InfoSphere
Information Server applications have completed initialization.

Checking the status of IBM WebSphere Application Server
node agents
In a WebSphere Application Server cluster installation, use the WebSphere
Application Server administrative console to check the status of node agents.

Procedure
1. Log in to the WebSphere Application Server administrative console.
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2. In the navigation pane, expand System administration and click Node agents.
The Node agents page appears. Each node agent is listed on the page. The
Status column indicates the status of each node agent.

Checking the status of the IBM WebSphere Application Server
Deployment Manager
In a WebSphere Application Server cluster installation, use the serverStatus
command to check the status of the deployment manager.

Procedure
Run the serverStatus command. The command is located on the computer on
which the Deployment Manager runs, in the following directory:
WAS_install_path/profiles/profile/bin
In the directory path:
v WAS_install_path is the location where WebSphere Application Server is installed.
The default installation path is:
–

UNIX

Linux

/opt/IBM/WebSphere/AppServer

Windows
C:\IBM\WebSphere\AppServer
–
v profile is the name of the Deployment Manager profile.

For more information about the serverStatus command, see the WebSphere
Application Server documentation.
v Version 8.5: publib.boulder.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=/
com.ibm.websphere.nd.doc/ae/rxml_serverstatus.html
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Appendix A. Product accessibility
You can get information about the accessibility status of IBM products.
The IBM InfoSphere Information Server product modules and user interfaces are
not fully accessible.
For information about the accessibility status of IBM products, see the IBM product
accessibility information at http://www.ibm.com/able/product_accessibility/
index.html.

Accessible documentation
Accessible documentation for InfoSphere Information Server products is provided
in an information center. The information center presents the documentation in
XHTML 1.0 format, which is viewable in most web browsers. Because the
information center uses XHTML, you can set display preferences in your browser.
This also allows you to use screen readers and other assistive technologies to
access the documentation.
The documentation that is in the information center is also provided in PDF files,
which are not fully accessible.

IBM and accessibility
See the IBM Human Ability and Accessibility Center for more information about
the commitment that IBM has to accessibility.
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Appendix B. Reading command-line syntax
This documentation uses special characters to define the command-line syntax.
The following special characters define the command-line syntax:
[]

Identifies an optional argument. Arguments that are not enclosed in
brackets are required.

...

Indicates that you can specify multiple values for the previous argument.

|

Indicates mutually exclusive information. You can use the argument to the
left of the separator or the argument to the right of the separator. You
cannot use both arguments in a single use of the command.

{}

Delimits a set of mutually exclusive arguments when one of the arguments
is required. If the arguments are optional, they are enclosed in brackets ([
]).

Note:
v The maximum number of characters in an argument is 256.
v Enclose argument values that have embedded spaces with either single or
double quotation marks.
For example:
wsetsrc[-S server] [-l label] [-n name] source
The source argument is the only required argument for the wsetsrc command. The
brackets around the other arguments indicate that these arguments are optional.
wlsac [-l | -f format] [key... ] profile
In this example, the -l and -f format arguments are mutually exclusive and
optional. The profile argument is required. The key argument is optional. The
ellipsis (...) that follows the key argument indicates that you can specify multiple
key names.
wrb -import {rule_pack | rule_set}...
In this example, the rule_pack and rule_set arguments are mutually exclusive, but
one of the arguments must be specified. Also, the ellipsis marks (...) indicate that
you can specify multiple rule packs or rule sets.
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Appendix C. Contacting IBM
You can contact IBM for customer support, software services, product information,
and general information. You also can provide feedback to IBM about products
and documentation.
The following table lists resources for customer support, software services, training,
and product and solutions information.
Table 23. IBM resources
Resource

Description and location

IBM Support Portal

You can customize support information by
choosing the products and the topics that
interest you at www.ibm.com/support/
entry/portal/Software/
Information_Management/
InfoSphere_Information_Server

Software services

You can find information about software, IT,
and business consulting services, on the
solutions site at www.ibm.com/
businesssolutions/

My IBM

You can manage links to IBM Web sites and
information that meet your specific technical
support needs by creating an account on the
My IBM site at www.ibm.com/account/

Training and certification

You can learn about technical training and
education services designed for individuals,
companies, and public organizations to
acquire, maintain, and optimize their IT
skills at http://www.ibm.com/training

IBM representatives

You can contact an IBM representative to
learn about solutions at
www.ibm.com/connect/ibm/us/en/
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Appendix D. Accessing the product documentation
Documentation is provided in a variety of formats: in the online IBM Knowledge
Center, in an optional locally installed information center, and as PDF books. You
can access the online or locally installed help directly from the product client
interfaces.
IBM Knowledge Center is the best place to find the most up-to-date information
for InfoSphere Information Server. IBM Knowledge Center contains help for most
of the product interfaces, as well as complete documentation for all the product
modules in the suite. You can open IBM Knowledge Center from the installed
product or from a web browser.

Accessing IBM Knowledge Center
There are various ways to access the online documentation:
v Click the Help link in the upper right of the client interface.
v Press the F1 key. The F1 key typically opens the topic that describes the current
context of the client interface.
Note: The F1 key does not work in web clients.
v Type the address in a web browser, for example, when you are not logged in to
the product.
Enter the following address to access all versions of InfoSphere Information
Server documentation:
http://www.ibm.com/support/knowledgecenter/SSZJPZ/

If you want to access a particular topic, specify the version number with the
product identifier, the documentation plug-in name, and the topic path in the
URL. For example, the URL for the 11.3 version of this topic is as follows. (The
⇒ symbol indicates a line continuation):
http://www.ibm.com/support/knowledgecenter/SSZJPZ_11.3.0/⇒
com.ibm.swg.im.iis.common.doc/common/accessingiidoc.html

Tip:
The knowledge center has a short URL as well:
http://ibm.biz/knowctr

To specify a short URL to a specific product page, version, or topic, use a hash
character (#) between the short URL and the product identifier. For example, the
short URL to all the InfoSphere Information Server documentation is the
following URL:
http://ibm.biz/knowctr#SSZJPZ/

And, the short URL to the topic above to create a slightly shorter URL is the
following URL (The ⇒ symbol indicates a line continuation):
http://ibm.biz/knowctr#SSZJPZ_11.3.0/com.ibm.swg.im.iis.common.doc/⇒
common/accessingiidoc.html
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Changing help links to refer to locally installed documentation
IBM Knowledge Center contains the most up-to-date version of the documentation.
However, you can install a local version of the documentation as an information
center and configure your help links to point to it. A local information center is
useful if your enterprise does not provide access to the internet.
Use the installation instructions that come with the information center installation
package to install it on the computer of your choice. After you install and start the
information center, you can use the iisAdmin command on the services tier
computer to change the documentation location that the product F1 and help links
refer to. (The ⇒ symbol indicates a line continuation):
Windows

IS_install_path\ASBServer\bin\iisAdmin.bat -set -key ⇒
com.ibm.iis.infocenter.url -value http://<host>:<port>/help/topic/

AIX Linux

IS_install_path/ASBServer/bin/iisAdmin.sh -set -key ⇒
com.ibm.iis.infocenter.url -value http://<host>:<port>/help/topic/

Where <host> is the name of the computer where the information center is
installed and <port> is the port number for the information center. The default port
number is 8888. For example, on a computer named server1.example.com that uses
the default port, the URL value would be http://server1.example.com:8888/help/
topic/.

Obtaining PDF and hardcopy documentation
v The PDF file books are available online and can be accessed from this support
document: https://www.ibm.com/support/docview.wss?uid=swg27008803
&wv=1.
v You can also order IBM publications in hardcopy format online or through your
local IBM representative. To order publications online, go to the IBM
Publications Center at http://www.ibm.com/e-business/linkweb/publications/
servlet/pbi.wss.
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Notices and trademarks
This information was developed for products and services offered in the U.S.A.
This material may be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

Notices
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.
IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.
For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan
The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.
This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
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Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:
IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003 U.S.A.
Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.
The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.
Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.
All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.
This information is for planning purposes only. The information herein is subject to
change before the products described become available.
This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.
COPYRIGHT LICENSE:
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This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.
Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:
© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.
If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Privacy policy considerations
IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings
can help enable you to collect personally identifiable information. If this Software
Offering uses cookies to collect personally identifiable information, specific
information about this offering’s use of cookies is set forth below.
Depending upon the configurations deployed, this Software Offering may use
session or persistent cookies. If a product or component is not listed, that product
or component does not use cookies.
Table 24. Use of cookies by InfoSphere Information Server products and components
Component or
feature

Type of cookie
that is used

Collect this data

Purpose of data

Disabling the
cookies

Any (part of
InfoSphere
Information
Server
installation)

InfoSphere
Information
Server web
console

v Session

User name

v Session
management

Cannot be
disabled

Any (part of
InfoSphere
Information
Server
installation)

InfoSphere
Metadata Asset
Manager

v Session

Product module

v Persistent

v Authentication

v Persistent

No personally
identifiable
information

v Session
management

Cannot be
disabled

v Authentication
v Enhanced user
usability
v Single sign-on
configuration
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Table 24. Use of cookies by InfoSphere Information Server products and components (continued)
Product module

Component or
feature

Type of cookie
that is used

Collect this data

Purpose of data

Disabling the
cookies

InfoSphere
DataStage

Big Data File
stage

v Session

v User name

v Persistent

v Digital
signature

v Session
management

Cannot be
disabled

InfoSphere
DataStage

XML stage

Session

v Authentication

v Session ID

v Single sign-on
configuration

Internal
identifiers

v Session
management

Cannot be
disabled

v Authentication
InfoSphere
DataStage

InfoSphere Data
Click

IBM InfoSphere
DataStage and
QualityStage
Operations
Console

Session

InfoSphere
Information
Server web
console

v Session

InfoSphere Data
Quality Console

No personally
identifiable
information

User name

v Persistent

v Session
management

Cannot be
disabled

v Authentication

v Session
management

Cannot be
disabled

v Authentication
Session

No personally
identifiable
information

v Session
management

Cannot be
disabled

v Authentication
v Single sign-on
configuration

InfoSphere
QualityStage
Standardization
Rules Designer

InfoSphere
Information
Server web
console

InfoSphere
Information
Governance
Catalog

InfoSphere
Information
Analyzer

v Session

User name

v Persistent

v Session
management

Cannot be
disabled

v Authentication
v Session

v User name

v Persistent

v Internal
identifiers

v Session
management

Cannot be
disabled

v Authentication

v State of the tree v Single sign-on
configuration
Data Rules stage
in the InfoSphere
DataStage and
QualityStage
Designer client

Session

Session ID

Session
management

Cannot be
disabled

If the configurations deployed for this Software Offering provide you as customer
the ability to collect personally identifiable information from end users via cookies
and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent.
For more information about the use of various technologies, including cookies, for
these purposes, see IBM’s Privacy Policy at http://www.ibm.com/privacy and
IBM’s Online Privacy Statement at http://www.ibm.com/privacy/details the
section entitled “Cookies, Web Beacons and Other Technologies” and the “IBM
Software Products and Software-as-a-Service Privacy Statement” at
http://www.ibm.com/software/info/product-privacy.
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Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at www.ibm.com/legal/
copytrade.shtml.
The following terms are trademarks or registered trademarks of other companies:
Adobe is a registered trademark of Adobe Systems Incorporated in the United
States, and/or other countries.
Intel and Itanium are trademarks or registered trademarks of Intel Corporation or
its subsidiaries in the United States and other countries.
Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
Microsoft, Windows and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and other
countries.
Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
The United States Postal Service owns the following trademarks: CASS, CASS
Certified, DPV, LACSLink, ZIP, ZIP + 4, ZIP Code, Post Office, Postal Service, USPS
and United States Postal Service. IBM Corporation is a non-exclusive DPV and
LACSLink licensee of the United States Postal Service.
Other company, product or service names may be trademarks or service marks of
others.
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